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1 What’s New in This Release

What’s New in Siebel Insurance Guide, Version 8.0, Rev. A
Table 1 lists changes described in this version of the documentation to support release 8.0, Rev. A of 
the software.

What’s New in Siebel Insurance Guide, Version 8.0
Table 2 lists changes described in this version of the documentation to support release 8.0 of the 
software.

Table 1. New Product Features in Siebel Insurance Guide, Version 8.0, Rev. A

Topic Description

“About Managing Group Pensions” 
on page 75

Added a reference for more information regarding using 
catalog funcitonality to create group pensions.

Table 2. New Product Features in Siebel Insurance Guide, Version 8.0

Topic Description

“Activating the Workflow 
Processes” on page 97 and 
“Claims Workflows” on page 141

Many workflow processes are provided for Siebel Claims.

“Administering Reserve Codes” on 
page 97

In the new Administration - Insurance > Reserve Codes view, 
administrators can now define a reserve code for a particular 
reserve to determine how the reserve value is calculated.

“Administering Loss Codes” on 
page 98

In the new Administration - Insurance > Loss Codes view, 
administrators can now define a loss code for a particular type 
of loss and associate a default activity plan template and 
default coverages with that loss code.

“Administering Adjusters’ Financial 
Limits” on page 99

In the new Administration - User > Employees > Claims 
Reserve Limits view, administrators can now set reserve and 
payment limits for each reserve code, and also set total reserve 
and total payment limits for a claim for an employee.

“Integrating with the Office of 
Foreign Assets Control” on 
page 103

Siebel Insurance now allows you to check claims payees 
against a blacklist of individuals and organizations provided by 
the Office of Foreign Assets Control (OFAC).
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“Recording Details of Involved 
Parties (End User)” on page 105

In the new Claims > Loss Details > Involved Parties view, end 
users can now associate claims with accounts as well as with 
contacts. Previously, you associated claims with contacts. Also 
in this release, accounts and contacts can have a multiple role, 
for example, a Service Provider can be the insured, claimant, 
or a witness.

“Managing Claims Events (End 
User)” on page 107

In the new Claims Events screen, end users can now associate 
multiple claims with a single event. Previously, users had to 
enter the loss details for a single event multiple times, 
resulting in data duplication.

“Creating an Activity Plan (End 
User)” on page 110

In the enhanced Claims > Diary Management > Activity Plans 
view, there is now a Default Plans button that automatically 
creates an activity plan based on the loss code for a claim.

“Integrating with the Insurance 
Services Office (ISO)” on page 100 
and “Checking a Claim Against the 
ISO Database (End User)” on 
page 108

In the new Claims > Reports / Documents > ISO Database 
Search view, end users can check claims against the Insurance 
Services Office (ISO) ClaimSearch database and receive a 
response within a few minutes.

Previously, claims adjusters had to enter claims information in 
the ISO Web site, which took much longer.

“Assigning Claims to a Specialist 
Unit (End User)” on page 112

The following buttons are now available in the Claims List 
screen for evaluating the fraud and subrogation (that is, 
recovery) potential of a claim:

■ Evaluate Subrogation Potential. Evaluates the 
subrogation potential of the claim.

■ Evaluate SIU Potential. Evaluates the fraud potential of 
the claim.

“Creating a Reserve (End User)” on 
page 115

In the news Claims > Loss Details - Auto and Claims > Loss 
Details - Property views, end users can make sure that the 
customer has the right policy and coverage for a claim and 
create a reserve for each coverage. End users can now create 
reserve based on reserve codes created by the administrator.

“About Managing Reserves” on 
page 117 and “Managing Reserves 
(End User)” on page 120

In the enhanced Claims > Reserves view, end users can open 
and adjust reserve, create new reserves, and delete existing 
reserves.

Table 2. New Product Features in Siebel Insurance Guide, Version 8.0

Topic Description
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This version also contains the following changes:

■ Improvements to the organization of the book.

■ Chapter 19, “Business Services for Siebel Financial Services” was added. Previously this material 
was included only in the Siebel Finance Guide although it is also applicable to this book.

“Creating an Invoice Record (End 
User)” on page 121, “Generating a 
Payment Record (End User)” on 
page 122 and “Tracking Payments 
Related to Invoices (End User)” on 
page 122

The Invoices screen and Claims > Invoices view are now used 
instead of the Bills view to capture details of invoices for 
claims. End users can use the Invoices > Claim Payments view 
to track all of the payments for invoices.

In the new Claims > Financials > Invoices view, end users can 
capture invoices received from claimants and third parties. 
When an adjuster clicks the Generate Payment button, Siebel 
Insurance creates a payment record for that invoice.

“About Issuing a Settlement 
Payment (End User)” on page 122

In the enhanced Claims > Financials > Payments view:

■ Payments can be associated with multiple reserves

■ The processing for the Submit Payment button includes 
checks for adjuster’s payment limits, checks against the 
OFAC blacklist, and so on.

■ The Void payment button is available to cancel the 
transaction.

“Making a Bulk Payment (End 
User)” on page 127 and “Viewing 
the Invoices and Claims for a 
Payment (End User)” on page 128

In the new Payments > Insurance Payments view, end users 
can query the payments for a particular vendor in a particular 
period and generate a single bulk payment record for that 
vendor.

The Payments > Insurance Payments view also allows end 
users to display all of the invoices and claims associated with 
a particular payment.

“Managing Recovery Information 
(End User)” on page 128

In the news Claims > Recoveries view, end users can now 
manage the claims recovery process using a dashboard view.

“Creating a Recovery Payment 
Record (End User)” on page 134

In the new Claims > Financials > Recoveries view, end users 
can create a record of invoices related to recoveries from third 
parties. This view is used to capture recoveries payments as 
well as to keep track of invoices sent to third parties to collect 
the money. 

“Managing Fraud Information (End 
User)” on page 134

In the new Claims > SIU Dashboard view, end users can now 
manage fraudulent claims processing in one place and there is 
no need to reenter information.

Table 2. New Product Features in Siebel Insurance Guide, Version 8.0

Topic Description
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2 Overview of Siebel Insurance

Oracle’s Siebel Insurance includes various modules that you can mix and match according to your 
business needs. The next topic, “Siebel Insurance Functionality and Modules” on page 17, describes 
Siebel Insurance functionality.

Siebel Insurance is built upon the Siebel Business Architecture, which includes Siebel Sales, Siebel 
Service, and Siebel Call Center applications. Like many other Siebel Business Applications, Siebel 
Insurance uses the Siebel Data Model, the Siebel Object Architecture, and the Siebel Application 
Server Architecture. 

Siebel Insurance Functionality and 
Modules
Siebel Insurance is an information management application designed to meet the needs of the 
insurance industry as they relate to sales, marketing, and customer service. 

Siebel Insurance provides the following functionality:

■ Access to contact data for individuals, their households, their activities, their policies, and 
associated underwriting information

■ Managing auto policies (including European auto policies), property insurance policies, PUL 
(personal umbrella liability) policies, life insurance policies and annuities, and group insurance 
policies, from quoting through issuance and maintenance

■ Managing the claims process, including reporting and handling processes throughout the life 
cycle of a claim for both call center and mobile users

■ Audit trail capabilities

■ Managing agent and broker requirements, including licensing, continuing education and product 
training hours, and NASD registrations

■ Total management of customer requests for action or information through the Service Request 
features

■ Monitoring customer satisfaction using online surveys

■ Access to solutions in a text-based retrieval system

NOTE: Some functionality requires the installation of optional product modules such as Siebel 
Briefings, Siebel SmartScript, and Siebel Configurator.

Siebel Insurance includes the following modules:

■ Call Reports. Siebel Call Reports are records of meetings and conversations with clients or other 
organizations and individuals. Financial institutions often require employees to generate call 
reports when they meet with customers. 
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■ Service Requests. Siebel Service Requests is targeted at call center, field and branch service 
personnel, their managers, and their associates, and focuses on support for retail banking 
customers. Siebel Insurance allows agents to perform key service transactions, such as name or 
address changes, fulfilling requests for statement or check copies, performing fee reversals and 
funds transfers, initiating stop payments on checks, and tracking these requests to completion.

■ Retirement/Pension Management. Siebel Retirement/Pension Management provides support 
for group pensions. It allows a user to manage private group pensions, including defined 
contribution plans, such as 401(k) plans and occupational pensions, and defined benefit plans. 
It is designed to meet the needs of sales and service professionals, managers, and pension 
administrators. The module allows users to define group pension plans, plan classes, plan 
eligibility rules, and plan funding vehicles. Siebel Retirement/Pension Management also provides 
eligible and enrolled participants tracking, participant contribution and investment allocation 
management, as well as a participant beneficiary management. 

Siebel Retirement/Pension Management includes the Securities module that provides for the set 
up and profiling of funding vehicles, such as mutual funds for pension plans. The plan 
administrators are provided with a picture of each mutual fund available for investment under 
the terms of the plan including literature about the fund, fund objectives, risk profile, and asset 
mix. 

■ Rollup. Siebel Rollup provides a view of a client relationship in a single click, thereby eliminating 
the process to collect this information.

Siebel Rollup offers four views of the relationship with a client - Activities, Opportunities, 
Coverage Team, and Contacts, that show the records for the selected client and for any 
hierarchical children. For example, the Contacts Rollup view displays contacts associated with the 
selected company, subsidiaries of the selected company and the regional offices. 

Executives, sales managers, or sales professionals are often looking for aggregate information 
across a corporate enterprise and the individuals who work there. For example, before the Global 
Relationship Manager visits the CEO at his client company, he may want to view a report of all 
the latest activities, and deals conducted with the client company or with any of the subsidiaries, 
divisions and offices of the client company. This information arms the Global Relationship 
Manager with a picture of the relationship between the client and his company, a tool for 
preparing for his important meeting.

NOTE: Optional modules from Siebel Business Applications can be used to provide enhanced 
functionality to support various business processes. For information about the optional modules, 
contact your Siebel sales representative.
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3 Getting Started with Siebel 
Insurance

This chapter lists the applications administration tasks that are specific to Siebel Insurance. Use this 
chapter in combination with Siebel Applications Administration Guide.

This chapter includes the following topics:

■ “About Applications Administration Tasks” on page 19

■ “Renaming Siebel Account Objects” on page 20

■ “Configuring Lists of Values” on page 20

■ “Configuring Summary Views” on page 20

■ “Configuring Lists of Values” on page 20

■ “About Command Center” on page 22

■ “Command Center Configuration and Administration” on page 22

■ “Process of Configuring the Command Center Action Form” on page 22

About Applications Administration Tasks
Siebel Applications Administration Guide covers the setup tasks that are common to all Siebel 
Business Applications, such as using license keys, defining employees, and defining your company’s 
structure. It also provides the information you will need to implement, configure, and monitor the 
Siebel sales, service, and marketing products and to perform data administration and document 
administration tasks.

This guide assumes that you have already installed or completed the upgrade of Siebel Insurance. If 
you have not, go to the Installation/Upgrade section of the Siebel Bookshelf and click the links to the 
guides that are relevant to your company’s implementation.

The Siebel database server installation creates a Siebel administrator account that can be used to 
perform the tasks described in this guide. For more information about this process, see the 
Installation Guide for your operating system.

CAUTION: Do not perform system administration functions on your local database using the Mobile 
Web Client. Although there is nothing to prevent you from doing this, it can have serious results, 
such as data conflicts, an overly large local database, or a large number of additional transactions 
to route.
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Renaming Siebel Account Objects
In general, Siebel applications refer to companies as accounts. In the Financial Services industry, the 
term account has typically been synonymous with financial accounts, so historically the word 
company has been used in many places in Siebel Insurance. By default, Siebel Insurance installs 
using the term accounts. Users can change this term and use another description, such as 
Companies, Clients, or Customers. Users wishing to change this default need to rename all Siebel 
Account objects prior to deployment. Make changes to the UI layer (for example, applet titles and 
control labels), rather than the Business Objects layer. For more information, see Siebel Database 
Upgrade Guide.

NOTE: All of the chapters in this guide are written assuming you have renamed Siebel Account 
objects to Companies.

Configuring Lists of Values
In Siebel Insurance, modify the List of Values (LOV) in accordance with the terminology used by your 
financial institution. For example, the list of transaction types used in Siebel Insurance should match 
those used by your financial institution. For more information on configuring a LOV, see Siebel 
Applications Administration Guide.

NOTE: This may impact certain forms and lists, which rely on the preconfigured values for correct 
operation.

Configuring Summary Views
In Siebel Insurance, summary views have been restructured. In the past, multiple summary views 
existed, typically one summary view for a particular type of user. For example, there were 
preconfigured summary views specifically for salespeople and customer service agents. This has 
been replaced by common summary views whose appearance can be configured by individual end 
users.

Users can change the way a list appears in a summary view by using the controls in the top right 
corner of each list. These controls, described in Table 3, allow users to manage what appears on the 
summary view. 

Table 3. Summary View Controls

Button Description

Hide Temporarily hides a list or form from view.

Collapse Collapses the list of records. If the list cannot be collapsed, the expand button 
appears instead of the collapse button.

Expand Expands the list of records. If the list cannot be expanded, the collapse button 
appears instead of the expand button.
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Any changes made to a summary view layout are only visible to the current user and remain in effect 
until that user changes them again or reverts to the default layout. If users hide a list, they must 
click Edit Layout to restore it. For more information, see “Editing a Summary View Layout.”

Editing a Summary View Layout
Using the Edit Layout view, users can restore hidden lists, collapse or expand all lists, move lists or 
forms up or down on the page, or revert to the default layout. The edit layout buttons, described in 
Table 4, allow users to change the way a summary view appears and apply those changes to future 
sessions.

For more information on available summary views, see “Viewing a Contact Summary (End User)” on 
page 56, “Viewing Company Summaries (End User)” on page 45, and “Viewing Household Summaries” 
on page 62.

Adding Products and Product Lines
Administrators must set up products, such as insurance products, in Siebel Insurance. After setting 
up a product, administrators can specify that it be included in a product line. They can also specify 
which product lines your company contracts agencies to sell or which ones the state licenses agencies 
to sell.

Setting up products is discussed in detail in Siebel Product Administration Guide. However, this guide 
also explains some steps for adding products in the appropriate chapters. In those chapters, values 
for specific fields are given to help administrators set up products correctly.

NOTE: Only those users with the required administrative responsibilities, such as Siebel 
administrators, can add products and information about product lines. 

Table 4. Edit Layout Buttons

Button Description

Collapse Collapses the list or form.

Expand Expands the list or form.

Move up Moves the list or form up on the home page.

Move down Moves the list or form down on the home page.

Show Displays the list or form on the home page.

Hide Hides the list or form from view on the home page.
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About Command Center
The command center allows you to launch a process, perform a task, or jump to a view. Command 
center actions are preconfigured by your system administrator in accordance with your company’s 
business process requirements. For example, if the financial services agents at your company often 
need to jump to the financial accounts view for a contact, you could configure the command center 
to perform this action, saving them time and keystrokes. See “Command Center Configuration and 
Administration” on page 22 for information on how to configure the command center.

Out of the box, the command center is only available from the Summary views on the Contacts and 
Companies screens.

Command Center Interface Types
There are two interface types for the command center:

■ Action form

■ Command line

Figure 1 shows the action form, a menu-driven interface guiding the end user through preconfigured 
choices in order to launch an action. The command line requires the end user enter specific command 
line syntax to launch the action.

Command Center Configuration and 
Administration
Command Center configuration and administration should only be done by expert users accustomed 
to working with business services.

Process of Configuring the Command 
Center Action Form
To configure the appearance and function of the Command Center Action form you must:

Figure 1. Command Center Action Form
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1 Define the business object where the Command Center Action form appears and what business 
component and fields are to be used. See “Defining the Command Center Business Object.”

2 Define actions available for the business object, indicating for each combination of possible 
attribute values what action is taken (launch a business service or workflow, go to a view, and 
so on). See “Defining the Command Center Actions.”

3 For actions defined as private, select the defined roles for which the actions will be available. See 
“Selecting the Command Center Responsibilities.”

An example configuration is included at “Example of Configuring the Command Center Action Applet” 
on page 27.

Defining the Command Center Business Object
The first step in configuring the Command Center Action form is to define the business object where 
the Command Center form appears, and what business component and fields are to be used. Out of 
the box, the Command Center forms appear on the Contact Summary and Company Summary views.

This task is part of “Process of Configuring the Command Center Action Form.”

To define the business object

1 Navigate to Site Map > Administration - Command Center screen > Defined Objects view.

2 Create a new object definition record and complete the fields as follows:

Field Parameters Description

Business Object Any Business Object for which 
the forms have been defined. 
For example, Contact or 
Companies. 

This identifies the screen where the 
Command Center form is to appear.

Source Business 
Component

The business component 
against which the Driving Field 
will be compared. For 
example, FINCORP Account.

This should be a business 
component available on the 
view where the Command 
Center applets are visible (for 
example, Contact Summary 
view).

The value of this field is constrained by the 
value of Business Object field. In turn, it is a 
constraint for the Driven Field.
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Source Business 
Search 
Specification

A filter on the source business 
component. For example, Acct. 
Status = Open. Only Financial 
accounts with a status of Open 
will be available in the 
Command Center.

Use this field to enter an optional filter 
criteria on the selected Business Component.

Driving Field A field name from the Source 
Business Component. The field 
name can be ascertained using 
Siebel Tools. 

Following the examples in the 
preceding field parameter 
descriptions, this could be the 
Financial Account name or ID.

The value of this field is constrained by 
Source Business Component and Source 
Business Search Specification (if entered).

The driving field is equivalent to Attribute 1.

Driving Field 
Label

Free text field, 20 character 
limit.

The text label exposed in the UI for Driving 
Field (Attribute 1). If blank, the label defaults 
to the Driving Field on the Command Center 
form.

Attribute 2,3,4 
Label

Free text fields, 20 character 
limit.

The text label for each of Attributes 2-4. If 
left blank, the attribute will not appear on the 
form.

Field Parameters Description
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Defining the Command Center Actions
After you define the business object, you define actions for each object. These actions indicate for 
each object a combination of possible attribute values what action is taken (launch a business service 
or workflow). The relationship is one-to-many.

This task is part of “Process of Configuring the Command Center Action Form” on page 22.

To define actions for the Command Center applet

1 Navigate to Administration - Command Center screen > Defined Objects view, and select the 
Object Definition for which you wish to define actions.

Driving Field on 
Cmd Form

Check box. If checked, it exposes the Driving Field label 
on the Command Center form preceding the 
Command field.

Expression Free text field. Use this field to constrain the available set of 
actions based on what the user has selected 
in the Driving Field. As each object definition 
can have multiple action definitions, the 
expression field is a way to limit the available 
actions based on a business component field.

For example, if the user selects a checking 
account, investment based actions may not 
be appropriate. 

For example: IIF([Account Number] LIKE 
'1800*', Liability, Asset). That is, if the 
account number starts with 1800, it maps to 
action definitions in the Action Definition list 
that have the Attribute 1 Map field set to 
Liability. Otherwise, it is mapped to action 
definitions that have the Attribute 1 Map field 
set to Asset.

If there is no need to constrain the actions, 
then any value will suffice (for example, 
Contact - All). 

Field Parameters Description
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2 Scroll down to the Action Definition list, create actions and complete the fields as described in 
the following table.

Field Parameters Description

Attribute 1 
Required

Check box. Indicates whether or not an entry in the 
Driving Field (Attribute 1) is required for 
the Command Center to return results.

Attribute 1 Map Free text. Works in concert with the Expression field 
of the Object Definition to determine the 
contents of the Command Center 
dropdown menus.

Attribute 2-4 Free text. Value lists for Attributes 2-4.

Command Free text. Each entry must be 
unique, that is, you cannot use 
the same command for different 
actions.

The command line equivalent for the 
action. 

These commands are restricted to the 
Business Object with which they are 
associated.

See also “Creating Global Commands for 
the Command Line Applet” on page 29.

Command Help 
Text

Free text. The Help text for the command help 
feature when a question mark (?) is 
entered using the command line.

This field is reserved for future use. You 
can expose it in some manner, should you 
choose, using a custom configuration.

Business Service Free text. 

EX: FINS Goto View Service

The name of the Business Service to be 
run. 

Business Service 
Context

Free text. The parameters for the Business service.

Business Service 
Method

Free text. The method for the selected Business 
service.

Public Flag Check box. If checked (true), then any roles selected 
for the action do not apply. 

If unchecked (false), then any roles 
selected do apply and visibility to actions 
will be limited by the selected roles.

Inactive Check box. This hides the defined action and 
attribute combination.



Getting Started with Siebel Insurance ■ Process of Configuring the Command Center
Action Form

Siebel Insurance Guide Version 8.0, Rev. A 27

Selecting the Command Center Responsibilities 
For each action, select the defined responsibilities for which the action will be available. The 
relationship between actions and responsibilities is one-to-many. 

This task is part of “Process of Configuring the Command Center Action Form” on page 22.

To select responsibilities for a Command Center action

1 Navigate to Administration - Command Center screen > Defined Objects view, and select the 
Action for which you wish to define responsibilities.

2 Scroll down to the Responsibility list, create a new record, and select the desired responsibility.

The responsibilities information appears as read-only in the Responsibility list. Selected 
responsibilities are only enforced if the Public Flag for the action is unchecked (false).

Example of Configuring the Command Center Action 
Applet
This topic gives an example of configuring the Action applet. You may use this feature differently, 
depending on your business model.

NOTE: This example uses a view available only in Siebel Healthcare. Although it is not visible to 
Siebel Insurance users, the example is still useful to all Siebel Financial Services users to illustrate 
how to set up the Command Center.

The Command Center is available on the Siebel Healthcare Member Summary view and can be 
configured to launch several key sales processes such as ordering a new ID card or changing a 
primary care physician. For more information on using the Member Summary Command Center when 
configured as in this example, see Siebel Healthcare Guide. 

The Command Center is set up using the Administration - Command Center view.

To configure the action applet to run the business service FINS Goto View

1 Navigate to FINS Command Center Admin Object view and create a new object definition record. 
Complete the fields as follows:

Field Value

Business Object Name FINS Members

Source Business Component FINS Members

Driving Field Last Name

Driving Field Label Name

Attribute 2 Label Area
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2 To set up a pop-up applet, in the Action Definition list create a new action record and complete 
the fields as follows:

3 To set up a view navigation, in the Action Definition list create a new action record and complete 
the fields as follows: 

Attribute 3 label Action

Expression RedundantExpression

Driving Field On Cmd Form Checked

Field Value

Attribute 2 ID Card Requests

Attribute 3 Show History

Command IDCSH

Business Service SLM Save List Service

Business Service Context 'Applet Mode', '6', 'Applet Name', 'FINS Service 
Request Order ID Popup Applet'

NOTE: The applet in this example is only 
available in Siebel Healthcare. Siebel Insurance 
customers would select a suitable view and applet 
available in their respective applications.

Business Service Method LoadPopupApplet

Public Flag Checked

Field Value

Attribute 2 ID Card Requests

Attribute 3 Order New ID Card

Command IDCOR

Business Service FINS Goto View Service

Business Service Context 'ViewName', 'FINS Member Benefits View', 
'RowId', '[Current Src Rec Id]', 'AppletName', 
'FINS Member Form Applet - short'

NOTE: The view and applet in this example are 
only available in Siebel Healthcare. Siebel 
Insurance customers would select a suitable view 
and applet available in their respective 
applications.

Field Value
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Creating Global Commands for the Command Line 
Applet
Some users may prefer to use only the Command form. In this case, the only configuration required 
is to indicate the command line syntax and the associated business service and responsibility 
information. Use these global commands through the Command line form on whatever business 
object it appears.

To create global commands for the Command Line applet

1 Navigate to the Administration - Command Center screen > Global Commands view.

2 In the Global Commands list, create a command record, and complete the fields as described in 
“To define actions for the Command Center applet” on page 25.

3 For each Command, record select responsibilities as described in “To select responsibilities for a 
Command Center action” on page 27.

Business Service Method GotoView

Public Flag Checked

Field Value
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4 Managing Companies

This chapter describes managing companies and accounts information. It includes the following 
topics:

■ “About Managing Companies and Accounts” on page 31

■ “About Company Hierarchies” on page 32

■ “Scenario for Managing Company Information” on page 32

■ “Process of Managing Companies” on page 33

■ “Setting Up Values for Companies” on page 34

■ “Deleting Company Information” on page 35

■ “Managing Competitor Information” on page 35

■ “Verifying Coverage Team Members” on page 36

■ “Managing the Custom-Defined Relationship Types LOV” on page 37

■ “Generating Company Hierarchies for Data Aggregation” on page 38

■ “Adding Companies and Investors (End User)” on page 41

■ “Viewing Company Hierarchies in Roll-Up Views (End User)” on page 41

■ “Creating Company Assessments (End User)” on page 43

■ “Adding Company Applications (End User)” on page 43

■ “Adding Company Service Requests (End User)” on page 44

■ “Managing Company Coverage Teams (End User)” on page 45

■ “Viewing Company Summaries (End User)” on page 45

■ “Viewing Company Summaries (End User)” on page 45

About Managing Companies and 
Accounts
Within Siebel Insurance, the term companies refers to entities that are typically referred to as 
accounts in other Siebel applications. A company represents the relationship between your 
organization and companies or organizational entities (or structures) with which you do business. 
Use the Companies screen and its associated views to view company information and interactions.

CAUTION: This chapter assumes you have renamed Siebel Account objects to Companies. By 
default, Siebel Insurance installs using the term Accounts. For more information on renaming Siebel 
Account objects, see Siebel Database Upgrade Guide.
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In Siebel Insurance, the term investors refers to financial organizations such as mutual fund or 
money management institutions; investors are not contacts, rather they are companies that are 
identified as investors. In Siebel Financial Services, the investors functionality has migrated to the 
Companies screen. This chapter covers both regular company and investor procedures.

Use the procedures in this chapter to perform the administrator tasks of controlling company 
information, generating company hierarchies, managing competitor information, verifying coverage 
team members, and managing custom-defined relationship types. 

End users use the Companies views to add new companies and investors, create company 
assessments, associate service requests with a company, update the coverage team, define 
relationships to other companies, contacts, and households, and view company summary 
information. In addition, end users can retrieve information about investors, including investors’ 
preferences, holdings, and transactions.

You can save time and reduce keystrokes by using a workflow to automate steps that are repeatedly 
performed by end users. For more information, see Siebel Business Process Designer Administration 
Guide.

About Company Hierarchies
A company hierarchy is a group of companies that are organized by parent-child relationships. Siebel 
Industry Applications support displaying these company relationships in a hierarchical tree.

The hierarchical tree is a visual representation of company hierarchy data that allows end users to 
view the relationships between companies. By viewing a company roll-up, users can see aggregated 
company information, including contacts, coverage teams, activities, and opportunities. 

When end users have access to a company, they can review the hierarchical structure for that 
company, its child divisions, and the contacts that work there. Company hierarchies are displayed in 
five subviews of the Companies screen—Relationship Hierarchy view, Activity Roll-up, Contact Roll-
up, Opportunity Roll-up, and Coverage Team Roll-up. 

Depending on your configuration, a company that does not have a parent-child relationship with 
another company may not appear in the roll-up views. 

For more information on company hierarchies, see “Generating Company Hierarchies for Data 
Aggregation” on page 38 and “Viewing Company Hierarchies in Roll-Up Views (End User)” on page 41.

Scenario for Managing Company 
Information
This scenario features sample tasks performed by a sales representative in the insurance and 
healthcare industries. Your company may follow a different workflow according to its business 
requirements.

In this scenario, end users are the sales representatives who manage company information. They 
enter information to:

■ Add new companies to the database and create company assessments
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■ Associate applications and service requests with a company

■ Manage company coverage teams

■ View company summary information

■ View relationships in a graphical manner

Sales Representative Tracks Company Information
A sales representative uses the Companies screen to capture and manage profile information about 
her business customer, such as contacts, organizational structure, management, and financial 
information. In addition to viewing market statistics and D&B reports. Using Siebel Insurance, she 
can capture and track information about a company’s:

■ Relationship with her organization, such as the coverage team, contract terms, sales and service 
information

■ Preferred delivery channels, at both summary and detailed levels

She can also view details of competitors and create and access marketing and sales presentations.

The sales representative can create a new company record or view and modify information about 
existing companies. For example, if the sales representative is preparing for a sales call, she can use 
the Companies screen to answer the following questions:

■ What business is this company in?

■ Who are the executives I should be calling on?

■ What is this company’s financial profile?

■ What financial accounts and products does the company already own?

■ What types of service issues has the company had?

Process of Managing Companies
This section details sample tasks often performed by administrators and end-users when managing 
companies. Your company may follow a different process according to its business requirements. 

Administrator Procedures
The following list shows tasks administrators typically perform to manage companies:

■ “Setting Up Values for Companies” on page 34

■ “Deleting Company Information” on page 35

■ “Managing Competitor Information” on page 35

■ “Verifying Coverage Team Members” on page 36

■ “Managing the Custom-Defined Relationship Types LOV” on page 37
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■ “Generating Company Hierarchies for Data Aggregation” on page 38

End-User Procedures
The following list shows tasks end users typically perform when managing companies:

■ “Adding Companies and Investors (End User)” on page 41

■ “Viewing Company Hierarchies in Roll-Up Views (End User)” on page 41

■ “Creating Company Assessments (End User)” on page 43

■ “Adding Company Applications (End User)” on page 43

■ “Adding Company Service Requests (End User)” on page 44

■ “Managing Company Coverage Teams (End User)” on page 45

■ “Viewing Company Summaries (End User)” on page 45

■ “Viewing Company Relationship Hierarchies (End User)” on page 46

Setting Up Values for Companies
Administrators can create new industries and territories so that the appropriate selections are 
available to end users when they add companies. 

When a company is added to Siebel Insurance, the end user adding the company is responsible for 
indicating the industry to which the company belongs. Administrators are responsible for creating 
the industries that appear to end users. 

To add an industry

1 Navigate to the Administration - Data screen > Industries view.

2 In the Industries list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Companies are often associated with a territory. Administrators can create the territories that appear 
in the Territory field when end users add a company to Siebel Insurance.

Field Description

Language Code Primary language of the classification used.

SIC Code Standard Industry Classification code as defined by the U.S. 
Department of Commerce.

Type The classification used to describe the industry.
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To add a territory

1 Navigate to the Administration - Assignment screen > Territories view.

2 In the Territory List list, add a record, and complete the necessary fields.

Deleting Company Information
Deleting a company completely removes the company, as well as all activities related to the 
company, from the system. Only delete a company record if you are certain that the company is no 
longer active. If end users are unsure whether or not a company is still active (and therefore should 
not be deleted), they have the option of removing themselves from the company team instead of 
deleting the record.

As the Siebel administrator, you can make a company unavailable to all other users. First, you can 
assign yourself as the primary team member. Second, you remove all other employees from the 
company’s team. 

To make a company unavailable to all other users

1 Navigate to the Companies screen > Companies Administration view.

2 In the Company list, drill down on the Name link.

3 In the Company Team dialog box, locate the administrator, and click in the Primary field.

4 In the Company Team dialog box, delete all other coverage team members and click OK.

Only those users with access to the All Companies and All Companies Across Organizations views 
will be able to see this company. 

Managing Competitor Information
Effective sales and marketing requires that your employees have up-to-date and consistent 
information about the competition and their products. This section describes how to administer 
information about competitors and competitive products within the Companies screen. 

To indicate that a company is a competitor

1 Navigate to the Companies screen > Companies Administration view.

2 In the Company list, add or select a company.

3 In the Company form, click the show more button.
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4 Select the Competitor check box to add the company to the Competitor’s list.

The company appears in the Competitor’s list. The Competitor’s list is available in the 
Competitors screen and related screens, such as Opportunities.

NOTE: Non-administrators can specify that a company is a competitor by selecting Competitor from 
the Type drop-down list. However, selecting Competitor from the Type drop-down list does not add 
the company to the Competitor’s list as seen on the Competitor’s screen, or in the Pick Competitors 
dialog box, which is accessible on related screens, such as Opportunities. 

When a company has been indicated as a competitor, you may want to add document files of 
comparative and competitive literature. For more information, see the chapter on literature 
administration in Siebel Applications Administration Guide.

Removing Records from the Competitors List
You cannot delete records that have been added to the Competitors list, since deleting them would 
also remove them from related screens, like Opportunities. For example, a company may have been 
a competitor for an opportunity last month. Even if the company is no longer a competitor, the 
competitor record should remain as part of the history of the opportunity. 

If you no longer want a record to appear in the Competitor’s list, deselect the Competitor check box. 
This removes the record from the Competitors screen without affecting other screens.

Verifying Coverage Team Members
If you are logged on as a Siebel administrator, you can search for companies that do not have any 
coverage team members.

Managers can add or delete the members of a company’s coverage team if they are the existing 
primary team member, or the primary team member is one of their direct reports. If you are logged 
in as an administrator, you can change the primary team designate for any company in the Company 
Administration view. (Navigate to the Companies screen > Companies Administration view.)

NOTE: In Siebel Financial Services, the terms sales team and account team are equivalent to 
coverage team.

The procedures that follow involve making selections in the Account Team field. If the Account Team 
field does not appear in your installation, you may need to reveal it using the Columns Displayed 
dialog box.

NOTE: Usually, Assignment Manager resolves problems with coverage teams and owner assignment 
automatically. For more information on Assignment Manager, see Siebel Assignment Manager 
Administration Guide.

To search for a company without any coverage team members

1 Navigate to the Companies screen > Companies Administration view.
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2 In the Companies list, define a new query where the Name field is:

count(

) = 0

3 Execute the query.

The query returns a list of all companies that do not have any coverage team members.

To add or delete members of the coverage team for a company

1 Navigate to the Companies screen > Companies Administration view.

2 In the Companies list, select a company, and click the More Info view tab.

3 In the Account Team field, select an employee in the Coverage Team dialog box, and click Add or 
Remove.

To change the primary coverage team member for a company

1 Navigate to the Companies screen > Companies Administration view.

2 In the Companies list, select a company, and click the More Info view tab.

3 In the Account Team field, select the Primary field for the new primary coverage team member.

Managing the Custom-Defined 
Relationship Types LOV
If you are logged in as the Siebel administrator, you can create and maintain a list of predefined 
custom-defined relationship types. A default list of values is provided with the application. These 
relationship types appear in the drop-down LOV for the Type field found on the Relationship Hierarchy 
views, in the Party Relationship applet.

To add a custom-defined relationship type

1 Navigate to the Administration - Data screen > List of Values view.

2 In the List of Values list, create a New Query where Type equals PARTY_RELATIONSHIP_TYPE.

At least six records will be returned, showing the existing list of values for custom-defined 
relationship type.
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3 In the List of Values list, add a record, and complete the necessary fields. 

Some fields are described in the following table.

NOTE: You cannot delete LOV table entries. Use the Active check box to deactivate an LOV entry and 
thereby remove it from the Relationship drop-down list.

Generating Company Hierarchies for 
Data Aggregation
Data aggregation is available by using the Roll-up views, providing the administrator defined one or 
more hierarchies. The application administrator typically defines a default hierarchy by associating 
accounts with one another using the parent field on a company form, or the subaccount view for child 
accounts. Administrators can define Company hierarchies to display aggregated data—the activities, 
opportunities, contacts, and coverage teams—across organizational structures. For example, the top 
node of the hierarchy contains activities for the organization, the subsidiaries below the organization, 
the departments at the subsidiaries, and contacts working at any level of the tree. As the end users 
move up and down the tree, they see more or less data rolled up to the selected level.

By default, only companies that are part of a relationship hierarchy can display roll-up data. You can 
modify the application to display roll-up data for companies which are not part of a hierarchy.

To configure display of roll-up data for companies not in a hierarchy
■ Using Siebel Tools, set the DynHierachry user property of the Dynamic Hierarchy Direct 

Relationship business component to LoadAllAccounts

For more information on setting user properties, see Configuring Siebel Business Applications.

Field Comments

Active Determines whether the value is displayed to the end user in the 
Relationship drop-down list. 

Display Value Value as displayed in the Relationship drop-down list.

Language Independent 
Code

Code used internally by the Siebel application.

Language Name Language used for the list of values Display Value field.

Order Numerical order in which a value is displayed within the Relationship 
drop-down list.

Parent LIC Language-independent code of a parent list of values. It is used in 
hierarchical list of values.

Translate When checked, indicates that the list of values is part of a multilingual 
list of values (MLOV).

Type The type of list of values. For this procedure, select 
PARTY_RELATIONSHIP_TYPE.
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Siebel Global Accounts is the module that provides this aggregation functionality. For more on global 
accounts, see Siebel Applications Administration Guide.

The application administrator can define two types of hierarchies for data aggregation:

■ Default hierarchy for all end users, see Default Company Hierarchies on page 39

■ Specific hierarchies that are used only by certain end users, see Dynamic Company Hierarchies on 
page 40

Default Company Hierarchies
The application administrator sets up a default company hierarchy one time, during the initial 
application setup. The default hierarchy is available to all end users who are not tied to a specific 
hierarchy, and who have been granted view access to the companies represented in the hierarchy. 
It is the administrator’s responsibility to give end users access to Company views. For more 
information, see Siebel Applications Administration Guide.

When new companies are added, they are automatically added to the default hierarchy tree. The 
contacts, coverage teams, activities, and opportunities that are associated with the company are 
automatically displayed in the roll-up views. 

In the preconfigured application, using the Generate Hierarchy button adds only parent account and 
child companies to the hierarchy. Any company that does not have a child or parent is not displayed 
in the roll-up views. Use Siebel Tools to change the DynHierarchy LoadAllAccounts user property to 
alter this behavior.

You can set the DynHierarchy LoadAllAccounts user property on the Dynamic Hierarchy Direct 
Relationship business component to N or Y. When it is set to N, only parent and children appear in 
the a generated hierarchy. When DynHierarchy LoadAllAccounts user property is set to Y, all 
companies are added to the generated hierarchy. For more information on setting user properties, 
see Siebel Developer’s Reference.

To generate a default company hierarchy

1 Navigate to the Companies screen > Global Companies Administration view.

2 In the Company Hierarchies list, click Generate Hierarchy.

The parent-child account relationships that have been defined in your application are registered 
for participation in the roll-up views. This process may take some time, depending on the 
quantity of account records that are in your existing environment.

When the company hierarchy has been generated, a new record appears in the Company 
Hierarchies list. The Hierarchy Name field of the record contains the user ID of the administrator 
who generated the hierarchy and the time it was generated. If it is the only hierarchy record, the 
Default field is automatically checked. The companies that have been added for participation in 
the roll-up views appear in the Company Relationships list.

NOTE: If no accounts are visible in the Company Relationships list, click the query button, step 
off the query, and click Go to refresh the view.
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3 (Optional) Rename the company hierarchy and, if necessary, check the Default field.

NOTE: If end users are using the application when you generate a hierarchy, they must log off 
and log on again to see the default hierarchy in the roll-up views.

Dynamic Company Hierarchies
In some cases, users work with particular companies within a large corporation, but not with others. 
In these instances, some end users do not need to or should not see aggregated data across the 
entire corporation. An administrator can define a custom hierarchical structure across which data can 
be aggregated. This defined structure, called a dynamic hierarchy, can be as simple or complex as 
needed and offers users the ability to aggregate data across the companies they are interested in 
seeing.

To create a dynamic company hierarchy of selected companies

1 Navigate to the Companies screen > Global Companies Administration view.

2 In the Company Hierarchy list, and create a new record.

3 Scroll down to the Company Relationships list, create a new record, and select company.

All the accounts in the Company Relationship list belong to the new account hierarchy.

4 To define parent and child relationships:

a Select an company in the Company Relationship list that has no parent.

b In the Parent field, select a parent.

NOTE: Only companies entered in the Company Relationships list (Step 3) are available for 
selection in the parent field.

5 Repeat Step 4 for all companies that have no parents.

To associate the dynamic hierarchy with an organization

1 Navigate to the Administration - Group screen > Organizations view.

2 Select the organization in the Organizations list.

3 In the organization form, select the desired hierarcy in the Account Hierarchy field.

End users can only see the hierarchy with which their current position’s primary organization is tied. 
It is the administrator’s responsibility to associate end users with positions, positions with 
organizations, and organizations with hierarchies. For more information, see Siebel Applications 
Administration Guide.
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Adding Companies and Investors (End 
User)
When end users identify a possible lead, the lead can be added as a company. Users can then begin 
to add and track information about the company.

To add a company or investor

1 Navigate to the Companies screen > Companies List view.

2 In the Companies form, click the show more button, add a record, and complete the necessary 
fields.

3 To specify a privacy level, in the Privacy Option field select one of the following:

■ Opt-In. Sharing of non-public personal information is allowed without restrictions.

■ Opt-Out - Affiliates. Sharing of non-public personal information with affiliates is not 
allowed.

■ Opt-Out - Third Party. Sharing of non-public personal information with third parties is not 
allowed.

■ Opt-Out - All Parties. Sharing of non-public personal information with any affiliate or third 
party is not allowed.

United States law requires that financial institutions disclose their privacy policies regarding the 
sharing of non-public personal information with third parties, and fair credit reporting, that 
impacts the sharing of non-public personal information with affiliates. End users can specify a 
privacy level by making a selection from the Privacy Option field.

The Privacy Option field is for registering the privacy level requested by the company; it does not 
impact record visibility in any way. 

4 To identify the company as an investor, check the Investor box in the Company form.

Viewing Company Hierarchies in Roll-Up 
Views (End User)
End users can review the company and its parent organization, subsidiaries, contacts, opportunities 
and relationships to other entities using the graphical relationship hierarchy tree control. This control 
is available in the roll-up views. By drilling down on hypertext links on the hierarchy tree, end users 
can navigate to related views.

NOTE: If the company has not been added to a hierarchy tied to the user's position's organization 
(either default hierarchy or dynamic hierarchy), the hierarchy tree is not visible to the end user. The 
following message appears: “The selected record is not included as part of your defined hierarchy. 
If you feel this is in error, please contact your system administrator.” The administrator is responsible 
for associating positions with organizations and an organization with a hierarchy.
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The Activities-Roll-up view shows all of the activities associated with the selected company and its 
children. End users can apply filters to the list to find specific activity records and save the filtered 
list.

NOTE: If a company is not associated with any other organizations through the relationship 
hierarchy, then the roll-up views will not contain any data. A company must have a parent 
organization, or have children organizations, in order to display roll-up data.

To view aggregated activities for a company

1 Navigate to the Companies screen> Companies List view.

2 Drill down on the desired company, and click the Activities-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All activities associated with 
the company and all of its children appear in the Activities-Roll-up list. 

In the Activities-Roll-up List, you can:

■ Drill down on an activity type to navigate to the Activities screen > Attachments view.

■ Drill down on a company name to navigate to the Companies screen > Contacts view.

NOTE: If you create an activity in the Activities screen and do not set the Company field, the 
activity will not appear in the Activities-Roll-up list.

To view the aggregated coverage team for a company

1 Navigate to the Companies screen > Companies List view.

2 Drill down on a company, and click the Coverage Team-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All coverage team members 
associated with the company and all of its subsidiaries appear in the Coverage Team-Roll-up list.

In the Coverage Team-Roll-up list, you can:

■ Drill down on a last name to navigate to the Employees screen.

■ Drill down on an email address to open a blank email message addressed to the team 
member who has that address.

To view aggregated opportunities for a company

1 Navigate to the Companies screen > Companies List view.

2 Drill down on an company, and click the Opportunities-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All opportunities associated with 
the company and all of its children appear in the Opportunities-Roll-up list.

In the Opportunities-Roll-up list, you can:

■ Drill down on an opportunity name to navigate to the Opportunities screen.

■ Drill down on a company name to navigate to the Companies screen > Contacts view.
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To view an aggregated list of contacts for a company

1 Navigate to the Companies screen > Companies List view.

2 Drill down on a company, and click the Contact-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All contacts associated with the 
company and all of its children appear in the Contacts-Roll-up list.

In the Contacts-Roll-up list, you can:

■ Drill down on a last name to navigate to the Contacts screen.

■ Drill down on a company to navigate to the Companies screen > Contacts view.

■ Drill down on an email address to open a blank email message addressed to the contact who 
has that address.

Creating Company Assessments (End 
User)
An assessment is a set of attributes used to assess the business potential or credit worthiness of a 
company. Company assessments can be used to compare companies to each other or against a 
model, or to learn about companies and sales situations. End users complete the company 
assessment by selecting the appropriate values for the different attributes.

To perform a company assessment

1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the company for which the assessment is being performed.

3 Click the Assessments view tab, and create a new record.

4 In the Template Name field, select the appropriate template.

Attribute records are automatically generated in the Assessment Attributes list. 

5 In the Assessment Attributes list, make a selection in the Value field for each attribute.

NOTE: Administrators must create the assessment templates. See Siebel Applications 
Administration Guide for more information on how to create assessment templates.

Adding Company Applications (End 
User)
Applications are used for companies that want to apply for offered services or products. For example, 
a small business wants to apply for a business checking account. The end user handling the inquiry 
finds the company in the All Companies view, navigates to the Applications view, and creates an 
application record for this business checking account application. 
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To associate an application with a company 

1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the company to associate with an application.

3 Click the Applications view tab, create a new record, and complete the necessary fields.

NOTE: Drill down on the Application Name link to enter more detailed application information.

Adding Company Service Requests (End 
User)
A service request is a request from a company for information or assistance with a problem related 
to purchased products or services. When a customer calls about an existing service request, end 
users can find the service request and give status information to the caller in several ways. They can:

■ Review the service request information

■ Create an activity to record the customer’s call

■ Update the service request with additional information from the customer

■ Resolve the service request

■ Assign the service request 

■ Transfer the caller to another service representative

If a call requires that an end user create a new service request, she can create one. Siebel Insurance 
automatically assigns a unique service request (SR) number to track the new service request 
throughout the system.

To add a service request associated with a company

1 Navigate to the Companies screen > Companies List view.

2 From the Show drop-down list, select All Companies.

3 In the Companies list, drill down on the desired company.

4 Click the Service Requests view tab, create a new record, and complete the necessary fields.

The application automatically assigns a service request number (SR#).
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Managing Company Coverage Teams 
(End User)
A coverage team is the group of employees that are assigned to manage the relationship with a given 
company. The coverage team for a company is defined as all users who have access to the company 
in the My Companies view. 

NOTE: Similar coverage team functionality is also available for contacts. You can use the Contact 
Coverage Team view (Navigate to the Contacts screen > Coverage Team view) to manage the contact 
coverage team.

End users can use the company coverage team functionality available in Siebel Insurance to:

■ Record and display employees covering a company within a single company record

■ Specify and review the nature of the employee's relationship with each covered company, defined 
as the Coverage Role and Attributes list

To add a member to a coverage team

1 Navigate to the Companies screen > Companies List view. 

2 In the Companies list, drill down on the desired company.

3 Click the Coverage Team view tab, create a new record, and select an employee.

4 If known, select the employee’s coverage role using the drop-down list in the Coverage Role field.

NOTE: The Siebel administrator maintains the Coverage Role LOV in the List of Values screen 
under the Type field value type FINS_COVERAGE_ROLE_TYPE. Navigate to the Administration - 
Data screen > List of Values view, to access the List of Values screen.

5 If desired, scroll down to the Categories and Securities view tabs and select values defining the 
coverage relationship between the employee and the company; you can select one or more 
attributes. 

The application adds the employee to the coverage team with a defined relationship. The 
company will appear in the employee’s My Companies view.

Viewing Company Summaries (End 
User)
The Company Summary view provides a comprehensive view of a company in an editable format. 
This view displays basic company information, financial accounts, call reports, logged alerts, and 
contacts associated with a company. 

To view company summary information

1 Navigate to the Companies screen > Companies List view. 

2 In the Companies list, drill down on the desired company.
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3 Click the Summary view tab.

For more information on editing summary view information, see “Configuring Summary Views” on 
page 20.

Viewing Company Relationship 
Hierarchies (End User)
End users use the Relationship Hierarchy view to identify and capture key relationships for a 
company. This view features a graphical tree that provides a visual representation of a company’s 
relationships. The tree shows the natural hierarchy of a company’s parent-child relationships to 
entities such as companies, subsidiaries, divisions, contacts, and coverage relationships with 
employees, as well as custom-defined relationships.

Custom-defined relationships are ad-hoc associations between the company and any contact, 
organization, household, or employee. End users can record custom-defined relationships between 
any two entities in the adjacent Party Relationships list.

NOTE: The Relationship Hierarchy view is also available on the Contacts, Employee (read only) and 
Households screens. For more information, see “Viewing Contact Relationship Hierarchies (End User)” 
on page 56 and “Using the Household Relationship Hierarchy” on page 62.

To establish a natural parent-subsidiary relationship between two companies

1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the company to be established as the subsidiary.

3 Click the More Info view tab.

4 In the Parent field, select the parent company.

5 Repeat Step 2 through Step 4 to set up companies, subsidiaries, branches, and departments as 
needed for your deployment.

6 Click the Relationship Hierarchy view tab.

The new parent-subsidiary relationship is shown in the Relationship Hierarchy explorer in the 
lower-left corner of the screen.

To create a custom-defined relationship

1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the company for which you want to create a custom-defined 
relationship.

3 Click the Relationship Hierarchy view tab.
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4 In the Party Relationship list, add a record, and complete the necessary fields. 

Some fields are described in the following table.

The newly defined relationship appears in the Relationship Hierarchy explorer.

Field Comments

Relationship Categorizes the relationship between the company and another entity. 
Field has an LOV for custom-defined Relationship values. Predefined 
values include Reports To, Spouse, Child, Lawyer, Board Member, Primary 
Contact (Backup), Admin Assistant, Competitor, Referral, Service 
Provider, Investor, Wealth Management Rep, Related Subsidiary, Bank 
Attorney, Trustee Attorney, and Debtor Attorney.

This LOV can be modified by the Siebel administrator. For more 
information, see “Managing the Custom-Defined Relationship Types LOV” on 
page 37.

Start Date

End Date

If the custom-defined relationship falls:

■ Between the Start and End Dates, it appears in the tree. 

■ Outside the range, it does not appear to the user. The user can enter 
a start or end date, or both.

Type Use this field to determine the type of entity with which you wish to 
establish a relationship. Defaults to Contact. Other values include 
Household, Organization, and Employee.

Value The value in this field is based on the Type field. For example, if Type 
equals Contact, then clicking the select button in the Value field displays 
the Select Contact dialog box.
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5 Managing Contacts

This chapter includes the following topics:

■ “About Managing Contacts” on page 49

■ “Scenario for Adding a New Contact” on page 50

■ “Process of Managing Contacts” on page 50

■ “Managing Contact Information (End User)” on page 51

■ “Creating Customer Assessments (End User)” on page 55

■ “Setting the Customer Value Icon (End User)” on page 56

■ “Viewing a Contact Summary (End User)” on page 56

■ “Viewing Contact Relationship Hierarchies (End User)” on page 56

About Managing Contacts
Contacts are entities or individuals with whom the company does business with or with whom it 
expects to do business with in the future. Contacts includes employees of other companies, 
independent consultants, vendors, or personal acquaintances. Contacts can belong to only one 
company, but they can be part of many opportunities, including opportunities that do not involve 
their companies. Within Siebel Insurance, contacts are presented in a single view of the customer 
and your relationship with the customer.

CAUTION: This chapter assumes you have renamed Siebel Account objects to Companies. By 
default, Siebel Insurance installs using the term Accounts. For more information on renaming Siebel 
Account objects, see the Upgrade Guide for your operating system.

End users can:

■ Enter and track information about contacts, which includes products bought, details of signed 
agreements or contracts, and products previously recommended to the customer. 

■ Document marketing campaigns and details of each customer’s response. 

■ Maintain a history of service requests, insurance claims, and product applications that the 
customer has made in the past. 

■ Analyze a customer’s financial health as well as a customer’s needs.

The Contacts screen provides an alternative view of data that is available in other screens. Many 
tasks that can be performed in the Contacts views can also be performed in other screens. For 
example, users can create activities for a contact either in the Contact Activities view, or they can 
go to the My Activities view to enter a new activity, and then associate it with the contact.
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For more information on basic contact functionality and administration, see Siebel Applications 
Administration Guide.

You can save time and reduce keystrokes by using a workflow to automate steps that are repeatedly 
performed by end users. For more information, see Siebel Business Process Designer Administration 
Guide. 

Scenario for Adding a New Contact
These scenarios feature sample tasks performed by a sales representative in the insurance industry. 
Your company may follow a different workflow according to its business requirements. 

Sales Representative Adds a New Contact
At a conference, a new account representative meets a potential customer. The potential customer 
gives the new account representative his business card and informs her that he had recently moved 
to the area and works for a medium sized software company.

The new account representative returns to her office and enters her new acquaintance into Siebel 
Insurance as a new contact. She can also enter his company information and associate the company 
with the contact. In the Relationship Hierarchy view, she can enter the relationships for this contact, 
including all companies he is associated with, the contact's business partners, lawyer, his family 
members, and other influential relationships. As the creator of this new contact record, she is 
automatically added to the coverage team as the primary representative for the customer. If 
necessary, she can also add the small business manager and other product experts to the coverage 
team so they can see this new contact in their My Contacts view. 

As the customer is looking for personal and business services, the account representative can create 
separate opportunity records in Siebel Insurance associated with the contact. In the opportunity 
records, she records the products and services the customer is interested in as well as other follow-
up activities to serve the customer's needs.

In the scenario, end users are the new account representatives who manage company information 
in the field. They enter information to:

■ Add a new contact and associate him/her with companies

■ Use the Relationship view to enter all the contact's influential relationships

■ Add other account representatives to the coverage team

■ Create new opportunities associated with the contact

■ Create follow-up activities and assign them to the right representatives to close the potential 
opportunities

Process of Managing Contacts
This section details sample tasks often performed by administrators and end-users when managing 
contacts. Your company may follow a different process according to its business requirements. 
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End-User Procedures
The following list shows tasks end users typically perform when managing contacts:

■ “Managing Contact Information (End User)” on page 51

■ “Creating Customer Assessments (End User)” on page 55

■ “Setting the Customer Value Icon (End User)” on page 56

■ “Viewing a Contact Summary (End User)” on page 56

■ “Viewing Contact Relationship Hierarchies (End User)” on page 56

Managing Contact Information (End 
User)
Contacts are entities or individuals with whom the company currently does business with or with 
whom it expects to do business with in the future. End users manage contact information by:

■ Adding new contacts. See “Adding Contacts” on page 51.

■ Creating contact categories and notes. See “Creating Categories for Contact Information” on 
page 52 and “Creating Notes About Contacts” on page 53.

■ Managing contact referral information. See “Managing Contact Referral Information” on page 53.

Adding Contacts
When end users meet someone in the course of business, they add a contact record for that 
individual to track pertinent personal information and possible potential future business.

NOTE: The Personal Contacts List is different from the Contacts Lists because it is designed for 
contacts not associated with a company. Therefore, in the Personal Contacts List, adding a company 
to a record does not also add it to the My Contacts view, All Contacts view, and so on. End users 
must add business contacts in one of the Contacts List views proper. They must create, review, and 
manage activities for their personal contacts only in the Activities view of the Personal Contacts List 
view, not in the other Contacts views.

To add a contact

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts form, click the show more button, add a record, and complete the necessary 
fields.

3 To specify a privacy level, drill down on the contact name link, scroll down to the Privacy Option 
field, and select one of the following:

■ Opt-In. Sharing of non-public personal information is allowed without restrictions.
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■ Opt-Out - Affiliates. Sharing of non-public personal information with affiliates is not 
allowed.

■ Opt-Out - Third Party. Sharing of non-public personal information with third parties is not 
allowed.

■ Opt-Out - All Parties. Sharing of non-public personal information with any affiliate or third 
party is not allowed.

United States law requires that financial institutions disclose their privacy policies regarding the 
sharing of non-public personal information with third parties, and fair credit reporting, that 
impacts the sharing of non-public personal information with affiliates. End users can specify a 
privacy level by making a selection from the Privacy Option field.

The Privacy Option field is for registering the privacy level requested by the contact; it does not 
impact record visibility in any way. 

To associate a contact with a company

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.

3 Click the More Info view tab.

4 In the Account Name field, select a record from the list of available companies.

The application automatically associates the company with the contact and populates the address 
with the default company address information. 

5 To change the address, click the select button in the Address Line field, and select an address.

6 To specify an address as the contact’s primary address, click the Primary field.

NOTE: The primary address in the Contact Addresses dialog box appears in the address fields 
on the More Info form.

7 In the Time Zone field, select the contact’s time zone.

Creating Categories for Contact Information
If the default Contacts list and More Info form do not contain fields to track the type of information 
that end users need to track, they can add additional categories. A manager may have set up a list 
of values from which they can select.

To add a category to a contact

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts form, query for the desired contact.

3 Drill down on the Last Name link, click the Categories view tab, and create a new record.

4 In the Categories list, select a category from the list of values or create a new category.
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5 Complete the necessary fields.

6 Create additional categories by repeating Step 4 through Step 5.

Creating Notes About Contacts
As end users work with contacts, they learn things they may want to remember. Often these tidbits 
of information are best stored as notes. Users can create notes that everyone with access to the 
contact record can see, or they can create notes that only they can see.

To create a note regarding a contact 

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.

NOTE: If the contact does not exist, add it. For more information, see “Adding Contacts” on 
page 51.

3 Click the Notes view tab.

4 From the link bar, select one of the following:

■ Public Notes. Notes that others can see.

■ Private Notes. Notes that only their creators can see.

5 In the Notes list, add a record and complete the necessary fields.

NOTE: You can perform a spell check in Private Notes, but not in Public Notes.

Some fields are described in the following table.

Managing Contact Referral Information
The Referrals view tab allows end users to enter referral information associated with contacts. 
Referrals are potential opportunities. 

In the Referrals tab view, end users can record both referrals they give to their contacts, as well as 
referrals received from a contact.

Field Comments

Created Automatically populates with a date and timestamp.

Type Default value is Note. Select alternate value to categorize the type of 
note.

Description Text field for the content of the note.
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To create a new contact for a referral

1 On the Contacts screen, create contacts. For more information, see “To add a contact” on page 51.

2 Associate those contacts with the new company. For more information, see “To associate a contact 
with a company” on page 52.

3 On Referrals view tab, select the Contact from the Pick Contact dialog box associated with this 
field.

To enter a referral received from a contact

1 Navigate to the Contacts screen > Contacts List view. 

2 In the Contacts list, drill down on the desired contact.

3 Click the Referrals view tab.

4 From the drop-down list, select Referral From This Contact. 

NOTE: View all referrals from the contact by selecting Referrals From This Contact in the drop-
down list.

5 In the form, add a record, and complete the necessary fields.

Some fields are described in the following table.

To create a referral to a contact

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.

3 Click the Referrals view tab.

4 Scroll down to the Referrals to This Contact list, and from the drop-down list, select Referrals To 
This Contact.

Field Comments

Company Select an existing company or create a new one. The company selected 
represents the potential opportunity for your organization.

Last Name Select a contact to associate with the referral company, as selected in the 
Company field; if you entered a Company, the list of Contacts is restricted 
to those associated with the selected company.

Referred By Select the employee who made the referral. 
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5 In the list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Creating Customer Assessments (End 
User)
The Contacts Assessments view can help end users qualify contacts. Contact assessments are 
created in the Contacts Assessments view. 

NOTE: A similar assessment functionality is available for companies. For more information, see 
“Creating Company Assessments (End User)” on page 43.

A customer assessment evaluates a contact based on defined criteria. Each assessment template has 
a group of assessment attributes that make up the different measurement points of the assessment. 
A Siebel administrator can create new templates and add or modify assessment attributes. For more 
information on assessment templates and how to define and manage them, see Siebel Applications 
Administration Guide.

To create a customer assessment

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact for whom the assessment will be added.

3 Click the Assessments view tab, and create an new record.

4 In the Template Name field, select the desired template. 

Assessment attributes, as defined for the template, are automatically created in the Assessment 
Attributes list.

5 Scroll down to the Assessment Attributes list, and where possible, select a value for each 
attribute by clicking the select button in the Value field.

Field Comments

Disposition The status of the referral.

Company Select an existing company or create a new one. The company 
selected represents the potential opportunity for your service 
provider.

Last Name Select a contact to associate with the referral company, as selected 
in the Company field; if you entered a Company, the list of Contacts 
is restricted to those associated with the selected company.

Referred By Select the employee from your organization who made the referral. 
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Setting the Customer Value Icon (End 
User)
In addition to the customer value assessment tool described in “Creating Customer Assessments (End 
User)” on page 55, there is an alternative customer value measurement device in Siebel Insurance.

The customer value icon is a series of five stars visible on the contact form. The number of stars 
activated indicates the perceived value of the contact. 

To adjust the customer value stars
■ From the Contacts > More Info view, adjust the value in the Tier field.

Viewing a Contact Summary (End User)
The Contact Summary view provides a comprehensive view of a contact’s relationship with an end 
user’s organization in an editable format. This view displays the customer’s contact information, 
financial accounts, applications, alerts, campaigns targeted at the customer, and service requests 
and opportunities associated with the customer. 

The Customer Value stars on the Contact form indicates the customer’s value to the organization. 
For more information, see “Setting the Customer Value Icon (End User)” on page 56.

To view contact summary information

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on a contact.

3 Click the Summary view tab.

For more information on editing summary view information, see “Configuring Summary Views” on 
page 20.

Viewing Contact Relationship 
Hierarchies (End User)
A contact’s relationships are those of influence. End users may have a contact who relies heavily on 
the opinions of others when making purchasing or other decisions. If so, they may want to keep track 
of the relationships between a contact having purchasing authority and those who might influence 
his purchasing decisions.

End users use the Contacts Relationship Hierarchy view to identify and capture key relationships for 
a contact. This view features a graphical tree that provides a visual representation of a contact’s 
relationships. The tree displays both the natural hierarchy of a contact’s parent-child relationships 
to entities such as companies and households, as well as custom-defined relationships.
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Custom-defined relationships are ad-hoc associations between the contact and any other contact, 
organization, or household. End users can record custom-defined relationships between any two 
entities in the adjacent Party Relationships list.

NOTE: The Relationship Hierarchy view is also available on the Companies and Households screens. 
For more information, see “Viewing Company Relationship Hierarchies (End User)” on page 46 and 
“Using the Household Relationship Hierarchy” on page 62.

To view a contact’s relationship hierarchy

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact for whom you want to view a relationship hierarchy.

3 Click the Relationship Hierarchy view tab.

The Contacts Relationship Hierarchy view appears.

To define a relationship between contacts

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact for whom you want to describe relationships; if the 
contact does not exist, add it. 

For more information on adding contacts, see “Adding Contacts” on page 51.

3 Click the Relationship Hierarchy view tab.

4 In the Party Relationship list, add a record, and complete the necessary fields. 

Some fields are described in the following table.

The newly defined relationship is expressed in the Relationship Hierarchy explorer.

Field Comments

Relationship Categorizes the relationship between the contacts. The field has an LOV for 
Custom Defined Relationship values. Predefined values include Reports To, 
Spouse, Child, Lawyer, Board Member, Primary Contact (Backup), Admin 
Assistant, Competitor, Referral, Service Provider, Investor, Wealth 
Management Rep, Related Subsidiary, Bank Attorney, Trustee Attorney, and 
Debtor Attorney.

The Siebel administrator can modify this LOV. For more information, see 
“Configuring Lists of Values” on page 20.

Type Defaults to Contact. Other values include Household, Organization, and 
Employee.

Value Identifies the other member of the relationship. The values are constrained by 
the Type field selection. For example, if Type equals Contact, then clicking the 
select button displays the Select Contact dialog box.
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6 Managing Households

This chapter includes the following topics:

■ “About Managing Households” on page 59

■ “Scenario for Managing Households” on page 60

■ “Process of Managing Households” on page 60

■ “Adding Households” on page 60

■ “Setting the Household Privacy Option” on page 61

■ “Associating Contacts with Households” on page 61

■ “Viewing Household Summaries” on page 62

■ “Using the Household Relationship Hierarchy” on page 62

About Managing Households
A household is a group of contacts generally sharing a common link or association. Households 
provide valuable segmentation information on the household as a whole, as well as a summary of 
information about the household member contacts. Users can use the Households screen for 
identifying and capturing demographic information about a household. They can also use the 
Households screen to review customer’s financial accounts, products, and contact information 
associated with that household. This information allows them to assess customers’ data.

CAUTION: This chapter assumes you have renamed Siebel Account objects to Companies. By 
default, Siebel Insurance installs using the term Accounts. For more information on renaming Siebel 
Account objects, see the Upgrade Guide for your operating system.

Grouping all of a customer’s accounts by household allows a service provider to identify a client’s 
real value to the organization and seek opportunities to cross-sell and up-sell additional products and 
services to them, such as homeowners insurance and loans for children’s education. In addition, the 
ability to view all of a customer's financial accounts and related portfolio information by household 
allows an organization to view the household’s overall financial position. 

By following the procedures described in this chapter, users can enter, manage, and review 
information about household members (contacts), accounts, policies, underwriting reports, claims, 
opportunities, activities, service requests, and relationship hierarchies.

NOTE: Many of the views are read-only, as they provide a summary of information about household 
contacts. The only editable views are Contacts and Relationship Hierarchy.

The Households screen and associated views that appear in Siebel Insurance share much of the 
functionality found in Siebel Business Applications. This chapter focuses on the household 
functionality that is unique to Siebel Insurance. For more information on basic household 
functionality, see Siebel Applications Administration Guide.
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Scenario for Managing Households
These scenarios are examples of workflows performed by sales representatives and their managers 
in the insurance and healthcare industries. Your company may follow a different workflow according 
to its business requirements.

Household information supports sales and service decisions for segmentation and cross-selling. It 
also provides background information for the finance and insurance industries about a household and 
all of its contacts.

A sales representative uses the Household screen for identifying and capturing demographic and 
relationship information about the household, and for reviewing policies and products associated 
with that household. From the Households screen, the sales representative creates a new household 
for a new customer. He then adds contacts to the household. 

Some weeks later, the sales representative wants to review household information. He navigates to 
the My Households view, and then selects the Insurance Summary view to review a list of contacts, 
service requests, policies and quotes, and claims associated with a household.

In this scenario, end users are the sales representatives who manage household information in the 
field. They enter and review information to:

■ Add a household

■ Add a contact to a household

■ View household summary information

■ View household relationships

■ View household policies

Process of Managing Households
This section details sample tasks often performed by end-users when managing households. Your 
company may follow a different process according to its business requirements. 

■ “Adding Households” on page 60

■ “Setting the Household Privacy Option” on page 61

■ “Associating Contacts with Households” on page 61

■ “Viewing Household Summaries” on page 62

■ “Using the Household Relationship Hierarchy” on page 62

Adding Households
End users can collect and manage information about a customer’s household. Households are added 
from the Households screen. For detailed information on how to add a household see Siebel 
Applications Administration Guide.
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Setting the Household Privacy Option
United States law requires that financial institutions disclose their privacy policies regarding the 
sharing of non-public personal information with third parties, and fair credit reporting, that impacts 
the sharing of non-public personal information with affiliates. End users can specify a privacy level 
by making a selection from the Privacy Option field.

The Privacy Option field is for registering the privacy level requested by the household; it does not 
impact record visibility in any way. 

To set the privacy option for a household

1 Navigate to the Households screen > List view. 

2 To specify a privacy level, scroll down to the Privacy Option field and select one of the following:

■ Opt-In. Sharing of non-public personal information is allowed without restrictions.

■ Opt-Out - Affiliates. Sharing of non-public personal information with affiliates is not 
allowed.

■ Opt-Out - Third Party. Sharing of non-public personal information with third parties is not 
allowed.

■ Opt-Out - All Parties. Sharing of non-public personal information with any affiliate or third 
party is not allowed.

Associating Contacts with Households
Contacts are persons associated with a household. End users can specify one person in the household 
as the head of household and then identify the others as spouse, child, or dependent parent.

To add a contact to a household

1 Navigate to the Households screen > List view.

2 In the Households list, drill down on the household to which the contacts will be added.

3 Click the Contacts view tab.

4 In the Contacts list, click Add, and do one of the following:

■ Select an existing contact and click OK.

■ Perform a query to choose an existing contact. 

■ Select New to add a new contact.

The contact is associated with the household.

NOTE: In the Households screen, a contact’s address is his or her residential or personal 
address. In the Contact’s screen, a contact’s address is his or her work address. Household 
addresses can only be selected from among residential addresses.
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Viewing Household Summaries
The Household Summary view provides a comprehensive view of the household’s relationship with 
an end user’s organization in an editable format. This view displays basic information about the 
household, contacts, financial accounts, and past or pending service requests. 

To view household summary information

1 Navigate to the Households screen > List view.

2 In the Households list, drill down on the household, and click the Summary view tab.

Using the Household Relationship 
Hierarchy
End users use the Household Relationship Hierarchy view to identify and capture key relationships 
for a household. This view features a graphical tree that provides a visual representation of a 
household’s relationships, which includes its natural relationships to the household contacts as well 
as custom-defined, ad-hoc relationships. 

Users can create custom-defined relationships between a household and any contact or organization. 
End users can record custom-defined relationships between any two entities in the adjacent Party 
Relationships list.

NOTE: The Relationship Hierarchy view is also available on the Contacts and Companies screens. For 
more information, see “Viewing Contact Relationship Hierarchies (End User)” on page 56 and “Viewing 
Company Relationship Hierarchies (End User)” on page 46.

To create a custom-defined relationship

1 Navigate to the Households screen > List view.

2 In the Households list, drill down on the household for which you wish to define relationships.

3 Click the Relationship Hierarchy view tab, and in the Party Relationship list, add a record.
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4 Complete the necessary fields.

Some fields are described in the following table.

.

The newly defined relationship appears in the Relationship Hierarchy explorer.

Field Comments

Relationship The value in this field categorizes the relationship between the household 
and the other entity. The field has an LOV for custom-defined Relationship 
values. Predefined values include Reports To, Spouse, Child, Lawyer, 
Board Member, Primary Contact (Backup), Admin Assistant, Competitor, 
Referral, Service Provider, Investor, Wealth Management Rep, Related 
Subsidiary, Bank Attorney, Trustee Attorney, and Debtor Attorney. This 
LOV can be modified by the Siebel administrator. For more information, 
see “Configuring Lists of Values” on page 20.

Type The value in this field determines the type of entity with which you wish 
to establish a relationship. Defaults to Contact. Other values include 
Household, Organization, and Employee.

Value The value in this field is based on the Type field. For example, if Type 
equals Contact, then clicking the select button in Value field displays the 
Select Contact dialog box.
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7 Managing Call Reports

This chapter includes the following topics:

■ “About Managing Call Reports” on page 65

■ “Scenario for Managing Call Reports” on page 66

■ “Process of Managing Call Reports” on page 66

■ “Viewing Call Report Charts” on page 67

■ “Activating the New Call Report Workflow” on page 68

■ “Managing Call Report Templates” on page 69

■ “Adding Call Reports (End User)” on page 69

■ “Creating Call Report Distribution Lists (End User)” on page 71

■ “Associating Action Items, Notes, and Attachments with Call Reports (End User)” on page 71

■ “Setting the Call Report Privacy Flag (End User)” on page 72

■ “Emailing and Printing Call Reports (End User)” on page 72

About Managing Call Reports
Call reports are records of meetings and other conversations with clients, organizations, and 
individuals. Call reports are often required of employees because they:

■ Are a means for new relationship managers to learn about the client and its history with the 
organization.

■ Allow senior managers and product specialists associated with a certain client to keep up with 
the developments in the client relationship, even if they do not meet with the client on a regular 
basis.

■ Provide a record of important and informal agreements. In the event that a failed financing 
transaction results in legal proceedings, these reports are an important component of the legal 
process.

Administrators use these procedures to view a chart of call reports and manage call report templates. 
End users use the Call Reports screen to add a new call report, create a call report distribution list, 
designate a report as private, and email or print call reports.

Siebel Insurance can provide notification of new call reports to designated individuals. For more 
information, see Siebel Business Process Designer Administration Guide.
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Scenario for Managing Call Reports
This scenario features sample tasks performed by an insurance agent and his manager. The scenario 
outlined in this section is based on the business requirements of the insurance industry. Your 
company may follow a different workflow according to its business requirements. 

After returning to the office following a successful meeting with the client, an insurance agent loads 
Siebel Insurance to complete his call report. The agent navigates back to his calendar and marks the 
meeting as Done. He then navigates to the Call Reports screen and enters a new call report to 
document the meeting. In the Report Detail view, he types a brief log of the meeting and adds the 
names of contacts and employees who participated.

Upon completing his report, the insurance agent turns to the action items that resulted from the 
meeting. First, he needs to send an email to a fellow employee to tell her about the meeting. He uses 
the Email Report button on the Call Report form to accomplish this task. 

Next, he remembers that he promised to include the client on the invitation list for the upcoming 
Charity Ball, so he adds an action item on the Call Reports Action Items view tab. He does this by 
clicking Add Action Items on the Call Report form. After he enters his action item, along with several 
others, he assigns them to members of his team for follow-up. 

The insurance agent’s boss is also a member of the client team. When she arrives in the office the 
next day and loads Siebel Insurance, she reviews the new call reports on the Call Reports screen, 
reading about the meeting details and notes. 

In this scenario, managers or Siebel administrators can use Siebel Insurance to view graphical 
representations of their call reports, and perform volume analysis of their own calls, their team’s 
calls, or all call reports.

The end users are insurance agents who create call reports to record their meetings and activities. 
They enter information to:

■ Create new call reports 

■ Create call report distribution lists

■ Create call report action items

■ Attach related documents

■ Specify a call report as private

■ Review and add additional notes or comments

■ Email or print call reports

Process of Managing Call Reports
This section details sample tasks often performed by administrators and end-users when managing 
call reports. Your company may follow a different process according to its business requirements.
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Administrator Procedures
The following list shows tasks administrators typically perform to manage call reports:

■ “Viewing Call Report Charts” on page 67

■ “Activating the New Call Report Workflow” on page 68

■ “Managing Call Report Templates” on page 69

End-User Procedures
The following list shows tasks end users typically perform when managing call reports:

■ “Adding Call Reports (End User)” on page 69

■ “Creating Call Report Distribution Lists (End User)” on page 71

■ “Associating Action Items, Notes, and Attachments with Call Reports (End User)” on page 71

■ “Setting the Call Report Privacy Flag (End User)” on page 72

■ “Emailing and Printing Call Reports (End User)” on page 72

Viewing Call Report Charts
As a manager or Siebel administrator, you can use the Call Report Charts view for call volume 
analysis of your own calls, your team’s calls, or all call reports in Siebel Insurance. Use this view to 
analyze call volume and call types by employee and by customer, in order to determine which clients 
are receiving the most service.

To view a chart for your call reports

1 Navigate to the Call Reports screen > Call Report List view.

2 From the visibility filter, select one of the following:

■ My Call Reports

■ My Team’s Call Reports

■ All Call Reports

The view selected returns an appropriate set of call report records to be analyzed.

3 Click the Charts link on the link bar.

The chart reflects only those call report records in the current query; that is, those records listed 
in the Call Reports list preceding the chart.
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4 From the lower Show drop-down list, select one of the following chart types:

NOTE: Place your cursor over any chart segment to reveal additional information about that 
segment. Click a segment to drill down and refocus on just the call reports in that segment.

Activating the New Call Report Workflow
When activated, the New Call Report Workflow allows end users to create call report records 
automatically from the Contacts, Companies, Activities, and Opportunities screens. After the 
administrator activates the New Call Report Workflow, the New Call Report icon appears in the upper-
left corner of those screens for end users.

To activate the New Call Report Workflow

1 Navigate to the Administration - Business Process screen > Workflow Deployment view.

2 In the Repository Workflow Processes list, query for the New Call Report Workflow record.

3 Click the Activate button at the top of the list to activate this workflow process.

When activated, the definition is written to the run-time tables and appears in the Active 
Workflow Processes view.

To use the New Call Report feature after it is activated, end users can do one of the following: 

■ Click the icon

■ Choose File > Auto > Call Report from the application-level menu 

■ Use the short cut key Alt+P

NOTE: The New Call Report Workflow uses the Data Transfer Utility business service to transfer fields 
from one view to another. For information on modifying the New Call Report Workflow, so that it is 
available from more screens, or populating more fields when moving from one screen to the next, 
see “Using Data Transfer Utilities (DTU)” on page 260 for details on the Data Transfer Utilities business 
service. The current Data Map Objects used for the New Call Report in the Data Transfer Utility 
business service include: New Call Report - Account, New Call Report - Activity, New Call Report - 
Contact, and New Call Report - Opportunity.

Chart Comments

Call Type Analysis A breakdown of all selected call reports by Call Type.

Call Volume Analysis Charts the number of calls per month, quarter, or year.

Call Volume by Employee Charts the number of calls per month, quarter, or year, per 
employee.

Company Calling Analysis Charts the number of calls per company.

Employee Calling Analysis Charts the number of calls per company, by employee.
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Managing Call Report Templates
You can email call reports. Emailed call reports, like other communications in Siebel applications, use 
templates to automatically format information in a message sent as an email. When you email a call 
report, Siebel Insurance uses the Call Report Email template to populate the email message. 

For more information on configuring communication templates, see Siebel Communications Server 
Administration Guide.

To view or change the call report email template 

1 Navigate to the Administration - Communications screen > All Templates view. 

2 In the Templates list, query for the template named Call Report Email.

3 Review or change the call report in the Call Report Email form.

Siebel Insurance provides additional syntax for customizing message templates, offering a way to 
embed multi-value fields within the body of the message templates. As an example of this syntax, 
examine the template text for the Call Report Email template. 

Adding Call Reports (End User)
End users add call reports to create a record of meetings and other conversations with clients, 
organizations, and individuals.

To add a call report

1 Navigate to the Call Reports screen > Call Report List view.
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2 In the Call Report form, add a record and complete the necessary fields. 

Some fields are described in the following table.

NOTE: In the Call Reports list, the New flag is a calculated field and appears checked for five 
days after the creation of a call report. Your systems administrator can change this setting. 

3 In the Call Reports list, drill down on the Description link to navigate to the Report Detail view.

4 In the Employees and Contact lists, enter detailed information about the call. 

Information you enter here appears in emailed or printed call reports.

Field Comments

Associated 
Activity

The activity that is the subject of the call report; each call report can have 
only one associated activity. Selection of the associated activity is 
governed by the following constraints if those fields are populated:

■ Same Company ID

■ Same Primary Opportunity ID

■ Same Primary Contact ID

Contacts Enter the participating contacts who were at the meeting. Designate a 
primary contact if desired, otherwise the first contact selected is defaulted 
as the primary. Entries appear in the Report Detail view and on the printed 
Call Report.

Description A summary description of the call report; enter a more detailed report in 
the Report Detail view.

Distribution List additional employees from your organization who should receive the 
Call Report, but should not appear on the list of participants. The call 
report creator and all Employee Participants are automatically placed on 
the distribution list.

Employees List employees from your organization who participated in the call. Entries 
appear in the Report Detail view and on the printed Call Report. The call 
report creator is automatically listed as a participant.

Opportunity Associate an opportunity with the call report. You can view all call reports 
associated with any given opportunity from the Opportunities screen.

Type The LOV type for this field is FINCORP_CALLRPT_CONTACT_TYPE.
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Creating Call Report Distribution Lists 
(End User)
A distribution list is the list of contacts who need to know what is happening with a particular client. 
Usually, it is the coverage team for the client, plus any additional employee participants. The 
application automatically places the call report creator and each employee participant on the 
distribution list. For other employees, such as the coverage team, to receive a call report, end users 
must manually add them to the distribution list.

When end users use the call report Email Report feature, the distribution list controls who receives 
the report. The call report Print Report function and the Send Email function, both available through 
the application-level File menu (F9), are not affected by the distribution list.

To create a distribution list

1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, drill down on the call report for which you want to create a distribution 
list.

3 In the Distribution field, select one or more employees to add to the distribution list.

The selected name or names are added to the distribution list.

Associating Action Items, Notes, and 
Attachments with Call Reports (End 
User)
After an end user has added a call report, they can associate it with action items, notes, and 
attachments.

NOTE: Call report attachments, like the attachments for other activities, are stored in the 
S_ACTIVITY_ATT table. 

To associate action items, notes, and attachments

1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, drill down on the desired call report.

3 To add notes or action items to the call report, in the Call Report form click the appropriate view 
tab:

■ Notes. Adds notes or comments.

■ Action Items. Adds an action item.

4 To attach external documents to a call report, click the Attachments view tab, and choose a file 
or select a URL.
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Setting the Call Report Privacy Flag (End 
User)
Certain call reports may contain sensitive or confidential information about a given company or 
opportunity. Users can designate certain calls as private by clicking the Private check box in the call 
report form or list. After a call report is marked as private, only those employees on the employees 
list can access it. 

To set a privacy flag

1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, select the desired call report, and click the Private field.

The call report is now categorized as private. Only the employees on the employees list can 
access it.

Emailing and Printing Call Reports (End 
User)
You can email or print call reports for distribution and record keeping. First, submit a call report and 
then email or print the report.

To submit a call report

1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, select the call report to submit.

3 In the Call Report form, select Submitted from the drop-down list.

To email or print a call report

1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, drill down on the call report to email or print.
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3 In the Call Report form, do one of the following:

To... Click...

Email the report. Email Report.

The report is automatically emailed to 
everyone on the distribution list.

Print the report. The toolbar Reports icon.

In the Reports dialog box, select 
Summary or Detail and click Run.
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8 Managing Group Pensions

This chapter includes the following topics:

■ “About Managing Group Pensions” on page 75

■ “Scenario for Creating a Company 401(k) Plan” on page 75

■ “Group Pension Sample Tasks” on page 76

■ “Process of Managing Group Pension Plans” on page 77

■ “Defining Group Pension Products” on page 77

■ “Defining Group Pension Plans” on page 78

■ “Administering Group Pension Plans (End User)” on page 80

About Managing Group Pensions
Siebel Insurance provides support for group pensions and is designed to meet the needs of sales and 
service professionals, managers, and pension administrators. End users can use the Group Pensions 
screen to manage private group pensions, which includes defined contribution plans, such as 401(k) 
plans and occupational group pensions, and defined benefit plans. 

Use these procedures to define group pension plans, plan classes, plan eligibility rules, and plan 
funding vehicles. Once a group pension plan is defined, users can track eligible and enrolled 
participants, participant contribution and investment allocations, and participant beneficiary 
information.

You can save time and reduce keystrokes by using a workflow to automate steps that are repeatedly 
performed by end users. For more information, see Siebel Business Process Designer Administration 
Guide.

You can also set up group pension plans using catalog functionality. For more information about 
catalogs, see Siebel Product Administration Guide.

Scenario for Creating a Company 401(k) 
Plan
The following business scenario features sample tasks performed by a pension administrator. Your 
company may follow a different workflow according to its business requirements. 

You can use the Product Administration view to define a new group pension product and investment 
options for plan participants. The pension administrator then creates a new 401(k) retirement plan 
and enters all the basic plan information. In this instance, the pension administrator defines one 
class, enters the plan eligibility rules, and specifies the key contacts for the plan.
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A week later, the administrator updates information for the 401(k) retirement plan participants. First, 
the administrator imports a list of eligible participants. Then, the administrator enrolls 10 new 
participants, specifying each employee’s contribution amount, the employer match, and the selected 
fund allocations.

In this scenario, the end user is a pension administrator who uses the Group Pensions screen to:

■ Define a group pension product and specify pension plan investment options

■ Define a group pension plan, including participant classes, eligibility rules, and key group pension 
plan contacts

■ Add eligible plan members

■ Enroll group pension plan participants and record participant beneficiary information

Group Pension Sample Tasks
Figure 2 illustrates sample tasks that end users typically perform when managing group pensions.

Figure 2. Group Pension Sample Tasks
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Process of Managing Group Pension 
Plans
This section details sample tasks often performed by administrators and end-users when managing 
group pension plans. Your company may follow a different process according to its business 
requirements.

Administrator Procedures
The following list shows tasks administrators typically perform to manage group pension plans:

■ “Defining Group Pension Products” on page 77

■ “Defining Group Pension Plans” on page 78

End-User Procedures
The following list shows a task end users typically perform when managing group pension plans:

“Administering Group Pension Plans (End User)” on page 80

Defining Group Pension Products
Before end users create an actual group pension plan, the product administrator must first define a 
group pension product and specify investment options for plan participants.

To define a group pension product

1 Navigate to the Administration - Product screen > Products view.

2 Click the New and Release button and do the following:

■ In the Name field, enter a name for this group pension product.

■ In the Finance Product Type field, select Retirement from the drop down list.

■ In Products form, select Pension from the Sub Type drop down list.

3 Drill down on the name, and on the link bar, click the Group Pensions Product Administration.

4 In the Funding Vehicles list, create a new record and complete the fields.

To define funding vehicles for a group pension product

1 Navigate to the Group Pensions screen > Group Pensions Administration List view.

2 In the Product list, select a group pension product.

3 In the Funding Vehicles list, add a record, and complete the necessary fields. 
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4 In the Name field, select the funds and investments available on this plan.

5 In the Effective Date field, specify the date this plan will become available within the system.

Once users have defined a group pension product and funding vehicles, the next step is to create a 
group pension plan for an account (see “Defining Group Pension Plans”).

Defining Group Pension Plans
To define a group pension plan, end users must perform the following steps:

■ Define a group pension plan. For more information, see “To define a group pension plan” on 
page 78.

■ Specify plan rules. End users use the Rules view tab to define the types of rules that govern 
the selected group pension plan. For more information, see “To specify plan rules” on page 79.

■ Define participant classes. End users define different groups of plan participants in the Classes 
view tab. For more information, see “To define participant classes for plan participants” on page 79.

■ Record key plan contacts. End users use the Contacts view tab to define key contacts 
associated with the selected plan. These contacts are not plan participants, but consist of key 
individuals associated with the selected plan such as a plan administrator, trustee, or investment 
committee member. For more information, see “To record key group pension plan contacts” on 
page 79.

■ Enter billing information. End users use the Bill To view tab to specify high-level payment 
information, such as payment frequency and a billing address. For more information, see “To 
enter billing information” on page 80.

To define a group pension plan

1 Navigate to the Group Pensions screen > Group Pensions List view.

2 In the lower form, add a record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Plan Sponsor A company or account that has a group pension plan associated with it 
or a company or account that provides a group pension for a group of 
people. For more information on adding additional companies, see 
“Adding Companies and Investors (End User)” on page 41.

Name The group pension product defined in the Group Pension Product 
Administration view. 

For more information on defining group pension products, see “To define 
a group pension product” on page 77.
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To specify plan rules

1 Navigate to the Group Pensions screen.

2 In the Group Pensions list, select a group pension plan, and drill down on the plan # link.

3 Click the Rules view tab.

4 In the Rules form, complete the necessary fields.

To define participant classes for plan participants

1 Navigate to the Group Pensions screen.

2 In the Group Pensions list, select a group pension plan, and drill down on the plan # link.

3 Click the Classes view tab.

4 In the Classes list, add a record and complete the necessary fields.

5 If this is an employer-sponsored plan, enter the appropriate percentage in the Employer Match% 
field.

To record key group pension plan contacts

1 Navigate to the Group Pensions screen.

2 In the Group Pensions list, select a group pension plan, and drill down on the plan # link.

3 Click the Contacts view tab.

4 In the Contact list, add a record and complete the necessary fields.

5 In the Contact Role field, select one of the following:

Type The type of group pension plan. Options include:

■ Defined Benefit. Group pension plan that defines the amount of the 
benefit a plan participant will receive upon retirement.

■ Defined Contribution. Group pension plan that describes the plan 
sponsor's annual contribution to the plan on behalf of each plan 
participant. 

Sub Type Further defines the type of group pension plan being created. Available 
values are based on the Type field selection.

If the Type is:

■ Defined Benefit, available options include Final Salary and Average 
Salary.

■ Defined Contribution, available options include 401(k), 403(b), 
Group Occupational Pension, Group Personal Pension, and Group 
Stakeholder Pension (UK-specific).

Field Comments
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■ Administrator

■ Investment Committee

■ Trustee

To enter billing information

1 Navigate to the Group Pensions screen.

2 In the Group Pensions list, select a group pension plan and drill down on the plan # link.

3 Click the Bill To view tab.

4 In the Pay Plans list, create the appropriate number of pay plans by adding a record for each plan 
and completing the necessary fields.

5 Scroll down to the lower applet and enter the required information to complete the payment 
information.

Administering Group Pension Plans (End 
User)
End users administer group pension plans by performing the following tasks:

■ View available plan funds and investments. End users view which funds and investments are 
available within a specific group pension plan in the Funding Vehicles view tab. For more 
information, see “To view the funds and investments available within a group pension plan” on 
page 81.

■ Add eligible plan members. End users can track individuals who are eligible to participate in 
a group pension plan in the Eligible Members view tab. For more information, see “To add eligible 
plan members” on page 81.

■ Create service requests to track plan administration. End users can use the Service 
Requests view tab to track general plan administration activities, which includes account value 
inquiries, changes in participant contributions, and updates to participant contact information. 
Users can also use this view to track changes to the features and benefits of a specific plan. For 
more information, see “To create a service request associated with a group pension plan” on 
page 81.

■ Enroll group pension plan participants. End users enroll new group pension plan participants 
in the Participants view tab. For more information, see “To enroll new participants in a group 
pension plan” on page 81.

■ Record beneficiary information. End users record beneficiary information for plan participants 
in the Beneficiary view tab. For more information, see “To record participant beneficiary 
information” on page 81.

■ Create activities and notes associated with a group pension plan. For more information, 
see “To create an activity associated with a group pension plan” on page 82 and “To create a note 
associated with a group pension plan” on page 82.
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For more information on defining funding vehicles, see “To define funding vehicles for a group pension 
product” on page 77.

To view the funds and investments available within a group pension plan

1 Navigate to the Group Pensions screen > Group Pension List view.

2 In the Group Pensions list, select a group pension plan, and drill down on the plan # link.

3 Click the Funding Vehicles view tab.

To add eligible plan members

1 Navigate to the Group Pensions screen > Group Pension List view.

2 In the Group Pensions list, select a group pension plan, and drill down on the plan # link.

3 Click the Eligible Members view tab.

4 In the Participants list, add a record and complete the necessary fields.

To create a service request associated with a group pension plan

1 Navigate to the Group Pensions screen > Group Pension List view.

2 In the Group Pensions list, select a group pension plan, and drill down on the plan # link.

3 Click the Service Requests view tab.

4 In the Service Requests list, add a record and complete the necessary fields.

5 To add further information about the service request, drill down on the SR # link.

To enroll new participants in a group pension plan

1 Navigate to the Group Pensions screen > Group Pension List view.

2 In the Group Pensions list, select a group pension plan, and drill down on the plan # link.

3 Click the Participants view tab.

4 In the Participants list, add a record and complete the necessary fields.

NOTE: In order for Siebel Insurance to automatically populate the Employer Match % field in the 
Participants view tab, you must enter a value in the Class field.

5 In the Allocations form, add a record for each fund or investment option. Select the appropriate 
funds and investments options from the Pick Funding Vehicle list.

To record participant beneficiary information

1 Navigate to the Group Pensions screen > Group Pension List view.

2 In the Group Pensions list, select a group pension plan, and drill down on the plan # link.

3 Click the Beneficiary view tab.
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4 In the Participants list, select a participant. 

5 In the Beneficiary list, add a record and complete the necessary fields.

NOTE: Make sure all the values entered in the % field equal 100%.

For more information on adding participants, see “To enroll new participants in a group pension plan” 
on page 81.

To create an activity associated with a group pension plan

1 Navigate to the Group Pensions screen > Group Pension List view.

2 In the Group Pensions list, select a group pension plan, and drill down on the plan # link.

3 Click the Activities view tab.

4 In the Activities list, add a record and complete the necessary fields.

To create a note associated with a group pension plan

1 Navigate to the Group Pensions screen > Group Pension List view.

2 In the Group Pensions list, select a group pension plan, and drill down on the plan # link.

3 Click the Notes view tab.

4 In the Notes list, add a record and complete the necessary fields.
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9 Managing Auto Policies

This chapter includes the following topics:

■ “About Managing Auto Policies” on page 83

■ “Scenario for Managing Auto Policies” on page 83

■ “Process of Managing Auto Policies” on page 84

■ “Adding Auto Coverages and Coverage Values” on page 85

■ “Providing Quotes” on page 85

■ “Adding Discounts” on page 86

■ “Adding Vehicles or Drivers to Policies” on page 87

■ “Setting Up Payment Plans” on page 87

■ “Adding Underwriting Information” on page 87

■ “Ordering Underwriting Reports” on page 88

About Managing Auto Policies
In Siebel Insurance, a quote is a policy that has not been issued. An automobile insurance policy 
quote has one or more insured drivers, one or more insured vehicles, and one set of coverages for 
those vehicles and drivers. Each variation of these rating and risk evaluation (underwriting) variables 
is represented in Siebel Insurance by a separate quote. Because a new quote is generated for each 
combination of variables that a customer inquires about, multiple quotes typically are generated for 
customers before they choose and purchase a policy. 

The Auto Policies screen allows end users to create and manage automobile insurance policies. End 
users can issue a quote for a new policy or for a change in an existing policy. Administrators can add 
auto coverage and coverage values in the Insurance Administration views.

For more information on views common to all policy screens, see “Common Policy Views” on page 154.

Scenario for Managing Auto Policies
This scenario features sample tasks performed by a licensed sales representative. Your company may 
follow a different workflow according to its business requirements.

In this scenario, a licensed sales representative for an auto insurance company is on the phone with 
a prospective customer.
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She uses the Quick Quote view to prompt the customer for enough information to provide an initial 
quote. Then, she adds underwriting information and runs an underwriting report to obtain the rest 
of the information she needs. Next, she enters information about vehicle coverages and value. Then 
she adds adjustments for policy discounts and feeds the revised data into the external rating 
calculator to view the resulting premiums. She gives the prospect a verbal quote and ends the 
conversation. 

The next day, she receives an email message that the prospect has called back and will probably 
purchase a policy, but requires a new quote with a $250 deductible instead of $100.

During the second call, the prospect confirms the intent to purchase the quoted policy. The quote 
now needs to be prepared for eventual contract issuance. This includes collecting information about 
any parties that hold liens against the insured vehicles and determining billing and payment 
arrangements. The sales representative follows the procedures implemented by her company to 
submit the policy for issuance and billing.

In this scenario, end users are the sales representatives who manage auto policy information. They 
enter information to:

■ Provide auto insurance policy quotes

■ Add underwriting information 

■ Order underwriting reports

■ Add the appropriate discounts

■ Add vehicles or drivers to a policy

■ Set up payment plans

Process of Managing Auto Policies
This section details sample tasks often performed by administrators and end-users when managing 
auto policies. Your company may follow a different process according to its business requirements.

Administrator Procedures
The following administrator procedure is described in this section:

■ “Adding Auto Coverages and Coverage Values” on page 85

NOTE: Only those users with the required administrative responsibilities, such as Siebel 
administrators, can change entries in the Insurance Administration screen.

End-User Procedures
The following list shows a task end users typically perform when managing auto policies:

■ “Providing Quotes” on page 85
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■ “Adding Underwriting Information” on page 87

■ “Ordering Underwriting Reports” on page 88

■ “Adding Discounts” on page 86

■ “Adding Vehicles or Drivers to Policies” on page 87

■ “Setting Up Payment Plans” on page 87

Adding Auto Coverages and Coverage 
Values
The Administration - Insurance view allows you to add and make changes to auto coverages, driver 
coverages, and auto coverage values. You can use the existing fields to define the default limits and 
deductibles of auto coverages, or you can add more fields using Siebel Tools. For more information, 
see Configuring Siebel Business Applications.

To add an auto coverage and coverage value

1 Navigate to Site Map > Administration - Insurance > Auto Coverages.

2 In the Coverage Administration list, add a record and complete the necessary fields.

NOTE: If you leave the Vehicle Type field as null, the coverage can be used for driver coverage. 
If you select Private passenger vehicle in the Vehicle Type field, the coverage can be used for 
auto coverage.

3 Scroll down to the Coverage Values list.

4 In the Coverage Value list, add a record and complete the necessary fields.

Providing Quotes
In Siebel Insurance, a quote is a policy that has not been issued. End users can provide a quote for 
a new policy or for a change to an existing policy. The Quick Quote view provides a faster way to 
gather basic policy and rating information. The information collected through the Quick Quote view 
represents the minimum rating information needed to create an initial premium estimate.

To provide an auto insurance policy quote

1 Navigate to the Auto Policies screen.

2 Create a new policy, or select an existing policy, and drill down on the policy #.

3 Click the Quick Quote view tab.

4 In the Vehicles list, add a record and complete the necessary fields.

5 In the Drivers list, add a record.

6 In the Add Drivers dialog box, perform one of the following tasks:
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■ To choose an existing record, select a record and click OK.

■ To add a new record, click New and complete the fields.

NOTE: When you add a driver with a Primary designation, the application automatically 
populates the Primary field in the Policy/Quote form.

7 Click the Rate Model view tab.

Coverages might be defaulted to a standard set (through configuration) or manipulated through 
the Rate Model view to further refine the quote. You can collect additional data to aid in the 
underwriting and administration of the quote.

8 In the Vehicle Coverages list, add a record and select coverages and values.

NOTE: You can manually add premium amounts or configure your Siebel application to add a 
Rate button that activates the software program your company uses to rate policies.

End users can view a summary of all vehicles, coverages, and premiums associated with a policy in 
the Multi Vehicle Rate Model view tab. The information that appears on this view is a different 
presentation of information entered in the Rate Model view.

To view a summary of all vehicles, coverages, and premiums associated with a policy

1 Navigate to the Auto Policies screen.

2 In the Policies/Quotes list, drill down on the desired policy.

3 Click the Multi Vehicle Rate Model view tab.

■ Click Next Vehicle Set to view additional vehicles that do not display. 

■ Click Prior Vehicle Set to return the previous view.

Adding Discounts
After end users create a quote or policy, they can add policy, driver, and vehicle discounts to the 
policy.

To add a discount

1 Navigate to the Auto Policies screen.

2 In the Policies/Quotes list, drill down on the desired policy.

3 Click the Discounts view tab.

4 In the appropriate list, add a record and complete the necessary fields:

■ Policy Discounts. To add policy discounts such as long-term customer discounts.

■ Driver Discounts. To add driver discounts such as good driver discounts.

■ Vehicle Discounts. To add vehicle discounts such as anti-theft discounts.
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Adding Vehicles or Drivers to Policies
End users can add vehicles or drivers to existing policies.

To add a vehicle or driver to a policy

1 Navigate to the Auto Policies screen.

2 In the Policies/Quotes list, drill down on the desired policy.

3 Click the Quick Quote view tab.

4 To add a driver, scroll down to the Drivers list, add a record, and complete the necessary fields.

5 To add a vehicle, scroll down to the Vehicles list, add a record, and complete the necessary fields.

Setting Up Payment Plans
End users can set up payment plans, including details about payment methods, for auto insurance 
policies.

To set up a payment plan for an auto policy

1 Navigate to the Auto Policies screen.

2 In the Policies/Quotes list, drill down on the desired policy.

3 Click the Payment Plans view tab.

4 In the Payment Plans list, add a record and complete the necessary fields.

Adding Underwriting Information
After end users provide a quote or accept an application for an auto policy, they can add information 
for use in ordering underwriting reports for the drivers and vehicles associated with the policy.

To add underwriting information

1 Navigate to the Auto Policies screen.

2 In the Policies/Quotes list, drill down on the desired policy.

3 Click the appropriate view tab:

■ Underwriting. To query for prior insurance history and to add prior insurance history, prior 
claims, or residence information.

■ Accidents/Violations. Use the Accidents/Violations list to add information about each 
driver’s accidents and violations.

NOTE: The lists and forms that appear depend on the type of vehicle you select.
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4 Add a record in the selected list or form and complete the necessary fields.

Ordering Underwriting Reports
After end users add the necessary policy, driver, or vehicle information, they can order underwriting 
reports for a policy. Examples of underwriting reports are motor vehicle, credit bureau, or loss history 
reports.

To order an underwriting report

1 Navigate to the Auto Policies screen.

2 In the Policies/Quotes list, drill down on the desired policy.

3 Click the Underwriting Reports view tab.

4 In the Underwriting Reports list, add a record and complete the necessary fields.

5 Use the procedures developed by your company to submit the order.

NOTE: You can configure your Siebel application to add an Order button that activates the 
software program your company uses to submit orders for underwriting reports.



Siebel Insurance Guide Version 8.0, Rev. A 89

10 Managing Claims

This chapter is about managing claims in Siebel Insurance. It contains the following topics:

■ “About Managing Claims” on page 90

■ “Scenario for Opening and Managing a Claim—Property Loss” on page 92

■ “Scenario for Opening and Managing a Claim—Auto Damage” on page 92

■ “Process of Managing Claims” on page 93

■ “About Siebel Insurance eService Claims Center Locators” on page 95

■ “Setting up Siebel Insurance eService Claims Center Locators” on page 95

■ “Activating the Workflow Processes” on page 97

■ “Administering Reserve Codes” on page 97

■ “Administering Loss Codes” on page 98

■ “Administering Adjusters’ Financial Limits” on page 99

■ “Administering the Employee Hierarchy” on page 100

■ “Integrating with the Insurance Services Office (ISO)” on page 100

■ “Integrating with the Office of Foreign Assets Control” on page 103

■ “Checking the Policy Validity and Coverage (End User)” on page 104

■ “Creating First Notices of Loss (End User)” on page 104

■ “Recording Details of Involved Parties (End User)” on page 105

■ “Recording Insured and Adverse Claimant Property Details (End User)” on page 106

■ “Managing Claims Events (End User)” on page 107

■ “Assigning a Claim to An Adjuster (End User)” on page 108

■ “Checking a Claim Against the ISO Database (End User)” on page 108

■ “Creating an Activity Plan (End User)” on page 110

■ “Assigning a Claim Element (End User)” on page 111

■ “Assigning Claims to a Specialist Unit (End User)” on page 112

■ “Adding an Appraisal (End User)” on page 113

■ “Attaching Claims Documentation (End User)” on page 114

■ “Tracking Police and Fire Reports (End User)” on page 114

■ “About Coverages and Reserves” on page 114

■ “Creating a Reserve (End User)” on page 115
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■ “Managing Reserves (End User)” on page 120

■ “Creating an Invoice Record (End User)” on page 121

■ “Generating a Payment Record (End User)” on page 122

■ “Tracking Payments Related to Invoices (End User)” on page 122

■ “About Issuing a Settlement Payment (End User)” on page 122

■ “Issuing a Settlement Payment (End User)” on page 127

■ “Making a Bulk Payment (End User)” on page 127

■ “Viewing the Invoices and Claims for a Payment (End User)” on page 128

■ “Managing Recovery Information (End User)” on page 128

■ “Creating a Recovery Payment Record (End User)” on page 134

■ “Managing Fraud Information (End User)” on page 134

■ “About the Business Rules Processor and Claims Logic” on page 138

■ “Claims Workflows” on page 141

About Managing Claims
Siebel Personal Lines Claims allows agents, call center representatives, and claims adjusters to 
capture notice of loss information, to view claim information and activities, and to link claims to 
customer and policy information. Incident and claim information is used across multiple business 
units including claims, policy servicing, sales, and underwriting, presenting an integrated view of the 
customer.

Claims management is an important part of service interactions with insurance companies. 
Therefore, Siebel claims management can be integrated with other software components, such as 
legacy claims management systems, to provide an integrated solution.

End users can use the Claims screen to open and track claims, as well as to track service requests 
and other activities associated with claims. 

The overall process of managing a claim might involve the following:

■ Claims intake and First Notice of Loss (FNOL). A call center agent creates a First Notice of 
Loss, records the necessary details from the policy holder, and then assigns the claim to a claims 
adjuster.

■ Review and assignment. A claims adjuster reviews the claim and assigns parts of the claim to 
other people or third parties. For example, the adjuster can assign an appraiser to appraise the 
damage, or can assign claim elements to third-party vendors, such as glass vendors.

■ Reserve and adjustment. The claims adjuster creates a reserve with which the claim payment 
will be made.

■ Settlement. The adjuster makes the necessary payment to the policy holder to settle the claim.
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■ Special unit investigation. Throughout the claims process, an adjuster can assign the claim to 
a special unit, such as a subrogation or fraud unit. An investigator in the special unit then 
processes the claim.

Insurance Claims Terminology
The following definitions are useful in understanding Siebel Claims:

■ Appraisal. A survey to determine a property's insurable value, or the amount of a loss.

■ Arbitration. The procedure in which an insurance company and the insured or a vendor agree 
to settle a claims dispute by accepting a decision made by a third party.

■ Bodily injury liability coverage. The portion of an auto insurance policy that covers the 
injuries that the policyholder causes to someone else.

■ Catastrophe. A single incident or a series of closely related incidents causing severe, insured 
property losses, totaling more than a given amount, which is currently $25 million.

■ Comprehensive coverage. The portion of an auto insurance policy that covers damage to the 
policyholder's car not involving a collision with another car (including damage from fire, 
explosions, earthquakes, floods, and riots), and theft.

■ Deductible. The amount of loss paid by the policy holder. Either a specified dollar amount, a 
percentage of the claim amount, or a specified amount of time that must elapse before benefits 
are paid. 

■ First-party coverage. Coverage for the policyholder's own property or person. In no-fault auto 
insurance, first-party coverage pays for the cost of injuries. In no-fault states with the broadest 
coverage, the personal injury protection (PIP) part of the policy pays for medical care, lost 
income, funeral expenses and, where the injured person is not able to provide services such as 
child care, for substitute services.

■ Fraud. Intentional lying or concealment by policyholders to obtain payment of an insurance 
claim that would otherwise not be paid, or lying or misrepresentation by the insurance company 
managers, employees, agents, and brokers for financial gain.

■ Loss costs. The portion of an insurance rate used to cover claims and the costs of adjusting 
claims. Insurance companies typically determine their rates by estimating their future loss costs 
and adding a provision for expenses, profit, and contingencies.

■ No fault insurance. An auto insurance system that both requires drivers to carry insurance for 
their own protection, and which places limitations on their ability to sue other drivers for 
damages.

■ Subrogation. The legal process by which an insurance company, after paying a loss, seeks to 
recover the amount of the loss from another party who is legally liable for it. 

■ Salvage. The damaged property an insurer takes over to reduce its loss after paying a claim. 
Insurers receive salvage rights over property on which they have paid claims, such as badly 
damaged cars. 
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Scenario for Opening and Managing a 
Claim—Property Loss
This scenario features sample tasks performed by a claims representative. Your company may follow 
a different workflow according to its business requirements.

A claims representative for a property insurance company is on the phone with a policy holder whose 
home was burgled. The claims representative must first check that the policy holder has a valid policy 
and that there is appropriate coverage.

To report this first notice of loss, the representative opens a claims file in Siebel Insurance by 
navigating to the Claims screen and creating a new Claims record. The claims representative enters 
the loss date and selects a Policy effective at the time of loss. The representative then moves on to 
the Loss Description view to capture additional details about the burglary.

Next, he creates a detailed list of the lost insured items in the Insured Property view. Then, he uses 
the Police And Fire Reports view to initiate an order for a policy report on the burglary. Because 
heirloom jewelry was among the property that was stolen, he goes to the Appraisals view to 
document the value of the stolen property. Finally, he documents the coverages for the lost items. 

During the next few weeks, he uses other views to track the adjustment process, including reserving 
and recoveries (subrogation or salvage). After the claim is settled, he adds payment details.

In this scenario, the end users are claims representatives. They enter information to:

■ Create a loss claim and record details about it

■ Associate the loss with a contact

■ Create a list, record the worth, and the coverages for the lost insured items

■ Record any police or fire reports, if applicable

■ Track the adjustment process and record payment details

Scenario for Opening and Managing a 
Claim—Auto Damage
This scenario features sample tasks performed by call center agents and claims adjusters. Your 
company may follow a different workflow according to its business requirements.

A call center agent for an insurance company is on the phone with a policy holder whose car was 
damaged in a road traffic accident. The call center agent must first check that the policy holder has 
a valid policy and that there is appropriate coverage.

To report the first notice of loss, the call center agent opens a claims file in Siebel Insurance by 
navigating to the Claims screen and creating a new Claims record. She enters the loss date and 
selects a policy that was effective at the time of the loss. She then moves to the Loss Description 
view to capture some details about the damage to the vehicle and whether there were injuries or 
fatalities.
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The call center agent navigates to the Involved Parties view to capture the contact and account 
information. She then goes to the Insured Property view to capture more information about the 
damaged vehicle and the damage that occurred.

The call center agent assigns the claim to an adjuster who then reviews the claim and assigns part 
of the claim to other people or third parties as necessary. As part of the evaluation, the adjuster 
navigates to the ISO Database Search view to check whether the policy holder has already made a 
claim for the same vehicle with another insurance company.

The adjuster creates an activities plan based on the appropriate loss code in the Activities Plan view, 
then assigns an activity to a particular appraiser who appraises the damage. The adjuster creates 
claim elements and assigns them as necessary to third-party vendors, such as a repair shop to fix 
the damage, or a glass vendor to replace the car windshield.

The next step is to set up a reserve, which is a set amount of money that the insurer puts aside to 
make a claims payment. The adjuster navigates to the Loss Details - Auto view and creates reserves 
for the coverages that apply to the policy. He then navigates to the Reserves view and opens the 
reserves.

In due course, the adjuster receives the invoices associated with the claim and creates a record for 
each invoice in the Claims screen > Invoices view. In the Claims screen > Invoices view, he clicks 
the Generate Payment button to create a payment record for the invoices. The adjuster navigates to 
the Payments view and clicks the Submit Payment button to make the necessary payment and settle 
the claim. 

Throughout the claims process, an adjuster can assign the claim to a specialist unit such as a 
subrogation unit or a fraud unit. The specialist unit then processes the claim in their area.

In this scenario, the end users are call center agents and claims adjusters. They enter information to:

■ Check that the claimant has a valid policy with the appropriate coverage

■ Create a loss claim and record details about it

■ Associate the loss with a contact and account

■ Record details about the damage to the vehicle

■ Check whether the claimant has filed a similar claim with another insurance company

■ Create an activities plan and assign activities to appraisers

■ Assign claim elements to appropriate third-party vendors

■ Create and open reserves

■ Record invoice details

■ Generate and submit payments

Process of Managing Claims
This topic details tasks performed by administrators and end users when managing claims. Your 
company may follow a different process according to its business requirements.
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Administrator Procedures for Managing Claims
The following list shows tasks administrators typically perform to manage claims:

■ “Setting up Siebel Insurance eService Claims Center Locators” on page 95

■ “Administering Reserve Codes” on page 97

■ “Administering Loss Codes” on page 98

■ “Administering Adjusters’ Financial Limits” on page 99

■ “Administering the Employee Hierarchy” on page 100

■ “Integrating with the Insurance Services Office (ISO)” on page 100

■ “Integrating with the Office of Foreign Assets Control” on page 103

End-User Procedures for Managing Claims
The following list shows tasks call center agents typically perform to create the First Notice of Loss 
(FNOL):

■ “Checking the Policy Validity and Coverage (End User)” on page 104

■ “Creating First Notices of Loss (End User)” on page 104

■ “Recording Details of Involved Parties (End User)” on page 105

■ “Recording Insured and Adverse Claimant Property Details (End User)” on page 106

■ “Managing Claims Events (End User)” on page 107

■ “Assigning a Claim to An Adjuster (End User)” on page 108

The following list shows tasks claims adjusters typically perform to review and assign claims:

■ “Checking a Claim Against the ISO Database (End User)” on page 108

■ “Creating an Activity Plan (End User)” on page 110

■ “Assigning a Claim Element (End User)” on page 111

■ “Assigning Claims to a Specialist Unit (End User)” on page 112

■ “Adding an Appraisal (End User)” on page 113

■ “Attaching Claims Documentation (End User)” on page 114

■ “Tracking Police and Fire Reports (End User)” on page 114

The following list shows tasks claims adjusters typically perform to create reserves and adjust 
claims:

■ “About Coverages and Reserves” on page 114

■ “Creating a Reserve (End User)” on page 115

■ “Managing Reserves (End User)” on page 120

The following list shows tasks claims adjusters typically perform to settle claims:
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■ “Creating an Invoice Record (End User)” on page 121

■ “Generating a Payment Record (End User)” on page 122

■ “Tracking Payments Related to Invoices (End User)” on page 122

■ “About Issuing a Settlement Payment (End User)” on page 122

■ “Issuing a Settlement Payment (End User)” on page 127

■ “Making a Bulk Payment (End User)” on page 127

■ “Viewing the Invoices and Claims for a Payment (End User)” on page 128

The following list shows tasks special unit investigators typically perform to investigate claims:

■ “Managing Recovery Information (End User)” on page 128

■ “Creating a Recovery Payment Record (End User)” on page 134

■ “Managing Fraud Information (End User)” on page 134

About Siebel Insurance eService Claims 
Center Locators
The Contact Us applet on the Siebel Insurance eService home page has a Locate Nearby Claims 
Centers hyperlink. When users with the role of Insurance Member click this link, an applet opens in 
which they can perform a parametric search using location attributes that they select from drop-
down lists. For more information on Siebel Insurance eService, see Siebel eService Administration 
Guide Addendum for Industry Applications.

Setting up Siebel Insurance eService 
Claims Center Locators
This task is a step in “Process of Managing Claims” on page 93.

To set up Claims Centers Locator functionality, administrators must complete the following tasks:

■ Import the geocode data for their region

■ Enter claim center locations

■ Assign longitudes and latitudes to claim center locations

Geocode Data
The geocode data is used to reference your region. Geocode data for the U.S. geographical region is 
included in every licensed copy of Siebel Insurance.For information on importing geocode data, see 
Siebel eService Administration Guide. 
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Entering Claim Center Location
The claim center information is matched with locations entered by end users when they perform a 
search to locate a branch. Administrators can use the Sites screen to enter claim center location 
information.

To enter claim center location information

1 Navigate to Site Map > Administration - Marketing > Sites.

2 In the Sites list, add a record.

3 In the Sites form:

a In the Name field, enter the name of this claim center.

b In the Type field, select Claim Center.

c In the Address field, enter the address for this claim center.

d Complete the necessary fields. 

4 To add a service for a site, scroll down to the Site Services list, add a record and complete the 
necessary fields.

5 To add hours of operation, add a record in the Hours Of Operation list, and complete the 
necessary fields.

Assign a Longitude and a Latitude
The Siebel Insurance Claim Center Locator searches for claim centers using latitude and longitude. 
If you do not know the latitude and longitude, leave those fields blank. If the City, State, Zip Code, 
and Country fields are correct, the latitude and longitude values are automatically generated when 
you save the record.

NOTE: The latitude and longitude values will not generate if any one value in the City, State, Zip 
Code, or Country fields is incorrect. For example, if the ZIP Code is incorrect, you will receive an 
error message. To correct this problem, navigate to the Application Administration, ZIP Code 
Administration view and make sure the Geo values for that city, state, and ZIP Code combination has 
been loaded. For more information, see Siebel eService Administration Guide.

To add a new center to the Claim Center Locator

1 Navigate to Site Map > Administration - Application > Branch Locator.

2 In the More Info form, add a record and complete the necessary fields.

3 In the Name field, enter a name for the branch.

4 In the Division field, select a site.

For more information on adding a site, see “To enter claim center location information” on page 96.

When the record is saved, the application automatically populates the Latitude and Longitude 
fields. 
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Activating the Workflow Processes
Siebel Claims uses many workflows processes, which, for example, are activated when a user clicks 
a particular button such as the Submit Payment button. You must activate these workflow processes 
before the user can use Siebel Claims.

For more information about the workflow processes, see “Claims Workflows” on page 141.

To activate the workflow processes

1 Navigate to the Administration - Business Process screen > Workflow Deployment view.

2 In the Repository Workflow Processes list, use a query to find all processes where the Name field 
contains the word claims.

NOTE: You can query on *Claims*.

3 Activate each workflow process that has a status of Inactive:

a Select the workflow process record.

b Click Activate.

The workflow processes are activated.

Administering Reserve Codes
You can define a reserve code for a particular reserve to determine how the reserve value is 
calculated. You can determine whether the reserve has a default value and whether that default value 
can be overridden. You use the reserve code in the Administration - Insurance screen > Loss Codes 
view as well as in the Loss Details - Auto, Loss Details - Property, and Reserves views in the Claims 
screen. 

This task is a step in “Process of Managing Claims” on page 93.

To add a reserve code

1 Navigate to the Administration - Insurance screen > Reserve Codes view.
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2 In the Reserve Code Administration list, create a new record, and complete the fields.

Some fields are described in the following table.

Administering Loss Codes
You can define a loss code for a particular type of loss and associate a default activity plan template 
and default coverages with that loss code.

You use the activity plan association in the Claims screen > Activity Plans view. When the user enters 
a loss code and clicks the Default Plan button, the default activity plan for the loss code is created.

The default coverage association is used in the Claims screen > Loss Details - Auto and Loss Details 
- Property views to populate these views with default coverage data. From these views, the user can 
create appropriate reserves for each coverage.

This task is a step in “Process of Managing Claims” on page 93.

To add a loss code

1 Navigate to the Administration - Insurance screen > Loss Codes view.

2 In the Loss Code Administration list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Code Enter a code.

Type Select the type of reserve:

■ Manual. The value is set at the time of creating 
the reserve code by the adjuster. 

■ Factor. The reserve has a default value.

■ Calculated. The reserve value is computed in 
real-time by a business service. 

NOTE: The customer must develop this business 
service during implementation.

Factor Value Enter the default value for a reserve of type Factor. 
The reserve will have this value when it is opened.

Allow 
Override?

Whether the adjuster can override a default reserve 
value.

Field Comments

Code Enter a loss code.

LOB Select the line of business associated with the loss 
code: Auto or Property.

Active? Whether the loss code is active.
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3 In the Activity Plans list, add a record for the default activity plan for the loss code, and complete 
the Template and Description fields.

You must set up the activity plan in the Administration - Data screen > Activity Templates view.

4 In the Coverages list, add records for the required coverages, and complete the fields.

The coverages created in this coverages list are used to recommend the reserves to open for the 
particular loss code.

Some fields are described in the following table.

Administering Adjusters’ Financial 
Limits
You can set financial limits for adjusters on both the reserves level and on the claims level.

You can set reserve and payment limits for each reserve code, and you can also set total reserve and 
total payment limits for a claim for the employee.

Reserve and payment limits are checked when the user clicks the Open Reserve button (in the 
Reserves view) and the Submit Payment button (in the Payments view) respectively. For more 
information, see “Managing Reserves (End User)” on page 120 and “About Issuing a Settlement 
Payment (End User)” on page 122.

This task is a step in “Process of Managing Claims” on page 93.

To set the adjusters financial limits

1 Navigate to the Administration - User > Employees screen.

2 Select an employee record.

3 In the Employees list, enter the required values for:

■ Total Reserves. The total reserve amount available to the employee for a claim.

■ Total Payments. The total payment amount available to the employee for a claim.

4 Click the Claims Reserve Limits view tab.

5 For each reserve code, enter the required values for: 

■ Reserve Limit. The maximum value of reserve available to the employee for this reserve 
type.

Field Comments

Coverage Select the coverage.

Rate State Displays the rate state.

Type Displays the type of coverage.

Reserve Code Select the reserve code associated with the coverage.
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■ Payment Limit. The maximum payment value available to the employee for this reserve 
type.

Administering the Employee Hierarchy
When an adjuster clicks the Open Reserve button (in the Reserves view) and the Submit Payment 
button (in the Payments view), Siebel Insurance checks the reserve or payment limit for the coverage 
as well as for the total claim. If the limit is not enough, the adjuster’s supervisor is prompted to 
approve the reserve or payment.

It is therefore necessary to set the employee hierarchy to determine the supervisor for each adjuster. 
You set the employee hierarchy in the Administration – Group screen > Position view. For more 
information, see Siebel Applications Administration Guide.

NOTE: You must set the employee and supervisor as the primary for that position.

This task is a step in “Process of Managing Claims” on page 93.

Example of Setting up the Employee Hierarchy
This topic gives one example of setting up the employee hierarchy for approval of claims payments 
or reserves. You may use this feature differently, depending on your business model. 

You have two employees Chacko and Chandra and you want to set up Chandra as the manager of 
Chacko using the positions Position1 and Position2. You must set up Position2 as the parent position 
of Parent1.

To set up the employee hierarchy

1 Navigate to the Administration – Group screen > Position view.

2 In the Parent Position field, set Position2 as the parent position of Position1.

3 Select the record for Position1 and enter Chacko in the Last Name field.

4 Select the record for Position2 and enter Chandra in the Last Name field.

Now if Chacko is an adjuster, and he tries to open a reserve that is over his limit, it is sent for 
approval to Chandra. 

Integrating with the Insurance Services 
Office (ISO)
The ISO ClaimSearch database is an insurance fraud detection system owned by the Insurance 
Services Office (ISO), an organization that operates only in the U.S.
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ISO is one of the largest private databases in the world. It contains detailed records of insurance 
premiums collected and losses paid from participating insurers. Insurance companies can become a 
member of ISO and they can send claims information to ISO to check whether similar claims have 
been filed with other insurance companies.

End users use the ISO Database Search view to check whether a similar claim has been filed by the 
claimant with another insurance company.

This task is a step in “Process of Managing Claims” on page 93.

Before an insurance company can integrate with the ISO, it must be an ISO member and pay the 
associated fees. The steps involved in integrating with the ISO include:

■ “Setting the ISO System Preferences” on page 101

■ “Checking the ISO Run-Time Event” on page 102

■ “Checking the Validation Rules” on page 102

■ “Creating the Named Subsystem for the ISO Search Response” on page 102

■ “Configuring the ISO Assigned Company ID” on page 103

Setting the ISO System Preferences
You must configure the System Preferences shown in Table 5 using the Administration – Application 
screen. The values are available as seed data, but you must make sure that the ISO Connection Info, 
ISO CustLogInId, and ISO Pswd system preferences have the appropriate values assigned for the 
insurance provider.

For more information about setting system preferences, see the chapter that discusses ongoing
administrative tasks in Siebel Applications Administration Guide.

Table 5. ISO System Preferences

System Preference Name System Preference Value

ISO ClientAppName Client Application Name. The is XML_TEST for 
ISO ClaimSearch US customers. 

ISO ClientAppVersion Client Application Version. The value is 1.0 for 
ISO ClaimSearch U.S. customers.

ISO Connection Info ISO Application URL.

ISO CustLogInId Customer Login ID. The ISO assigns a unique 
user ID to each customer. 

ISO Pswd Clear text Password. The ISO assigns the 
password. 
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Checking the ISO Run-Time Event
You must verify the configuration of the run-time event that invokes the ISO Search Request 
workflow. You do this through the Administration – Runtime Events screen. Table 6 shows the data 
for the run-time event and the associated action set, ISO Integration.

This data is available as seed data in the Siebel repository.

Checking the Validation Rules
The Validation Rule Set named INS Claims ISO Integration Validation specifies the validation rules 
that need to be applied before an ISO search request is submitted.

You can verify the configured rule set through the Administration – Data Validation screen.

The validation rule checks that some of the mandatory fields for the ISO search exist in the Claim 
record. The fields are Company Id, Policy Number, and Loss Date. The validation rule is available as 
seed data in the Siebel repository. This rule is invoked as one of the initial steps in the FINS Claims 
ISO Search Request Workflow. The Siebel systems administrator has to make sure that the validation 
rule is present in the system.

Creating the Named Subsystem for the ISO Search 
Response
The Siebel system administrator must create a Named Subsystem called ProcessISOResponse and 
configure it with the inbound workflow, FINS Claims ISO Search Response. This is required for 
handling the results sent back by ISO after an ISO Database Search request is submitted.

For more information about creating a Named Subsystem, see Siebel System Administration Guide.

To create and configure the Named Subsystem

1 Start the Siebel Gateway Name Server and Siebel Server.

2 At a DOS prompt start the Siebel Server Manager (srvrmgr) and verify that the Siebel Server is 
running.

3 Enter the following Siebel Server Manager command:

create named subsystem ProcessISOResponse for subsystem 
EAITransportDataHandlingSubsys with DispatchWorkflowProcess="FINS Claims ISO Search 
Response", DispatchMethod=RunProcess

Table 6. ISO Run-Time Event Data

Sequence Object Type Object Name Event Subevent
Action Set 
Name

1 BusComp INS Claims 
ISO Search 

InvokeMethod EventMethod
Submit 

ISO 
Integration
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4 Connect to the Gateway Name Server using nsbrowse, and verify that the Named Subsystem is 
created correctly.

5 In the eai.cfg file in the \siebel\bin\w32ud\enu directory, add the following entry.

[HTTP Services]

ProcessISOResponse=ProcessISOResponse

6 Enable the EAI component group.

7 Restart the Siebel Gateway Name Server and the Siebel Server.

Configuring the ISO Assigned Company ID
The ISO assigns unique company identifiers to member insurance companies. One company can have 
multiple IDs for different offices or divisions. The IDs are used during ISO database searches to check 
whether the company is an ISO member.

The Siebel system administrator must associate the ISO-assigned company ID with the Internal 
Division to which a user who performs an ISO database search belongs.

To configure the ISO-assigned company ID

1 Navigate to the Administration – Group screen > Internal Divisions view.

2 Select the Internal Division to which the employee belongs, or create a new Internal Division 
record as required.

3 In the Internal Division List applet, or Internal Division Entry applet, enter the ISO-assigned 
company ID in the Company ID field.

4 Save the record.

Integrating with the Office of Foreign 
Assets Control
The Office of Foreign Assets Control (OFAC) administers and enforces economic sanctions programs 
primarily against countries and groups of individuals, such as terrorists and narcotics traffickers. 
Siebel Insurance allows you to check claims payees against a blacklist of individuals and 
organizations provided by OFAC.

The blacklist is stored in the Siebel database and you must keep it up to date by importing data from 
an XML file, sdn.xml that you obtain from the OFAC site:

http://www.treasury.gov/offices/enforcement/ofac/sdn/sdn.xml.

You can schedule the FINS Claims OFAC Data Import Process workflow on a monthly basis to process 
the XML file and import the OFAC data.
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The FINS Claims OFAC Data Import Process workflow has a process property for the Input File. You 
can set the default string of the this process property to C:\TEMP\OFAC_SDN.xml, or whatever location 
you require.

TIP: Run the workflow after work hours to update the Siebel data; this minimizes the performance 
impact.

This task is a step in “Process of Managing Claims” on page 93.

Checking the Policy Validity and 
Coverage (End User)
When a call center agent receives a call about a claim, she must check that there is a valid policy 
associated with the claim and that there is appropriate coverage.

This task is a step in “Process of Managing Claims” on page 93.

To check policy validity

1 Navigate to the Contacts screen.

2 Search for the contact.

3 Drill down on the contact.

4 In the Summary view, select the appropriate policy.

5 Drill down on the policy and check whether:

■ The contact has a valid policy.

■ The contact has the right sort of coverage for the claim, for example, for an auto policy, the 
right coverage for driver and vehicle.

■ Claims are already associated with the policy.

Creating First Notices of Loss (End User)
When end users create a first notice of loss, they add basic loss information and link a policy to the 
loss.

This task is a step in “Process of Managing Claims” on page 93.

To create a first notice of loss

1 Navigate to the Claims screen.

2 In the Claims list, add a record, and complete the necessary fields.

3 Drill down on the Claim # hyperlink.

4 Click the Loss Details > Loss Description view tab.
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5 In the Claim Loss Description form, complete the necessary fields.

Recording Details of Involved Parties 
(End User)
As part of the first notice of loss process, a call center agent must record details of all parties involved 
in the claim. An involved party can be a contact or an organization. In the Involved Parties view, end 
users can see the relationship of all accounts and contacts related to the claim.

Each account and contact can have multiple roles. For example, a single party can be both the 
insured and the claimant; that is, insured with their own policy and a third party claimant on the 
other party's policy. As another example, a service provider can be the insured, claimant, or a 
witness.

In both the Contacts and Accounts forms, the On Behalf field records details of names and 
endorsement roles for the purpose of making payments. Because of legal requirements, it is 
necessary to capture all names and relationship correctly. Table 7 shows some examples of 
endorsement roles.

In the examples in the table, the insurance company is making a single claims payment to Bill 
Franklin who is the attorney for Todd Smith and Lisa Myers and to Lisa Powers who is a guardian of 
Sandra Oh.

In the first example, the end user must:

■ Create three contact names: Bill Franklin, Todd Smith, and Lisa Myers.

■ In the record for Bill Franklin, select Todd Smith and Lisa Myers in the On Behalf field. Siebel 
Insurance concatenates the names in the On Behalf field.

When the adjuster later makes a payment in the Claims > Financials > Payments view, he can select 
Bill Franklin as payee and Siebel Insurance will already have the information that Bill Franklin is the 
attorney on behalf of Todd Smith and Lisa Myers.

This task is a step in “Process of Managing Claims” on page 93.

To associate an involved party with a loss

1 Navigate to the Claims screen.

2 In the Claims list, drill down on the desired claim.

3 Click the Loss Details > Involved Parties view tab.

Table 7. Contact Details and Endorsement Roles

Contact Payee Endorsement Role Claim Contacts

Bill Franklin Attorney for Todd Smith and Lisa Myers

Lisa Powers Guardian of Sandra Oh
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4 If the involved party is a person, add the required details for the contact.

a If required, enter information in the On Behalf field.

b If required, select Contact Detail, and enter detailed information for the contact.

5 If the involved party is an organization, scroll down to the Accounts form, and complete the 
necessary fields.

If required, select Account Detail, and enter detailed information for the account.

6 Repeat Step 4 through Step 5 for each involved party that you want to add to the claim.

Recording Insured and Adverse 
Claimant Property Details (End User)
After they have created a claim, end users record details about the property involved in a claim using 
the following Claims views:

■ Insured Property. Track details about the insured property in a claim.

■ Adverse Claimant Property. Track details about claims or damages filed against the policy 
holder.

This task is a step in “Process of Managing Claims” on page 93.

To record insured property information

1 Navigate to the Claims screen.

2 In the Claims list, drill down on the desired claim. 

3 Click the Loss Details > Insured Property view tab.

4 In the Insured Property list, add a record for each insured property involved in the claim.

5 In the Sequence # field, click the select button and select the insured property from the Pick 
Insured Property dialog box.

The type of property selected in the Insured Property list determines whether the application 
displays the Insured Vehicle Detail form or Insured Property Detail form.

6 In the Claim Elements # field, select a claim element, if applicable.

Many insurance companies break down claims into subcomponents called claim elements. By 
subdividing claims in this way, insurers can delegate the management of these subcomponents 
to specific groups within their company according to their business rules. For more information 
on claim elements, see “Assigning a Claim Element (End User)” on page 111.

7 In the form that appears, complete the necessary fields.

To record adverse claimant property information

1 Navigate to the Claims screen.
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2 In the Claims list, drill down on a claim. 

3 Click the Loss Details > Adverse Claimant Property view tab.

4 In the Adverse Claimants list, add a record for each claimant.

5 In the Adverse Claimant Property list, add a record for each property.

6 In the Property Type field, select Auto or Property.

The Property Type you select determines whether the application displays the Vehicle Detail or 
Property Detail form.

7 In the Claim Elements # field, select a claim element, if applicable.

Many insurance companies break down claims into subcomponents called claim elements. By 
subdividing claims in this way, insurers can delegate the management of these subcomponents 
to specific groups within their company according to their business rules. For more information 
on claim elements, see “Assigning a Claim Element (End User)” on page 111.

8 In the form that appears, complete the necessary fields.

Managing Claims Events (End User)
There are several circumstances in which a group of claims are associated with one event:

■ Catastrophic events. Events such as tornado or hurricane damage that result in claims under 
multiple policies. There can be multiple claims for one insured person under different policies. 

■ Single loss involving multiple lines of business. Events where a single loss involving an 
insured person is covered under two different policies; for example, an insured person’s vehicle 
might be broken into and personal property stolen. In this case, the vehicle damage is covered 
under the auto policy, and the personal property is covered under the homeowner policy. A single 
incident occurs with the same loss date, description, and so on.

■ Single loss involving multiple people from the same company. Events, where, for example, 
two people insured with the same company are involved in a traffic accident. This is a single loss 
involving two insured people, on two separate auto policies. In this case, there are two claims, 
but a single incident with the same loss date, description, and so on.

The ability to record event details in one place reduces data duplication and the time required to 
collect claim information. It also provides the ability to track major catastrophic events and 
incorporate the statistics into risk-rating processes.

End users use the Claims Events screen to record details of claims events and to associate claims 
with an event. 

This task is a step in “Process of Managing Claims” on page 93.

To record details of a claims event

1 Navigate to the Claims Events screen.

2 In the Claims Events list, add a record, and complete the necessary fields.
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To associate a claim with a claims event

1 Navigate to the Claims Events screen.

2 In the Claims Event list, select the event with which you want to associate the claim or group of 
claims.

3 In the Claims list applet, add a record or click the Associate button to display a picklist of claims, 
and select the appropriate claims.

Assigning a Claim to An Adjuster (End 
User)
There are two ways to assign a claim to an adjuster.

1 By entering the adjuster name in the Team field in the Claims header form applet.

2 By using Assignment Manager so that when the Call Center agent changes the status from Notice 
of loss to Open in the Status field in the Claims header form applet, it initiates an Assignment 
Manager function to assign the claim to an adjuster.

NOTE: This Assignment Manager function is not provided out-of-the-box.

For more information about using Assignment Manager, see Siebel Assignment Manager 
Administration Guide.

This task is a step in “Process of Managing Claims” on page 93.

Checking a Claim Against the ISO 
Database (End User)
The ISO ClaimSearch database is an insurance fraud detection system owned by the Insurance 
Services Office (ISO), a U.S. specific organization. This task is a step in “Process of Managing Claims” 
on page 93.

ISO is one of the largest private databases in the world and it contains detailed records of insurance 
premiums collected and losses paid from participating insurers. Insurance companies can become a 
member of ISO and they can send claims information to ISO to check whether similar claims have 
been filed with other insurance companies.

ISO Database search currently handles only Auto (Insured and Adverse Claimant) and Property 
(Insured only) searches.

End users use either the ISO Database Search view or the ISO Database Search Attachments view 
to check whether a similar claim has been filed by the claimant with another insurance company.

The ISO Database Search view displays the search records and, in the Claim Matches list applet, any 
matching records for that search that are returned by ISO.
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The ISO Database Search Attachment view also displays the search records, and in the Attachments 
list applet, displays the actual search responses from ISO as XML data. Clicking the Attachment name 
opens the XML file in the default editor. The end user can also drill down to this view from the ISO 
Database Search view, through the Match Details field.

The claim data that must be sent to ISO for a database search is shown in Table 8.

In the ISO Database Search view, the Report Type field specifies the type of search as follows:

■ Initial Search. Used when a claim is sent to ISO for the first time. The ISO ClaimSearch system 
writes the claim data to its database and then searches the database for claims that belong to 
the same claimant. This report type is used only for a first-time search or for resubmitting an 
initial search that had errors.

■ Replacement. Used to overwrite data sent in the initial search. The data is updated in the 
database and a new search is performed. To locate the initial claim in the database, the data 
must include the Insuring Company ID, Claim Number, Policy Number, and Date of Loss.

Table 8. Required Data for ISO Database Search

Claims and Losses Data Required

For each claim submitted ■ Report Type

■ Insuring Company ID

■ Policy Number

■ Policy Type

■ Claim Number

■ Date of Loss

■ Location of Loss State

■ Loss Type

For each involved party ■ Role in the Claim

■ Business Name (for accounts)

■ First Name (for contacts)

■ Last Name (for contacts

■ Address Information Line 1

■ City

■ State

For a casualty or third-party 
property damage loss

Alleged Injuries or Property Damage

For first-party property loss Theft items
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When the end user submits the search, the following information is displayed:

To check a claim against the ISO database

1 Navigate to the Claims screen.

2 In the Claims list, drill down on the desired claim. 

3 Click the Reports / Documents > ISO Database Search view tab.

4 Create a new record.

5 In the Report Type field, select Initial Search or Replacement.

NOTE: You can perform a replacement search only if at least one initial search has already been 
completed for the claim record.

6 Click Submit to send the claim data to ISO.

Creating an Activity Plan (End User)
An adjuster uses the Activity Plans view to manage the claims task to completion and assign activities 
to different individuals. When he clicks the Default Plans button, Siebel Insurance automatically 
creates an activity plan based on the loss code for the claim.

Table 9. Information Displayed in the ISO Database Search List Applet

Field Comments

Date The date when the search request was 
submitted.

Requested by The ID of the person who submitted the request.

Status The status of the request:

■ Pending. The request is being created.

■ Acknowledged. The request has been 
received by ISO.

■ Error. The search is completed and there are 
errors.

■ Complete. The search is completed and 
there are no errors.

# Matches The number of matches returned.

Error Message Any error messages returned. If the data sent is 
incomplete, or fields contain invalid data, an 
error is returned.

Match Details A link that the end user can drill down on to see 
the details of matches.
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One of the adjuster’s jobs is to assign a field appraiser to appraise damage. Assigning an appraiser 
can be complex because the customer schedule and appraiser schedule must be optimized. In the 
activity plan, the user can drill down on an activity of type Field Appraisal to go to the Activities > 
Schedule view. The user can also drill down on the Status field in the activity plan, and if the status 
value is Unscheduled, the user is taken to the Dispatch Board view, which allows complex appraisal 
scheduling. For more information about scheduling with the Dispatch Board, see the Siebel Field 
Service Guide. 

This task is a step in “Process of Managing Claims” on page 93.

To create an activities plan

1 Navigate to the Claims screen.

2 In the Claims list, drill down on the desired claim. 

3 Click the Diary Management > Activity Plans view tab.

4 Click the Default Plans button.

The default activities plan is created based on the loss code for the claim.

Assigning a Claim Element (End User)
Many insurance companies break down claims into subcomponents called claim elements. By 
subdividing claims in this way, insurers can delegate the management of these subcomponents to 
specific groups within their company according to their business rules.

You can also create a claim element and assign it to a third party. For example, you can assign a 
claim element to a service provider, such as Auto service, who then does the repair. The third party 
can see the claim element through the Partner Portal.

This task is a step in “Process of Managing Claims” on page 93.

To assign a claim element

1 Navigate to the Claims screen.

2 In the Claims list, drill down on the desired claim. 

3 Click the Assignments view tab.

4 In the Claim Elements list, create a new record.

To add claim element details

1 Navigate to the Claim Elements screen.

2 In the Claim Elements list, drill down on the desired Line #.
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3 Select the appropriate view tab to add details specific to the currently selected claim elements.

NOTE: The view tabs on the Claim Elements screen function identically to those on the Claims 
screen.

Assigning Claims to a Specialist Unit 
(End User)
The following buttons are available in the Claims List screen for evaluating the fraud and subrogation 
(that is, recovery) potential of a claim:

■ Evaluate Subrogation Potential. Evaluates the subrogation potential of the claim.

■ Evaluate SIU Potential. Evaluates the fraud potential of the claim.

■ Details. Captures the claims combined score details.

During implementation, the customer can write a business service or enable the Analytics application 
to drive the logic behind these evaluation buttons. When the user clicks either the Evaluate 
Subrogation Potential or Evaluate SIU Potential button, Siebel Insurance takes the value from the 
Details button, which captures the claims combined score details, and performs the calculation that 
determines the value in the Subro Potential or Suspicious Claims indicator in the Claims form 
respectively. Each indicator has ten bars each representing 10% and colors are displayed in the bars 
according to the value in the field to the right of the bars, which can have a value from 0 through 1.

The following buttons are available for assigning claims to appropriate specialist units:

■ Notify SIU. Assigns the claim to the special investigation unit (SIU)

■ Notify Subro. Assigns the claim to the subrogation unit

After the Assignment Manager assigns the claim, an Alert applet in the Home page displays details 
of the claim. The user can then drill down on the alert to go to either the SIU dashboard view or the 
Recovery dashboard view, as appropriate. 

NOTE: The Assignment Manager component must be running. To check that it is running, navigate 
to the Administration - Server Configuration > Servers > Components screen, and check for 
Assignment Manager and Batch Assignment entries in the list.

For information about managing claims through the recovery process, see “Managing Recovery 
Information (End User)” on page 128. For information about managing suspicious claims through the 
investigative process, see “Managing Fraud Information (End User)” on page 134.

This task is a step in “Process of Managing Claims” on page 93.

To assign a claim to a subrogation unit

1 Navigate to the MyClaims screen.

2 Drill down on a claim.

3 Select a record, and click the Notify Subro button.

The claim is assigned to the subrogation unit.
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To assign a claim to an SIU

1 Navigate to the MyClaims screen.

2 Drill down on a claim.

3 Select a record, and click the Notify SIU button.

The claim is assigned to the SIU.

Adding an Appraisal (End User)
End users use the Appraisals view to record a property's insurable value, or the amount of a loss.

A row in the view shows the total estimation value for all adjusters. End users can click the Check 
Reserves button to compare the total estimation value with the total reserve amount set for the 
claim. (The INS Reserve Estimation Check business service is invoked.)

If the reserve value is less than the total estimation value for all adjusters, Siebel Insurance notifies 
the end user that the reserve value must be adjusted.

This task is a step in “Process of Managing Claims” on page 93.

To add an appraisal

1 Navigate to the Claims screen.

2 In the Claims list, drill down on a claim.

3 Click the Reports/Documents > Appraisals view tab.

4 In the Appraisals form, add a record, and complete the necessary fields.

Some fields are described in the following table.

5 Click Check Reserves to check that the total estimates do not exceed the available reserves.

Field Comments

Type The type of appraisal. Values include: Automobile, 
Home, RV.

Property Appraised The property being appraised.

Amount The amount of the appraisal.

Appraiser Type The type of appraiser: Adjuster or Body Shop.

Appraiser Name An employee chosen from a Select Appraiser applet.

Service Region The service region applicable to the appraiser. This 
field is automatically prefilled when the appraiser 
name is selected.
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Attaching Claims Documentation (End 
User)
Adjusters use the Claims screen > Attachments view to attach documents associated with a claim, 
for example: 

■ All Claims. Statements, photographs, scene diagrams, state statutes, payments, estimates.

■ Auto Claims. Ticket disposition, uninsured: subrotech information.

■ Property Claims. Proof of loss.

This task is a step in “Process of Managing Claims” on page 93.

To attach claims documentation

1 Navigate to the Claims screen.

2 In the Claims list, drill down on a claim.

3 Click the Reports/Documents > Attachments view tab.

4 In the Attachments list, create a new record, and complete the necessary fields.

Tracking Police and Fire Reports (End 
User)
End users can use the Police And Fire Reports view to collect and manage police and fire report 
information.

This task is a step in “Process of Managing Claims” on page 93.

To add police and fire report information

1 Navigate to the Claims screen.

2 In the Claims list, drill down on a claim.

3 Click the Reports/Documents > Police And Fire Reports view tab.

4 In the Police/Fire Reports Detail list or form, add a record, and complete the necessary fields.

About Coverages and Reserves
When a customer purchases an insurance policy, the policy specifies which coverages are included 
in the policy. For example, for an auto policy there might be coverages for: towing and labor, rental 
car, collision, and bodily injury. Each of these coverages has an associated maximum amount covered 
and the deductible amount.
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An adjuster must open a reserve for each coverage that applies to a claim. A reserve is an amount 
of money made available for payments in respect of claims. For example, if the claimant was involved 
in a collision accident, the adjuster must open a reserve for collision coverages. If the claimant was 
injured, the adjuster must open a bodily injury reserve.

The money that the insurance companies put aside cannot be used for anything else, therefore it is 
important to create the right amounts for reserves.

This task is a step in “Process of Managing Claims” on page 93.

Creating a Reserve (End User)
A claims adjuster uses the Loss Details - Auto and Loss Details - Property views to make sure that 
the customer has the right policy and coverage for a claim and to create a reserve for each coverage.

It is essential to capture policy information at the time that the claim is opened, because policy 
information might change over time. To do so, the end user must select the right policy for the 
customer in the Policy field in the Claims form header applet. In the case of the Loss Details - Auto 
view, the Driver, Vehicle and Coverages applets are then populated with the policy details.

NOTE: There is also a Get Policy button in the form applet that is disabled by default. The customer 
can enable this button by writing an appropriate business service to get the policy information from 
their policy system to populate the policy information in the claim.

Table 10 shows the information displayed in the Coverages applet.

Table 10. Coverage Information in Loss Details Views

Field Comments

Coverage The name of the coverage, for example, collision, bodily 
injury and so on.

Individual Limit The individual limit of the coverage.

For example, for a bodily injury, the typical individual 
limit is $100,000, which means that the most the 
insurance company will pay for bodily injury for a 
particular person is only up to $100,000.

Total Limit The total limit for a particular coverage. 

For example, for bodily injury, the typical total limit is 
$300,000, which means that the most the insurance 
company will pay for bodily injury for this claim is 
$300,000, regardless of how many persons are 
involved.

Deductible The amount of loss paid by the policy holder.

Coverage Applies? A flag to indicate that a reserve is opened based on the 
loss code for the claim.

Reserve Code The reserve code. 
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For each coverage, the Coverage Applies flag indicates whether a reserve must be created for the 
coverage. For example if the claim is for a car collision accident, the Collision coverage is flagged so 
that a reserve is created for that coverage. Coverages are flagged as applicable according to the 
default coverages for the loss code. For more information about loss codes, see “Administering Loss 
Codes” on page 98.

The adjuster clicks the Create Reserve button to create a reserve for all the coverages that have the 
Coverage Applies flag set. If you want to create a reserve from a coverage that does not have the 
Coverage Applies flag set, you can set the flag for that coverage and add the appropriate reserve 
code. Reserves are created according to the reserve code and reserve type that are associated with 
the coverage. For more information about reserve codes, see “Administering Reserve Codes” on 
page 97.

After a reserve is created, it can be viewed in the Claims > Financials > Reserves view, see “Managing 
Reserves (End User)” on page 120.

This task is a step in “Process of Managing Claims” on page 93.

To create a reserve for an auto policy claim

1 Navigate to the Claims screen.

2 In the Claims list, drill down on a claim. 

3 Click the Loss Details > Loss Details - Auto view tab.

4 Select the required policy in the Policy field in the Claim form header applet.

The policy information including details for Vehicles, Driver, and Coverages are copied into the 
view.

5 In the Coverages list, click the Create Reserve button.

Reserve The name of the reserve.

Reserve Type The type of reserve, which specifies how the reserve is 
set.

■ Manual. The value is set at the time of reserve 
creation by the adjuster. 

■ Factor. The reserve has a default value

■ Calculated. The reserve value is computed in real-
time by a business service.

Reserve Amount The amount of the reserve.

Table 10. Coverage Information in Loss Details Views

Field Comments
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About Managing Reserves
An adjuster uses the Claims > Financials > Reserves view to: 

■ Open reserves

■ Adjust reserves 

■ Delete a reserve created using the Create Reserve button in the Loss Details - Auto or Loss 
Details - Property view

■ Create new reserves

Opening Reserves
To open a reserve, the adjuster enters the amount of reserve to open in the Reserve Amount field 
and clicks the Open Reserve button. Siebel Insurance then performs the following checks.

■ Reserve authority limit check. Siebel Insurance checks the adjuster’s reserve limit for each 
coverage as well as the total reserve limit for the claim. For example, suppose an adjuster has a 
collision reserve limit of $5,000, bodily injury reserve limit of $6,000, and a total claim reserve 
limit of $20,000. If the adjuster tries to open a collision reserve of $16,000, and a bodily injury 
reserve of $5,000, Siebel Insurance displays an error message advising that the reserve for the 
collision is pending approval, because the collision reserve limit and the total reserve limit are 
exceeded. The adjuster’s supervisor is notified of an activity to approve the reserve and must go 
to the Inbox screen for the reserves to be approved. A supervisor can use the Open Reserve 
Approval Mode button to open a reserve, as long as his or her own limits are not exceeded. For 
more information about using the Inbox, see Siebel Applications Administration Guide.

■ Split limit check. Siebel Insurance checks the individual policy limit and the total policy limit 
fields and does some comparison. If the reserve amount set for a contact or an account is more 
than the individual limit, Siebel Insurance displays an error message. Also, if the reserve amount 
set for a particular coverage is more than the total limit, Siebel Insurance displays an error 
message. For example, a Bodily Injury coverage can have a $100,000 individual limit and 
$300,000 total limit. Siebel Insurance checks that the reserve amount to be opened for each 
individual or account for the Bodily Injury reserve is no more than $100,000 and that the total 
reserves amount for bodily injury reserves for all individuals or accounts is no more than 
$300,000.

After the checks are performed, The Outstanding Reserve field is updated with the amount that was 
entered in the Reserve Amount field.

For more information about financial limits for adjusters, see “Administering Adjusters’ Financial 
Limits” on page 99.



Siebel Insurance Guide Version 8.0, Rev. A

Managing Claims ■ About Managing Reserves

118 

Table 11 shows the fields in the Reserves applet.

Table 11. Reserve Fields

Field Comments

Status The status of the reserve. 

If the reserve status is Open, the reserve record is read only and the 
only way an adjuster can modify this record is by clicking the Reserve 
Adjustment button.

Reserve Code The code of the reserve.

Reserve The name of the reserve.

Reserve Amount The reserve amount. The adjuster can enter the amount of reserve in 
this field. If the reserve type is Factor, this field is automatically 
prefilled. 

Reserve Type The type of the reserve such as Factor, Manual, or Calculated.

Reserve Open The date the reserve is opened.

Reserve Closed The date the reserve is closed.

Outstanding 
Reserve

The amount of reserve outstanding at a particular time. The value of 
this field is automatically decreased every time an adjuster makes an 
indemnity payment.

Last Name The last name of the contact for which the reserve is opened. 

First Name The fist name of the contact for which the reserve is opened.

Account The name of the account in which the reserve is opened.

A reserve can only be opened for either a contact or account and cannot 
be opened for both.

Individual limit The individual limit for a particular reserve for a particular contact or 
account. 

The individual limits for reserves of the same reserve code must be the 
same. If, for example, you have two bodily injury reserves of the same 
code, one for person A, and you specify an individual limit of $100,000 
and on the other bodily injury for person B you specify an individual 
limit of $150,000, Siebel Insurance displays an error message.

Total Limit The total limit for a particular reserve. 

The total limits for reserves of the same reserve code must be the 
same.

Deductible The deductible for the reserve. 

The deductibles for reserves of the same reserve code must be the 
same.
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Adjusting a Reserve
After a reserve is opened, the user can adjust only the reserve amount by selecting the reserve 
record and clicking the Reserve Adjustment button. The user can then change the reserve amount 
and reopen the reserve. The adjuster can make the adjustment even after the reserve is used to 
make payment.

When the adjuster makes a payment of type Indemnity, the value of the Outstanding Reserve field 
is decreased by the amount of the payment. If the Outstanding Reserve amount is 0, the adjuster 
cannot use this reserve to make other indemnity payments. If the adjuster wants to make indemnity 
payments, he must adjust the reserve amount by clicking the Reserve Adjustment button and 
entering the new reserve amount in the Reserve amount field. Siebel Insurance then updates the 
Reserve Outstanding field.

Only the adjuster that is assigned to a reserve can open or adjust that reserve.

An adjuster can assign a reserve to a different adjuster by changing the Adjuster field in the Reserves 
view.

Adjuster The name of the adjuster to which this particular reserve is assigned. 

Different reserves can be assigned to different adjusters and only the 
assigned adjuster can open that particular reserve, therefore it is 
necessary to enter the adjuster name.

Approver The approver name. 

Siebel Insurance automatically populates the approver name with the 
adjuster’s supervisor name. For information about how the employee 
hierarchy is set to determine the supervisor for each adjuster, see 
“Administering the Employee Hierarchy” on page 100.

The supervisor can then go to the Inbox screen, drill down on the claims 
that need approval, and select the Open Reserve: Approval Mode button 
to open the reserve. When the supervisor drills down on the Inbox item, 
the Inbox item status changes to Completed.

If this supervisor does not have enough reserve limit, Siebel Insurance 
fills in the supervisor’s supervisor name in the Approver field. Siebel 
Insurance then notifies that supervisor to go to the Inbox screen to 
approve the reserve. 

Insured property The insured property.

Total payment The total amount of payment that has been made using this reserve.

Table 11. Reserve Fields

Field Comments
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Managing Reserves (End User)
After a reserve is created, an adjuster can open and adjust the reserve. You can also create new 
reserves and delete existing reserves.

This task is a step in “Process of Managing Claims” on page 93.

To open a reserve

1 Navigate to the Claims screen.

2 In the Claims list, drill down on a claim. 

3 Click the Financials > Reserves view tab.

4 In the Reserves list, select the required record.

5 Enter the required amount in the Reserve Amount field.

6 Click Open Reserve.

To adjust a reserve

1 Navigate to the Claims screen.

2 In the Claims list, drill down on a claim. 

3 Click the Financials > Reserves view tab.

4 In the Reserves list, select the required record.

5 Click Reserve Adjustment.

6 Enter the required amount in the Reserve Amount field.

7 Click Open Reserve.

To create a new reserve

1 Navigate to the Claims screen.

2 In the Claims list, drill down on a claim. 

3 Click the Financials > Reserves view tab.

4 In the Reserves list, create a new record and complete the necessary fields.

For information about the fields in a reserve, see Table 11.

To delete a reserve

1 Navigate to the Claims screen.

2 In the Claims list, drill down on a claim. 

3 Click the Financials > Reserves view tab.
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4 In the Reserves list, select the required record.

5 Click Delete.

Tracking Demands for Payment (End 
User)
End users use the Bills view to record demands for payment associated with a claim.

NOTE: The Bills view was used in versions prior to Siebel Insurance 8.0. In Siebel Insurance 8.0, 
you can use either the Bills view or the Invoices view to capture information about bills.

This task is a step in “Process of Managing Claims” on page 93.

To record demands for payment

1 Navigate to the Claims screen.

2 In the Claims list, drill down on a claim.

3 Click the Financials > Bills view tab.

4 In the Bills list, add a record, and complete the necessary fields.

For more information on claim elements, see “Assigning a Claim Element (End User)” on page 111.

5 In the Attachments list, attach an electronic version or image of the bill.

Creating an Invoice Record (End User)
An adjuster uses the Claims > Invoices view to create a record of bills and invoices received from 
the claimant and third parties in respect of a claim. The view is also used to associate invoices with 
claims. If the adjuster wants to add additional line items for the invoice, or to attach an invoice image 
and note, the adjuster can drill down on the invoice number to go to the Invoices Screen.

For information about using the Invoices screen, see Siebel Communications Guide.

This task is a step in “Process of Managing Claims” on page 93.

To create invoice records

1 Navigate to the Claims > Invoices view.

2 In the Invoices list, add a new record, and complete the necessary fields.

3 Drill down on the invoice to go to the Invoices screen.

4 (Optional) In the Line Items list, add line items for the invoice.

5 (Optional) In the Attachments list, attach an electronic version or image of the invoice.

6 (Optional) In the Notes list, add any notes for the invoice.
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Generating a Payment Record (End 
User)
An adjuster can use the Claims screen > Invoices view to create a record of invoices received from 
the claimant and third parties in respect of a claim, and to generate a payment record for invoices.

When the adjuster clicks the Generate Payment button, Siebel Insurance creates a payment record 
for one invoice or multiple invoice records.

NOTE: A similar view is in the Claims Element screen.

This task is a step in “Process of Managing Claims” on page 93.

To generate a payment record

1 Navigate to the Claims screen.

2 In the Claims list, drill down on a claim.

3 Click the Financials > Invoices view tab.

4 In the Invoices list add records and complete the necessary fields.

5 Click Generate Payment.

Tracking Payments Related to Invoices 
(End User)
Adjusters can use the Invoices > Claim Payments view to track all of the payments for invoices. 

This task is a step in “Process of Managing Claims” on page 93.

To view the payments for an invoice

1 Navigate to the Invoices screen.

2 In the Invoices list, drill down on an invoice.

3 Click the Claim Payments view tab.

About Issuing a Settlement Payment 
(End User)
End users use the Financials > Payments view tab to issue a settlement payment. This task is a step 
in “Process of Managing Claims” on page 93.
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A payment can be associated with a single or multiple reserves. For example, an adjuster can make 
a payment of $10,000, and this payment can be drawn from a collision reserve and a towing-and-
labor reserve.

NOTE: End users can associate a payment with reserves only if the payment type is indemnity. For 
other payment types, the Reserves list applet is a read-only applet.

Table 12 shows the fields in the Payment list applet.

Table 12. Payment List Applet Fields

Field Comments

Payment # The system-generated payment number.

Payment Code The code of the payment. Values include: After Full 
Payment, Full Payment, and Partial Payment

Payment Type The type of payment. Values include: SIU Expenses, 
Subrogation Expenses, Expenses, Indemnity Payment, 
Loss, and Loss - Supplemental.

Payment Method The method of payment. Values include: Check, Cash, 
Cashier Check, Third Party, Payroll Deposit.

Payee The name of the contact to whom payment is made.

Vendor Payee The name of the company to which payment is made.

Amount The amount of the payment.

Cash Settlement Whether the payment represents a cash settlement.

Claim Element # The claim element associated with the payment.

Claim Element Coverage The claim element coverage.

Invoice # The invoice associated with the payment.

Issued The date the payment is issued.

Check # The number of the check issued for payment.

Paid By The name of the adjuster making the payment.
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Table 13 shows the fields in the Reserve list applet.

Payment Status The status of the payment. 

■ Pending. The default status and the status when the 
validation fails.

■ On-Hold OFAC. The status when the OFAC check fails.

■ On-Hold Limit. The status when the authority limit 
check fails.

■ Approved Limit. The status when the supervisor 
approves.

■ Rejected. The status when the supervisor rejects the 
payment.

■ Payment Generated. The status when all the checks 
are good and the payment goes through.

■ Void. The status when the payment is voided.

■ Bulk Payment. The status when the payment is made 
through bulk payment.

From Date For medical claim or bodily injury bills, the from date for the 
customer’s stay in hospital.

To Date For medical claim or bodily injury bills, the to date for the 
customer’s stay in hospital.

Table 13. Reserve List Applet Fields

Field Comments

Reserve Code The code of the reserve.

Reserve The name of the reserve.

Reserve Amount The reserve amount. 

Outstanding Reserve The amount of reserve outstanding at a particular time. The 
value of this field is automatically decreased every time an 
adjuster makes an indemnity payment.

Reserve Applied to 
Payment

The amount of the reserve that will be applied to the 
selected payment.

Deductible The deductible for the reserve.

Apply Deductible? Whether the deductible has been applied to the payment.

Table 12. Payment List Applet Fields

Field Comments
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When the user clicks the Submit Payment button, the following checks are performed:

1 Check whether some of the fields are entered correctly. Siebel Insurance checks:

a That the Date From field is not null, and that it is before the date in the Date To field.

b That the Date To field is not null, and that it is later than the date in the Date From field.

c That the Payment Amount field is not 0.

d That the Payment Status field is pending. Only a payment with status Pending is evaluated when 
the user clicks the Submit Payment button.

e Whether the Mail To Flag is set for the Payee or Vendor Payee field. There must be only one payee 
among both the contact payees and the vendor payees that have the Mail Payment Flag checked.

2 Check whether the contact payee or account payee is in the OFAC database. Siebel 
Insurance checks whether the contact or account is in the OFAC database. If the payee or vendor 
payee is in the OFAC database, Siebel Insurance suspends the payment and changes the status 
of the payment to On Hold OFAC. For more information, see “Checking a Claim Against the ISO 
Database (End User)” on page 108.

3 Check whether the per-coverage deductible has been applied to the payment amount. 
Siebel Insurance checks whether the deductible flag in the Reserve list applet is checked. This 
step is only applicable if the payment is associated with a reserve (that is, a payment of type 
Indemnity payment). If the deductible flag is not checked, Siebel Insurance displays a message 
prompting the adjuster to reduce the amount in the Reserve applied toward payment field by the 
deductible amount. When the flag is set to true, the deductible flag field become a read-only field 
and it applies to the reserve. So, the next time the adjuster associates the reserve to another 
payment, the deductible flag remains checked.

Individual limit The individual limit for a particular reserve for a particular 
contact or account. 

Total Limit The total limit for a particular reserve. 

Last Name The name of the contact for which the reserve is opened. 

First Name The last name of the contact for which the reserve is 
opened.

Account The name of the account in which the reserve is opened.

A reserve can only be opened for either a contact or account 
and cannot be opened for both.

Reserve Open The date the reserve is opened.

Reserve Closed The date the reserve is closed.

Total Payment The total amount of payment that has been made using this 
reserve.

Status The status of the reserve.

Table 13. Reserve List Applet Fields

Field Comments
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4 Check whether the payment amount is equal to the total of reserve applied to payment. 
Siebel Insurance checks whether the Total reserve applied toward payment field in the Reserve 
list applet is the same amount as in the Payment amount field in the Payment list applet. If the 
value is not the same, Siebel Insurance displays an error message prompting the user to adjust 
the amount to make it the same.

5 Check whether the reserve applied to payment is equal or less than outstanding 
reserve. Siebel Insurance checks whether there is enough outstanding reserve to make the 
payment. If there is not enough reserve left to make the payment, Siebel Insurance displays a 
message to adjust the Reserve Applied to Payment field in the Reserve list applet to be less or 
equal to the Outstanding Reserve field in the Reserve list applet.

6 Checking if the payment authority limit is correct. Siebel Insurance checks whether the 
adjuster has enough payment limit to make this payment. The adjuster has a payment limit on 
the coverage level as well as on the total claim level (see“Administering Adjusters’ Financial Limits” 
on page 99). For every payment made by this adjuster, Siebel Insurance keeps track of how much 
payment has been made on the coverage level and on the claim level. Siebel Insurance then 
compares this with the adjuster payment limit for each coverage and for the claim. For example: 
Adjuster A has a bodily injury payment limit of $10,000, collision payment limit of $5,000, and 
a total indemnity payment limit of $20,000. If the adjuster receives an invoice, say for $12,000, 
and he wants to draw from the collision and bodily injury reserves to make this payment, the 
most he can pay from the bodily injury reserve is $10,000, and the most he can draw from the 
collision reserve is $5000. If he tries to pay more than his payment limit, Siebel Insurance 
displays a message and sends notification to the supervisor for approval.

Siebel Insurance keeps track of how much the user has paid from a particular limit. Suppose on 
this $12,000 payment, the user draws $10,000 from the bodily injury reserve and $2,000 from 
the collision reserve. The next time he wants to make a payment, he can not make a payment 
from bodily injury reserve without Siebel Insurance notifying his supervisor for approval, because 
he has already used up to his payment limit on bodily injury reserves.

Siebel Insurance keeps track of the adjuster payment limit on the per reserve and per contact 
level. For example, adjuster A might have a bodily injury payment limit of $10,000. Suppose he 
wants to make a payment, and wants to draw $6,000 from the bodily injury reserve 1 for Mary 
and $6,000 from bodily injury reserve 2 for Todd. In this case, Siebel Insurance lets this 
transaction go through because each of the bodily injury payments is less than the adjuster A 
$10,000 limit.

If the adjuster does not have enough payment limit, Siebel Insurance creates an Inbox item for 
the supervisor’s approval. The supervisor can then go to the Inbox screen to approve the 
payment. The supervisor can drill down on the Inbox item to view the payment details. He can 
then return to the Inbox view and approve or reject the Inbox item. When the supervisor 
approves the payment, the payment status goes to Payment Generated. If the supervisor's limit 
is not enough, another Inbox item is created for the supervisor's supervisor. However, if the 
supervisor rejects the Inbox item, the payment status goes to Rejected. For more information 
about using the Inbox, see Siebel Applications Administration Guide.
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7 Updating the reserve outstanding amount if all the above check are passed. Siebel 
Insurance reduces the Outstanding Reserve field by the amount of payment made. For example, 
suppose an adjuster sets a $2,000 collision reserve for the claim, and the collision reserve has 
a $500 deductible. If the adjuster receives a bill from a glass vendor for $1,000, the adjuster 
applies the deductible for the collision reserve and pays the $500 from the $2,000 collision 
reserve. After he makes the payment, the outstanding reserve becomes $1,500. The adjuster 
can then use this $1,500 outstanding reserve to pay another bill related to collision coverage.

For more information about the financial limits for adjusters, see “Administering Adjusters’ Financial 
Limits” on page 99.

If the adjuster makes a mistake, the adjuster can select the Void button to reverse the transaction. 
When the user select the Void button, Siebel Insurance adds the payment amount back into the 
outstanding reserve amount. Furthermore, the user can modify the payment and reserve record 
accordingly.

Issuing a Settlement Payment (End 
User)
An adjuster issues a payment to settle a claim.

This task is a step in “Process of Managing Claims” on page 93.

To issue a settlement payment

1 Navigate to the Claims screen.

2 In the Claims list, drill down on a claim.

3 Click the Financials > Payments view tab.

4 (Optional) If the payment type is Indemnity, in the Reserves list, associate one or more reserves 
with the payment.

5 In the Payments list, add a record and complete the necessary fields.

NOTE: You can configure your Siebel application to connect to the system your company uses to 
produce a draft or check to pay the claim. For more information, see “Integration” on page 189.

Making a Bulk Payment (End User)
Insurance companies usually have a relationship with vendors such as car rental companies where 
the insurance company can make one large payment in a particular period, for example, every two 
weeks, or every month. For such bulk payments, Siebel Insurance allows the adjuster to query all 
the payments for the vendor, sum the payments, and generate one payment for the vendor.

To use the bulk payment capability, the user must first set the relevant account for bulk payment.

This task is a step in “Process of Managing Claims” on page 93.
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To set an account for bulk payment

1 Navigate to the Accounts screen 

2 Drill down on an account.

3 Click the Profiles > Customer Profiles view tab.

4 In the Pricing and Purchasing Information section of the form, select the Bulk Pay check box.

Bulk payment can now be used for the account.

To make a bulk payment

1 Navigate to the Payments screen > Insurance Payments view.

2 Click the Generate Bulk Payment button.

3 In the Payments query box, select the appropriate Account, and select a From Date and To Date.

Siebel Insurance queries all payment record for the vendor for the specified period and generates 
a payment record for the vendor. The payments associated with that particular bulk payment are 
displayed in the Payment screen > Insurance Payment > Bulk Payment view.

NOTE: For the query to work properly, make sure that the Issued field in the Claims > Payment 
view contains the payment issue date.

Viewing the Invoices and Claims for a 
Payment (End User)
Adjusters can use the Payments > Insurance Payments view to display all of the invoices and claims 
associated with a particular payment.

This task is a step in “Process of Managing Claims” on page 93.

To view the invoices and claims for a payment

1 Navigate to the Payments screen > Insurance Payments view.

2 Drill down on a payment.

The invoices and claims for the payment are displayed.

Managing Recovery Information (End 
User)
End users use the Claims screen > Recoveries view to record and track information regarding 
subrogation and salvage activities. This task is a step in “Process of Managing Claims” on page 93.
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Subrogration refers to sections of a property insurance or liability insurance policies that give the 
insurer the right to take legal action against the third party who is responsible for the loss. For 
example, a customer’s car might be hit by another car and instead of waiting for the other car 
owner’s insurance to pay, the customer files a claim with his insurance company. The insurance 
company pays for the damage but contacts the other insurance company to get reimbursement for 
the payment. The process of getting reimbursement from the other insurance company is an example 
of subrogation.

Salvage occurs when the insurer takes ownership of the damaged property after the claim has been 
settled.

An adjuster can assign a claim to a subrogation unit if required. One or more investigators can then 
use the Recoveries dashboard to manage the subrogation activities and to recovery money from the 
third party.

A claim can be assigned to various investigators, for example, to arbitration or litigation specialists, 
or to people handling collection and salvage. Table 14 shows the primary fields in the Recovery 
dashboard.

Table 14. Recovery Dashboard Fields

Field Comments

Subro Referral Indicates whether the claim has been referred to subrogation. 

Referral Source Identifies how the case was referred to subrogation: 

■ System. The case was referred automatically due to the 
subrogation potential score.

■ Manual - adjuster. An adjuster referred the case manually.

■ Manual - Reassignment. The case was reassigned.

Assignment Date Displays the time and date on which the subrogation file was opened.

Closed Date Displays the time and date on which the subrogation file was closed.

Subro Potential Displays the combined subrogation potential score. 

This field is updated by the Evaluate Subrogation Potential button in the 
Claims List applet.

Overall Fault % Displays the theory of liability value for the claim. This field is set 
through the Update Theory of Liability task.

Status Select the status of the subrogation case. Values include: Assigned, 
Accepted, Initial Review, Negotiations, Decision Pending, Closed, and 
Re-opened. 

Disposition Select the final status of the subrogation case after processing. Values 
include: Partial Recovery, Full Recovery, Collections Handoff, Arbitration 
Handoff, Litigation Handoff, and Abandoned. 
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Table 15 shows the fields in the dashboard that display the key financial information.

Table 16 shows the fields in the dashboard used for arbitration or litigation referrals.

Table 15. Recovery Dashboard Key Financials Fields

Field Comments

Total Claim Payment Displays the total of payments made on the claim to date.

This field is updated by the Recalculate Payment task.

NOTE: The value in this field comes from the Claims > Payment view 
for payments with a type other than Subrogation Expense or SIU 
Expense.

Total Expenses Displays the total subrogation expenses incurred to date.

This field is updated by the Update Expenses task.

NOTE: The value in this field comes from the Claims > Payment view 
for payments with a type of Subrogation Expense.

Recovery Potential Displays the recovery potential for the claim. The default value is 
(Theory of Liability % * Total Claim Payment), that is the theory of 
liability percentage multiplied by the total claim payment amount.

This field is updated by the Update Recovery potential task.

Table 16. Recovery Dashboard Arbitration/Litigation Referral Fields

Field Comments

Arb./Lit. Referral Indicates whether the claim is assigned to a 
litigation or arbitration specialist. 

Assignment Date Displays the date and time when the case was 
assigned to arbitration or litigation for further 
pursuit.

Counsel/Arb. Board Select the arbitration board or the external counsel 
handling the case. If the organization is a business 
unit, it is added to the claims Service Provider list 
with a role of Subro Arb./Lit. Provider.

Settlement Amount Enter the settlement amount for the subrogation 
case.



Managing Claims ■ Managing Recovery Information (End User)

Siebel Insurance Guide Version 8.0, Rev. A 131

Table 17 shows the fields in the dashboard that display the final outcome of the recovery processing

Table 18 shows the fields in the dashboard used for collections referrals.

Status Select the status of the arbitration or litigation 
process. Values include: Assigned, Accepted, 
Initial Review, Filed Arbitration, Under Litigation - 
Internal, Under Litigation - External, Decision 
Pending, Closed, and Re-opened.

Disposition Select the final status of the arbitration or litigation 
case. Values include: Settled - Full Recovery, 
Settled - Partial Recovery, Collections Handoff, and 
Abandoned.

Table 17. Recovery Dashboard Outcome Fields

Field Comments

Recovery Amount Enter the total recovery amount on the claim. 

Debt Schedule Select the debt schedule for the subrogation recovery. Values 
include Installments and Single Payment.

Deductible Return Displays the deductible return amount for the subrogation 
case.

This field is updated by the Calculate Deductible Return task.

Table 18. Recovery Dashboard Collections Referral Fields

Field Comments

Collections Referral Indicates whether the claim has been assigned to 
collections.

Assignment Date Displays the date and time when the case was 
assigned to collection for further pursuit.

Collection Agency Select the collection agency handling the case. If the 
organizations is a business unit, it is added to the 
claims Service Provider list with a role of Subrogation 
Collection Agency.

Collection Amount The collection amount for the subrogation case.

Table 16. Recovery Dashboard Arbitration/Litigation Referral Fields

Field Comments
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Table 19 shows the fields in the dashboard used for salvage processing.

Using the Common Task Links
In the Recovery dashboard, task links allow the user to update information in the dashboard or to 
reassign the case to a different person. 

Collection Status Select the status of the collection process. Values 
include: Assigned, Accepted, Negotiating, Closed, and 
Re-opened.

Disposition Select the final status of the collection process. Values 
include: Full Recovery, Partial Recovery, and 
Abandoned.

Table 19. Recovery Dashboard Salvage Potential Fields

Field Comments

Notify Salvage Indicates whether salvage potential has been notified.

Recovered Date Enter the date recovery took place.

Amount Recovered Enter the amount salvaged.

Table 20. Tasks in the Recovery Dashboard

Action Description

Check State Statutes Checks the state statutes. 

During implementation, the customer can extend the business 
service for this task to implement statute of limitations logic 
specific to the states in which they operate.

Update Theory of Liability Displays a dialog box with the following fields:

■ New Theory of Liability %. Enter a new value with which to 
update the Overall Fault % field in the dashboard.

■ Reason for Change. Enter the reason for adjusting the theory 
of liability to create a new note of type Subro Liability 
Assessment with the text you enter.

■ Update Recovery Potential flag. Select this check box to 
update the Subro Potential field with the calculated value (New 
Theory of Liability % * Total Claim Payment Amount).

Table 18. Recovery Dashboard Collections Referral Fields

Field Comments
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Update Recovery Potential Displays a dialog box with the following fields:

■ New Recovery Potential Amount. Enter a new value with 
which to update the Subro Potential field in the dashboard.

■ Reason for Change. Enter the reason for changing the 
recovery potential to create a new note of type Subro Recovery 
Potential with the text you enter.

Recalculate Payment Recalculates the total claim payment and updates the Total Claims 
Payment in the dashboard.

Update Expenses Recalculates the total subrogation expenses and updates the Total 
Expenses field in the dashboard.

Calculate Deductible Return Calculates the amount of the deductible that must be returned to 
the insured party and updates the Deductible Return field in the 
dashboard.

Notify Salvage Updates the Notify Salvage flag.

Reassign Claim Displays a dialog box with the following fields:

■ Assign To. Select the User ID of the person to whom you want 
to assign the claim. Leave the field blank if you require 
Assignment Manager to assign the claim automatically.

■ Reason for Reassignment. Enter the reason for reassigning 
the case to create a new note of type Subro Reassignment with 
the text you enter.

Refer to Arbitration / 
Litigation

Displays a dialog box with the following fields:

■ Assign To. Select the User ID of the person to which you want 
to assign the claim. Leave the field blank if you require 
Assignment Manager to assign the claim automatically.

■ Referral Notes. Enter any referral notes to create a new note 
of type Subro Litigation Referral with the text you enter.

Refer to Collections Displays a dialog box with the following fields:

■ Assign To. Select the User ID of the person to which you want 
to assign the claim. Leave the field blank if you require 
Assignment Manager to assign the claim automatically.

■ Referral Notes. Enter any referral notes to create a new note 
of type Subro Collection Referral with the text you enter.

Table 20. Tasks in the Recovery Dashboard

Action Description



Siebel Insurance Guide Version 8.0, Rev. A

Managing Claims ■ Creating a Recovery Payment Record (End User)

134 

Creating a Recovery Payment Record 
(End User)
A subrogation or SIU specialist uses the Financials > Recoveries view to create a record of invoices 
related to recoveries from third parties. This view is used to capture recoveries payment as well as 
to keep track of invoices that you send to third parties to collect the money. It is similar to the Claims 
screen > Invoices view but has a filter to show only invoices and payments related to the SIU and 
subrogation unit.

This task is a step in “Process of Managing Claims” on page 93.

To create recovery payment records

1 Navigate to the Claims screen.

2 In the Claims list, drill down on a claim.

3 Click the Financials > Recoveries view tab.

4 In the Invoices list, add records, and complete the necessary fields.

Managing Fraud Information (End User)
End users use the Claims screen > SIU Dashboard view to record and track information regarding 
fraudulent claims. This task is a step in “Process of Managing Claims” on page 93.

Cases of fraud relating to claims are usually handled by a special investigation unit (SIU). An adjuster 
can assign a claim to a SIU if he thinks there is fraud involved in the claims. One or more 
investigators in the SIU can then use the Claims screen - SIU Dashboard view to manage the fraud-
related activities. A claim can be assigned to various investigators, for example, to arbitration or 
litigation specialists. Table 21 shows the primary fields in the SIU dashboard.

Table 21. SIU Dashboard Fields

Field Comments

SIU Referral Indicates whether the claim has been referred to the SIU. 

Referral Source Identifies how the case was referred to the SIU:

■ System. The case was referred automatically due to the suspicious 
claim score.

■ Manual - adjuster. An adjuster referred the case manually.

■ Manual - Reassignment. The case was reassigned.

SIU Assignment Date Displays the time and date on which the claim was assigned to the SIU.

SIU Closed Date Displays the time and date on which the SIU file was closed.

Stop Payment Indicates whether the payment is on hold.
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Table 22 shows the fields in the dashboard that display the key financial information.

Table 23 shows the fields in the dashboard that display the final outcome of SIU investigation.

Suspicious Claim 
Score

Displays the combined fraud potential score.

Prob. of Resolution Displays the probability of resolution value for the claim. This field is 
set through the Update Probability of Resolution task.

SIU Status Select the status of the fraud case. Values include: Assigned, Accepted, 
Initial Review, Negotiations, Decision Pending, Closed, and Re-opened.

SIU Disposition Select the final status of the fraud case after processing is complete. 
The values include: Abandoned, Deny, Litigate, Negotiated, Pay.

Table 22. SIU Dashboard Key Financials

Field Comments

Total Claim Payment Displays the total of payments made on the claim to date.

This field is updated by the Recalculate Payment task.

NOTE: The value in this field comes from the Claims > Payment view 
for payments with a type other than Subrogation Expense or SIU 
Expense.

Total Expenses Displays the total SIU expenses incurred to date.

This field is updated by the Update SIU Expenses task.

NOTE: The value in this field comes from the Claims > Payment view 
for payments with a type of SIU Expense.

Recovery Potential Displays the recovery potential for the claim. The default value is 
(Prob. of Resolution % * Total Claim Payment).

This field is updated by the Update Recovery Potential task.

Table 23. SIU Dashboard Outcome Fields

Field Comments

Conservation Amount Displays the total outstanding reserve amount for the claim.

This field is updated by the Recalculate Conservation task.

Recovery Amount Enter the total recovery amount for the claim. 

Debt Schedule Select the debt schedule for the fraud recovery. The values 
are: Installments and Single Payment.

Table 21. SIU Dashboard Fields

Field Comments
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Table 24 shows the fields in the dashboard used for arbitration or litigation referrals.

Using the Common Task Links
In the SIU dashboard, task links allow the user to update information in the dashboard or to reassign 
the case to a different person.

Table 24. SIU Dashboard Litigation Referral Fields

Field Comments

Litigation Referral Indicates whether the claim is assigned to a litigation or arbitration 
specialist. 

Assignment Date Displays the date and time when the case was assigned to 
litigation for further pursuit.

Outside Counsel Select the organization; that is, the external counsel handling the 
case. If the organization is a business unit, the organization is 
added to the claims Service Provider list with a role of Fraud/Lit. 
Provider.

Settlement Range Enter the minimum and maximum settlement amounts for the 
fraud case.

Table 25. Tasks in SIU Dashboard

Action Description

Recalculate Payment Recalculates the total claim payment and updates the Total Claim 
Payments field in the dashboard.

Update SIU Expenses Recalculates the total SIU expenses and updates the Total Expenses 
field in the dashboard.

Update Recovery Potential Displays a dialog box with the following fields:

■ New Recovery Potential Amount. Enter a new value with 
which to update the Recovery Potential field in the dashboard.

■ Reason for Change. Enter the reason for changing the 
recovery potential to create a new note of type Fraud Recovery 
Potential with the text you enter.
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Update Probability of 
Resolution

Displays a dialog box with the following fields:

■ New Theory of Liability %. Enter a new value with which to 
update the Prob. of Resolution field in the dashboard.

■ Reason for Change. Enter the reason for adjusting the theory 
of liability to create a new note of type SIU Liability Assessment 
with the text you enter.

■ Update Recovery Potential flag. Select this check box to 
update the Recovery Potential field with the calculated value 
(New Theory of Liability % * Total Claim Payment Amount).

Recalculate Conservation Recalculates the conservation amount and updates the 
Conservation Amount field in the dashboard.

http://www.nicb.org Goes to the National Insurance Crime Bureau (NICB) Web site to 
allow you to enter information for investigation by NICB.

The NICB is a nonprofit organization that analyzes and investigates 
insurance fraud cases. 

Reassign Claim Displays a dialog box with the following fields:

■ Assign To. Select the User ID of the person to which you want 
to assign the claim. Leave the field blank if you require 
Assignment Manager to assign the claim automatically.

■ Reason for Reassignment. Enter the reason for reassigning 
the case to create a new note of type SIU Reassignment with 
the text you enter.

Refer to Arbitration / 
Litigation

Displays a dialog box with the following fields:

■ Assign To. Select the User ID of the person to which to assign 
the claim, or leave the field blank if you require Assignment 
Manager to assign automatically.

■ Referral Notes. Enter any referral notes to create a new note 
of type SIU Litigation Referral with the text you enter.

Table 25. Tasks in SIU Dashboard

Action Description
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About the Business Rules Processor and 
Claims Logic
Much of the logic for Siebel Insurance is implemented using the Business Rules Processor (BRP) 
business service. The BRP is appropriate for business logic that can be modified, and you can modify 
claims business logic without deploying a new SRF. Because BRP is a business service, it can be called 
from workflow processes. For more information about using the BRP, see “Business Rule Processor” 
on page 203.

Table 26. BRP Business Rules Processes for Claims

BRP Name Description Used In

FINS Claims Evaluate 
Subrogation Potential

Calculates the Subrogation Real Time score. Evaluate Subrogation 
Potential button in 
MyClaims view

FINS Claims Calculate 
Combined Score

Calculates the Subrogation Combined score. Field that drives the 
subrogation indicator in 
MyClaims view

FINS Claims Calculate 
Fraud Score

Calculates the combined Fraud Potential score 
based on the Real time Rule score, Real time 
Predictive Model score, and Batch Predictive 
Model score.

Field that drives the 
fraud indicator in 
MyClaims view

FINS Claims Evaluate 
Fraud Potential

Evaluates the Fraud Potential score. Evaluate SIU Potential 
button in MyClaims view

FINS Claims Reserve 
Estimation Check BRP

Compares the Total Estimation amount with 
the Total Reserve amount.

Claims > Appraisals view

FINS Claims Authority 
Limit Check

Performs the authority limit check before the 
reserve is opened.

Open Reserve button in 
Claims > Reserves view

FINS Claims Split 
Limit Check

Performs checks on the limits for reserve 
claims.

Open Reserve button in 
Claims > Reserves view

FINS Claims Calculate 
SIU Expenses

Calculates the SIU Total Expenses. Task link in SIU 
dashboard view

FINS Claims Calculate 
Total Conservation 
Amount

Calculates the Conservation Amount. Task link in SIU 
dashboard view

FINS Claims Calculate 
Total Payment 
Amount

Calculates the Total Claim Payments amount. Task link in SIU 
dashboard view

FINS Claims Create 
Fraud Case 
Assignment Alert

Creates an alert for a fraud case assignment. Task link in SIU 
dashboard view
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FINS Claims Calculate 
Subrogation Expenses

Calculates the Subrogation Total Expenses. Task link in Recovery 
view

FINS Claims Calculate 
Deductible Return

Calculates the Subrogation Deductible Return 
amount.

Task link in Recovery 
view

FINS Claims Create 
Subrogation Case 
Assignment Alert

Creates a subrogation case assignment alert. Task link in Recovery 
view

FINS Claims Set 
Notify Salvage

Sets the Notify Salvage flag. Notify Salvage flag in 
Recovery view

FINS Claims 
Subrogation 
Reassignment

Reassigns the claim to a subrogation 
specialist.

Task link in Recovery 
view

FINS Claims 
Subrogation Update 
BC Fields

Updates the subrogation fields for Recovery 
Potential or Update Theory of Liability tasks.

Task link in Recovery 
view

FINS Claims Fraud 
Litigation Assignment

Performs the Claims fraud Arbitration 
Litigation assignment.

Task link in Recovery 
view

FINS Claims SIU 
Reassignment

Reassigns the claim to a fraud specialist. Task link in SIU 
dashboard view

FINS Claims Fraud 
Update BC Fields

Updates business component fields when the 
Update Recovery Potential or Update 
Probability Of Resolution link is clicked.

Task link in SIU 
dashboard view

FINS Claims 
Subrogation 
Arbitration Litigation 
Assignment

Assigns the claim to a subrogation arbitration 
or litigation unit.

Task link in Recovery 
view

FINS Claims 
Subrogation 
Collections 
Assignment

Assigns the claim to a subrogation collections 
unit.

Task link in Recovery 
view

FINS Claims 
Subrogation Check 
State Statutes

Checks the State Statutes. Task link in Recovery 
view

FINS Claims Assign 
SIU Opportunity

Assigns the claims to the SIU unit when the 
user clicks the Notify SIU button.

Notify SIU button in 
MyClaims view

FINS Claims Assign 
Subrogation 
Opportunity

Assigns the claims to the subrogation unit 
when the user clicks the Notify Subro button.

Notify Subro button in 
MyClaims view

Table 26. BRP Business Rules Processes for Claims

BRP Name Description Used In
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FINS Claims Invoke 
Assignment Manager

Invokes the Assignment Manager component. All assignment buttons 
and assignment links.

FINS Claims Check 
OFAC Status For 
Contact Payees

Checks and updates the OFAC-related fields 
for the Contact payees during the Submit 
Payment processing.

Submit Payment button 
in Claims > Payments 
view

FINS Claims Check 
OFAC Status For 
Vendor Payees

Checks and updates the OFAC-related fields 
for the Vendor payees during the Submit 
Payment processing.

Submit Payment button 
in Claims > Payments 
view

FINS Claims Payment 
Update Reserves

Updates the Reserve fields during the Submit 
Payment processing.

Submit Payment button 
in Claims > Payments 
view

FINS Claims Payment 
Validate Reserves

Validates the Reserve fields during the Submit 
Payment processing.

Submit Payment button 
in Claims > Payments 
view

FINS Claims Reserve 
Adjustment 

Changes the Status from Pending - Open to 
Open when a user clicks the Reserve 
Adjustment button.

Reserve Adjustment 
button in Claims > 
Reserves view

FINS Claims Add 
Reserve Position to 
Claim Team

Adds the Reserve position to the Claim team. Open Reserve button in 
Claims > Reserves view

FINS Claims Manual 
Override Flag

Sets the Manual Override flag. If the reserve 
is of type Factor and the Allow Override flag is 
set, and if the reserve amount is changed, the 
Manual Override flag is set to true.

Claims > Reserves view

FINS Claims Void 
Payment Reserves 
Process

Cancels the submitted payment. Void payment button in 
Claims > Payments view

FINS Claims Apply 
Deductible For 
Reserve

Applies the deductible flag for the reserve 
across payments.

Apply Deductibles flag in 
Claims > Payments view

Table 26. BRP Business Rules Processes for Claims

BRP Name Description Used In
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Claims Workflows
Siebel Claims uses many workflows processes, which, for example, are activated when a user clicks 
a particular button, such as the Submit Payment button in the Payments view.

Table 27. Workflows for Siebel Claims

Workflow Name Description Used In

FINS Claims Add 
Reserve Position to 
Claim Team

Adds an adjuster position to a claim. For 
each adjuster for the current reserve, it 
checks if the position is part of the claim 
team, and if not, it adds the position to the 
claim team.

Adjuster field in the 
Claims > Reserves view

FINS Claims Call 
Evaluate SIU Potential 
Process

Calls the FINS Claims Evaluate Fraud 
Potential and FINS Claims Calculate Fraud 
Score BRPs and displays a popup message.

Evaluate SIU Potential 
button in MyClaims view

FINS Claims Call 
Evaluate Subrogation 
Potential Process

Calls the FINS Claims Evaluate Subrogation 
Potential and FINS Claims Calculate 
Combined Score BRPs to initialize the real-
time rule score and calculate the 
subrogation combined score.

Evaluate Subrogation 
Potential button in 
MyClaims view

FINS Claims Get Policy 
Details Process

Creates a new revision of the policy and 
returns the new policy ID.

Get Policy button in 
Claims > Loss Details -
Auto view

FINS Claims ISO 
Search Request

Sends a search request to the ISO database. Submit button in ISO 
Database Search view

FINS Claims ISO 
Search Response

Updates Siebel Insurance with the results 
from the ISO database search.

Submit button in ISO 
Database Search view

FINS Claims OFAC Data 
Import Process

Imports the OFAC XML data to the Siebel 
database.

Submit Payment button in 
Claims > Payments view

FINS Claims Open 
Reserve Process

Opens the reserve for a claim. Open Reserve button in 
Claims > Reserves view

FINS Claims Payment 
Create Activity Alert 
Sub Process

Creates an activity of type Alert, and assigns 
it to the subrogation or fraud unit.

Submit Payment button in 
Claims > Payments view

FINS Claims Payment 
Validation Sub Process

Validates the payment record (Submit 
Payment Validation Ruleset) and also checks 
that it is not a duplicate payment.

Submit Payment button in 
Claims > Payments view

FINS Claims Approval 
Manager Process

Checks whether the Inbox item is approved. 
If so, updates the proper Status value in the 
original request.

Submit Payment button in 
Claims > Payments view
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FINS Claims Payments 
Create Payments 
Process

Creates the bundled Payment record based 
on the selected invoice records.

Generate Payment button 
in Claims > Invoices view

FINS Claims Payments 
Inbox Action 
SubProcess

Checks whether additional approvals are 
required when a user approves an Inbox 
item.

Inbox screen for payment 
approval

FINS Claims Payments 
Inbox Drilldown 
Process

Fetches the proper payment when the user 
clicks on the Inbox item and invokes a view 
navigation subprocess.

Inbox screen for payment 
approval

FINS Claims Payments 
Inbox GotoView 
SubProcess

Navigates to the Claim Payments view with 
the given payment information.

Inbox screen for payment 
approval

FINS Claims Payments 
Status Update 
SubProcess

Checks whether the Inbox item is approved. 
If so, updates the proper Status value in the 
original request.

Inbox screen for payment 
approval

FINS Claims Payments 
Query Payments 
GotoView SubProcess

Navigates to the Claims Payments view. Submit Payment button in 
Claims > Payments view

FINS Claims Submit 
Payment Check Draft 
Authority Limits 
SubProcess

Checks whether the payment limits for the 
user are exceeded. If so, sends the item to 
the appropriate supervisor’s Inbox for 
approval.

Submit Payment button in 
Claims > Payments view

FINS Claims Submit 
Payment Check OFAC 
Status SubProcess

Checks the imported OFAC data for the 
payee. 

Submit Payment button in 
Claims > Payments view

FINS Claims Submit 
Payment Process

Invokes the main submit payment process. Submit Payment button in 
Claims > Payments view

FINS Claims Submit 
Payment Updated 
Reserves

Updates the Claims Reserve totals during 
the processing of a claims payment.

Submit Payment button in 
Claims > Payments view

Table 27. Workflows for Siebel Claims

Workflow Name Description Used In
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FINS Claims Submit 
Payment Validate 
Reserves SubProcess

Checks to verify that there is enough reserve 
in the Claims Reserve totals before allowing 
the workflow to process a claims payment.

Submit Payment button in 
Claims > Payments view

FINS Claims Void 
Payment Process

Cancels a payment that was generated 
successfully during the Submit Payment 
process. Sets the payment status to void 
and reverses the reserve outstanding made 
during the Submit Payment process. Also, 
creates an activity for the logged in user 
indicating that a payment has been 
cancelled.

Void button in Claims > 
Payments view

Table 27. Workflows for Siebel Claims

Workflow Name Description Used In
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11 Managing Life and Annuity 
Policies

This chapter is about working with life and annuity policies in Siebel Insurance. It includes the 
following topics:

■ “About Managing Life and Annuity Policies” on page 145

■ “Scenario for Life and Annuity Policies” on page 146

■ “Process of Managing Life and Annuity Policies” on page 147

■ “Defining Life or Annuity Insurance Products” on page 148

■ “Defining Life or Annuity Insurance Coverages” on page 148

■ “Administering Assessment Templates” on page 148

■ “Providing Life and Annuities Quotes” on page 149

■ “Ordering Underwriting Reports” on page 150

■ “Adding a Beneficiary” on page 150

■ “Submitting Transaction Requests” on page 151

■ “Viewing Value History Information” on page 152

■ “Setting Up Payment Plans” on page 152

About Managing Life and Annuity 
Policies
The Life & Annuities screen allows users to create and manage a variety of individual life insurance 
and annuity policies. Administrators can set up life and annuity plans in the Insurance Administration 
screen. Table 28 lists some common individual life insurance and annuity products.

Table 28. Life and Annuities Products

Product Description

Term Life Insures a life for a specified period of time. If the insured dies during the term, 
a benefit is paid. If the policy is not renewed and the insured dies after the term, 
no benefit is paid.

Whole Life Often referred to as permanent insurance because it provides a death benefit 
and a savings feature. The insurance accumulates a cash value, and the policy 
owner can generally borrow up to 95% of the cash value of the policy.
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For more information on views common to all policy screens, see “Common Policy Views” on page 154.

Scenario for Life and Annuity Policies
This scenario features sample tasks performed by a Siebel administrator and a licensed sales 
representative. Your company may follow a different workflow according to its business 
requirements.

In this scenario, a Siebel administrator defines life and annuity coverages and creates assessment 
templates.

A licensed sales representative for a life insurance company is on the phone with a prospective 
customer who has called to request a quote for Variable Life insurance. She searches for the contact 
in Siebel Insurance and finds that the customer is part of an existing household. She adds a new life 
quote as well as data about the type of policy and the proposed insured.

Next, she fills out a rating questionnaire for the prospect and creates an underwriting report. Then, 
she adds information about coverages and amounts. After that, she adds beneficiaries, and then sets 
up a payment plan with a bill-to address. After the data has been collected, she submits it to an 
external rating engine to determine the premium. 

She gives the prospect a verbal quote for the policy and the customer agrees to purchase it. Then, 
she follows the procedures implemented by her company to submit the policy application for 
underwriting.

After the policy is issued, she can submit loan, transfer, withdrawal, and surrender requests.

End users are the sales representatives who manage customer requests. They enter information to:

■ Generate a life insurance or annuity quote

Variable Life A form of whole life insurance in which the face amount and the cash value 
fluctuate according to the investment performance of a separate account fund. 
The policy holder can choose how a portion of the premium is invested.

Universal Life An insurance policy characterized by flexible premiums and cash values. 
Universal Life policies do not allow the policy holder to choose how premiums 
are invested.

Fixed Annuity A form of annuity in which the rate of interest on the annuity account value is 
guaranteed (fixed) for a specific period.

Variable Annuity A form of annuity in which the rate of return on the account value fluctuates 
according to the investment performance of a separate account fund. The 
annuity owner can choose how to invest a portion of the premium.

Endowment and 
Annuity

A policy that allows you to accumulate funds that will be payable in a lump sum 
at a future date. The money accumulates tax-free. If the insured dies before the 
pay-off date, the full face value of the policy is paid to the beneficiaries.

Table 28. Life and Annuities Products

Product Description
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■ Add underwriting information or order an underwriting quote

■ Add a beneficiary

■ Set up a payment plan and add a bill-to-address

■ Submits the policy application for underwriting

Process of Managing Life and Annuity 
Policies
This section details sample tasks often performed by administrators and end-users when managing 
life and annuity policies. Your company may follow a different process according to its business 
requirements. 

Administrator Procedures
The administration tables of Siebel Insurance store definitions of important insurance constructs 
such as coverages and coverage options information. These tables can be used to define a flexible 
set of insurance administrative data. Within the base product, the administrative tables are used to 
define life insurance coverages and limits. The administration tables for Life & Annuities are in the 
Administration - Insurance screen’s Life & Annuity Coverages view.

The following list shows tasks administrators typically perform to manage life and annuity policies:

■ “Defining Life or Annuity Insurance Products” on page 148

■ “Defining Life or Annuity Insurance Coverages” on page 148

■ “Administering Assessment Templates” on page 148

NOTE: Only administrators can change entries in the Administration - Insurance screen.

End-User Procedures
The following list shows tasks end users typically perform when managing life and annuity policies:

■ “Providing Life and Annuities Quotes” on page 149

■ “Ordering Underwriting Reports” on page 150

■ “Adding a Beneficiary” on page 150

■ “Submitting Transaction Requests” on page 151

■ “Viewing Value History Information” on page 152

■ “Setting Up Payment Plans” on page 152
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Defining Life or Annuity Insurance 
Products
As an administrator, you can add products to the Siebel database and add the product to a product 
line, if applicable. This section describes the procedure for setting up products in general terms.

For more information about defining products, see Siebel Product Administration Guide.

To add an insurance product

1 Navigate to Site Map > Administration - Product > Products view.

2 In the Product form, add a record, and complete the necessary fields.

a In the Category field, select Life & Annuity.

Defining Life or Annuity Insurance 
Coverages
After defining life and annuity products, you may need to add coverages.

To define a life or annuity coverage 

1 Navigate to Site Map > Administration - Insurance > Life & Annuity Coverages.

2 In the Life & Annuity Coverages list, add a record and complete the necessary fields.

You have defined the coverage type and levels for a life or annuity insurance product.

3 In the Coverage Options list, add a record and type a coverage option.

4 Repeat Step 3 for each coverage option you want to add.

Administering Assessment Templates
There are three types of assessment templates that are administered by sales administrators:

■ Rating

■ Reinstatement 

■ Underwriting

Each template is a collection of questions designed to obtain information needed to rate, reinstate, 
or underwrite a policy. They are all administered in the Sales Assistant Administration screen’s Sales 
Assessment Templates view. For more information, see Siebel Applications Administration Guide.

To administer an assessment template

1 Navigate to Site Map > Administration - Data > Sales Assessment Templates.
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2 In the Assessment Templates list, add a record.

■ In the Type field, select Life & Annuity.

■ Complete the remaining fields.

3 In the Assessment Attributes list, add a record and complete the necessary fields.

■ In the Name field, specify a question, such as “Have you used any form of nicotine products 
in the last 12 months?”.

4 For each assessment attribute entered, in the Attribute Values list, add a record and complete 
the necessary fields.

a In the Value field, add a possible answer (such as Yes or No) to the question defined in the 
Assessment Attributes list. 

b In the Score field, add a numeric value that represents how important that answer is to the 
assessment.

NOTE: You need to add one record for each potential answer to the question created in the 
Assessment Attributes list. For example, if a question requires a yes or no answer, you will 
need two Attribute Values records, one with a value of Yes and one with a value of No.

Providing Life and Annuities Quotes
In Siebel Insurance, a quote is a policy that has not been issued. End users can provide a quote for 
a new policy or for a change to an existing policy. For a life insurance quote, users need to specify 
coverage information in the Coverages view tab.

After the data has been collected, users can submit it to an external rating engine or illustration 
system to determine an initial premium, future account value, future annuity payments, or other 
calculations.

Coverages might be defaulted to a standard set (through configuration) or manipulated through the 
Questionnaire and Coverages views to further refine the quote. Users can collect additional data to 
aid in the underwriting and administration of the quote.

To generate a life insurance or an annuity quote 

1 Navigate to the Life & Annuities > Life Policy List view.

2 In the Policies/Quote list, add a record and complete the necessary fields.

■ To request a life insurance quote, in the Contract Type drop-down list, select Life Quote.

■ For an annuity quote, in the Contract Type drop-down list, select Annuity Quote.

NOTE: Additional fields are available in the More Info view tab.

3 Drill down on the Policy # hyperlink.

4 Click the Participants view tab and scroll down to the Contacts list.

a In the Contacts list, add a new record for each new participant.
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b In the new record, complete the fields.

CAUTION: Make sure you select the Named check box for each Contact that will be covered 
under the policy. If you do not check this box, the Contact will not appear in the Questionnaire 
view.

c Repeat Step 4 for each participant to add to the policy.

5 For all quotes, click the Questionnaire view tab.

6 In the Insured/Annuitant list, select a record.

7 Scroll down to the Questionnaire Templates list and add a new record.

a In the Template Name field, click the select button.

b In the Select Assessment Template dialog box, in the Template Name field, select the desired 
template and click OK.

c Step off the record to save the record and select the saved record.

The questions appear in the Questionnaire list.

8 In the Questionnaire list, complete the value field for each question.

9 For a life insurance quote, click the Coverages view tab.

10 In the Coverages list, add a record and complete the necessary fields.

Ordering Underwriting Reports
After end users add the necessary underwriting information, they can order underwriting reports for 
a policy.

To order an underwriting report

1 Navigate to the Life & Annuities screen.

2 In the Policies/Annuities list, select a policy.

3 Click the Underwriting Reports view tab.

4 In the Underwriting Reports list, add a record and complete the necessary fields

5 Follow the procedures defined by your company to submit orders for underwriting reports.

Adding a Beneficiary
End users can add or make changes to policy beneficiaries.

To add a beneficiary

1 Navigate to the Life & Annuities screen.

2 In the Policies/Quotes list, drill down on a policy.
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3 Click the Beneficiaries view tab and review the three view links:

■ Beneficiary Class. To add or change classes of individuals, such as all my children.

■ Individual Beneficiary. To add or change beneficiaries.

■ Organizations. To add or change organizations.

4 Click the appropriate view link.

5 In the Coverage Component list, select the desired record.

6 Scroll down to the lower list, add a record and complete the necessary fields.

Submitting Transaction Requests
End users can submit transaction requests for:

■ Loans 

■ Transfer of funds

■ Withdrawal or surrender of funds

To submit a loan request

1 Navigate to the Life & Annuities screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Transaction Request view tab. 

4 From the Transaction Requests view link list, select Loans. 

5 In the Loans list, add a record and complete the necessary fields.

6 Follow the procedures defined by your company to submit requests for loans.

To submit a transfer request 

1 Navigate to the Life & Annuities screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Transaction Request view tab.

4 From the Transaction Requests view link list, select Transfers. 

5 In the Transfers list, add a record and complete the necessary fields

6 Follow the procedures defined by your company to submit requests for transfers.

To submit a withdrawal or surrender request

1 Navigate to the Life & Annuities screen.

2 In the Policies/Annuities list, select a policy.
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3 Click the Transaction Request view tab.

4 From the Transaction Requests view link list, select Withdrawals & Surrenders. 

5 In the Withdrawals & Surrender list, add a record and complete the necessary fields 

6 Follow the procedures defined by your company to submit requests for withdrawals or 
surrenders.

Viewing Value History Information
End users can use the Value History view to display cash values. Usually, this requires integration of 
Siebel Insurance with a policy administration system. For more information, see “Integration” on 
page 189.

To display value history

1 Navigate to the Life & Annuities screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Policy Values view tab.

4 Select the Value History view link.

NOTE: Choose the Value History Chart view link to see value history data in chart format.

Setting Up Payment Plans
End users can set up payment plans and payment method details for life insurance and annuity 
policies.

To set up a payment plan

1 Navigate to the Life & Annuities screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Payment Plans view tab.

4 In the Payment Plans list, add a record and complete the necessary fields.

NOTE: The payment method you choose determines the type of list that appears. For example, 
if you select Electronic Funds Transfer as a payment method, the Payroll Deduction Plan/
Electronic Funds Transfer Details form appears after you save the record.
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12 Managing Group Policies

This chapter contains the following topics:

■ “About Group Policies” on page 153

■ “Scenario for Group Policies” on page 155

■ “Process of Managing Group Policies” on page 155

■ “Adding Group Insurance Products and Product Lines” on page 156

■ “Adding Group Insurance Rate Bands” on page 157

■ “Defining Activity Plan Templates for Group Policies” on page 157

■ “Defining Proposal Templates for Group Policies” on page 158

■ “Adding Group Policy Records” on page 158

■ “Importing Census Information” on page 159

■ “Adding Census Information in the Group Policies Screen” on page 160

■ “Adding Employee Classes for Group Policies” on page 161

■ “Designing Plans for Group Policies” on page 162

■ “How Enrollment Waiting Periods Affect the Start of Coverage” on page 163

■ “Reconfiguring Customizable Products in Plan Design” on page 164

■ “Generating Proposals for Group Policies” on page 164

■ “Managing Underwriting Information” on page 165

■ “Adding Eligible Members to Group Policies” on page 166

■ “Enrolling Members in Group Policies” on page 166

■ “Adding Beneficiaries to Group Policies” on page 167

■ “Setting Up Payment Plans for Group Policies” on page 167

About Group Policies
Group policies are insurance policies sold to a group on behalf of its members. The group is the 
insured party and can be an employer purchasing insurance for its employees, a group of employers 
who are purchasing insurance together, or an association or club purchasing insurance for its 
members.

Each group policy can offer many products. Group insurance products include group life, 
supplemental group life, group disability, group health, vision, and dental.
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Some group policies, especially those for larger groups, offer different products to different employee 
classes of group members. Examples of employee classes are salaried employees and hourly 
employees.

Group members have the option to accept coverage that is available for their class. Group members 
who accept coverage are enrolled in the policy and are considered the primary member of the policy. 
Enrolled members are usually referred to as members (for health insurance) or policyholders (for 
other kinds of insurance).

Primary members can choose products for themselves and for family members or dependents. 
Usually, different products are available for primary members and for other policy members.

The Group Policies screen allows users to manage group insurance. Specifically, it allows end users 
to generate proposals, create policies and quotes, add employee classes, design plans, enroll 
members, and provide service for the policy.

NOTE: In order to generate proposals from the Group Policies screen, you must purchase the Siebel 
Proposals & Presentations module.

Common Policy Views
Table 29 describes views common to all policy screens.

For more information on other insurance policy views, see Chapter 9, “Managing Auto Policies,” 
Chapter 11, “Managing Life and Annuity Policies,” Chapter 14, “Managing Property Policies,” and 
Chapter 15, “Managing PUL Policies.”

Table 29. Common Policy Screen Views

View Tab Description

Summary Displays a summary of key data associated with a policy in a single view.

Rate Model Applicable to auto and property policies. Allows users to select coverages and 
limits for an individual policy.

Claims Displays claims recorded for an individual policy. 

Proposals Allows for the creation and retrieval of quotes prepared for a customer 
associated with an individual quote or policy. Proposals would normally show 
up in the quote process, but not later.

Underwriting 
Reports

Allows users to collect and manage underwriting information associated with 
an application. These reports are sometimes ordered during the application 
process and sometimes after an application is submitted.

Documents Allows users to collect and manage documents associated with an application.

Third Parties Applicable to auto and property policies. Allows users to collect and manage 
information describing other parties who have an interest in insured property. 
Examples include a loss payee for an automobile loan or a mortgagee on real 
property.
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Scenario for Group Policies
This scenario features sample tasks performed by a licensed sales representative. Your company may 
follow a different workflow according to its business requirements.

In this scenario, a licensed sales representative for an insurance company is on the phone with an 
insurance agent. The insurance broker has called on behalf of a prospective customer who wants to 
offer insurance to its employees at group rates.

In Siebel Insurance, the sales representative adds a policy record for the company, which 
automatically assigns a unique policy number to the company. Then he imports census information 
for the company using the electronic file he received from the broker (alternatively, the broker may 
import the census himself through the Siebel Agent Portal). Next, he sets up employee classes, and 
adds a plan design by adding products for the policy. The plan design information and census data 
can be sent to the insurance company’s rating engine to generate a quote for this policy.

Next, he uses a template to generate a proposal, which he then sends to the prospect.

Two weeks later, he receives an email message from the broker indicating that the prospect has 
called back and will probably purchase a policy, but requires a revised proposal. He selects a group 
insurance plan according to the needs of the prospect. Next, he schedules an activity as a reminder 
to return the call with the revised premium information.

The prospect accepts the revised proposal. Now the sales representative needs to complete the 
procedures necessary to issue a policy. This includes collecting information about group members 
and about billing and payment preferences. He follows the procedures implemented by his company 
to submit the policy for issuance and billing.

Process of Managing Group Policies
This section details sample tasks often performed by administrators and end-users when managing 
group policies. Your company may follow a different process according to its business requirements.

Administrator Procedures
The following list shows tasks administrators typically perform to manage group policies:

■ “Adding Group Insurance Products and Product Lines” on page 156

■ “Adding Group Insurance Rate Bands” on page 157

■ “Defining Activity Plan Templates for Group Policies” on page 157

■ “Defining Proposal Templates for Group Policies” on page 158

NOTE: Only those with Siebel administrator responsibilities can change entries in the Insurance 
Administration and Product Administration screens.
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End-User Procedures
The following list shows tasks end users typically perform when managing call group policies:

■ “Adding Group Policy Records” on page 158

■ “Importing Census Information” on page 159

■ “Adding Census Information in the Group Policies Screen” on page 160

■ “Adding Employee Classes for Group Policies” on page 161

■ “Designing Plans for Group Policies” on page 162

■ “Reconfiguring Customizable Products in Plan Design” on page 164

■ “Generating Proposals for Group Policies” on page 164

■ “Managing Underwriting Information” on page 165

■ “Adding Eligible Members to Group Policies” on page 166

■ “Enrolling Members in Group Policies” on page 166

■ “Adding Beneficiaries to Group Policies” on page 167

■ “Setting Up Payment Plans for Group Policies” on page 167

Adding Group Insurance Products and 
Product Lines
As an administrator, you can add products to the Siebel database. This section describes the 
procedure for setting up products and product lines in general terms. 

You can also specify that a product line is one that your company contracts agencies to sell, or that 
the state licenses agencies to sell, or both.

For more information about adding product and product lines, see Siebel Product Administration 
Guide and Siebel Applications Administration Guide.

To add a group insurance product

1 Set up the product class structure, including product class attributes.

2 Add the products in the Product Administration screen and associate them with the appropriate 
class. 

3 In the Category field in the Products form, select Group Insurance.

4 Include the product in a product line.

5 Specify a product line type:

a From the application-level menu, choose View > Site Map > Application Administration > Product 
Lines.

b In the Product Line list, select one or both of the following fields:
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❏ Contracting. To specify that the product line is one that your company contracts 
agencies to sell. This product line will appear to end users as a choice in the Lines of 
Business dialog box in the Partners, Contracts view tab.

❏ Licensing. To specify that the product line is one that agencies can be granted a state 
license to sell. This product line will appear to end users as a choice in the Lines of 
Business dialog box in the Partners, Licenses & Appointments view tab.

A check box appears in the middle of the field.

c Click in a blank check box to select the product line type or click the X in a check box to clear it.

6 Set up the Customization Product by defining configuration rules and specifying the user 
interface. 

For more information, see the section on creating customizable products in Siebel Product 
Administration Guide.

Adding Group Insurance Rate Bands
After you add a product in the Product Administration screen, you can use the Insurance 
Administration screen to associate a rate band with a product. A rate band is pricing information 
about the deductible, the premium, and the payroll deduction for each insurance product.

To add a rate band

1 From the application-level menu, choose View > Site Map > Insurance Administration > Health 
and Group Products.

2 In the Products list, select a product.

3 In the Rate Bands list, add a record and complete the necessary fields.

Defining Activity Plan Templates for 
Group Policies
Activity Plan Templates allow you to create and manage activities related to group policies. You define 
templates using the Administration - Data screen Activity Templates and Activity Template Details 
views. 

To create an activity plan template 

1 Navigate to Site Map > Administration - Data > Activity Templates.

2 In the Activity Plan Templates list, add a record. 

3 In the Name field, type a name for the template.

4 In the Type field, choose FINS Group Policy.

5 Complete the remaining necessary fields.
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For more information, see Siebel Applications Administration Guide.

To create activities for the template 

1 Navigate to Site Map > Administration - Data > Activity Templates.

2 In the Activity Plan Templates list, select a template.

3 Click the Activity Template Details view tab. 

4 In the Activity Template Details list, add a record.

5 Complete the necessary fields for each activity assigned to the template.

6 From the drop-down list, choose an activity type.

NOTE: Repeat Step 2 through Step 6 to add activities to the template. 

7 Save the activity.

Defining Proposal Templates for Group 
Policies
Proposal Templates with a particular definition allow you to create and manage proposals related to 
group policies. You define templates using the Administration - Document screen Proposal Templates 
view. 

To create an proposal template for group policies

1 Navigate to Site Map > Administration - Document > Proposal Templates.

2 In the Proposal Templates list, add a record. 

3 In the Name field, type a name for the template.

4 In the Category field, select Insurance Proposal.

5 Complete the remaining necessary fields.

For more information, see Siebel Applications Administration Guide.

Adding Group Policy Records
Adding a group policy record is the first step in generating a policy proposal or issuing a group policy. 
After end users add a policy record, they must set up employee classes, add a policy plan design, 
and generate a policy proposal. If the customer accepts the proposal, they add eligible members, 
enroll members who elect coverage under the plan, and set up policy payment plans. 

To add a policy record

1 Navigate to the Group Policies screen.
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2 In the Policies/Quotes list, add a record and complete the necessary fields.

Importing Census Information
Insurance companies often receive group insurance census information from external sources. For 
example, an insurance broker collects this data and provides it to the insurance company as a comma 
separated text file.

End users can use the Group Policies Census view to import the census data into Siebel Insurance.

NOTE: Census data can also be imported from the Companies Census view.

Both detailed and segmented census data can be imported for each census. Usually, either only 
detailed or segmented census information is added for a company. However, both types of census 
information can be added.

Census data can also be imported by the originators, such as insurance brokers or employer groups, 
using Siebel Agent Portal or Siebel Group Portal. For more information about these two products, see 
Siebel Partner Relationship Management Administration Guide Addendum for Industry Applications.

Census data can also be entered manually. See “Adding Census Information in the Group Policies 
Screen” on page 160.

To import detailed census data

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Census view tab.

4 Click New to create a new census record and complete the fields.

5 In the Census list, from the view link list, select Detailed Census.

6 Scroll down to the Employee list and click Import.

7 In the Import dialog box, locate the file from which to import data and set the remaining 
parameters.

Some parameters are described in the following table.

The field mappings appear in a dialog box showing how each import field maps to the Siebel field. 
By default fields with matching labels are mapped to each other.

Parameter Description

Input Format Select either comma separated text or tab 
delimited text file type.

Input Source Select Auto Mapping.

Conflict Resolution Choose how to handle data conflicts. Defaults 
to Overwrite Existing Record.
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8 To add or change a field mapping:

a Highlight the field in the Import Field list

b Highlight the field to map to in the Siebel Field list

c Click Update Mapping

9 To remove an existing field mapping:

a Highlight the field in the Import Field list

b Highlight <ignore this field> to disregard the import field

c Click Update Mapping

10 Click Next.

The census data is imported into the Siebel application and appears in the Employee List list.

To import segmented census data
■ Follow the steps in “To import detailed census data” on page 159 except select Segmented Census 

in Step 5.

The census data is imported and appears in the Employee Count list.

Adding Census Information in the Group 
Policies Screen
End users can add census information for companies that request a quote or proposal for a group 
insurance policy. To add census information, end users must:

1 Add a policy in the Group Policies screen

2 Add census information using the instructions in the “To add census information” procedure

3 Associate the census with the policy using the instructions in the “To associate a census with a 
policy” procedure

Census data can also be automatically imported. See “Importing Census Information” on page 159.

To add census information 

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Census view tab.

4 In the Census list, from the view link list, select Segmented Census or Detailed Census.

■ Segmented Census. Add information for groups of employees.
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■ Detailed Census. Add information for individual employees.

NOTE: Usually, either only detailed or segmented information is added for a single census. 
However, information can be added for both.

5 In the Census list, add a record and complete the necessary fields.

6 For a Segmented Census:

■ Scroll down to the Employee Count list.

■ In the Employee Count list, add a record and complete the necessary fields.

7 For a Detailed Census: 

■ Scroll down to the Employee List list.

■ In the Employee List list, add a record and complete the necessary fields.

To associate a census with a policy

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, select a policy.

3 In the Policy Census field of the Policies/Quotes form, click the select button.

The Pick Group Census dialog box appears, showing each census available for that policy.

4 In the Pick Group Census dialog box, select a census and click OK.

Adding Employee Classes for Group 
Policies
Some group policies, especially those for larger groups, offer different products to different employee 
classes of group members. Examples of employee classes are salaried employees and hourly 
employees. Each employee class offers a unique combination of products, product options, and 
product rates. Users can use the Classes view to add or make changes to employee classes.

To add an employee class

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, select a policy.

3 Click the Classes view tab.

4 In the Classes list, add a record and complete the necessary fields.
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Designing Plans for Group Policies
End users can design plans for group polices by adding information about products, product classes, 
and rate bands. 

A rate band is pricing information about the deductible, the premium, and the payroll deduction for 
each insurance product. 

The following lists are available in the Plan Design view:

■ Product Attributes. This view contains the Plan Design Product list and the Attributes list. Use 
the Plan Design Product list to associate a product with the policy that appears in the Group Policy 
form. Use the Attributes list to view attribute information and change attribute values.

■ Product Classes. This view contains the Plan Design Product list and the Classes list. Use the 
Classes list to select employee classes that you want to associate with the selected product.

■ Product Class Matrix. This view contains the Plan Design Product Class Matrix list. In this list, 
you associate an employee class with the selected product.

■ Product Class Rate Bands. This view contains the Plan Design Product Class Rate Band list. 
Use this list to associate a rate band with the selected product/class.

To add a plan design

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on a group policy.

3 Click the Plan Design view tab.

The Plan Design Product list appears, showing the selected policy.

NOTE: If you need to add a product, in the Plan Design Products list, click New and complete the 
fields.

4 From the view link list, select Product Attributes and scroll down to the Attributes list.

5 In the Attributes list, change the appropriate information.

6 From the view link list, select Product Classes and scroll down to the Classes list.

a In the Classes list, click New to associate an employee class with the selected product.

b In the Class Name field, click the select button.

c In the Pick Class dialog box, select an employee class from the Class Name field and click OK.

NOTE: Only employee classes available for the selected product appear in the Pick Class dialog 
box. You can add employee classes to the list in this dialog box by using “Adding Employee Classes 
for Group Policies” on page 161.

7 From the view link list, select Product Class Matrix.

a In the Product Class Matrix list, check the appropriate product column for each class. 

8 From the view link list, select Product Class Rate Bands.
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a In the Product Class list, select a record with the appropriate product and class and scroll down 
to the Rate Bands list.

b In the Rate Bands list, click New to associate a rate band with the selected product and class.

c In the Rate Bands field, click the select button.

d In the Pick Product Rate Bands dialog box, select a Rate Band and click OK.

NOTE: Only available rate bands for the selected product appear in the Pick Product Rate Bands 
dialog box. Rate Bands are created in the Administration - Insurance > Health and Group 
Products view. For more information about how to add Rate Bands, see “Adding Group Insurance 
Rate Bands” on page 157. 

To generate a proposal for this plan, see “Generating Proposals for Group Policies” on page 164.

How Enrollment Waiting Periods Affect 
the Start of Coverage
You can control how Siebel Insurance calculates the start of coverage by defining the enrollment 
waiting period in the Group Policies screen. When you add a Plan Design (see “Designing Plans for 
Group Policies” on page 162), you define Product Classes that you then associate with a specific 
product. In the Classes list you can specify the Waiting Period, that is the number of days that must 
pass prior to the start of coverage. The actual start of coverage appears in the Effective Date field 
in the Group Policies, Enrollment view. The Waiting Period you specify in the Plan Design, Classes list 
directly impacts this Effective Date.

By default, Siebel Insurance has the following defined rules:

■ If a Waiting Period is specified, the Effective Date is set to the number of waiting days from 
today’s date.

■ If a Waiting Period is not specified, the application checks today's date. If that date is before the 
15th of the month, the Effective Date is set to the first of the month. If that date is after the 15th 
of the month, the Effective Date is set to the first of the following month.

When a user enrolls a new member in the Group Policy, Enrollment view, the Effective Date field 
defaults to a value based on these two rules and the application sets the Status field to Waiting. 

The FINS Member Enrollment Rules Workflow enforces these rules. Users can invoke this workflow 
by submitting a repeating component job request that repeats every 24 hours in batch mode. It 
checks the Effective Date of existing enrollment records and updates the Status from Waiting to 
Active if:

■ The Effective Date of a record is less than or equal to today’s date

■ The Status is still set to Waiting

For more information on component job requests, see Siebel System Administration Guide.
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Reconfiguring Customizable Products in 
Plan Design
End users can dynamically reconfigure customizable products by using the Customize Plan button in 
the Product Attributes list. The Customize Plan button is only available if Siebel Configurator was 
installed and the selected product was created as a customizable product in Siebel Configurator. For 
more information, see the chapters about customizable products in the Siebel Product Administration 
Guide.

To dynamically reconfigure customizable products in plan design

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on a group policy.

3 Click the Plan Design view tab.

4 Select the Product Attributes view link.

5 In the Product list, click Customize Plan.

A configuration session launches and a selection page appears. The changes made in the 
configuration session are reflected in the line items in the Attributes list. 

Generating Proposals for Group Policies
A proposal is a written quote for a policy. Before generating a proposal, end users must add the 
policy, set up classes, and add the policy plan design. Usually, the last step in adding the plan design 
is to activate the software program your company uses to rate policies. For more information, see 
“Designing Plans for Group Policies” on page 162.

Proposals are built off of pre-defined templates. For more information on creating proposal 
templates, see the chapter on proposals in Siebel Applications Administration Guide.

NOTE: Only those with Siebel administrator responsibilities can create or change proposal templates 
from the Administration - Document screen.

To generate a proposal

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Proposals view tab.

4 In the Proposals list, add a record.

5 In the new record, select the appropriate template.

6 Click Generate Draft.
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Managing Underwriting Information
End users can use the Underwriting Reports view tabs on the Group Policies screen to collect and 
manage underwriting information.

To add underwriting information

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Underwriting Reports view tab.

4 In the Underwriting Reports list, attach the information and complete the necessary fields. 

Some fields are described in the following table.

To view historical underwriting information

1 Navigate to the Group Policies screen.

2 Click the Group History view tab.

3 From the view link list in the Group History list, select a type of underwriting information:

■ Rates

■ Prior Insurance History

■ Premium/Claim History

■ Large Claimant History

Field Comments

Type Type of underwriting report or information being requested. 

Status Status of the current report. Valid options include:

■ Requested

■ Received

■ Submitted

Ordered Date automatically generated by the application when a new record is 
created.

Received Date the underwriting report was received.
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Adding Eligible Members to Group 
Policies
After a customer accepts a group policy plan, end users can add or make changes to eligible 
members. Eligible members can accept or decline group policy coverages. Members who accept 
coverage can be enrolled in the plan.

To add an eligible member

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on the policy.

3 Click the Eligible Members view tab.

4 In the Primary Members list, add a record.

5 In the Add Members dialog box, select an existing record, or add a record and complete the 
necessary fields.

NOTE: During implementation, you will import the eligible members from the final census. For 
more information, see “Importing Census Information” on page 159.

Enrolling Members in Group Policies
Group members who accept coverage are enrolled in the policy and are considered the primary 
member of the policy. End users use the Enrollment view to enroll eligible members, including the 
primary member and dependents, who accept coverage in the plan.

To enroll a member

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on the policy.

3 Click the Enrollment view tab.

4 In the Primary Members list, select the primary member to enroll and scroll down to the Member 
Products list.

a In the Member Products list, add a record and complete the necessary fields.

b Repeat Step 4 for each product you would like to add for this primary member.

All the products related to this primary member’s enrollment are added.

5 Scroll down to the Insured Members list.

a In the Insured Members list, click New to enroll the primary member and the dependents.

b In the Last Name field, click the select button. 

c In the Pick Contacts dialog box, select the primary member that you would like to associate with 
the selected product and click OK.
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d In the Insured Members list, complete the remaining fields.

NOTE: Add dependent members in the Pick Contacts dialog box by clicking on the New 
button and completing the fields.

6 Repeat Step 4 and Step 5 for each member you would like to enroll.

When you finish, all enrolled members, including the primary member, appear in the Insured 
Members list.

Adding Beneficiaries to Group Policies
Some group policies, such as group life insurance policies, require that members designate one or 
more policy beneficiaries. End users can use the Member Beneficiary view to add or make changes 
to group policy beneficiaries.

To add a beneficiary

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on the policy.

3 Click the Member Beneficiary view tab.

4 In the Member Life Products list, select a primary member record.

5 Scroll down to the Insured Members list and select a member for whom to add a beneficiary.

6 In the Beneficiary list, add a record and complete the necessary fields.

Setting Up Payment Plans for Group 
Policies
End users can set up payment plans, including details about payment methods, for group insurance 
policies.

To set up a payment plan for a group policy

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, drill down on the policy.

3 Click the Payment Plans view tab. 

4 In the Pay Plans list, add a record and complete the necessary fields.

5 Scoll down to the Payment Details form and update the statement information.

a In the Last Name field, click the select button.

b In the Pick Contact dialog box, select a name and click OK.
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13 Managing Partners and 
Agencies

This chapter contains the following topics:

■ “About Partners and Agencies” on page 169

■ “Scenario for Working with Partners and Agencies” on page 170

■ “Process of Managing Partners and Agencies” on page 170

■ “Adding New Partners” on page 171

■ “Setting Up Siebel Insurance eService Partners Locators” on page 171

■ “Adding Agents” on page 172

■ “Adding Information Associated with an Agent” on page 172

About Partners and Agencies
Siebel Insurance allows you to manage partners and agencies.

■ Partners include service providers, aggregators, and insurance agencies. 

■ Agencies are organizations that act on behalf of insurance companies to sell insurance policies. 
Agents and brokers are the licensed sales representatives who sell the insurance policies. For 
many insurance companies, agencies are often the most important type of partner. 

Tracking partner information is important because for many insurance, partners such as banks, 
agencies, and brokerages often function as a primary revenue channel.

NOTE: Adding partners on the Partners screen only allows you to track and monitor partner 
information. If you want to share data with a partner, the partner should be upgraded to a Siebel 
Organization. To perform this and other Partner administration tasks, you use the Administration -
Partner screen. For more information, see Siebel Partner Relationship Management Administration 
Guide.

End users use the Agents screen for insurance-related procedures such as:

■ Adding agents

■ Viewing agent information

■ Creating service requests or activities for agents

■ Tracking information about contracts, licenses, appointments, registration, errors and omissions, 
policies, and quotes

NOTE: Under the Party Model, where contacts include all persons, individuals added in the Agents 
business component are also members of the Contacts business component. Agents are a special 
subset of contacts who are engaged in the sales of Financial Services products.
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Scenario for Working with Partners and 
Agencies
These scenarios feature sample tasks performed by insurance company employees. Your company 
may follow a different workflow according to its business requirements.

In these scenarios, the end users are company employees who manage information in the field. They 
enter information to:

■ Create a partner 

■ Add a contact that represents an agency

■ Add new agents 

■ View information about existing agents

■ Track agent information about contracts, licenses, appointments, registration status, errors and 
omissions, policies, and quotes

■ Create service requests or activities for agents

Employee Adds a New Agency
In this scenario, an insurance company uses independent agencies as one of the channels for 
distribution of its insurance products. An employee for this insurance company needs to add a newly 
appointed agency to represent his company’s products to consumers.

His company has verified the qualifications of the agency, so he adds information about the agent. 
Then, he adds a new Partners record and adds information about the agency’s errors and omissions 
coverage. 

Next, he navigates to the Licenses & Appointments view to record information about the agency’s 
license. Finally, he adds a contact with the agency.

Company Signs a New Agent
An insurance company signs a new agent. A licensing and contracting coordinator for the company 
receives an interoffice mail containing the required paperwork. She enters the agent’s contact, 
license, appointment, and contract information into Siebel Insurance.

Six months later, the agent moves to a new office. He forwards his new address and phone number 
to the sales representative who is his main contact at the insurance company. The sales 
representative locates the agent in Siebel Insurance and updates his address and phone number.

Process of Managing Partners and 
Agencies
This section details sample tasks often performed by end-users when managing partners and 
agencies. Your company may follow a different process according to its business requirements.



Managing Partners and Agencies ■ Adding New Partners

Siebel Insurance Guide Version 8.0, Rev. A 171

End-User Procedures
The following list shows tasks end users typically perform when managing partners and agencies:

■ “Adding New Partners” on page 171

■ “Setting Up Siebel Insurance eService Partners Locators” on page 171

■ “Adding Agents” on page 172

■ “Adding Information Associated with an Agent” on page 172

Adding New Partners
End users can create new partner records and make changes to existing service provider information.

To create a partner

1 Navigate to Partners > Partner List view.

2 In the Partners form, add a record, and complete the necessary fields. 

3 In the Partner Type field, select the appropriate type; if this partner is a service provider, select 
Service Provider.

Setting Up Siebel Insurance eService 
Partners Locators
The Contact Us applet on the Siebel Insurance eService home page has a Locate Nearby Partners 
hyperlink. When users with the role of Insurance Member click this link, an applet opens in which 
they can perform a parametric search using location attributes that they select from drop-down lists. 
Users set up the records used in these searches in Siebel Insurance.

For more information on Siebel Insurance eService, see Siebel eService Administration Guide 
Addendum for Industry Applications.

To set up a Partner Locator

1 Navigate to Site Map > Partners > Partners List > Locations view.

2 In the Partners form, query for the desired partner. 
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3 In the Locations list, add a record for each partner address and complete the necessary fields.

When the record is saved, the application automatically populates the Latitude and Longitude 
fields.

NOTE: The latitude and longitude values will not generate if any one value in the City, State, Zip 
Code, or Country fields is incorrect. For example, if the ZIP Code is incorrect, you will receive an 
error message. To correct this problem, navigate to the Application Administration, ZIP Code 
Administration view and make sure the Geo values for that city, state, and ZIP Code combination has 
been loaded. For more information, see Siebel eService Administration Guide.

Adding Agents
Agents are the licensed sales representatives who sell insurance policies. Adding an agent is the first 
step in managing procedures related to the agent. 

To add an agent

1 Navigate to the Agents screen.

2 In the Agents list, add a record and complete the necessary fields.

a In the Partner field, click the select button.

b In the Partners dialog box, select a record and click OK, or click New to add a new partner.

c If adding a new partner, complete the fields.

NOTE: To add or change the columns displayed in the list, click the list’s menu button and choose 
Columns Displayed.

Adding Information Associated with an 
Agent
Using the view tabs on the Agents screen, end users can track additional information related to 
agents including information about contracts, licenses and appointments, errors and omissions, 
National Association of Securities Dealers (NASD) registration, and policies and quotes.

To add additional information about an agent

1 Navigate to the Agents screen.

2 In the Agents list, drill down on the desired agent and click the appropriate view tab from the 
following list:

■ Contracts. To add information about the agent’s contracts.

■ Licenses and Appointments. To add information about licenses the agent holds.

■ Errors and Omissions. To add information about the agent’s errors and omissions.
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■ Registration. To add information about the agent’s registration status.

■ Policies/Quotes. To view policies and quotes for the agent.

3 In the selected view list, add a record and complete the necessary fields.
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14 Managing Property Policies

This chapter contains the following topics:

■ “About Property Policies” on page 175

■ “Scenario for Property Policies” on page 175

■ “Process of Managing Property Policies” on page 176

■ “Adding Property Types” on page 177

■ “Adding Property Coverages and Coverage Limits” on page 177

■ “Providing Quotes” on page 178

■ “Adding Underwriting Information” on page 178

■ “Querying for Property Underwriting Information” on page 179

■ “Ordering Underwriting Reports” on page 179

■ “Adding Scheduled Personal Property” on page 179

■ “Setting Up Payment Plans” on page 180

■ “Additional Property Policies Views” on page 180

About Property Policies
Terminology for property insurance policies varies among insurance companies. For example, the 
same type of insurance could be referred to as fire insurance, homeowner’s insurance, home 
insurance, or property insurance.

Using the procedures given in this chapter, you will be able to perform the administrator tasks of 
adding property types, property coverage, and coverage limits in the Insurance Administration 
views. End users, usually service and licensed sales representatives, use the Property Policies screen 
to create and manage property insurance policies. Specifically, they can generate quotes for a new 
policy or for a change in an existing policy, add underwriting information, order underwriting reports, 
add scheduled personal property to the system, and setting up a payment plan.

For more information on views common to all policy screens, see “Common Policy Views” on page 154.

Scenario for Property Policies
This scenario features sample tasks performed by an administrator and a licensed sales 
representative. Your company may follow a different workflow according to its business 
requirements.
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In this scenario, a Siebel administrator adds property types, coverages, and coverage limits for his 
company’s property policies.

A licensed sales representative for a property insurance company is on the phone with a customer 
buying a first home. The customer wants to switch from a renter’s policy to a homeowner’s policy. 

Using the fields on the Quick Quote view as a guide, the sales representative asks the customer a 
series of questions in order to gather enough information to provide an initial quote. Next, she adds 
more underwriting information, orders underwriting reports to request additional information, and 
adds scheduled personal property. After the data has been collected, she submits it to an external 
She gives the customer a verbal quote and ends the conversation. 

Two weeks later, the sales representative receives another call from the customer. The offer was 
rejected for the property she quoted a premium for, but an offer on another house was accepted. 
She adjusts the coverages and limits accordingly, and then gives the customer the revised premium 
information. The customer confirms an intent to purchase the quoted policy.

The quote now needs to be prepared for eventual contract issuance. This includes collecting 
information about any parties that hold liens and mortgages against the insured property and billing 
and payment arrangements.

Then the sales representative follows the procedures implemented by her company to submit the 
policy for issuance and billing.

In this scenario, end users are sales representatives who service customers. They enter information 
to:

■ Provide quotes

■ Add underwriting information

■ Order an underwriting report

■ Add scheduled personal property to the system

■ Set up a payment plan

Process of Managing Property Policies
This section details sample tasks often performed by administrators and end-users when managing 
property policies. Your company may follow a different process according to its business 
requirements.

Administrator Procedures
The following list shows tasks administrators typically perform to manage property policies:

■ “Adding Property Types” on page 177

■ “Adding Property Coverages and Coverage Limits” on page 177

NOTE: Only those with the required administrative responsibilities, such as Siebel administrators, 
can change entries in the Insurance Administration views.
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End-User Procedures
The following list shows tasks end users typically perform when managing property policies:

■ “Providing Quotes” on page 178

■ “Adding Underwriting Information” on page 178

■ “Querying for Property Underwriting Information” on page 179

■ “Ordering Underwriting Reports” on page 179

■ “Adding Scheduled Personal Property” on page 179

■ “Setting Up Payment Plans” on page 180

■ “Additional Property Policies Views” on page 180

Adding Property Types
The Insurance Administration view allows you to add and make changes to property types. You can 
use the existing fields to define the default values of property types, or you can add more fields using 
Siebel Tools. For more information, see Configuring Siebel Business Applications.

To add a property type

1 Navigate to Site Map > Administration - Insurance > Property Types.

2 In the Property Type Administration list, add a record and complete the necessary fields.

Adding Property Coverages and 
Coverage Limits
The Property Coverage Administration view allows you to add and make changes to property 
coverages and property coverage limits. You can use the existing fields to define the default values 
of property coverages, or you can add more fields using Siebel Tools. For more information, see 
Configuring Siebel Business Applications.

To add a property coverage

1 Navigate to Site Map > Administration - Insurance > Property Coverages.

2 In the Property Coverage Administration list, add a record and complete the necessary fields.

To add a property coverage limit

1 Navigate to Site Map > Administration - Insurance > Property Coverages.

2 In the Property Coverage Administration list, select a record.

3 Scroll down to the Coverage Limit list, and add a record.
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4 In the Limit field, type a coverage limit and complete the remaining fields.

Providing Quotes
In Siebel Insurance, a quote is a policy that has not been issued. End users can provide a quote for 
a new policy or for a change to an existing policy. The Quick Quote view provides a way to gather 
basic policy and rating information. The information collected through the Quick Quote view 
represents the minimum rating information needed to create an initial premium calculation.

To provide a property insurance policy quote

1 Navigate to the Property Policies screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Quick Quote view tab.

4 In the Property Types list, add a record and complete the necessary fields.

5 Scroll down to the Dwelling Rating form and complete the fields.

NOTE: Coverages might be defaulted to a standard set (through configuration) or manipulated 
through the Rate Model view to further refine the quote. You can collect additional data to aid in 
the underwriting and administration of the quote.

Adding Underwriting Information
After end users provide a quote for a property policy, they can add additional information for 
underwriting.

To add underwriting information

1 Navigate to the Property Policies screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click one of the following view tabs and add a record.

■ Property Underwriting. To add property-related information.

■ Outbuilding Underwriting. To add information related to outbuildings such as detached 
garages.

■ Coverage Underwriting. To add other underwriting information, such as earthquake, farm, 
and brush hazard.

4 In the new record, complete the fields.
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Querying for Property Underwriting 
Information
End users can also query for property type and dwelling underwriting information.

To query for underwriting information

1 Navigate to the Property Policies screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Property Underwriting view tab.

4 In the Property Type list, click Query to search for property type and dwelling underwriting 
information. 

5 Select the query criteria and click Go.

Ordering Underwriting Reports
After end users add the necessary policy information, they can order underwriting reports for a 
policy. Examples of underwriting reports are motor vehicle, credit bureau, or loss history reports.

To order an underwriting report

1 Navigate to the Property Policies screen.

2 In the Policies/Quotes list, drill down on a policy.

3 Click the Underwriting Reports view tab.

4 In the Underwriting Reports list, add a record and complete the necessary fields.

NOTE: You can configure your application to activate the software program your company uses 
to submit orders for underwriting reports.

Adding Scheduled Personal Property
End users can add scheduled personal property, such as jewelry, coins, and fine art, to a property 
insurance policy. 

To add scheduled personal property

1 Navigate to the Property Policies screen.

2 In the Policies/Quotes list, drill down on the policy.

3 Click the Quick Quote view tab.
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4 In the Property Types list, add a record and complete the necessary fields.

NOTE: When you select a personal property value in the Type drop-down list, the Scheduled 
Property Rating form appears.

5 Scroll down to the Scheduled Property Rating form and complete the fields.

6 Click the SPP Detail view tab.

7 In the Property Type list, select a type and scroll down to the SPP Items list.

8 In the SPP Items list, add a record and complete the necessary fields.

9 Repeat Step 4 through Step 8 for each scheduled property item you want to add.

Setting Up Payment Plans
End users can set up payment plans, including details about payment methods, for property 
insurance policies.

To set up a payment plan for a property policy

1 Navigate to the Property Policies screen.

2 In the Policies/Quotes list, drill down on the policy.

3 Click the Payment Plans view tab.

4 In the Payment Plans list, add a record and complete the necessary fields.

Additional Property Policies Views
Table 30 describes additional views that are unique to the Property Policies screen.

Table 30. Additional Property Policy Screen Views

View Tab Description

Coverage Underwriting Records additional details regarding optional property policy coverages.

Replacement Cost Replacement cost is an estimate of what it would cost to rebuild a real 
property structure. A replacement cost estimate is the basis of 
determining the amount of dwelling coverage that should be applied to 
a policy covering real property structures. This view captures a detailed 
description of property to be insured from which a replacement cost 
estimation can be made. 

Replacement Cost 
Summary 

Displays the details of a replacement cost estimate. Replacement cost 
data is often obtained from an external system. 

For more information on integrating with external systems, see 
“Integration” on page 189.
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Boat Detail Records a detailed description of watercraft and associated equipment.

Boat Operator Records operator information for watercraft operators on a policy.

All SPP Items Displays a summary of all scheduled personal property items. For more 
information, see “Adding Scheduled Personal Property” on page 179.

Accident Violation Records details of accident and violation history for boat operators.

Table 30. Additional Property Policy Screen Views

View Tab Description
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15 Managing PUL Policies

This chapter includes the following topics:

■ “About PUL Policies” on page 183

■ “Scenario for PUL Policies” on page 183

■ “Providing PUL Policy Quotes” on page 184

About PUL Policies
PUL Policies are a specialized type of insurance policy. Rather than provide financial protection for 
real property, a PUL policy provides an umbrella of liability coverage that is above that provided by 
a policyholder’s other insurance policies. A PUL policy requires the collection of information about the 
property that is covered by the contract, plus information about the policies that provide the basic 
liability coverage for those pieces of property. Within a PUL policy, the policies that provide the basic 
liability coverage are termed “underlying policies.” The PUL policy provides for liability coverage that 
exceeds the liability coverage provided by the underlying policies.

The PUL (personal umbrella liability) Policies views are used by service and licensed sales 
representatives to create and manage PUL insurance policies, including issuing quotes for a new 
policy or for a change in an existing policy. 

For more information on views common to all policy screens, see “Common Policy Views” on page 154.

Scenario for PUL Policies
This scenario features sample tasks performed by a licensed sales representative. Your company may 
follow a different workflow according to its business requirements.

In this scenario, a licensed sales representative for a PUL insurance company is on the phone with a 
customer who has a homeowner’s policy with your company.

Using the fields on the Quick Quote view as a guide, the sales representative asks the customer a 
series of questions in order to gather enough information to provide an initial quote. Because this is 
a PUL quote, he collects vehicle information, property (residence) information, watercraft 
information, and underlying policy information. Underlying policies are those whose liability coverage 
is extended by the PUL policy.

After the data has been collected, he submits it to an external rating calculator to determine the 
premium. Then, he gives the customer a verbal quote, and the customer indicates an intention to 
purchase the policy.

The quote now needs to be prepared for eventual contract issuance. This includes collecting detailed 
information about the insured vehicles, boats, or property and any underlying policies and billing and 
payment arrangements. 
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Then, he follows the procedures implemented by his company to submit the policy for issuance and 
billing.

In this scenario, end users are licensed sales representatives who service customers. They enter 
information to:

■ Provide quotes

■ Collect underwriting, rating, and underlying policy information about vehicles, properties, and 
watercraft

Providing PUL Policy Quotes
In Siebel Insurance, a quote is a policy that has not been issued. End users can generate a quote for 
a new policy or for a change to an existing policy. 

The Quick Quote view provides a way to gather basic policy and rating information. The information 
collected through the Quick Quote view represents the minimum rating information needed to create 
an initial premium calculation.

To generate a PUL insurance policy quote

1 Navigate to the PUL Policies screen.

2 In the Policies/Quotes list, add a record and complete the necessary fields.

3 In the Policies/Quotes list, drill down on the policy.

4 Click the Quick Quote view tab.

5 In the Quick Quote form, complete the necessary fields.

6 Collect underwriting, rating, and underlying policy information about vehicles, properties, and 
watercraft using the following PUL Policies view tabs:

■ Vehicles

■ Property

■ Watercraft 

■ Underlying Policies 

After collecting the data, you can submit it to an external rating engine to determine the premium. 
In the application, you can add information to help underwrite and administer the quote. You can use 
the Rating form to manipulate the Rating factors and further refine the quote.

NOTE: You can configure your Siebel application to add a Rate button that activates the software 
program your company uses to rate policies.
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16 Managing Billing Accounts

This chapter contains the following topics:

■ “About Billing Accounts” on page 185

■ “Scenario for Billing Accounts” on page 185

■ “Process of Managing Billing Accounts” on page 186

■ “Creating Billing Account Records” on page 186

■ “Associating Billing Accounts with Other Records” on page 187

About Billing Accounts
To handle the payment of policy premiums, insurance companies use something called a billing 
account. A billing account is a construct that is used to handle the billing and payment activities 
associated with one or many insurance policies. The policy premiums are billed and collected through 
the billing account. This allows insurance companies to give users the flexibility to pay their 
premiums through a single bill, even though they may have several policies.

Siebel Insurance provides flexibility for companies to handle billing-oriented transactions in various 
ways. Although billing accounts are a popular method within the industry, many companies handle 
billing on a single policy basis and many use a blend of billing account and single policy billing.

Using the procedures given in this chapter, end users will be able to use the Billing Accounts screen 
to add a billing account, associate a billing account with a policy, contact, or company, and add a 
service request to a billing account.

Scenario for Billing Accounts
This scenario features sample tasks performed by an insurance agent. Your company may follow a 
different workflow according to its business requirements.

An insurance agent creates a new billing account to manage the various policies held by one of her 
customers. First, she associates the policies and certain contacts with the billing account. In this 
context, a contact can be someone who is responsible for paying the bills associated with an account 
or someone associated with the billing account, such as the secondary insured on a policy. 

Later, the insurance agent receives a call from one of her contacts. The contact has a problem with 
his latest bill. The insurance agent logs a service request against the customer’s billing account.
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Process of Managing Billing Accounts
This section details sample tasks often performed by end-users when managing billing accounts. 
Your company may follow a different process according to its business requirements.

End-User Procedures
The following list shows tasks end users typically perform when managing billing accounts:

■ “Creating Billing Account Records” on page 186

■ “Associating Billing Accounts with Other Records” on page 187

Creating Billing Account Records
End users can add a new billing account record from any Billing Accounts view, including the Contacts 
screen, the Companies screen, the Service Requests screen, or the Billing Accounts screen.

To add a billing account

1 Navigate to the Billing Accounts screen.

2 Add a new record and complete the necessary fields. 

Some fields are described in the following table.

Field Comments

Account # Automatically generated by the application. You can configure Siebel 
Insurance to assign a billing account number based on your company’s 
standards and conventions.

Effective Date Set to the current date.

Status Set to New.

Type The type of billing account. Select:

■ Single Policy if you will associate only one policy with the billing 
account.

■ Multiple Policy if you will associate more than one policy with the 
billing account.
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Associating Billing Accounts with Other 
Records
Billing accounts can be associated with policies, contacts, companies, service requests, and 
households. End users can make the associations directly from the Billing Accounts screen, the 
Contacts Billing Accounts view, or the Companies Billing Accounts views. 

Billing accounts can only be associated with households through an implicit relationship with a 
contact. That is, a billing account must be associated with a contact who is a member of a household 
in order for the billing account to be associated with the household. This relationship is then visible 
in the Households Billing Accounts view.

To associate a billing account with a policy

1 Navigate to the Billing Accounts screen.

2 In the Billing Account list, drill down on the billing account for which to associate a policy.

3 Click the Policies view tab.

4 In the Policies list, add a record.

The Add Policy dialog box appears.

5 Do one of the following:

■ If the policy already exists, select the policy in the Add Policy dialog box.

■ If the policy does not yet exist, click New to create a new policy.

The Add Policy dialog box closes and a record is added to the Policies list.

6 Complete the necessary fields.

The policy is now associated with the billing account.

NOTE: The billing account type determines how many policies should be associated. If the type 
is Single Policy, then only one policy should be associated.

To associate a billing account with a contact or a company 

1 Navigate to the Billing Accounts screen.

2 In the Billing Account list, drill down on the billing account with which to associate a contact or 
a company.

3 Click the Contacts view tab.

4 Do one of the following:

■ In the Contacts list, click New and either select or add a contact in the Add Contact dialog 
box.

■ In the Organizations list, click New and either select or add a company in the Add Companies 
dialog box.

The selected contact or company is now associated with the billing account.
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To add a service request to a billing account

1 Navigate to the Billing Accounts screen.

2 In the Billing Account list, drill down on the billing account to associate with a service request.

3 Click the Service Requests view tab.

4 In the Service Requests list, add a record and complete the necessary fields. 
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17 Integration

This chapter contains the following topics:

■ “About the Siebel Financial Services Business Platform” on page 189

■ “Siebel Insurance Integration Messages” on page 190

About the Siebel Financial Services 
Business Platform
The Siebel Financial Services Business platform combines a set of tools, technologies, and prebuilt 
functional integration components to facilitate application integration. This set of products are 
referred to as Siebel Financial Services Business Application Integration (EAI). Siebel Financial 
Services EAI is an EAI solution built on top of Siebel EAI offered by Siebel Systems. Siebel Financial 
Services EAI provides an integration solution using industry XML standards. These standards have 
been adopted by the industry and extended by middleware companies such as IBM MQSFSE. 

Siebel Financial Services EAI is designed as a set of interfaces that interact with each other and with 
other components within the Siebel application. These interfaces: 

■ Allow configurable messages within Siebel Tools for exchanging information using the various 
industry XML standards.

■ Expose internal Siebel Objects to external applications.

■ Take advantage of prebuilt adapters and enterprise connectors, and are compatible with third-
party adapters and connectors.

■ Allow prebuilt XML connectors for Siebel applications.

■ Allow for comprehensive data transformation.

■ Allow extension for customized XML connectors by providing the Siebel Industry XML Connector 
Factory API.

For more information on Siebel EAI, see Siebel Financial Services eBusiness Application Integration 
Guide and Overview: Siebel Enterprise Application Integration.
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Siebel Insurance Integration Messages
Siebel Insurance includes a number of integration messages designed to support key business 
processes for the insurance industry. Table 31 describes these messages by defining the message 
type, the message purpose, the target application, and where you can find more information about it.

Table 31. Siebel Insurance Integration Messages

Type Message Target Application Description

ACORD Dwelling Valuation 
Inquiry Request

Replacement Cost 
Estimation System

A message submitting details of a 
dwelling on a home policy in order 
to request for dwelling values.

For information, see Siebel Financial 
Services Connector for ACORD P&C 
and Surety Guide.

ACORD Dwelling Valuation 
Inquiry Response

Replacement Cost 
Estimation System

The response message to a home 
policy request for dwelling values.

For information, see Siebel Financial 
Services Connector for ACORD P&C 
and Surety Guide.

ACORD Home Policy Add 
Request

Policy Administration 
System

A request message to create a new 
home policy.

For information, see Siebel Financial 
Services Connector for ACORD P&C 
and Surety Guide.

ACORD Home Policy Add 
Response

Policy Administration 
System

The response message to a request 
for the creation of a new home 
policy.

For information, see Siebel Financial 
Services Connector for ACORD P&C 
and Surety Guide.

ACORD Home Policy Quote 
Inquiry Request

Rating Engine A message submitting details of a 
home policy rate quote.

For information, see Siebel Financial 
Services Connector for ACORD P&C 
and Surety Guide.

ACORD Home Policy Quote 
Inquiry Response

Rating Engine The response message to a request 
for a home policy quote.

For information, see Siebel Financial 
Services Connector for ACORD P&C 
and Surety Guide.
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ACORD Personal Auto Policy 
Add Request

Policy Administration 
System

A request message to create a new 
personal auto policy.

For information, see Siebel Financial 
Services Connector for ACORD P&C 
and Surety Guide.

ACORD Personal Auto Policy 
Add Response

Policy Administration 
System

The response message to a request 
to create a new personal auto 
policy.

For information, see Siebel Financial 
Services Connector for ACORD P&C 
and Surety Guide.

ACORD Personal Auto Policy 
Quote Inquiry Request

Rating Engine A message submitting details of a 
personal auto policy request for a 
rate quote.

For information, see Siebel Financial 
Services Connector for ACORD P&C 
and Surety Guide.

ACORD Personal Auto Policy 
Quote Inquiry 
Response

Rating Engine The response message to a request 
for a personal auto policy quote.

For information, see Siebel Financial 
Services Connector for ACORD P&C 
and Surety Guide.

ASI Create Life Policy 
Record

Policy Administration 
System

A message to create a new life 
insurance policy.

For information, see Application 
Services Interface Reference.

ASI Inquiry MIB Report Medical Insurance 
Bureau

A message to request a Medical 
Insurance Bureau report.

For information, see Application 
Services Interface Reference.

ASI Notice of Loss Claims Administration 
System

A message to create a claim record 
with initial loss information.

For information, see Application 
Services Interface Reference.

ASI Payment Information Claims Accounting 
System

A message to submit a claim 
payment.

For information, see Application 
Services Interface Reference.

Table 31. Siebel Insurance Integration Messages

Type Message Target Application Description
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ASI Request ParaMed 
Result

Medical Examination 
Service Provider

A message to request for the result 
of a physical examination for a life 
insurance applicant.

For information, see Application 
Services Interface Reference.

IAA Add Party Request; Add 
Party Response

Party Administration 
System

A message to add contact 
information.

For information, see Siebel Financial 
Services Connector for IAA-XML 
Guide.

IAA Delete Party Request; 
Delete Party Response

Party Administration 
System

A message to delete a contact.

For information, see Siebel Financial 
Services Connector for IAA-XML 
Guide.

IAA Find Party Request; 
Find Party Response

Party Administration 
System

A message to query for a contact.

For information, see Siebel Financial 
Services Connector for IAA-XML 
Guide. 

IAA Modify Party Request; 
Modify Party Response

Party Administration 
System

A message to update contact 
information.

For information, see Siebel Financial 
Services Connector for IAA-XML 
Guide. 

IAA Submit Application 
Request; Submit 
Application Response

Policy Administration 
System

A message to submit an insurance 
policy application.

For information, see Siebel Financial 
Services Connector for IAA-XML 
Guide.

IAA Inquiry Financial 
Services Agreements 
Request; Inquiry 
Financial Services 
Agreements Response

Policy Administration 
System

A message to inquire about the 
status of an insurance policy 
application.

For more information, see Siebel 
Financial Services Connector for 
IAA-XML Guide.

Table 31. Siebel Insurance Integration Messages

Type Message Target Application Description
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19 Business Services for Siebel 
Financial Services

This chapter describes the business services for Siebel Financial Services. It includes the following 
topics:

■ “About a Business Service” on page 194

■ “About Siebel Financial Services Business Services” on page 194

■ “VBC Cache and Instance Manager” on page 196

■ “Free Format Converter” on page 201

■ “Data Validation Manager” on page 202

■ “Business Rule Processor” on page 203

■ “Process of Defining Business Rule Processes” on page 204

■ “Creating and Managing Business Rule Processes” on page 205

■ “Defining Properties for a Business Rule Process” on page 208

■ “Defining Procedures for a Business Rule Process” on page 212

■ “Fine-Tuning the Assignment Statement” on page 220

■ “Handling Business Rules Processor Errors” on page 222

■ “Using BRP Helper Business Services” on page 224

■ “Invoking the Business Rule Processor” on page 234

■ “Logging Business Rules Processor Debug Messages” on page 236

■ “Requirements Manager” on page 236

■ “Customer Authentication Manager” on page 245

■ “Using the Calculation Manager” on page 251

■ “Using the Customer Expectations Manager” on page 257

■ “Using Data Transfer Utilities (DTU)” on page 260

■ “Automating Approval Processing” on page 275

■ “Automating the Display of Disclosure Documents” on page 279

■ “SmartScript Integration with Workflow” on page 282

■ “Dynamic UI Business Service” on page 285

■ “FINS Application View Navigation” on page 288
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About a Business Service
A business service is an object that simplifies the use of a specific set of functionality. Business 
services are not tied to specific objects, but rather operate or act upon objects to achieve a particular 
goal. You can use business services to execute predefined or custom actions in a workflow process.

For more information on:

■ Business services, see Overview: Siebel Enterprise Application Integration 

■ Workflows, see Siebel Business Process Designer Administration Guide

About Siebel Financial Services Business 
Services
Siebel Financial Services introduces a number of business services that fulfill a specific need in an 
end-to-end business process. The overall goal with these business services is to reduce the custom 
scripting that customers do during implementation. These business services benefit Siebel Financial 
Services customers in the following ways:

■ Increased efficiency and consistency with automation

■ Rapid deployment of functionality—less programming, and immediately deployable; SRF changes 
are not required

■ Better performance than scripting

■ Ease of maintenance—ability for a business analyst to maintain rules 

For example, the Data Validation business service allows customers to define data validation rules in 
an administration view that users trigger in run time. This significantly reduces the amount of custom 
scripting that would otherwise be required.

Other business services, such as the Disclosure and Approval business services, bring similar 
benefits to customers' disclosure and approval business processes. 
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Table 32 lists the business services available in Siebel Financial Services.

Table 32. Siebel Financial Services Business Services

Business Service Business Applications Functionality

Disclosure Manager Regulatory compliance, 
sales process 
compliance.

Present literature specific to products; logs 
presentation for compliance.

Approval Manager Policy exception 
approvals, underwriting.

Determines necessary approval sources 
and routes to inbox.

VBC Cache and Instance 
Manager

Cache data from external 
applications in Siebel for 
display.

Cache VBC data throughout user's session 
and use Siebel Workflow to query external 
data sources.

Free Format Converter Comma-delimited and 
other free-format 
message creation.

EAI Business Service to convert Siebel data 
to non-XML formats.

Workflow - SmartScript 
Integration

Embed Q&A style 
processes as part of a 
workflow process.

Launch SmartScript sessions within a 
workflow process. Pass information from 
SmartScript back into the workflow process 
for downstream processing.

Using Data Transfer 
Utilities (DTU)

Auto-creation, prefilling. Copies data from one Siebel BO/BC/Field to 
another BO/BC/Field.

Data Validation Manager Conditional logic, data 
integrity control.

Performs data validation across business 
component fields.

Requirements Manager Application closings, 
service case resolution.

Determines requirements and next steps 
for transaction completion.

Customer Authentication 
Manager

Transaction level 
security, regulatory 
compliance.

Situation specific customer authentication 
data collection and logging.

Using the Calculation 
Manager

Lead scoring, payment 
calculations, 
prioritization.

Performs arithmetic functions and if/then/
else calculations in background or through 
UI.

Using the Customer 
Expectations Manager

Customer services 
expectations, fulfillment 
expectations.

Calculates expected and promise dates, 
and sets priorities, based on item type and 
customer value.

Business Rule Processor Definition and execution 
of complex, frequently 
changing business logic.

Higher performance and more scalable than 
scripting. Can change business logic 
without a new SRF. Flexible - supports 
procedure, loops, if-then-else, switch-case 
constructs.
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CAUTION: As with other specialized code, users should use only the specialized business services 
that are documented in Siebel documentation. The use of undocumented services is not supported 
and can lead to undesired and unpredictable results.

VBC Cache and Instance Manager
Integrating external systems with Siebel data in real time is a common business requirement. A 
standard approach is to use Virtual Business Components (VBC) with a substantial amount of 
scripting. This approach, however, often has associated performance and scalability concerns. The 
Caching VBC was originally developed to address integration with external billing systems, and the 
design requires a minimal amount of scripting. These features, however, can be extended and applied 
to a broad set of integration challenges beyond billing.

Caching VBC Overview
The Caching VBC enhances the existing horizontal CSSBCVRec VBC class and works in conjunction 
with the SIA Billing Extern Service business service. Although the name of this business service 
implies that it is billing specific, it is a generic service without any industry specific functionality.

Features of the Caching VBC include:

■ Caching of response data, allowing navigation between records in a parent BC without generating 
duplicate requests in the child VBC

■ Ability to have a VBC be the parent of another VBC child within a single business object

■ Forced refresh of already cached data

■ Ability to generate integration object instances without using the EAI Siebel Adapter business 
service

■ Integration with workflow process that can take advantage of any existing integration flow that 
uses Application Service Interfaces (ASIs), Web Services, or connector technology

Possible limitations to consider:

■ Read-only behavior

Dynamic UI Business 
Service

Create read-only view 
that can be changed 
without the need to 
recompile and redeploy a 
Siebel Repository File 
(SRF).

Create and render views containing a single 
read-only applet in the Siebel Financial 
Services application. 

FINS Application View 
Navigation

View navigation. Guides users through a series of views 
based on administration data.

Table 32. Siebel Financial Services Business Services

Business Service Business Applications Functionality
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■ Only available as part of the Siebel Industry Applications (SIA) product

■ Queries are not supported

■ Only an active field of an active business component will have its value prefilled properly by the 
request integration object

■ The business service only references the top-level from the top-level integration component 
when creating the request message to populate predefault fields.

Components
Figure 3 shows the components to implement the Caching VBC.

Stages of the Caching VBC Process
The caching VBC process uses the following process flow.

1 The Caching VBC invokes the named service when queried.

2 User properties on the VBC identify:

■ Whether or not to enable caching

■ The service name to invoke (SIA Billing Extern Service)

■ The integration object name to be passed to the service as an input parameter

■ The workflow process name to be passed to the service as an input parameter

3 When the VBC is executed, the VBC calls the business service and passes it the integration object 
name and workflow process name.

4 The business service instantiates the named integration object and populates it with values in 
the currently active business object without using the EAI Siebel Adapter.

5 The business service passes the integration object instance to the SiebelMessage workflow 
process property and invokes the workflow process.

6 The workflow process handles any integration tasks, including communicating with the external 
system.

It receives data from the external system and populates a hierarchical process property that 
matches the field structure of the VBC.

7 The workflow process completes.

Figure 3. Caching VBC Components
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8 The business service reads the hierarchical output process property from the workflow process 
property named VBC Output and compares it with the fields in the VBC. 

Where matching field names are encountered, the value in the output process property is copied 
to the VBC. Field names that do not match are ignored and do not generate an error.

Caching VBC Configuration
Base the VBC on the CSSFABCVRec class. Table 33 lists the user properties VBC uses for its 
configuration.

You must also configure the fields for your business component. No other scripting is necessary to 
invoke the service or the workflow.

The VBC uses a special field called Vid. This field is an internally generated unique identifier. It is not 
necessary to create this field in your VBC. However, if you do create this field in your VBC, do not 
modify this value. Considered this field as a system field.

You can create link specifications between parent business components and this VBC, and between 
this VBC and any child VBC. Any field can be used as a link specification.

Table 33. User Properties for VBC Configuration

User Property Name Valid Names Description

Enable Caching Yes or No Yes enables the caching of 
records retrieved by the VBC.

No disables caching.

Outgoing Integration Object 
Name

An integration object name Name of the integration object 
to be passed to the business 
service.

ProcessName A workflow process Name of the workflow process 
to be passed to the business 
service.

Service Name A business service Name of the business service 
to be invoked when the VBC is 
executed.
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Purging the VBC Cache
Purge the VBC cache by configuring a button to invoke method RefreshVBCCache. Table 34 lists the 
consequences if Enable Caching is set to Yes or No.

Business Service Configuration
Base the business services specified in the Service Name parameter of the VBC on the 
CSSFAExternalService class, and have a method named query defined. You do not need to specify 
any input arguments to this method or configure any user properties. In this way, you can reuse this 
business service.

Integration Object Configuration
Use the integration object specified as the Outgoing Integration Object Name user property of the 
VBC to communicate record data between the business service and the workflow process. This 
integration object is non standard because it does not need to have an integration component for all 
the parent business components in the business object hierarchy. For example, if your business 
object hierarchy consists of Contact and the VBC as a child of Contact, you do not need to include a 
Contact integration component as the parent integration component in your integration object.

The reason for this is that this integration object is never used by the EAI Siebel Adapter. Therefore, 
you do not need to include the complete business component hierarchy in the integration object.

The integration object uses the PREDEFAULT user property (Table 35) on integration component fields 
to identify those fields that should be prefilled with data from the active business components:

Table 34. Consequences of Setting Enable Caching

If... Then...

Enable Caching is set to Y. The VBC purges cached values and forces a 
query of the external system.

Enable Caching is set to N. The RefreshVBCCache method has no effect.

Table 35. PREDEFAULT User Property

Integration Component Field 
User Property Valid Values Description

PREDEFAULT [Business Component 
Name.Field Name] 
For example, 
[Contact.Primary Personal 
Postal Code]

Identifies the source business 
component field that the 
Business Services uses to 
prefill the integration 
component field.
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After the workflow process completes, values in the integration component fields that have matching 
names in the VBC are copied back to the VBC. If the integration object has fields that do not match 
the VBC, then those fields are ignored and no error is produced.

Workflow Configuration
The workflow process specified as the ProcessName user property of the VBC is used to identify which 
workflow process the business service should invoke after instantiating the named integration object. 
Table 36 lists the two process properties that must be configured for this process to communicate 
with the business service.

Table 36. Workflow Process Properties

Process Property Name Type Description

SiebelMessage Integration Object The input of the workflow 
process. This is passed in by 
the business service.

Contains the integration 
object instance of the 
integration object identified 
with the Outgoing Integration 
Object Name user property 
on the VBC. This integration 
object instance contains data 
for integration component 
fields that have the 
PREDEFAULT user property 
set as described in the 
Integration Object 
Configuration section of this 
document.

VBC Output Hierarchy The output from the workflow 
process. 

This is returned to the 
business service. Contains 
the integration object 
instance of the result of 
querying the external system 
that is to be returned to the 
business service for inserting 
into the VBC.
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The SiebelMessage process property contains the query parameter for the external system. The 
workflow process transforms this data to a format understood by the external system, then uses a 
transport to send the request and receive the response from the business service. Finally, it must 
transform the response data back to a format that matches the VBC fields. This transformed 
response data needs to be stored in the VBC Output process property so that the calling business 
service can map it back to the VBC.

Free Format Converter
This section describes how to leverage the FINS EAI Free Format Hier Converter business service to 
convert a Siebel property set into a UTF-8 based text file structure for downloading.

Out of the box, the FINS EAI Free Format Hier Converter business service is used in the FINS 
eBanking Account Download Outbound workflow to enable the creation of flat file, tag-based data 
stream for download. The business service follows the same model as the EAI XML converter, but 
provides flexibility for manipulating the output data stream and header information.

If the desired output format is XML-based, use EAI XML Converter, XML Hierarchy Converter, or other 
XML related converter Business Service that Siebel Systems provides. If the file format is not XML-
based, use FINS EAI Free Format Hier Converter.

FINS EAI Free Format Hier Converter Methods
The FINS EAI Free Format Hier Converter business service provides two methods for creating text 
data streams:

■ PropSetToPlainText

■ PropSetToRawText

The difference between these two methods is that the PropSetToRawText method has the 
DiffBeginEndTag, EscCharSupport, and NewLineAfterNode user properties predefaulted. And in the 
PropSetToPlainText method, the following parameters are preset:

■ DiffBeginEndTag = N

■ EscCharSupport = N

■ NewLineAfterNode = Y

PropSetToPlainText and PropSetToRawText User Properties
Table 37 lists the user properties for the PropSetToPlainText and PropSetToRawText methods.

Table 37. User Properties

Parameter Name Description Predefault Value

BeginTagLeft A text value for the left boundary of the begin tag. <

BeginTagRight A text value for the right boundary of the begin tag. >
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Data Validation Manager
Many companies are governed by various regulatory agencies, as well as internal processes and 
procedures, to verify the quality and accuracy of their transactions. Data validation can involve many 
types of transactions, which includes orders, applications, claims, and various other service requests. 

Data validation is a key component of almost every business process in Financial Services. The Data 
Validation Manager business service can validate business component data based on a set of rules. 

DiffBeginEndTag Y or N

If there are different tags for the begin and end tag, 
then for XML, they are the same. Use “,” as the 
separator to set it differently.

For example, if this is set to Y, and the XML tag of 
any component is A,B, then the begin tag is A and 
end tag is B.

N

EndTagLeft A text value for the left boundary of the end tag. <

EndTagRight A text value for the right boundary of the end tag. >

EscCharSupport Y or N

Yes supports escape characters such as \n and \r.

Y

NewLineAfterNode Y or N

Yes prints a new-line character after each element.

N

PrintAggregateEndTag Y or N

Yes prints end tag for aggregate nodes.

Y

PrintElementEndTag Y or N

Yes prints end tag for element nodes (element that 
has no child).

Y

PrintEndTagBeforeChild Y or N

Yes prints the end tag before print out the first 
child.

N

PrintTagBound Y or N

Yes prints the tag boundaries.

Y

XMLHierarchy The IntObj instance that is parsed into the BusSvc.

Table 37. User Properties

Parameter Name Description Predefault Value
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In the case of a rule violation, a custom error message appears or a user-defined error code is 
returned. The validation rules are defined using the Siebel Query Language and can be conveniently 
constructed using the Personalization Business Rules Designer. The business service centralizes the 
creation and management of data validation rules without requiring Siebel Tools configuration, and 
does not require the deployment of a new SRF.

The Data Validation Manager business service significantly reduces the need for custom scripts, 
decreasing implementation costs and increasing application performance.

The Data Validation Manager features include:

■ Search automatically for the proper rule set to execute based on active business objects and 
views.

■ Write validation rules based on fields from multiple business components.

■ Apply a validation rule to a set of child business component records to see if a violation occurs 
from one or more records. 

■ Invoke specific actions to be performed as a result of a validation.

■ Write validation rules that operate on dynamic data supplied at run time without that data being 
from business component field.

■ Automatic logging of data validation events.

Some example business rules that can be enforced by the Data Validation Manager business service 
are:

■ In an insurance company, claim adjusters are required to enter a closed date whenever they 
close a claim. If the adjuster tries to close a claim without a closed date, he is prompted with an 
appropriate error message and the claim record is not committed to the database.

■ In a retail bank, different data validation rules are required for each of dozens of different service 
request types. When a customer service representative creates a new service request, the Data 
Validation manager identifies the appropriate validation rule set for the specific type of service 
request and executes the data validation rules of that rule set.

■ At a health insurance company, customer service representatives use activity plans and activities 
to track service requests. All activities must be closed before the service request can be closed. 
When the CSR closes the SR, the DVM loops through all associated activities making sure the 
status of each activity is closed. If any are still open, the SR cannot be closed.

For more information about Data Validation Manager, see Siebel Order Management Infrastructure 
Guide.

Business Rule Processor
The Business Rule Processor (BRP) business service is a general-purpose, highly-scalable business 
logic execution engine. The business logic is defined from within the Siebel client administration user 
interface, reducing the need to hard-code the logic into the Siebel Repository file. This supports 
scenarios in which there are constant changes to the business rules. The BRP can define and execute 
highly complex business logic.
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You can invoke the BRP by a run-time event, workflow, or Siebel script. This is described in Invoking 
the Business Rule Processor on page 234.

The Business Rule Processor features include:

■ Business logic administration through the application user interface.

■ Appropriate for complex business logic; supports procedure, loops, if-then-else and switch-case 
constructs.

■ Appropriate for business logic that changes frequently. You can modify business logic without 
deploying a new SRF.

■ Query, read, and write access to business components.

■ Error handling.

■ Support logging at multiple levels for easy testing and debugging.

■ Can potentially replace large amounts of custom scripts.

The BRP executes business rule processes. A business rule process is constructed much like a 
computer program or a Siebel workflow. A process consists of procedures. Procedures are made of 
steps. Steps, in turn, contain statements. A statement is a conceptual line of code.

BRP configuration and administration should only be done by expert users accustomed to working 
with business services.

TIP: Before you begin to create a business rule process, you need to carefully consider and plan out 
the required steps for the process.

Process of Defining Business Rule 
Processes
Defining business rules processes involves the following procedures:

1 “About Business Rule Process Property Types” on page 208

2 “Defining Procedures for a Business Rule Process” on page 212

3 “Using BRP Helper Business Services” on page 224
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Figure 4 presents an overview of defining business rule processes.

Creating and Managing Business Rule 
Processes
This topic describes how to create and manage business rule processes.

Figure 4. Business Rule Processor Design Diagram
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About Business Rule Processes
A BRP process is uniquely identified by its name. A process name must begin with a letter. It can 
contain alphanumeric, space, underscore, and hyphen. The name cannot contain other special 
characters like @ or !. 

NOTE: BRP names are case sensitive and limited to 75 characters.

TIP: It is important to establish a naming convention before you engage in the development of BRP 
processes.

About Defining Business Rule Processes
You define business rule processes from the Business Rule Processor screen. You can either revise 
an existing process or create a new one. 

A business rule process is made up of procedures and properties. 

A BRP process can have one of three statuses: 

■ In progress. You can modify only a process in the In-progress status

■ Active. An Active status indicates that the process definition is released for execution

■ Inactive. An Inactive process indicates that the process is in no longer in use and has been retired

NOTE: The status of process indicates its edit disposition rather than its current run-time execution 
status.

Additionally, all BRP process definitions are cached in the object manager across all login sessions to 
improve scalability. Hence, if any modifications are made to the process definitions, then they are 
not available to the run-time sessions until the cache is refreshed. 

It is recommended that you put in place procedures to promote BRP processes from development to 
production, and establish controls on how to refresh the cache.

You can import and export business rule processes. This makes migrating process definitions across 
development and production environments easier. The process is saved as an XML file for importing 
and exporting purposes. 

This step is part of Process of Defining Business Rule Processes on page 204.

To create a business rule process

1 Navigate to the Business Rule Processor screen.

2 Create a new record.

To revise an existing business rule process

1 Navigate to the Business Rule Processor screen.

2 In the Processes list, select a business rule process of status Active or Inactive and click Revise.

Clicking Revise changes the status of the process to In Progress. 
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3 Make the appropriate changes to the process.

To activate a business rule process

1 Navigate to the Business Rule Processor screen.

2 In the Processes list, select the business rule process you wish to activate.

3 Click the Activate button.

Clicking Activate changes the Status from In Progress to Active and makes the record read-only.

4 Click the Refresh Cache button. 

This clears the OM cache and creates a new copy of the process definitions.

Any process that is executing when the cache is cleared is allowed to complete. However, the 
new process definition is available to all processes that start right after the button is clicked.

NOTE: Take care while using this feature. Refresh Cache clears the cache for all BRP process 
definitions. Hence, any processes that are In-progress or Inactive are lost from the cache. 

To export a business rule process

1 Navigate to the Business Rule Processor screen.

2 In the Processes list, select the process you wish to export and click the More Info view tab.

3 In the Processes form, click the Export Process button.

4 Follow the on-screen prompts to save the rule set as an XML file.

To import a business rule process

1 Navigate to the Business Rule Processor screen.

2 Click the More Info view tab.

3 In the Processes form, click the Import Process button.

4 In the Workflow Process Import dialog box, locate the file you wish to import and click Import.

The imported process appears with a status of In Progress.

5 To activate the imported process, select it in the Processes list and click Activate.

Clicking Activate changes the rule set Status to Active and makes the record read-only. 

NOTE: If the process already exists, the process status must be In progress to allow the import.
View imported processes by performing a query/go operation to refresh the Processes list.
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Defining Properties for a Business Rule 
Process
Properties are:

■ Variables that are used either to facilitate flow of data in and out of a process or to store 
information temporarily for the life of the process.

■ Either global process properties or local procedure properties. Global properties are available for 
all procedures that are associated with the business rule process.

The property name:

■ Must begin with a letter.

■ Can contain alphanumeric, spaces, underscore, and hyphen. 

■ Cannot contain other special characters such as an ampersand (@ ) or exclamation mark (!).

■ Are case sensitive and limited to 75 characters.

NOTE: If a procedure defines a local property with the same name as a global property, the local 
property takes precedence over the global property within the scope of that procedure.

This step is part of Process of Defining Business Rule Processes on page 204.

About Business Rule Process Property Types
You can categorize properties into two classes:

■ Simple property types. Scalar properties such as an integer, string, or date.

■ Complex property types. Non-scalar properties such as property sets, vectors, and Siebel 
Business Component references. 

At run time, you can pass values for global properties to the BRP business service as an input 
argument. This run-time value overwrites the initial value definition, if any, on the property.

TIP: Use an appropriate prefix, such as global_, local_, or l_ to designate local and global 
properties.

Complex properties except ProperySet and Vector cannot be passed as inputs to a BRP process.
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Table 38 describes the complex types in further detail.

Table 38. Complex Property Types

Type Description

BusComp This data type stores a reference to a Siebel Business Component (BC) and 
is used in conjunction with the FINS CAP Buscomp Handler business service. 

See Using BRP Helper Business Services on page 224.

BusComp is used within BRP process as a stand-alone BC, without the 
context of Business Object (BO). Hence, you have to explicitly query the 
BusComp with the correct key values to establish a context.

Property Set Property sets are collections of properties used for storing data. They may 
have child property sets assigned to them to form a hierarchical data 
structure. 

See Siebel Object Interfaces Reference.

The Property Set itself can contain child property sets. This is particularly 
convenient to store array-like data. For example, to store multiple contacts 
and their properties such as Name, Phone Number, and Date of Birth. Each 
contact is stored as a child property set of Contacts. At the leaf, the property 
map stores data as a name-value pair.

A property set cannot be instantiated with an assignment. Property sets are 
always instantiated using a business service, such as FINS CAP Buscomp 
Data Loader Service. See Using BRP Helper Business Services on page 224.



Siebel Insurance Guide Version 8.0, Rev. A

Business Services for Siebel Financial Services ■ Defining Properties for a Business Rule 
Process

210 

Vector Vectors are special-formatted Property Sets, where each non-leaf node 
stores a unique key as its value.

NOTE: The vector root node type for a BRP process is always 
SEBLFACapVector.

A vector cannot be instantiated with an assignment. Vectors are always 
instantiated using an business service, such as FINS CAP Buscomp Data 
Loader Service. See Using BRP Helper Business Services on page 224.

The following diagram shows a ProductRate vector that has 2 levels - Region 
& Product name. At the leaf level the vector stores the rate and the balance 
as key value pairs.

Table 38. Complex Property Types

Type Description
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To define a property for a business rule process

1 Navigate to the Business Rule Processor screen and select a process for which you want to create 
global variables.

Vector Reference Vector Reference is a reference to a property set, vector or a child property 
set. Once defined, you can use Vector Reference as a vector or propertyset. 

When the referenced object is reset, the dependent reference is 
automatically set to NULL.

This property set is particularly useful when accessing data on the child 
property sets. There are two ways to make a child Property Set reference:

■ childPropertySetRef = parentPropertySet[strkeyValue]

■ childPropertySetRef = parentPropertySet(nIndex)

About Using Parentheses
Round parentheses ( ) are used to retrieve a child Property Set by index. 

NOTE: The index starts at 0. 

Square parentheses [ ] are used to get a child Property Set by value. 

NOTE: Accessing by value is only valid for Vectors.

Only literals or property names can be used within [ ] or ( ). Expressions 
cannot be used within.

TIP: To use expressions within [ ] or ( ), assign these to a simple property 
type and use the simple property within [ ] or ( ).

You can use square and round parentheses in combination. 

Example:

grandchildPropertySetRef = parentPropertySet(2)["California"]

In the preceding notion, parentPropertySet itself can be a reference. In other 
words, a reference and a property set are used interchangeably for data 
access.

Retrieve leaf properties by using square parentheses [ ]. 

Example:

ProductRate = productRate[productId][domain]["Annual Fee"]

Table 38. Complex Property Types

Type Description
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2 Click the Properties view tab and create a new property completing the fields as necessary.

Some fields are described in the following table.

Defining Procedures for a Business Rule 
Process
Procedures are collections of steps. When a procedure is executed, each step in the procedure is 
executed in sequence.

One of the procedures is designated at the process level as the entry procedure. This procedure is 
executed when the process is executed. Within the entry procedure, other procedures are invoked 
by additional procedure statements.

Field Comments

Sequence Identifies the numeric sequence of this property. The application 
initializes properties in numerical order based on this number.

Data Type The data type for the property. The value can be one of the following. 

Simple types:

■ String

■ Integer

■ Number

■ Date

■ Boolean

Complex types:

■ Property Set

■ Vector

■ Vector Reference

■ BusComp

Value Initial value of the property.

Initial values can be set only for Simple property types.

Output Select this check box to make property an output argument and is used 
to pass information out of the business service. which has no output 
arguments of its own.

This flag does not apply to Complex property types except ProperySet 
and Vector.
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Each procedure is uniquely identified by its name. The name must begin with a letter. It can contain 
alphanumeric, spaces, underscores, and hyphens. It cannot contain other special characters such as 
an ampersand (@), exclamation mark (!), or percent sign (%). Procedure names are case sensitive.

A procedure can have its own local properties. These properties can only be accessed within the 
procedure where they are defined. If a local property has the same name as a global property, the 
local property takes precedence over the global property.

This step is part of Process of Defining Business Rule Processes on page 204.

To define a procedure for a business rule process procedure

1 Navigate to the Business Rule Processor screen and select a process.

2 Click the Procedures view tab, and create a new procedure.

3 In the Properties list, create new records to define local variables for the procedure.

The fields for a local variable are equivalent to those of a global variable. The fields are described 
in To define a property for a business rule process on page 211.

NOTE: Properties defined for a procedure are local variables accessible only to the parent 
procedure. You can define global variables in the Business Rule Processor Properties view. See 
Using BRP Helper Business Services on page 224.

To define a step for a business rule process procedure

1 Navigate to the Business Rule Processor screen, select a process and a procedure.
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2 Navigate to the Steps list and create a new record to define each step for the procedure.

Some of the fields are described in the following table.

3 Drill down on the Step Type and proceed to one of the following steps, depending on the step 
type.

■ “Statement Step” on page 214

■ “Business Service Step” on page 219

■ “Switch Step” on page 220

Statement Step
For a statement step:

Field Comments

Sequence The numerical order in which the steps are executed.

Step Type There are three types of steps:

■ Statement Step. Contains one or more child statements that are 
executed if and when the statement step is executed.

■ Business Service Step. Invokes a Siebel business service. Business 
Service Step provides a way to extend the capabilities of BRP beyond 
its out-of-box features. 

For instance, you could code custom functionality in an eScript and 
then wrapped as a Siebel Business Service. You could invoke this 
Business Service within the Business Service step and exchange 
arguments between the script and the BRP process.

■ Switch Step. Contains switch criterion and a switch block for each 
criteria. The switch block is like a statement step and contains one or 
more child statements.

TIP: Use the switch step if a variable is a bounded variable. From a 
performance and maintenance standpoint, a switch step is better than 
multiple conditional statement steps.

Inactive A check box to activate or inactivate a given step.

Comment A free text field used to document the step.

TIP: Make sure that each step has appropriate comments for ongoing 
maintenance of BRP process definitions.
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a Complete the fields in the Statement Steps form, some of which are described in the following 
table.

b Add one or more records to the Statements list, defining the statements of the statement step. 
Some of the field are described in the following table.

Field Comments

Condition A Siebel Query Language expression evaluated to be TRUE or FALSE. 

If the expression is evaluated to be TRUE, then the statement step is 
executed. If the field is not specified, then the statement step 
executes every time it is encountered.

Example: [SomeIntegerVariable] < 0

Loop If checked, the statement step iterates over and over as long as the 
Condition is evaluated to TRUE.

If neither Condition nor Loop is asserted, then the statement step is 
executed one time, unconditionally.

The looping is counted and compared with the maximum allowed Loop 
Count in order to avoid infinite looping. By default, this number is set 
to 1000, however, you can overwrite this value by defining the system 
preference FINS CAP Max Iteration. If the iteration number exceeds 
the maximum, an error is thrown. Refer to Handling Business Rules 
Processor Errors on page 222 for more information on handling errors.

TIP: Construct a For…next loop, by defining a local variable and then 
either incrementing or decrementing that variable in a statement. On 
the condition, check if the local variable has reached its limit.

Statement Type Value Expression Example

Assignment. 
Evaluates the 
expression and 
assigns the resulting 
value to the property 
listed in the Value 
field.

Name of a local, 
global, and system 
properties 
previously defined 
for the business 
rule process.

A Siebel Query 
Language 
expression.

Procedure. Invokes 
another procedure 
defined inside the 
BRP process.

Name of a defined 
procedure which is 
part of the business 
rule process.

Null and read-
only.
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PropertySet Value. 
Retrieves a property 
value from a property 
set or child property 
set, as defined by 
Expression. This 
property value is 
placed into the 
variable defined by 
Value.

Name of a local, 
global, and system 
properties 
previously defined 
for the business 
rule process.

A property set 
value retrieve 
expression. The 
expression must 
begin with a 
variable of type 
property set, 
vector set 
reference, or 
vector. 

Each index can be 
either a variable 
of type integer or 
number, or 
numeric literal. 
No Siebel 
calculation 
expressions can 
be involved.

EX: 
PropSet[AnIntege
r][“SomeName”]

PropSet(2)[“Som
eName”]

No Siebel 
calculation 
expressions can 
be involved.

Consider a Property Set 
called productRate that 
contains banking 
product information 
organized by Region and 
Product Name.

Retrieve the Annual Fee 
property from the 
Property Set and assign 
this to a local property 
named l_Rate, by 
setting:

Value = l_Rate

Expression = 
productRate["West"]
["Checking"]["Annual 
Fee"]

PropertySet Set 
Value. Assigns a 
value to a property 
set property value.

A property set 
value retrieve 
expression.

If the stated 
property name 
value does not 
exist, a new name/
value pair is 
created. 

Name of a local or 
global property.

If the property is 
not a string, it is 
internally 
converted to a 
string first by 
BRP.

Set the Annual Fee 
property on the Property 
Set productRate, by 
setting:

Value = 
productRate["West"]
["Checking"]["Annual 
Fee"]

Expression = l_Rate

Statement Type Value Expression Example
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PropertySet 
Reference. Creates 
a reference to a 
vector or property 
set. If the referenced 
object is a vector, the 
reference acts as a 
vector. Otherwise, 
the reference acts as 
a property set.

Creates an alias to a 
subset of a property 
set.

A local or global 
property of type 
Vector Reference.

The expression 
must begin with a 
variable of type 
property set, 
vector set 
reference, or 
vector.

Each index can be 
either a scalar 
property or a 
string or numeric 
literal. No Siebel 
calculation 
expressions can 
be involved.

Create a new Property 
Set Reference to all the 
products in the "East" 
region from the 
productRate Property 
Set, and assign this to a 
local variable 
l_east_prod, by setting:

Value = l_east_prod

Expression = 
productRate["East"]

PropertySet Sum. 
Retrieves an 
aggregation value 
from a vector or 
property set.

A local, global 
property.

The property 
should be of data 
type number or 
integer.

A property set 
value retrieve 
expression.

This expression 
differs from other 
property set 
retrieval 
expressions in 
that one of the 
indexes must be a 
wild card, 
indicating 
summing of all 
indices of that 
node. This is done 
by using an 
empty set of 
parenthesis.

If the child 
property set, or 
the property does 
not exist, the 
return value is set 
to null.

Calculate the sum of 
balances under the 
Savings product across 
all regions from the 
productRate Property 
Set, and assign this to a 
local variable 
l_savings_bal, by 
setting:

Value = l_savings_bal

Expression = 
producetrate[]
["Savings"]["Balance"]

Statement Type Value Expression Example
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PropertySet 
Childcount. 
Retrieves the number 
of child property 
sets.

A local, global 
property. 

Property should be 
of data type integer 
or number.

A property set 
reference retrieve 
expression.

If the property set 
does not have a 
child property set, 
the return value is 
0. If the property 
set does not 
exist, the return 
value is -1. The 
latter is a useful 
approach to 
determine if a 
property set, or a 
reference is null.

Calculate the number of 
products available in the 
west region from the 
productRate Property 
Set, and assign this to a 
local variable 
l_west_count, by 
setting:

Value = l_west_count

Expression = 
producetRate["West"]

Table Lookup. Look-
up a value based on 
ranges. The look up 
table is stored as a 
specialized property 
set. The property set 
consists of child 
property sets, and 
the child property 
sets contain three 
properties 
corresponding to 
Lower Bound, Upper 
Bound, and Value. 

At run time, for any 
input value, BRP 
looks up the child 
property set and 
locates the leaf 
whose lower Bound is 
smaller than the 
input value, but 
whose Upper Bound 
is bigger than the 
input value, and 
returns the Value 
property.

A local, global 
scalar property. 

The expression 
follows property 
set retrieval 
syntax, but in the 
following 
specialized 
format:

PropertySet 
[Upper Bound 
Field Name] 
[Lower Bound 
Field 
Name][Return 
Value Field Name] 
[InputProperty]

The Upper Bound 
Field Name, 
Lower Bound 
Field Name, and 
Return Value Field 
Name must be a 
string literal or a 
BRP string 
property. The 
InputPropety 
must be the name 
of a BRP numeric 
property used to 
do the lookup.

Consider a TaxRateTable 
vector, where High, Low, 
and Rate fields define 
the Upper Bound, Lower 
Bound, and Return 
Value. 

Lookup the effective tax 
rate for a person given 
the Total Income and 
assign this to a local 
variable l_tax_rate, by 
setting:

Value: l_tax_rate

Expression: 
TaxRateTable["High"]
["Low"]["Rate"]
[dMyTotalIncome]

Statement Type Value Expression Example
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Business Service Step
For a business service step:

a In the Business Service Step form, complete the fields as described in the following table.

b In the Arguments list, define required input and output arguments for the business service 
invoked. Some of the fields required are described in the following table.

Field Comments

Business Service The name of the business service to invoke. In particular for BRP, 
there are two helper business services that you are likely to use for 
data access: FINS CAP Buscomp Data Loader Service and FINS CAP 
Buscomp Handler.

For more information on these two business services, see Using BRP 
Helper Business Services on page 224.

Method The business service method to use.

BusComp A reference to a Buscomp Property Type.

This field is used only in conjunction with the two BRP helper business 
services, FINS CAP Buscomp Data Loader and FINS CAP Buscomp 
Handler. See Using BRP Helper Business Services on page 224.

Field Comments

Direction Type of argument: Input, Output, or Input/Output.

Name The argument name.

Use the pick list to select the name for registered business services. 
Picking the argument name automatically sets the direction.

Type The mechanics of passing values to the Business Service. Select from 
one of three values:

■ Literal. For Input and Input/Output arguments, the literal string 
in the value field is passed as an input to the Business Service 
method. For output arguments, this selection is invalid.

■ Property. For Input and Input/Output arguments, the value of the 
local or global property is passed as an input to the Business 
Service method. For output arguments, the return value is 
populated into the local or global property.

■ Expression. For Input and Input/Output arguments, the 
expression in the Value field is evaluated and is passed as an input 
to the Business Service method. For output arguments, this 
selection is invalid.
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Switch Step
For a switch step:

a In the Switch Steps form, enter the switch criteria, a Siebel Query Language Expression that 
evaluates to be a string.

b In the Switch Blocks list, create records and complete the fields as described in the following 
table.

c In the Statements list, enter one or more statements. See Statement Step on page 214 for 
details on creating statements.

Fine-Tuning the Assignment Statement
You can use two fields available at the statement level to fine-tune the performance of Assignment 
Statements:

■ Cache Flag

■ Light Parser Flag

For most cases, it is recommended to leave these fields at their default values. It is only necessary 
to consider changing these values if performance is deemed poor.

Value Contains different values depending on the argument type:

■ Literal. Contains the string value. 

■ Expression. Contains the Siebel query expression.

■ Property. Disabled.

Property Local or global property.

This field is disabled for Literal or Expression type arguments.

Field Comments

Value A string value used to compare with the switch step criterion value. 

If they are the same, the switch block is executed, which, in turn, 
executes the child statements belonging to the switch block.

Default If checked, the switch block acts as the default switch block. It is 
executed if no match is found for the switch step criteria.

At any point, you can disengage only one Switch Block as the default 
block.

Field Comments
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About the Light Parser Flag
Within your Siebel application, calculation expressions are evaluated using Siebel Query Language 
Parser. This parser could be performance and resource intensive if the expressions are simple 
numeric. However, to improve performance, BRP includes a high-performance light parser, which is 
used solely to evaluate numeric expressions. In most cases, the light parser works many times faster 
than the Siebel Query Language for simple numeric. 

The following examples are numeric expressions that can be handled by the light parser:

■ 12 + 8 + [A]* [B]

■ 5 + (12 + [A]* ([B] + [C]))

The following examples are considered complex and cannot be handled by the light parser:

■ IIf ([A] > [B], 0, 1)

■ [A] IS NULL

■ LN (10)

When the Light Parser flag is checked, BRP attempts to use the light parser to parse and evaluate 
the expression. If this fails, BRP resorts to Siebel Query Language engine to parse the expression. 
By default, Light Parser Flag is checked. 

TIP: If the Light Parser flag is checked, but the expression is not a simple expression, the BRP logs 
an entry in the log file at run time if the Siebel log level is informational or higher. Use these log 
entries to help you fine-tune assignment statements. See Logging Business Rules Processor Debug 
Messages on page 236 for more information.
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About the Cache Flag
Table 39 shows the options if the Cache flag is checked or unchecked. It is recommended that you 
leave this flag at its default value, that is, checked. 

NOTE: The Cache flag is only meaningful when the expression is not handled by a light parser. 

Handling Business Rules Processor 
Errors
BRP offers a mechanism to handle errors that includes two key features:

■ “Throwing Errors Within a Business Rules Process” on page 223

■ “Recovering From Errors Within a Business Rules Process” on page 223

Table 39. Cache Flag Options

If... Then...

The Cache flag is checked. Only one single parse tree is established for the 
expression within the object manager, 
irrespective of the number of open sessions. 

Therefore, when all sessions share the same 
parse tree, the memory footprint is reduced, 
however an overhead for context switch is 
assumed.

The flag is not checked. Each session has its own parse tree for the 
expression. 

There will be no context switch, but the memory 
footprint is increased. 
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Throwing Errors Within a Business Rules Process
The BRP process definition includes three global system properties to throw errors and provide some 
meaningful information when a run-time error occurs. These properties are presented in Table 40.

After each statement, step, or procedure is executed, the BRP processor checks if System_ErrorCode 
is an empty string. There are two ways to set System_ErrorCode:

■ Manually (Expected Error Conditions). An explicit assignment statement sets a non-empty 
string to System_ErrorCode.

■ Automatically (Unexpected System Error Conditions). The BRP Processor detects a system 
error such as failure to invoke a business service, or failure to evaluate a Siebel query language 
expression, and sets System_ErrorCode to a Siebel error code.

When System_ErrorCode is non empty, an error occurs and the BRP processor uses the following 
syntax to automatically set the error source to the full context of the current execution unit:

Statement Seq (Block Seq) Step Seq Procedure Name

where, Seq represents the sequence number of the Statement, Block, or Step. 

NOTE: Block is optional and occurs only inside a switch step.

The three output global properties System_ErrorCode, System_ErrorMessage, and 
System_ErrorSource are returned back to the calling process. 

Recovering From Errors Within a Business Rules 
Process
For every BRP process, a procedure can be nominated as the error procedure at the process level. If 
defined, when an error condition occurs, this procedure is automatically invoked to handle the error. 

On completion of the error procedure, System_ErrorCode property is rechecked. If it is empty, the 
execution continues from the point where the error was originally thrown. If the error code is still 
populated, the process does not necessarily end, but rather follows an error bubbling process. 

Table 40. Global System Properties for Errors

Property Name Type Description

System_ErrorCode String Alphanumeric error code.

This property contains an empty string when 
there is no error. 

System_ErrorMessage String Descriptive error message.

System_ErrorSource String Current context of the error.
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For example, if an error encounters in Statement 10 Step 5 Procedure Main, the error procedure is 
first executed with System_ErrorSource to be 'Statment 10 Step 5 Procedure Main'. If the error is 
not handled, the error bubbles one level higher, to Step 5 Procedure Main. The error procedure is 
then re-executed with System_ErrorSouce to be 'Step 5 Procedure Main'. If error is handled there, 
the next step following Step 5 is executed. Otherwise, the error bubbles to Procedure Main. 

The whole bubbling process continues until it reaches the process level, with System_ErrorSource to 
be Process myProcessName. If the error is not handled at the process level, the process ends with 
an error.

It is important that the error procedure be thoroughly tested. If an execution error occurs within the 
error procedure, the error procedure will not be recursively invoked; the error procedure will end 
with an error.

TIP: Use a Switch block within the error procedure to check for known error codes.

Using BRP Helper Business Services
In Siebel Financial Services, there are two helper business services that are used as business service 
steps within the BRP. They are both used to facilitate data access with a business rule process. The 
two business services are:

■ FINS CAP Buscomp Data Loader Business Service. The FINS Buscomp Data Loader is used to 
load data for prop sets.

■ FINS CAP Buscomp Handler Business Service. This business service takes the results of 
calculations done within the BRP and then either creates new buscomp records, updates existing 
buscomp records, or queries on calculation results. 

FINS CAP Buscomp Data Loader Business Service
Use this business service to load data from a Siebel business component into a Siebel property set. 
Additionally, once this data is loaded into a property set, it can be cached and shared across all login 
sessions.

This business service exposes three methods:

■ LoadData

■ ClearCache

■ NewVector
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About LoadData Method
Use the LoadData method to load Buscomp data into a property set. The property set follows the 
vector format. Table 41 describes the input and output parameters for this method.

NOTE: Default the Search Spec, Sort Spec, Hierarchical Key, Key Field, Value Field, and Aggregate 
field arguments by defining these as user properties on the source business component. Pre-fix the 
BC user property with FINS Data Loader to identify these fields. 

For example, define the default search spec as the Buscomp user property: FINS Data Loader Search 
Spec.

Table 41. LoadData Method Parameters

Parameter 
Name Direction Description

BusComp Input The name of a Siebel BC.

IsCachedData Input If true, the resulting vector is cached within the OM.   Further 
requests to load data from the same business component are 
handled through the cache. 

Cached data is retrieved based on the business component 
name. If a second retrieval request uses different search 
spec, fields, format, and so on, release the original cached 
data first.

Search Spec Input The search spec applied to the business component when 
loading data.

Since the FINS CAP Data Loader Service works outside the 
context of a business object, the search spec should include 
the appropriate user key fields.

Hierarchical Key 
[n]

Input Hierarchical keys define the hierarchy within the vector. These 
keys identify the unique key at each level.

Specify multiple hierarchical keys by defining [n] = 1, 2, 3 … n

Refer to the ProductRate vector illustrated under Defining 
Properties for a Business Rule Process on page 208. In the 
ProductRate vector, Region and Product fields represent the 
hierarchical keys.
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Sort Spec Input The sort specification applied to the business component 
when loading data.

It is important to match the Sort Spec and the hierarchical 
keys when creating the vector. When a business component is 
accessed through the FINS CAP Buscomp Data Loader 
Service, sorting controls the shape of the parent/child tree 
structure. Records are processed sequentially and are aware 
of only the last parent node key. When children nodes are 
added to a parent node, they continue to be added until a new 
value is retrieved for the hierarchical key. When a new key 
value is discovered, a new parent node is immediate created, 
and children are assembled under that parent. This process 
continues until all records are collected.

If a key equal to a previously processed node is retrieved after 
a different node key has been processed, a new node is 
produced rather than adding to the original.

Field [n] Input The name of Buscomp fields whose values are retrieved as the 
leaf propertyset properties. The property name is the field 
name, and the property value is the field value.

[n]=1,2,…

This represents one approach to how Buscomp fields can be 
retrieved. See Example of LoadData Method Using Field [n] on 
page 227. 

Key Field & Value 
Field

Input Used to retrieve data as Key/value pair and store as a 
property in the leaf propertyset. The field value of the Key 
Field is the name of the property and the value of Value Field 
is stored as the value of the property.

This is an alternative approach to Field [n] to retrieve data. 
See Example of LoadData Method Using Key Field and Value 
Field on page 228.

Duplicate Key/Value pairs are not allowed. If duplicates are 
found when the vector is created, the new entry replaces the 
old entry.

Table 41. LoadData Method Parameters

Parameter 
Name Direction Description
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Example of LoadData Method Using Field [n]
Golden Gate Bank defines its product rates in the Buscomp Financial Product. The fields in the 
Buscomp and some sample data are:

Use the following arguments to retrieve the data and store it in a format as defined by the 
ProductRate Vector sample diagram shown in Vector type in Table 38.

The data is stored into a vector named productRateVector. Then, the rate of the Checking product in 
the East region can be retrieved as:

       productRateVector["East"]["Checking"]["Rate"]

using a PropertySet Value statement.

Aggregate 
Field[n]

Input Fields that will be aggregated if duplicates occur. Multiple 
aggregate fields can be specified by defining [n] = 1, 2, 3 … n

This parameter is useful with the Key Field/Value Field data 
retrieval approach. For example, a contact can have multiple 
income records with different types. If the Aggregate Field is 
defined, the data loader service automatically sums the 
income and stores this as a single income key/value pair.

Vector Output The resultant vector output.

Region Product Balance Rate

West Checking 10000 0.2

West Saving 29000 2.1

West N Market 87560 2.5

East Checking 40000 0.24

Input Argument Name Value

Buscomp Financial Product

IsCachedData Y

Hierarchical Key 1 Region

Hierarchical Key 2 Product

Sort Spec Region, Product

Field 1 Balance

Field 2 Rate

Table 41. LoadData Method Parameters

Parameter 
Name Direction Description
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Example of LoadData Method Using Key Field and Value Field
Golden Gate Bank decides to implement its product rates using a different schema. Instead of one 
record for one product as shown in Example of LoadData Method Using Field [n] on page 227, they 
would like to store the data using name-value pairs for each product. The advantage of this approach 
is that they can add new attributes without schema changes. The data is stored in Financial Product 
Attribute buscomp in the following manner:

Use the following arguments to retrieve the data and store it in a format as defined by the 
ProductRate Vector sample diagram shown in Vector type in Table 38.

About ClearCache Method
Use this method to create an empty Vector or PropertySet. There is one output argument, Vector. In 
BRP, PropertySets and Vectors are uninitialized before they are populated by a business service 
method, for example, the data loader LoadData method. You can use the NewVector method to 
generate an empty PropertySet/Vector.

FINS CAP Buscomp Handler Business Service
FINS CAP Buscomp Handler Business Service provides the ability perform data operations such as 
query, update, and insert within the context of a business rules process. 

NOTE: The business component is established without the context of business object. Pay special 
care to identify the user keys for each record when inserting and setting values. Additionally, the 
normal Siebel error handling resulting from the business object context is not enforced.

FINS CAP Buscomp Handler Business Service provides the following five methods:

■ Query 

■ NextRecord

Region Product Attribute Name Attribute Value

West Checking Balance 10000

West Checking Rate 0.2

West Saving Balance 29000

East Saving Rate 2.1

Input Argument Name Value

Buscomp Financial Product Attribute 

IsCachedData Y

Hierarchical Key 1 Region

Hierarchical Key 2 Product

Sort Spec Region, Product

Key Field Attribute Name

Value Field Attribute Value
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■ GetFieldValue

■ SetFieldValue

■ InsertRecord

All of these methods need a BusComp variable to be defined under the business service step 
definition. See Business Service Step on page 219 for details on defining a business service step.

About Query Method
Use this method to retrieve data from a Siebel business component into a BRP BusComp property. 
Table 42 describes the input and output parameters for this method.

Table 42. Query Method Parameters

Parameter Name Direction Description

ActivateFieldName(1,2,3…n) Input The name of the fields that should be included in the 
query. List each field individually in a sequence.

Any field that you need to use with the GetFieldValue 
and SetFieldValue methods, must be activated prior 
to using these.

There are no limits to the number of fields that can 
be activated, however, care must be taken since this 
affects performance of the query.

BusCompName Input The Name of the business component from which the 
data is to be retrieved.

SearchSpec Input The search spec applied to the business component 
when retrieving data. This is a regular Siebel Query 
Language expression.

Since the business service operates without a context 
of business object, the search spec should include the 
appropriate user keys when the query is used for an 
update.

SearchSpecFieldName(1,2,3
…n)

Input Search Spec Field Name/Value pair is an alternative 
way to set search spec on a field. 

For example, SearchSpecFieldName1=Application 
Flag, SearchSpecFieldValue1=Y, then this is the 
equivalent of setting SearchSpec to be:

   [Application Flag] = Y

SearchSpecFieldValue(1,2,3
…n)

Input
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Figure 5 shows the use of Query method to retrieve data from the FINS Health Provider business 
component.

SortSpec Input The sort specification applied to the business 
component when querying data.

Status Output The status of the query operation. Status can have 
one of two values:

■ Succeeded. Indicates that the query returned at-
least one business component record.

■ Failed. Indicates that either the query returned 
no business component records or the query 
failed due to a system error.

Following any data operation, use the Status field to 
check for error conditions and take appropriate 
actions. See Handling Business Rules Processor 
Errors on page 222 for information on error handling.

Figure 5. Using Query Method to Retrieve Data

Table 42. Query Method Parameters

Parameter Name Direction Description
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About GetFieldValue Method
Use this method to get a value of a Business Component field into a local or global property. Table 43 
describes the input and output parameters for this method.

Table 43. GetFieldValue Method Parameters

Parameter Name Direction Description

BusCompName Input The Name of the business component from which the 
data is to be retrieved.

FieldName(1,2,3…n) Input Name of the fields to be retrieved. 

This field needs to be activated prior to retrieval. See 
Table 42 on page 229.

FieldValue(1,2,3…n) Output The output property into where the field value will be 
written. This is always of type property.

FieldName and FieldValue need to be defined in pairs. 
That is, for each FieldName defined, a FieldValue 
should be defined as well.

Status Output The status of the GetFieldValue operation. The status 
can have one of two values:

■ Succeeded. Indicates that the query returned at-
least one business component record.

■ Failed. Indicates that either the query returned 
no business component records or the query 
failed due to a system error.

Following any data operation, use the Status field to 
check for error conditions and take appropriate 
actions. See Handling Business Rules Processor 
Errors on page 222 for information on error handling.
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About SetFieldValue Method
Use this method to set a value of a business component field. Table 44 describes the input and output 
parameters for this method.

About InsertRecord Method 
Use this method to insert a record into a Business Component. Table 45 describes the input and 
output parameters for this method.

Table 44. SetFieldValue Method Parameters

Parameter Name Direction Description

BusCompName Input The name of a business component where the field to 
be updated is located.

FieldName(1,2,3…n) Input The name of the fields to be updated. 

This field needs to be activated prior to fetching. See 
About Query Method on page 229.

FieldValue(1,2,3…n) Input The new value for the field.

FieldName and FieldValue need to be defined in pairs. 
That is, for each FieldName defined, a FieldValue 
must be defined as well.

Status Output The status of the SetFieldValue operation. 

Status can have one of 2 values:

■ Succeeded. Indicates that the operation 
succeeded.

■ Failed. Indicates that the operation failed.

Use the status field to check for error conditions and 
throw appropriate errors. See Handling Business 
Rules Processor Errors on page 222 for information on 
error handling.

Table 45. InsertRecord Method Parameters

Parameter Name Direction Description

BusCompName Input The name of a business component to which a record 
is to be inserted.

FieldName(1,2,3…n) Input The name of the fields to be included in the insert. 
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About NextRecord Method
Use the NextRecord method to advance to the next record in a list of business component records. 
Table 46 describes the input and output parameters for this method.

FieldValue(1,2,3…n) Input The value for the field.

FieldName and FieldValue need to be defined in pairs. 
That is, for each FieldName defined, a FieldValue 
must be defined as well.

Status Output The status of the InsertRecord operation. 

Status can have one of 2 values:

■ Succeeded. Indicates that the operation 
succeeded.

■ Failed. Indicates that the operation failed.

Following any data operation, use the Status field to 
check for error conditions and take appropriate 
actions. See Handling Business Rules Processor 
Errors on page 222 for information on error handling.

Table 46. NextRecord Method Parameters

Parameter Name Direction Description

BusCompName Input The name of a business component.

Status Output The status of the NextRecord operation. 

Status can have one of 2 values:

■ Succeeded. Indicates that the operation 
succeeded.

■ Failed. Indicates that either the end record has 
reached or the operation failed with a system 
error.

Following any data operation, use the Status field to 
check for error conditions and take appropriate 
actions. See Handling Business Rules Processor 
Errors on page 222 for information on error handling.

Table 45. InsertRecord Method Parameters

Parameter Name Direction Description
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Invoking the Business Rule Processor
A business rule process can be invoked from a workflow or Siebel script. While the processor cannot 
be directly invoked from a run-time event, it can be invoked from a workflow that is triggered by a 
runtime event. For all three of these invocation methods, you can prepopulate global variables 
through the input arguments of the BRP. Input argument names must match the global variables you 
define.

For an example of how to invoke the BRP from a run-time event or a workflow, see the process for 
Data Validation Manager in Siebel Order Management Infrastructure Guide. 

For information on invoking the BRP from with eScript, see Using eScript to Invoke the Business Rule 
Processor on page 235.

NOTE: Within each session, BRP Processor creates a copy of the BRP executable objects. The 
executable objects belong only to a single login session and are not shared. These executable objects 
are cached within a login session. Release processes either explicitly or implicitly when the open 
session is closed.

The FINS CAP Processor Service Business Services exposes three methods. Table 47 describes these 
methods.

Table 47. FINS CAP Processor Service Business Services Methods

Method - Description Input Arguments Output Arguments

LoadProcess - The named 
calculation process definition is 
loaded, and an executable instance 
of the process is instantiated in the 
current Web session.

System_ProcessName - The 
name of a calculation process.

None.

RunProcess - This method executes 
the named process. If the process 
definition has not been loaded, the 
processor loads the definition first.

Whenever a BRP process is 
executed, the processor checks if the 
current process definition cached in 
the OM instance. If not, the 
processor instantiates the process 
definition into the OM instance.

System_ProcessName - The 
name of a calculation process.

System_ErrorCode

System_ErrorMessage

System_ErrorSource 

Return Codes. See 
Handling Business Rules 
Processor Errors on 
page 222.

ReleaseProcess - This method 
releases the named process 
executable in the current Web 
session. This does not affect other 
open Web sessions.

System_ProcessName - The 
name of a calculation process.

None.
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Using eScript to Invoke the Business Rule Processor
The following is an illustration of how to invoke the BRP using eScript. 

Example of Loading the BRP Business Service 
This example provides a sample eScript that loads a BRP process definition.

var psIn  = TheApplication().NewPropertySet();
var psOut = TheApplication().NewPropertySet(); 
var bs    = TheApplication().GetService("FINS CAP Processor Service");

psIn.SetProperty ("System_ProcessName", "MyBRPProcessName");

bs.InvokeMethod("LoadProcess", psIn, psOut)

Example of Running the BRP Business Service
This example provides a sample eScript that executes a BRP process definition. The script also shows 
how to pass an input argument (g_AssetId) to a BRP process.

function WebApplet_PreInvokeMethod (MethodName)
{

if (MethodName == "InvokeMyBRP")
{

var psinputs  = TheApplication().NewPropertySet();
var psoutputs = TheApplication().NewPropertySet();
var oBusObj   = TheApplication().ActiveBusObject();
var oBusComp  = oBusObj.GetBusComp("FINS Group Policy");
var sAssetId  = oBusComp.GetFieldValue("Id");

psinputs.SetProperty ("g_AssetId", sAssetId);
psinputs.SetProperty ("System_ProcessName", "MyBRPProcessName");

var obs = TheApplication().GetService("FINS CAP Processor Service");
obs.InvokeMethod ("RunProcess",psinputs, psoutputs);

return (CancelOperation);
}
return (ContinueOperation);

}
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Logging Business Rules Processor 
Debug Messages
BRP provides different levels of execution logging in the form of trace files to facilitate debugging a 
process. Currently, there are two levels of BRP logging. These levels are detailed in Table 48:

The BRP log level is set with the environment parameter SIEBEL_FACAP_LOG_EVENTS.

BRP logging is written to the Siebel object manager log file. In order to enable BRP logging, the Siebel 
log level must also be informational or higher. For a mobile client, set the workstation system 
environment parameter SIEBEL_LOG_EVENTS = 3.

The SIEBEL_LOG_EVENTS can be set from Server Administration. Refer to Siebel System 
Administration Guide for more information.

In BRP logs, each local property is appended with its procedure name. For example, if a local property 
was defined as local_dMyIncome in Procedure Main, within the log file, this property would be 
identified as Main@local_dMyIncome.

CAUTION: BRP log files can grow quickly. In general, the logs should be enabled only for 
administrators to do debugging. 

Requirements Manager
The section is about the Requirements Manager business service and includes the following topics:

■ “About Requirements Manager” on page 237

■ “Administering Requirements Manager” on page 238

■ “Creating Record Templates” on page 238

■ “Creating Requirement Templates” on page 239

■ “Using Requirements Manager” on page 242

■ “Creating Record Group Templates” on page 242

Table 48. BRP Levels of Execution Logging

Level Severity BRP Implementation

4 Detail Log the execution and initialization path of the BRP process 
without details.

5 Debug Log execution details.

Under this level of logging, the values of local and global 
properties are logged as a part of the assignment statements.

TIP: To check the value of a variable, use a dummy 
assignment step.
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■ “Example of Using Requirements Manager for Record Group Templates” on page 244

About Requirements Manager
The Requirements Manager is a business service that automatically generates activities, customer 
submissions, and workflows required at predetermined steps in the business process. 

For example, a loan applicant may be required to submit proof of employment, account statements, 
and other documents. The Requirements Manager allows a business analyst to specify conditions 
under which certain documents would be required in order to move the application process forward. 
The business service is invoked at a predetermined point during the application process to generate 
the appropriate follow-up activities for customer submissions. 

The Requirements Manager can be applied to a wide variety of usage scenarios including service 
processes such as the auto-creation of a fund transfer service request. Some examples of 
Requirements Manager scenarios are:

■ Life Insurance. A life insurance policy might require a trailing document (a physical exam), an 
activity (such as an interview with an underwriter), and several forms to complete. If the product 
type = life insurance for instance, this set of requirements might be selected. However, an 
exclusion rule might be present to eliminate the need for the underwriter interview if the policy 
was for less than $100,000.

■ Mortgage Application. A mortgage application might require several documents, several 
disclosures, two annual tax returns (documents), an appraisal (activities), and a credit check 
(workflows) to complete. This set of requirements might be run for every mortgage, but there 
might be an exclusion rule such that if the loan-to-value is less than 50%, the tax returns are 
not required.

The Closing Requirement view is preconfigured in the Applications and Life & Annuities screens. You 
can use this to view the output of the Requirement Manager business service, for requirement 
templates defined on the FINS Application, and FINS Life Policy business objects respectively.

Key Features of Requirements Manager
The Requirements Manager business service provides the following key features:

■ Define multiple requirement templates that supports version control

■ Provide support for conditional expression in each requirement template

■ Define record templates that can insert records into any Siebel business object and component

■ Invoke predefined workflows automatically to support the processes

About Invoking Requirements Manager
Requirement Manager is invoked the same as any other business service; through a workflow, run-
time event, or script. At the time of execution, the service evaluates the various templates from 
which to execute, and executes each requirement where the exclusion rule evaluates to false.
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Administering Requirements Manager
Administering the Requirements Manager business service involves the following steps:

1 “Creating Record Templates” on page 238

2 “Creating Requirement Templates” on page 239

Optionally, you can create record group templates in order to aggregate other record group template 
and record templates. See Creating Record Group Templates on page 242.

Creating Record Templates
The Record template is used to define templates that will work in a specific business object/ 
component. It also defines the fields that will automatically populate the template in that business 
object/component. Upon execution, the business service generates a record in the business object/
business component and populates the fields according to the specified template. 

To create a record template

1 Navigate to the Administration - Record Template screen > Record Template view.

2 In the Record Template list, create a new record, and complete the fields.

Some of the fields are described in the following table.

Field Description

Template Name Name for the record template.

Display Name The display name of the template as seen in the UI.

Business Object The business object for the template to be enabled.

For example, to auto populate a record in the Applications or Life & 
Annuities screen, you must select FINS Application or FINS Life 
Policy business objects, respectively.

Business Component Business Component on the selected business object.

The Record Template Administration view is preconfigured so you 
can specify the prefill of two applets in the Closing Requirements 
view: activities and documents. 

For example, to prefill the record in one of these two applets, you 
must select Action or INS Policy Document, or FINS Application 
Mortgage Trailing Documents business component.
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3 In the Fields list, create a new record and complete the fields.

Some of the fields are described in the following table.

4 In the Related Record Template list, create a new record and complete the fields.

The Related Record Template applet is used to specify child and grand child of record templates. 
Upon execution, the business service inserts a record as specified in the parent record template, 
as well as all records specified in child and grandchild templates.

Creating Requirement Templates
The Requirement Template is used to aggregate several record templates. The record template 
specified in Creating Record Templates on page 238 only inserts one record in the business object/ 
business component. Insert multiple records in different business objects/components, by 
aggregating multiple record templates in a single requirement template. Additionally, in a 
requirement template, you can specify a workflow to invoke. 

To create a requirement template

1 Navigate to the Administration - Requirement Template screen > Workflows view.

2 In the Requirement Template list, create a new record and complete the fields.

Some of the fields are described in the following table.

Field Description

Sequence # Sequence number for the fields.

Field Name The field name in the specified business component.

Pre-Default Value The prefilled value for the field.

NOTE: You can put conditional statements on this field.

Business Component Read-only field of the business component name.

Field Description

Template Name Name for the requirement template.

Display Name The display name of the template as seen in the UI.

Business Object The business object for the template to be enabled.

For example, to pick the template name in Applications or Life & 
Annuities screen, you must select FINS Application or FINS Life 
Policy business objects, respectively.
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3 In the Workflow list, create a new record and complete the fields.

Some fields are described in the following table.

Business Component Business Component on the selected business object.

For example, to be able to pick the template name in the 
Applications or Life & Annuities screen, you must select 
Opportunity or FINS Life Policy business components, respectively.

Condition A valid Siebel query language expression. If this conditional 
expression evaluates to True then the rules under the rule-set 
would be evaluated.

TIP: Use the expression builder to test the validity of conditional 
expressions.

Version The version number of the template. 

NOTE: When you select the Revise button, the Siebel application 
automatically versions the template.

Status Status of the template with values: active, pending active, inactive, 
outdated, and in progress.

Start Date Start date for the template.

You can specify a date in the future, and when activated, the status 
of the template changes to Pending Active. The application 
automatically changes the status to Active on the specified date 
and time, and executes the appropriate version of the template.

End Date End date for the template.

The application sets the status of the template to Outdated once 
the specified end date arrives.

Field Description

Sequence # Sequence number for the workflow.

Workflow Name Name of the workflow that is enabled for the business object/
business component specified in the requirement template.

NOTE: The workflow called here should be deployed and active. 
Please see Siebel Business Process Designer Administration Guide 
for further information.

Exclusion Rules A valid Siebel query language expression. If this conditional 
expression evaluates to True, then the workflow is excluded.

Field Description
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4 Click the Record Template view tab.

5 In the Record Template list, create new record, and complete the fields in the list.

Some fields are described in the following table.

6 In the Requirement Template list, click Activate.

7 (Optional) To revise the requirement template, click Revise.

8 (Optional) To deactivate a requirement template, click Deactivate.

Execute Immediately A flag to automatically execute the workflow when the requirement 
template is executed. This field should be empty to execute the 
workflow manually.

See Using Requirements Manager on page 242 for information on 
executing the workflow manually.

Workflow Context A text field passed as process properties to the workflow.

The format of this field should be in the form of comma delimited, 
Name-Value pairs. For example:

“State”, “CA”, “Source BusComp”, “FINS Life Policy”

Where State and Source BusComp are property names, and CA and 
FINS Life Policy are property values, respectively.

Business Component Read-only field similar to the business component specified in the 
requirement template applet. Identifies the business component on 
which the exclusion rules will be evaluated.

Field Description

Template Name Select the template you want to associate with the requirement 
template.

Exclusion Rule A valid Siebel query language expression. If this conditional 
expression evaluates to True, then the record template is excluded.

Expectation Set A flag to automatically invoke the Customer Expectations Manager.

NOTE: The Customer Expectations Manager should be set before 
hand for this to work. Please see Using the Customer Expectations 
Manager on page 257 for more information.

Auto-Assign A flag to automatically invoke the Siebel Assignment Manager.

NOTE: Assignment Manager should be set before hand for this to 
work. Please see Siebel Assignment Manager Administration Guide 
for more information.

Field Description



Siebel Insurance Guide Version 8.0, Rev. A

Business Services for Siebel Financial Services ■ Requirements Manager

242 

Using Requirements Manager
Use the Closing Requirement view, enabled in the Applications and Life & Annuities screens, to view 
the output of the Requirement Manager business service, for requirement templates defined on the 
FINS Application, and FINS Life Policy business objects respectively. However, through configuration, 
the Requirements Manager can be invoked from any screen. 

When invoked, the business service automatically prefills the target list or form with records as 
defined in the Administration - Requirement Template screen. 

To invoke Requirements Manager

1 Navigate to either:

■ Applications screen > Application List view > Closing Requirements view

■ Life & Annuities screen > Life Policy List view > Closing Requirements view

2 In the Templates list, create a new record.

3 Select the template name as defined in Creating Requirement Templates on page 239.

4 In the Templates list, click Execute.

Requirements Manager prefills Activities, Workflow, and Documents lists based on the records 
specified in the Administration - Requirement Template screen.

5 Complete the fields in the Activities, Workflow, and Documents lists.

NOTE: If the workflow is not set to run automatically, you can set the workflow manually by clicking 
Execute in the Workflow list.

Creating Record Group Templates
The Record Group Template is used to define a template that works in a specific business object/
component. The Record Group Template is used to aggregate other record group template and record 
templates. A record group template is based on the business component relationship defined in the 
business object layer. You can use the record group template to recursively execute interrelated 
business components, and generate data in a particular business component. 

A record group template can include other related record group templates and related record 
templates. When the business service executes a record group template, it automatically, recursively 
executes any other related record template or related record group template defined. 

Creating a Record Group Template involves the following steps:

1 Creating Record Group Templates 

2 Creating Related Record Group Templates

3 Creating Related Record Templates

For an example of setting up a record group template, see Example of Using Requirements Manager 
for Record Group Templates on page 244.
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To create a record group template

1 Navigate to the Administration - Record Template screen > Record Group Template view.

2 In the Record Group Template list, create a new record and complete the fields.

Some fields are described in the following table.

3 In the Related Record Template list, create a new record and complete the fields.

You can use the Related Record Template list to specify a child of the record group template. Upon 
execution, the business service inserts a record in the business component on which the record 
template is defined, for the corresponding parent record. 

4 In the Related Record Group Template list, create a new record, and complete the fields.

You can use the Related Record Group Template list to specify the child record group template. 
Upon execution, the business service executes the business component on which this record 
group template is defined, within the context of the corresponding parent record group template.

Field Description

Template Name Name for the record group template.

Display Name The display name of the template as seen in the UI.

Business Object The business object for the template.

Business Component The business component on the selected business object.

Field Description

Template Name Name of the child template record.

Exclusion Rules A valid Siebel query language expression. If this conditional 
expression evaluates to True, then the related record template is 
excluded.

Repeat Expression A field indicating the number of times the record template should 
be executed within the context of the parent record group 
template. By default this is set to 1.

Business Component Read-only field. Identifies the business component on which the 
exclusion rules are evaluated.

Field Description

Template Name Name of the related record group template.

Exclusion Rules A valid Siebel query language expression. If this conditional 
expression evaluates to True, then the related record template is 
excluded.

Business Component Read-only field. Identifies the business component on which the 
exclusion rules are evaluated.
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Example of Using Requirements Manager for Record 
Group Templates
This section provides an example of configuring record group templates for automatically generating 
vehicle coverages.

Record group templates can be used to automatically generate default coverage for vehicles in an 
auto policy. 

To setup auto coverage

1 Navigate to the Administration - Insurance screen > Auto Coverages view.

2 For each auto coverage in the Coverage Administration list, in the Coverage Values list, check 
the default flag for one of the values.

To configure a record group template for generating vehicle coverages

1 Navigate to the Administration - Record Template screen > Record Template view. 

2 Create a new record in the Record Template list, and enter the values as shown in the following 
table.

3 Leave the Fields list empty. 

The predefault values set for the fields in this business component in Siebel Tools will be 
considered during execution.

4 Click the Record Group Template link bar, create a new record in the Record Group Template list, 
and enter the values as shown in the following table.

Field Value

Template Name INS Vehicle Default Coverage

Display Name Auto Default Coverages

Business Object INS Policy

Business Component INS Vehicle Default Coverage

Field Value

Template Name INS Vehicle Available Coverage Value Template

Display Name INS Vehicle Available Coverage Value Template

Business Object INS Policy

Business Component INS Vehicle Available Coverage Value

Condition [Default]='Y'
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5 In the Related Record Template list, create a new record and pick the record template defined in 
Step 2.

6 Create another new record in the Record Group Template list, and enter the values as shown in 
the following table.

7 In the Related Record Group Template list, create a new record and pick the record group 
template defined in Step 2.

To create an new auto policy

1 Navigate to Auto Policies screen and create a new policy.

2 Drill down on the Policy # record to navigate to the Quick Quote view and create the following 
records:

a In the Vehicles list, create new vehicles 

b In the Drivers list, create new driver records

3 Click the Rate Model view tab.

The vehicles list should display the vehicles created in the previous step.

4 Select a vehicle record and click Default Coverages.

The Select Templates to Run dialog box appears, and displays the template defined in Step 6 after 
evaluating any conditional expressions defined.

5 In the dialog box, click Execute.

Default Vehicle Coverages are automatically created in the Vehicle Coverage list for the selected 
vehicle record. These default coverages correspond to the default coverages selected in the 
Administration - Insurance views in Step 2.

Customer Authentication Manager 
Financial service institutions require customer authentication before a financial transaction can take 
place. Furthermore, authentication becomes important as privacy and security regulations have 
become common in the retail banking, and also make their way into insurance and healthcare 
businesses. 

Field Value

Template Name INS Vehicle Template

Display Name Default Vehicle Coverage Template

Business Object INS Policy

Business Component INS Vehicle 
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Typically, a bank may enforce tiered authentication policies that require a basic validation for 
transactions up to certain limit, and require more rigorous transaction-based authentication for 
transactions over the limit. In certain cases, for customers who perform regular high-value 
transactions, the bank may use token validation, common ones being RSA tokens, or scratch lists.

Customer Authentication Manager is a utility that can be used to implement a secure and auditable 
customer authentication during a sales or service process. You can use the Customer Authentication 
Manager to prompt customer service representatives to authenticate a caller before providing any 
service. It provides the following key features:

■ Ability to define multiple authentication templates using fields from the contact profile

■ Rules-based, context sensitive invocation of authentication template

■ Access from the global toolbar

■ Audit trail of past authentication events; facilitates quick and accurate conflict resolutions

■ Ability to define success and failure workflows to take appropriate actions

Administering Customer Authentication Manager business service involves the following steps:

1 “Creating Customer Authentication Templates” on page 246

2 (Optional) “Defining Customer Authentication Rules” on page 248

Creating Customer Authentication Templates
Customer authentication templates define the credentials used for authentication and the actions 
that follow a successful or a failed authentication attempt. 

To create a customer authentication template

1 Navigate to the Administration - Application screen > Authentication Template view.

2 In the Templates list, create a new record, and complete the fields.

Some fields are described in the following table.

Field Comments

Name Name for the authentication template. 

Description Description for the template.

Success Workflow Invoke this Siebel workflow if the authentication is successful. 

The workflow called here should be deployed and active. The fields 
used for authentication are passed as process properties to this 
workflow.

TIP: Use the success workflow to log the status of the 
authentication for audit purposes.



Business Services for Siebel Financial Services ■ Customer Authentication Manager

Siebel Insurance Guide Version 8.0, Rev. A 247

3 In the Credentials list, create a new record, and complete the fields.

Some fields are described in the following table.

Failure Workflow Invoke this Siebel workflow if the authentication failed. 

The workflow called here should be deployed and active. The fields 
used for authentication are passed as process properties to this 
workflow.  

Default If flagged as default, this template is used as the default template. 
The default template is invoked if all rules defined in the 
Authentication Rules fail.

Only one template can be flagged as default.

Alternate Template Defines an alternate template to use for authentication if the caller 
fails to authenticate using the current template. The alternate 
template is invoked by clicking the alternate button on the 
authentication pop up window.

Field Comments

Business Object Business Object for the credential field. 

In the current Siebel release, the Contact business object is the only 
business object that is available for use. Hence, this field is 
predefaulted and read-only.

Business Component Business Component reference for the credentials field.

The business component used here should be a valid business 
component on the Contact business object.

Field Name Name of the business component field.

Only single value fields are supported; multi-value fields are not 
supported and may cause system instability if used.

Display Name The display name for the business component field. This specifies 
the label for the field at run time.

Search Specification For any one-to-many contact business component, the search 
specification provides the criteria to narrow selection to a single 
record.

Required Flag Flag indicates that the field needs to be verified for the 
authentication to be successful. If a required field is not confirmed 
at run time, the authentication fails.

Defaults to No.

Field Comments
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Defining Customer Authentication Rules
Customer authentication rules define the logic to select an authentication template. When the 
authentication manager is invoked, the business service steps through each rule for all applicable 
rule-sets to find a rule that evaluates to true. The template defined against this rule is used for 
authentication. If no rules are defined, or if none of the rules succeed, the default template, if 
defined, is used for authentication.

To create a customer authentication rule

1 Navigate to the Administration - Application screen > Authentication Administration view.

2 In the Rule Sets list, create a new record, and complete the fields.

Some of the fields are described in the following table. 

NOTE: If the conditional expression is not used, there should be only one rule-set per business 
object/business component defined. If there are multiple rule-sets for the same BO/BC, and a 
conditional expression is not defined, then the sequence of examination is random.

3 In the Rules applet, create a new record, and complete the fields.

Some of the fields are described in the following table.

Field Comments

Name Name for the authentication rule set.

Description Description for the rule set.

Business Object Business Object context for evaluating the rules. 

Business Component Business Component context for the conditional expression and 
rules evaluation.

Conditional Expression A valid Siebel query language expression. If this conditional 
expression evaluates to True, then the rules under the rule-set are 
evaluated.

TIP: Use the expression builder to test the validity of conditional 
expressions.

Active Flag Flag to activate or inactivate a rule-set. 

The field predefaults to Inactive.

Field Comments

Sequence Sequence number for rule evaluation.

Business Component Business component reference for the expression evaluation.

This field predefaults to the BC on the rule-set definition, and is a 
read-only field.
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Invoking Customer Authentication Manager
Customer Authentication Manager is available preconfigured on the Contact, Members, and Providers 
screens. However, using Siebel Workflow, you can invoke the Customer Authentication Manager from 
any screen that contains a Contact, Member, or Provider business component. 

Figure 6 shows the authentication icon on the toolbar. Click this icon to invoke the Customer 
Authentication Manager.

To authenticate a contact

1 Navigate to the Contacts List view.

2 Select the contact to authenticate and click the authentication icon on the toolbar.

The Siebel Authentication Manager dialog box appears. 

3 Check the Confirmed checkbox for each field listed.

Inclusion Expression Siebel query language expression that specifies the rule.

If this conditional expression evaluates to True, then the template 
associated with the rule is selected; further evaluation of the rules 
is aborted.

TIP: Use the expression builder to test the validity of Inclusion 
expressions.

Template Name The authentication template to use if the rule succeeds.

Figure 6. Authentication Icon on Toolbar

Field Comments
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4 Do one of the following:

NOTE: When Authentication Manager is invoked, if a matching template is not identified, an error 
message appears.

Configuring Customer Authentication Manager to 
Handle More Fields

By default Customer Authentication Manager is configured to handle only a maximum of three fields. 
To use more than three fields in Customer Authentication Manager, you must add more virtual fields 
to the authentication business component, and expose them through the appropriate applet.

To configure Authentication Manager to handle more fields

1 Log in to Siebel tools.

2 Navigate to the FINS Authentication Manager UI business component.

The following fields are defined for the business component: 

■ Field0, Field1 and Field2 

■ Required Flag0, Required Flag1, and Required Flag2

■ Ten confirmed flag fields

3 Define a new field called, Field3.

4 Define a new field called, Required Flag3.

5 Add a new confirmed flag field if you have more than 10 authentication fields.

6 Navigate to the FINS Authentication Manager Popup Form Applet.

7 Go to applet Control, and add the new fields: Field3, Required Flag3. 

8 Add a confirmed flag field if you have more than five authentication fields. (The applet already 
contains five confirmed flag fields).

9 Add the fields and corresponding labels to the applet templates.

10 Compile the changes into the SRF.

To... Click...

Authenticate. Authenticate. 

If all required fields are confirmed, the 
authentication succeeds. 

Use an alternate template. Alternate. 

If an alternate template is defined, it appears.

Cancel authentication. Cancel.
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Using the Calculation Manager
The Siebel Calculation Manager is designed to allow financial services institutions to declaratively 
define and execute simple to moderately complex calculations within their Siebel application. It is 
implemented as a business service that accepts input parameters for calculation, and the results are 
available as output parameters. The Calculation Manager is tightly integrated into the Siebel 
application architecture and can use Siebel Business component fields for input or output. The 
business service facilitates specification of embedded calculation by business analysts.

Some examples of how Siebel Calculation Manager could be used:

■ Loan Payment Schedule. The term, amount, and interest rate of a consumer installment loan 
are captured in a Siebel Application. Calculation Manager is invoked to generate a schedule of 
the amounts due—split by principle and interest—for each month of the term. The user evaluates 
the schedule, runs several what-if scenarios with different loan amounts, and then exports the 
schedule to an excel spreadsheet.

■ Currency Conversion. A user wants to know the value of $100,000 in Japanese yen at the 
current exchange rate. Calculation Manager is invoked, and an input dialog box is presented. The 
current exchange rate has been prefilled into the dialog box. The user enters 100,000 as an 
input, and clicks Calculate to see the result. The results are not saved.

■ Early Withdrawal Penalty Calculation. A customer wants to remove money from a retirement 
account he holds, but there is a penalty involved. The calculation of the penalty is complex, and 
has been entered into the Siebel application as eScript. Upon invoking the Calculation Manager, 
the Siebel application pulls in the variables necessary for the penalty calculation and runs the 
eScript. The result is saved in the Siebel business component.

Specifying Calculation Rules
Calculations are entered as calculation rules in a list, similar to how validation rules or Siebel 
personalization rules are administered. 

Calculation rules are specified in three stages:

1 Specify a calculation rule-set. 

See To specify a calculation rule-set on page 251.

2 Specify variables used in the calculation. 

See To specify variables on page 252.

3 Specify calculation details. 

See To specify calculation details on page 253.

To specify a calculation rule-set

1 Navigate to the Administration - Application screen > Calculation Manager view.
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2 In the Rule Sets list, create a new record, and complete the fields. 

Some fields are described in the following table.

To specify variables

1 Navigate to the Administration - Application screen > Calculation Manager view.

2 Select a Rule Set for which you want to specify variables.

3 in the Variables list, create a new record and complete the fields.

Some fields are described in the following table.

Field Comments

Name Calculation rule set name. Rule-set names are language 
independent.

Comments Rule set description.

Business Object Business object context for evaluating the rules.

Array Output Business 
Component

Business component context for writing the output of an array 
calculation, such as Amortization table calculation.

Active Flag Flag to activate the calculation rule set. By default a calculation rule 
set is inactive.

Script Flag Flag to indicate that the calculation rule is specified as a script, 
rather than declarative rules.

Type List of values that provide the ability to categorize rules for easier 
administration.

Applet Title Title for the pop-up applet that appears when the calculation 
manager is invoked in the interactive mode.

Field Comments

Sequence Number Sequence number for the variable specification. The variables on the 
pop-up applet appear in the sequence specified.

Name Internal name for the variable used when specifying the calculation 
rule.

Variable names can contain a maximum of 35 characters and cannot 
include spaces or arithmetic operators. 

Display Format Display format for the variable. Example,

$###.##

Display Name Label for the variable when presented to the user.

Type Type of variable. Values are Input, Output, or Output Array.

Business Component Business component context for the variable.
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To specify calculation details

1 Navigate to the Administration - Application screen > Calculation Manager view.

2 Select a Rule Set for which you want to specify calculation details.

BC Field Name Business Component field name.

If the variable is an:

■ Input variable, the run-time value of the business component 
field name is assigned to this variable. 

■ Output variable, the value calculated for the variable is written 
into the business component field name.

Optional Optional variables are variables not critical to the calculation, but 
may be specified to alter the calculation. 

This flag defaults to No.

Default Value Default value for the variable in the calculations. This value appears 
in the dialog box for the variable.

Testing Value Value for the variable when the Calculation Manager is invoked in the 
simulator.

Suppress Display Flag to indicate that the variable is hidden, and not displayed when 
calculation manager is invoked in the interactive mode.

Variable Include Include the variable in the script generation.

Field Comments
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3 In the Rules list, create a new record, and complete the fields.

Some fields are described in the following table.

Example of Using Embedded eScript for Mortgage 
Calculation
For compound calculations, embedded eScript is a more appropriate mechanism. The following is an 
example of a mortgage calculation using eScript.

var Amount= 0;
var NumPeriods= 0;
var Rate= 0;
var InterestPaid = new Array;
var Payment = new Array;
var Period = new Array;
var PrincipleBalance = new Array;
var PrinciplePaid = new Array;

Field Comments

Sequence Number Sequence number for the rule execution. 

Expression Calculation expression. The expression is guided by the following:

■ Operator Support. All basic arithmetic operators, including 
exponents, are supported (+,-,*,/,^). Nested quantities (that is 
parentheses) are also supported. 

■ Simple Calculations. Simple calculations, such as a+b=c, are 
defined in a single row.

■ Compound Calculations. Multiple rows of calculations 
specified in a single Template. This enables multiple variables to 
be calculated independently, and then used in subsequent 
calculations.

■ For-Next Logic. Simple looping enables the generation of 
arrays. Use a For statement and a Next statement to accomplish 
looping. Example: 

■ row 1: For N=1 to Period, 

■ row 2: [calculation] 

■ row3: Next N

For-Next loops may be nested.

■ If-Then-Else Logic. Simple If-Then-Else logic is supported 
declaratively. As in the case of For-Next, If-Then-Else statements 
appear on multiple rows of the calculation set. Nesting of If-
Than-Else statements is supported.
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var PeriodPayment = 0;
var TotalInterest = 0;
var TotalPayment = 0;

function GetInput (Inputs)
{

with(Inputs)
{

var temp;
temp = GetProperty(“Amount”);
if (temp.length!=0)

Amount= ToNumber(temp);

temp = GetProperty("NumPeriods");
if (temp.length!=0)

NumPeriods= ToNumber(temp);

temp = GetProperty("Rate");
if (temp.length!=0)

Rate= ToNumber(temp);

}

}

function Main()
{

Period[0] = 0;
InterestPaid[0] = 0;
PrinciplePaid[0] = 0;
Payment[0] =0;
PrincipleBalance[0] = Amount;
Rate = Rate /1200;
PeriodPayment = Amount / (1.00/Rate - (1.00/Rate)/Math.pow((1.00+Rate), 
NumPeriods));

for(var i=1; i<=NumPeriods-1; i++)
{ 

Period[i] = i;
InterestPaid[i] = PrincipleBalance[i-1]*Rate;
Payment[i] = PeriodPayment;
PrinciplePaid[i] = Payment[i]-InterestPaid[i];
PrincipleBalance[i] = PrincipleBalance[i-1] - PrinciplePaid[i];

}

TotalPayment = NumPeriods * PeriodPayment;
TotalInterest = TotalPayment - Amount;
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}
function Service_PreInvokeMethod (MethodName, Inputs, Outputs)
{

GetInput(Inputs);
Main();
SetOutput(Outputs);
return( CancelOperation );

}

function SetOutput (Outputs)
{

Outputs.SetType("Result");

var psArray = TheApplication().NewPropertySet();
psArray.SetType("Array");
var len = InterestPaid.length;
for(var j=0; j<=len-1; j++)
{

var psArrayElement = TheApplication().NewPropertySet();
psArrayElement.SetProperty("InterestPaid",InterestPaid[j]);
psArrayElement.SetProperty("Payment",Payment[j]);
psArrayElement.SetProperty("Period",Period[j]);
psArrayElement.SetProperty("PrincipleBalance",PrincipleBalance[j]);
psArrayElement.SetProperty("PrinciplePaid",PrinciplePaid[j]);
psArray.AddChild(psArrayElement);

}
Outputs.AddChild(psArray);

var psPeriodPayment= TheApplication().NewPropertySet();
psPeriodPayment.SetProperty("PeriodPayment",PeriodPayment);
Outputs.AddChild(psPeriodPayment);

var psTotalInterest= TheApplication().NewPropertySet();
psTotalInterest.SetProperty("TotalInterest",TotalInterest);
Outputs.AddChild(psTotalInterest);

var psTotalPayment= TheApplication().NewPropertySet();
psTotalPayment.SetProperty("TotalPayment",TotalPayment);
Outputs.AddChild(psTotalPayment);

}

Invoking Calculation Manager
Calculation Manager is invoked from within a Siebel workflow and can be triggered using a mini-
button on an applet. Use a business service step to invoke Siebel Calculation Manger in a workflow.
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Using the FINS Calculation Engine Business Service and the Calculate business service method, set 
the input arguments as described in Table 49. There are no output arguments for this business 
service.

When invoked interactively, the calculation manager displays a pop-up dialog box with the input and 
output arguments. Perform the calculation by entering all input arguments and clicking the Calculate 
button. A second pop-up dialog box appears with the calculated values. Finish the calculation by 
clicking the Cancel button.

Using the Customer Expectations 
Manager
Managing customer expectations around the length of time it takes to complete their requests is 
crucial in maintaining customer satisfaction. Although many financial transactions complete in 
seconds, a number of key relationship—enhancing tasks require lead time of one or more days to 
complete. For example:

■ Bank check deposits may not be available for immediate withdrawal and are subject to clearing.

■ Credit and insurance applications typically undergo an underwriting process where the 
application is evaluated for its creditworthiness, risk profile, and other factors that go into 
approval and pricing. Fast turnaround is a competitive differentiator.

■ Healthcare service complaints and grievances are handled through a structured review and 
appeals process. In many jurisdictions, the processing of the complaints and grievances must 
meet regulatory standards.

The Siebel Customer Expectations Manager (CEM) provides the ability to use historical estimates of 
task completion times to aid the customer service representative in setting expectations for service 
completion. It is most useful in situations where a standardized process is being executed, and there 
is a need to estimate the expected completion date. Siebel CEM has the following two key features:

■ Ability for an administrator to input the factors governing the time to complete task.

Table 49. Input Arguments to Invoke Calculation Manager

Name Type Comments

Rule Expression Name Literal Calculation Rule name

Primary BC Name Literal Primary Business Component name

Primary BC Rowid Process Property Typically the Object Id of the 
Workflow

Save To BC Literal Y or N

Child BC Namen (Optional) Literal Child Business Component name

Child BC RowIdn (Optional) Literal Child Business Component row id
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■ A run-time engine that sets Due Date and Expected Close Date for the enabled objects.

NOTE: For CEM versus Agreements/Entitlement Metrics, it is possible to establish an agreement for 
an account that includes entitlements mandating the completion of Service Requests within specified 
entitlement metrics. When these are setup, and the user navigates to the Service screen, they see 
a Verify button. Clicking this button invokes the calculation of an Agent Committed Time. The 
entitlement metrics will calculate a contracted due date. In contrast, CEM calculates an estimated 
completion time or due date based on how long a process historically takes to complete. In cases 
where a service agreement is in place, the contracted dates take precedence.

Defining Customer Expectation Manager Rules
The CEM administration screen holds the historical estimates for task completion times and the rules 
for selecting an appropriate line. When CEM is invoked, the business service steps through each rule 
for all applicable rule-sets to find a rule that evaluates to true. The estimates defined against this 
rule are used for calculation of expected times. 

To create a CEM rule

1 Navigate to the Administration - Application screen > Customer Expectations Manager view.

2 In the Rule Sets Applet, create a new record, and complete the fields.

Some fields are described in the following table.

NOTE: If the conditional expression is not used, there should be only one rule-set per business 
object/business component defined. If there are multiple rule-sets for the same BO/BC, and a 
conditional expression is not defined, then the sequence of examination is random.

Field Comments

Name CEM rule set name.

Business Object Business object context for evaluating the rules.

Business Component Business component context for the conditional expression and rules 
evaluation.

Conditional Expression A valid Siebel query language expression. If this conditional 
expression evaluates to True, then the rules under the rule-set 
would be evaluated.

TIP: Use the expression builder to test the validity of conditional 
expressions.

Active Flag Flag to activate or inactivate a rule-set.

The field predefaults to Inactive.
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3 In the Rules list, create a new record, and complete the fields.

Some fields are described in the following table.

Field Comments

Sequence Sequence number for rule evaluation.

Business Component Business component reference for the expression evaluation.

This field predefaults to the BC on the rule-set definition and is a 
read-only field.

Conditional Expression Siebel query language expression that specifies the rule.

If this conditional expression evaluates to True, then the estimates 
associated with the rule is selected; further evaluation of the rules 
is aborted.

TIP: Use the expression builder to test the validity of Inclusion 
expressions.

Name Unique name for the rule.

Used to improve performance of the rule-set search during 
execution. Internally, a user key is constructed on the name field.

Schedule Schedule to use for calculating the expected completion times for 
the task.

Schedules govern the working hours, holidays, and downtime. If 
selected, the start time for the task is calculated using the 
schedule. 

Schedules are administered by navigating to the Administration - 
Service screen > Schedules view. Refer to Siebel Field Service 
Guide for details on schedule administration.

Use Employee Schedule If flagged, the employee schedule is used to calculate the start 
time. Employee schedule override the default schedule.

Unit Unit of measure for the preparation, expected and slack times. 
Valid units: Minutes, Hours, or Days.

Preparation Time Queue time for the task. 

Expected Time Expected time to complete the task.

Slack Time Time buffer to allow for deviations from the expected completion 
time.

Auxiliary Field (Optional) Specify Business Component field-value pairs. The 
specified fields are updated with the values based upon the rule 
selected. Example:

"Priority","0-ASAP"
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Invoking Customer Expectations Manager
In the current version of Siebel Financial Services, CEM is enabled for the Service Request object. 

To invoke CEM

1 Click the Calculate Dates button on the Service Request form. 

The CEM business service is invoked, and based on the administrative setup a pop-up dialog box 
appears with the expected completion dates for the service request. 

Closing the dialog box, the expected completion times are written into the current service 
request. 

2 Click the show more button on the Service Request form to view the expected completion times 
in the Internal Tracking - Expected Times section.

Using Data Transfer Utilities (DTU)
This business service allows you to transfer data from a source business component to a destination 
component. For example, a user can enter data in one view, then use a toolbar command to navigate 
to another view. Data entered in the first view is automatically entered in the second view.

About Data Maps
Data maps are the logic defining the flow of data from one location to another. The DTU business 
service uses data maps to transfer data from one location in the Siebel application to another.

This section contains the following topics:

■ Data Map Objects on page 261

■ Data Map Components on page 261

■ Data Map Component Advanced Options on page 262

■ Data Map Fields on page 264
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Data Map Objects
Data map objects indicate the data that is being transferred from the source business object to the 
destination business object. You can use the Administration - Application > Data Map Administration 
screen to define data map objects. Only Siebel administrators should have access to this screen. Data 
map objects are described in Table 50.

TIP: Data map objects are cached in memory. Whenever you make changes to an existing data map 
object, click the Clear Cache button to refresh the cache so that your changes appear.

You can import or export data map objects as XML files through the Data Map Object applet menu 
items: XML Import, XML Export.

Data Map Components
Data map components define the mapping at the child business component level. Each data map 
object can contain multiple data map components. You can arrange data map components in a 
parent-child hierarchy, but you must specify a parent for all except one data map component. The 
parentless data map component is called the root data map component. Data map components are 
described in Table 51.

Table 50. Data Map Objects

Object Description 

Name Data map object name. Enter a unique name.

Source Business 
Object

Source business object name. You must define this name in the Siebel 
Repository file.

Destination Business 
Object

Destination business object name. You can specify the same business 
object as both source and destination business object.

Inactive Check this box to make the data map object inactive.

Table 51. Data Map Components

Component Description 

Name Data map component name. Enter a unique name for each data map 
component in a data map object.

Source/Destination 
Business Component

Source or destination business component name.

If you specify a parent for this data map component, you must define this 
business component in the Siebel repository file as a child of the source or 
destination business object to which the parent data map component is 
mapped.
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Data Map Component Advanced Options
Fine-tune data transfer at the component level by using Advanced Options multi-value fields. Data 
map components advanced options are described in Table 52.

Parent Parent data map component name.

If you:

■ Specify a parent, the parent is mapped to particular source and 
destination business components. Generally, you map the child data 
map component to a child of those source and destination business 
components.

■ Do not want to specify a parent, leave it empty to indicate that this is 
the root data map component. Each data map object can have only one 
root data map component.

Inactive Check this box to make the data map component inactive.

Table 52. Data Map Components Advanced Options

Component Description 

Source Search 
Specification/Source 
Sort Specification

Defines the source Buscomp search spec and sort spec. The value can be a 
literal search spec/sort spec string. It can also contain a named parameter. 
See Using Named Parameters in DTU on page 265. For example:

[Id] = [&ContactId]

where ContactId is a named parameter. At run time, only named 
parameters are replaced by their string values.

Source Record Row 
Number

One can selectively transfer only a subset of source Buscomp records. This 
can be defined in three formats:

■ Start-End

■ Start-

■ Number

For example, 0-5, 4-, 0. 

NOTE: The row number starts at 0.

Operation Override This option allows one to override the operation at the component level. For 
example, if the current operation is Insert, you can use this option to set 
some component to operate Update instead.

Table 51. Data Map Components

Component Description 
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All advanced option values can contain named parameters. At run time, the named parameter is 
substituted by its run-time value. 

If the source Buscomp has been well positioned, the source search spec, the source sort spec, and 
source record row number must be evaluated to be empty at run time, otherwise a wrong advanced 
option error is encountered. See Well-Positioned Buscomps on page 271 for more information.

Advanced Options does not apply to mvg subcomponents.

No Association Y/N. Applicable to buscomps that have association list. By default, it is Y. 
Data Transfer Utilities first try to locate the desired destination record in the 
associate list. If successful, the located record is associated. Otherwise, a 
new record is created.

If N, association of existing records is not attempted. A new record is 
created instead.

Cached Updates The valid values include:

■ Source BusComp

■ Destination BusComp

■ Source/Destination BusComps

This is a performance enhancement option that defers sending SQL 
statements to the database until they can be sent together. Since none of 
the SQL statements is sent until the end, subsequent steps in the block 
cannot be dependant on a previous step having been committed to the 
database.

When you turn on this option, make sure to confirm all SQL statements are 
generated correctly and there is no inter-dependency.

Field Validation Y/N. By default it is Y.

By default, setting field values in a Siebel BusComp triggers field value 
validation. If you have a bounded picklist, the new value is validated against 
the picklist and the fields in the pick maps are set. Disabling field validation 
also turns off picklists. It is a performance enhancement option.

Table 52. Data Map Components Advanced Options

Component Description 
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Data Map Fields
Data map fields define the field-to-field mapping. Data map fields are described in Table 53.

Table 53. Data Map Fields

Field Description 

Source Type/
Destination Type

Type of the source/destination field. Can be: Field, Expression, or 
Parameter:

■ Field. A Siebel Buscomp field as defined in the srf.

■ Parameter. A named parameter. The parameter should be pre-fixed 
with an ampersand (&). See Using Named Parameters in DTU on 
page 265. For example: 

&ContactId

■ Expression. A Siebel calculation expression. See Calculation 
Expressions in DTU on page 266.

Source/Destination. The contents of these fields depends on the source and destination type. 

If the type is:

■ Field, it should be a Buscomp field name.

■ Expression, it should be a Siebel calculation expression.

■ Parameter, it should be a named parameter.

If the destination field is a calculated expression, then the record is not 
used to update the destination Buscomp. Instead, the result of the 
expression, evaluated at run time, is written back into the source field at 
the end of the data transfer operation of the component. 

If the Source is:

■ A Buscomp field, then source Buscomp is updated. 

■ A Parameter, the corresponding named parameter value is updated.

■ An Expression, nothing happens.
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Using Named Parameters in DTU
You can use named parameters to pass in a run-time dynamic value into DTU. For example, imagine 
you want to pull a contact's latest information into your Buscomp. At design-time, you cannot foresee 
what is the contact’s Id. Instead, you use a named parameter, &ContactId, and at run time, you pass 
in the value &ContactId.

Named parameters are defined implicitly in two ways:

■ Business Service Arguments. Pass in the named parameters when DTU is invoked. DTU knows 
an argument is a named parameter if the argument name is prefixed with an ampersand (&). 

For example,

var psinputs, psoutputs;
var myContactId = '0-45TU890';
psinputs = TheApplication().NewPropertySet();
psoutputs = TheApplication().NewPropertySet();
psinputs.SetProperty ("DataMapObj", "My Test DTU Object");
psinputs.SetProperty ("Operation", "Update");

Key Matches the destination records with source records.

For example, the Update operation updates the record in the destination 
business component whose key destination fields all match those of the 
corresponding source fields.

Each data map component in general should contain at least one key field. 

When there is no key defined, if the operation is:

■ Insert, DTU would proceed without checking if a duplicate record with 
the same key fields already exists. 

■ Update, it would update the current destination record. 

If the destination business component is populated with an associated list 
business component, at least one key field is required.

Source/Destination 
Multi-Value Link

This link indicates that the source and destination fields are multi-value 
fields.

Data is transferred from one multi-value field to another by dividing data 
map fields into several subcomponents. All entries with the same source 
and destination multi-value link constitute a subcomponent. Specify a key 
for each subcomponent.

NOTE: Data transfer from a multi-value field to a single-value field is not 
allowed. 

Table 53. Data Map Fields

Field Description 
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psinputs.SetProperty ("&ContactId", myContactId);
var obs = TheApplication().GetService("FINS Data Transfer Utilities");
obs.InvokeMethod ("DataTransfer",psinputs, psoutputs);

&ContactId serves as a named parameter.

The input value of a named parameter can be a calculation expression. In order to do so, set the 
value to:

Expr: "YourExpression"

which is the syntax of Buscomp field predefault. At run time, the expression is evaluated against 
the initiator Buscomp. For more information on initiator buscomp, see the argument description 
in DataTransfer Method on page 268.

■ Assignment by DTU. At run time, you can transfer into a named parameter if the field type is 
Parameter. When this happens, if the named parameter is still not defined, it is instantiated.

A named parameter must be implicitly defined first before it can be used. In other words, un-
assigned named parameters cannot be used.

Named parameters can be used to define Data Map Component Advanced Options, and Data Map 
Field Source or Destination that are of type Expression. 

All named parameters are output into the DTU service output arguments.

TIP: Whenever a named parameter is used in DTU, it should be prefixed with &.

Calculation Expressions in DTU
When Data Map Field Source/Destination Type is Expression, the Source/Destination Fields are 
calculation expressions that follow Siebel Query Language syntax. See Siebel Personalization 
Administration Guide for more information on Siebel Query Language. 

DTU contains two extensions to Siebel Query Language:

1 Curly bracket pair {field}

2 Named Parameter 

Curly Bracket Pair {field}
Use this syntax to refer to a buscomp field at the other business component side. For example, if you 
define the following expression as the source:

{ContactId}

[ContactId] would be evaluated at the destination bsucomp. When {} is involved, please note that 
{} takes the highest precedence over other operator. Thus, if you have an expression like:

‘{Last Name}' +  'Test'

{Last Name} has precedence over quotes "". If the person's last name is Agee, {Last Name} is 
evaluated to be "Agee". As a result, the final value is
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"Agee" Test

instead of 

{Last Name} Test

Named Parameter
A calculation expression can contain named parameters, using the syntax of [&Parameter]. It is 
important to pre-fix the ampersand to indicate a named parameter. For example,

"Sadmin's opportunity #" + [&OpptyId]

For more information on named parameters, see Using Named Parameters in DTU on page 265.

Data Transfer Utilities Methods
This section describes the following Data Transfer Utilities business service methods:

■ DataTransfer Method on page 268

■ FAFireEventxxx Method on page 269

■ GetActiveViewProp Method on page 269

■ TryMockMethod Method on page 270

■ QueueMethod Method on page 270
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DataTransfer Method
The DataTransfer method transfers data from the source business component to the destination 
business component.

Argument Description

Data Map Object 
(Required)

The name of the data map object that defines the mapping.

Operation (Required) Valid entries include Insert, Update, Delete, and Upsert.

GotoView (Optional) The name of a view that appears to users after the data transfer 
operation.

Option (Optional) A text field that allows you to specify additional options for the operation. 
Supported options include:

■ NewSrcBusObj. Force to instantiate a new Source business object. 
Use instead of NewBusObj.

■ NewDstBusObj. Force to instantiate a new destination business 
object.

■ RootNotCommitted. Suggest DTU not to commit the root component, 
if possible.

■ SrcRootAdminMode. Set the source Buscomp of the root data map 
component to Admin mode. This is valid only if the root source 
Buscomp has not been executed.

■ BatchMode. This is a performance enhancement option that 
suppresses runtime events, disables undo, and defers field pre-
defaults until committing the record. Batch mode is only enabled for 
source or destination business objects that are not the active 
(initiator) business object.

The following syntax is recommended for defining Option: 

/option1 /option2 …

For example,

/NewSrcBusObj /NewDstBusObj

Initiator Business 
Object (Optional)

Used as a sanity check. If the BusObject that invokes DTU is different 
from what is specified by the InitBO argument, DTU exits as an external 
error.

Initiator Business Object is part of the invocation context. DTU receives 
a reference of the initiator business object only when invoked from 
Runtime Evens, Buscomp Named Methods, or workflow processes with its 
business object defined. In Siebel Finance, DTU can be invoked without 
an initiator business object. 
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NOTE: It is recommended that you specify both InitBO and InitBC specifically when invoking DTU.

DTU requeries the initiator buscomp when InitSearchSpec, InitSortSpec, InitEnumFlg are used. 

FAFireEventxxx Method
FAFireEventxxx is a hidden method that you can use to create a toolbar command. It invokes the 
method “EventMethodxxx” on the primary business component of the active view. “EventMethodxxx” 
triggers the event manager, which invokes either a workflow or a business service.

GetActiveViewProp Method
This is an auxiliary function to retrieve the active view’s properties. It does not take any input 
arguments.

Initiator Business 
Component (Optional)

By default, the Buscomp that invokes DTU serves as the InitBC. Initiator 
Buscomp plays an important role in determining how records are 
transferred. Use the InitBC argument to set other Buscomp in the 
Initiator BusObject as the Initiator Buscomp.

Initiator Search 
Specification / Initiator 
Sort Specification 
(Optional)

Initiator Buscomp search spec and sort spec. 

Initiator Buscomp 
Enumerate Flag 
(Optional)

Y/N. By default, Initiator Buscomp Enumerate Flag is N. When it is true, 
DataTransfer is applied to each record in the initiator Buscomp. When 
InitSearchSpec or InitSortSpec is specified, InitEnumFlag is implicitly 
true, even if InitEnumFlg is set to N.

MockMethodReplied Y/N.

Argument Description

Business Object Business object name.

View Active view name.

Screen Active screen name.

Thread Applet Thread applet name.

Argument Description
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TryMockMethod Method
This is an advanced auxiliary function for administration of the tool bar button workflow. It does not 
take any input arguments.

QueueMethod Method
Launch a queue method on an applet in another view. When invoked, the UI navigates to the view 
specified, and then the Queue method is invoked on the specified applet.

Other input arguments of this method will be cached into the application Shared Global, which can 
be retried back. 

DTU DataTransfer method has built-in integration with the QueueMethod. When the input argument 
DataMapObject has the format:

SharedGlobal: NameofSharedGlobal

The data map object name can be retrieved from Shared Global with the name NameofSharedGlobal.

Considerations for Data Transfer Utilities
This section contains the following topics:

■ Use of Active Business Objects on page 271

■ Invocation Context on page 271

Is Administration Mode Y or N.

View Mode Code An integer representing Siebel view mode:

■ 0: SalesRep View

■ 1: Manager View

■ 2: Personal View

■ 3: AllView

Argument Description

MockMethodReplied Y or N.

Argument Description

GotoView Name of the view to go to.

Applet Applet name.

Method Queued method to be invoked on the applet.

Argument Description
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■ Well-Positioned Buscomps on page 271

■ Recursive Invocation on page 272

CAUTION: Spool SQL statements during the development stage to verify that all operations are 
performed.

Use of Active Business Objects
Data Transfer Utilities execute inside a client's object manager. 

The DTU reuses the current active business objects. It does not instantiate an independent source 
business object unless directed. This leads to both a leaner memory use and better performance. 
This is even more so if the destination business object is the same as the source business object. In 
such a case, no new business objects are instantiated for the business service. 

Because of the reuse of active objects, you must exercise caution to preserve the current business 
object context. For example, the business components should not be in the query state when DTU is 
launched.

Invocation Context 
DTU in general needs the pass-in of a reference to the active Buscomp. To do so, the business service 
should be invoked from Event Manager, Buscomp Named Method, or a workflow process that is 
invoked by the event manager. However, in Siebel Insurance 7.7, the requirement that one must 
have an active Buscomp is relaxed.

Not all Buscomp events can be used to invoke the DataTransfer method. For example, Query event 
in general should not be used to trigger DataTransfer, as the buscomps are not in an updateable 
state. 

In general, use PreDeleteRecord event; do not use DeleteRecord event. The Siebel event manager 
does not pass in a reference to the active Buscomp in the DeleteRecord event.

Use special care when the service is used with other business services in a workflow. Other business 
services should not interfere the passing of a reference to the active buscomp. Use a spooled sql 
statement to confirm the operations carried out are correct.

Well-Positioned Buscomps
A well-positioned Buscomp is a Buscomp that has been positioned correctly, and whose position 
should not be disturbed. DTU uses the following rule:

■ The initiator Buscomp is a well-positioned Buscomp. 

■ The ascendants of a well-positioned Buscomp are well-positioned.

■ For a given data map component, the buscomps involved in all its parent data map components 
are well positioned.

If the source Buscomp is well-positioned:
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■ Data transfer is only invoked on the current row of the source BusComp. Otherwise, the operation 
is carried out on all rows in the source BusComp at the moment of invocation. 

■ Advanced options such as source search spec, source sort spec should be empty.

If the destination Buscomp is well-positioned:

■ You do not need to specify key fields to retrieve the destination record. Even if you do in this 
case, DTU would ignore them.

■ And if the current operation is Insert, it would change to Update by default, unless overridden 
by Operation Overrides.

Recursive Invocation
By default, you cannot use the DataTransfer operation to invoke another DataTransfer operation. In 
other words, at anytime within a client's object manager, there is only one DataTransfer method in 
the call stack.

Configuring Event-based Commands
The Data Transfer Utilities business service allows you to configure toolbar and menu commands 
based on Siebel Event Manager. 

To configure event-based commands

1 Define a command in Siebel Tools. 

Business Service =”FINS Data Transfer Utilities”. Method = “FAFireEventxxx”. The method name 
can be anything that begins with “FAFireEvent”. When the command is invoked, it, in turn, 
invokes method EventMethodxxx on the primary buscomp of the active view, where xxx is of the 
same value as in FAFireEventxxx.

2 Define a toolbar.

3 Define a toolbar item for the command you defined.

4 In the Siebel client, define a run-time event that will receive EventMethodxxx. 
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5 Navigate to the Administration - Runtime Events screen > Events view, and create a Buscomp 
run-time event as listed in the following table. See Siebel Personalization Administration Guide 
for more information on run-time events. 

Alternatively, you can define a workflow that has a Start step that contains run-time events. 
When the workflow is activated, both the Action Sets and run-time events are created 
automatically for you. See Siebel Business Process Designer Administration Guide.

6 Siebel run-time events are cached. After you make changes, click the Runtime Events applet 
menu item Reload Runtime Events.

7 Configure dynamic enabling of the command. For more information, see Dynamic Enabling of 
Commands on page 273.

8 Define command visibility. 

a In Siebel Tools, navigate to Business Services > FINS Data Transfer Utilities. 

b Define a user property in which Name = MethodName GotoView, and Value = The name of a 
view. MethodName is the name of the command method. 

When you define this user property, this method is enabled only for users who have visibility 
to the view defined in the value. If the method does not contain a GotoView, visibility is not 
imposed on the method.

Dynamic Enabling of Commands
When a command is invoked from a toolbar button or menu, the Data Transfer Utilities business 
service invokes the method EventMethodxxx on the primary business component of the active view. 
The primary business component should be derived from CSSBCBase to allow the invocation to be 
captured by Siebel Event Manager.

When the view is changed, Siebel framework polls each command for the application-level toolbar 
buttons and application menu to determine whether the button or menu items should be made read-
only. 

There are two mechanisms for the dynamic enabling/disabling of commands in DTU:

Field Entry

Sequence -1

Object Type BusComp

Object Name The name of the business component in which the event is invoked. For a 
toolbar command, this is the primary business component in the view in 
which the command is invoked.

Event InvokeMethod

Sub Event EventMethodxxx. Choose the same value for xxx that you chose for 
FAFireEvent.

Action Set Name The action set that invokes Siebel Workflow Manager or a business service.
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■ Srf mode

■ Mock Event Sink

The System Preference FINS DTU Enable FireEvent Mode is used to determine the mode. The value 
should be Srf or Runtime Event. The default value is Srf.

Srf Mode
In the Srf mode, a FAFireEventxxx invocation on a buscomp is enabled if there is a user property 
underneath the FINS Data Transfer Utilities business service as such that the name of the user 
property is: 

Name: FAFireEventxxx Static Enabled BC [n]

Value: Buscomp Name

You can define multiple Buscomps for a FAFireEventxxx method. 

Srf mode is introduced primarily for performance reasons. Compared with Runtime Event mode, it 
allows fast enabling/disabling of a command button without actually invoking a run-time event. Srf 
mode is the default mode.

Mock Event Sink
When System Preference FINS DTU Enable FireEvent Mode is Runtime Event, Data Transfer Utilities 
determines at run time whether a FAFireEventxxx method should be disabled or not by initializing 
Mock Event Mode. It sets up a global mock event flag within the client’s object manager. It then 
invokes EventMethodxxx on the primary business component of the active view. If this 
EventMethodxxx is finally captured by a Mock Event Sink, a global response flag is set. When the 
Data Transfer Utilities finds out the response flag is set by a mock event sink, it enables the 
FAFireEventxxx method for that particular view. Otherwise, the method is disabled.

Mock Event Sinks are specialized business service methods that capture mock events. They check 
whether the client’s OM is in the mock event mode. If not, they do nothing. If so, they reply to the 
mock event by setting the response flag as well as the output argument.

MockMethodReplied = Y.

TryMockMethod in Data Transfer Utilities is a mock event sink. DataTransfer method has a built-in 
mock event sink.

About Defining a Toolbar Button
For information about configuring a toolbar button, see Configuring Siebel Business Applications.
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Automating Approval Processing
In Siebel Insurance, administrators can define a number of approval levels without the need for 
programming, scripting, or configuring. You can define both basic or multiple step approval 
processing levels based on the needs of your organization. You can invoke approval processing from 
a workflow or a run-time event. 

Automating an approval process involves the following steps:

■ Administrator defines approval items and approval stages. 

For more information, see Defining Approval Items and Approval Stages on page 275.

■ Administrator invokes approval processing. 

For more information, see Invoking FINS Approval Item Service from a Workflow on page 276.

■ End users approve or decline an approval stage. 

For more information, see Approving or Declining Approval Stages (End User) on page 278.

Defining Approval Items and Approval Stages
An administrator defines the approval process by creating approval items and approval stages in the 
Approval Administration view. 

To define approval items and stages

1 Navigate to the Administration - Application screen > Approval Administration view.

2 In the Approval Item list, add a record and enter a name in the Approval Item field.

3 In the Approval Flow Type field, select one of the following:

■ Sequential. Indicates this Approval Item is distributed to approvers one after another in the 
sequence specified in the Approval Stage. The application routes the Approval Item to the 
next approver only if the current approver approves the request. If any one approver in the 
approval chain declines the request, the Approval Item is rejected and no further routing is 
conducted. 

■ Parallel. Indicates this Approval Item is distributed to all approvers simultaneously for 
approval. The Approval Item is rejected if at least one approver declines the approval 
request.

Once you have defined an Approval Item, the next step is to define the appropriate approval 
stages. The Approval Item and Approval Stage lists have a parent-child relationship. 
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4 In the Approval Stage list, add a record for each approval stage and complete the necessary 
fields.

Some fields are described in the following table.

End users use the My Approval Inbox view to approve an approval item. For more information, see 
Approving or Declining Approval Stages (End User) on page 278.

Invoking FINS Approval Item Service from a Workflow
Invoke FINS Approval Item Service from a workflow by creating a workflow process in Siebel Tools 
containing the following steps:

■ Start. Initiates the process instance. When the conditions have been met, the application 
initiates the process instance. See Configuring the Start Step on page 277 for details.

■ Business Service. A step in a process in which an automated call is made to the FINS Approval 
Item Service. A workflow process definition can have one or more business service steps. See 
Configuring the Business Service Step on page 278 for details.

■ End. A step in a process that specifies when a process instance is finished. 

In order for your workflow to execute correctly, the Start and Business Service steps must meet the 
minimum requirements described in the referenced sections. For more information on workflows, see 
Siebel Business Process Designer Administration Guide.

Field Comments

Sequence # Identifies the numeric sequence of this Approval Stage in the current 
Approval Item. The application executes Approval Stages in numerical order 
based on this number. 

Approval Type Specifies whether the approver is a position or an employee.

Owner Login 
Name

Indicates the login name tied to this Approval Stage. Relevant only if 
Approval Type is Employee.

Owner Position Indicates the position tied to this Approval Stage. Relevant only if Approval 
Type is Position.
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Configuring the Start Step
Table 54 details some of the start step parameters for the workflow process.

Table 54. Parameters for Start Step

Field Comments Example

Event The specific event that happens to 
the object. The set of available 
events is different for different 
object types.

Use the WriteRecord business 
component event if you want to 
trigger the approval process after the 
record is written to the database.

Use the WriteRecordNew business 
component event if you want to 
trigger the approval process after a 
new record is written to the 
database.

Event Object The name of the application, 
business component, or applet to 
which the event occurs.

Contact

Event Object Type The type of object to which the 
event occurs. This can be an 
application, business component, 
or applet.

BusComp

Name The name of the Next step branch.

The name of the branch must be 
unique or you cannot import or 
export the workflow process. 

Next Step The name of the step that follows 
when conditions are met. 

Picklist of existing process steps. 

Type The type of branch. The value can be one of the 
following: 

■ Condition. This value indicates 
that a condition is defined for the 
branch.

■ Default. This value indicates that 
if nothing else is satisfied, then 
this branch is followed. 
Additionally, if this value is used, 
any conditions defined for the 
branch are ignored.
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Configuring the Business Service Step
Table 55 and Table 56 detail some of the business service step parameters and input arguments for 
the workflow process.

Approving or Declining Approval Stages (End User)
End users approve approval items in the My Approval Inbox view. Users can view approval items by 
login name or position. For more information on setting up approval processing, see Defining Approval 
Items and Approval Stages on page 275.

To approve or decline an approval stage

1 Navigate to the My Approval Inbox screen.

2 Select one of the following views:

■ My Approvals. Displays all approval items associated with the user’s login name. 

■ My Position Approvals. Displays all approval items associated the current user’s position. 

3 To view additional details about an approval item, drill down on the Approval Identifier link.

4 In that Status field, select Approve or Decline.

Once you select a status, the application populates the Approval By and Approval Date field and 
sets the record to read-only.

Table 55. Parameters for Business Service Step

Field Value

Business Service FINS Approval Item Service

Method Create Approval Stage

Table 56. Input Arguments for Business Service Step

Input Argument Property Name Comments

Approval Item ID Object Id Row Id of the object (for example, a Service 
Request) that needs approval processing.

Approval Item Name Approval Item Name Name of the Approval Item defined in the 
Approval Administration view.

Requesting Buscomp Requesting Buscomp Name of the buscomp object (for example, a 
Service Request) that needs approval 
processing.
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Automating the Display of Disclosure 
Documents
Disclosure processing allows companies to comply with internal company policies and external 
regulations. These policies and regulations require they display disclosure statements or external 
documents to users, and then record whether or not they have read and understood them. 
Implementing the automatic display of disclosure documents involves the following steps:

■ Set up a disclosure by associating it with a product and literature. 

For more information, see Setting Up Disclosures on page 279.

■ Activate the appropriate workflows. 

For more information, see Understanding and Activating Disclosure Workflows on page 280.

■ Invoke the Disclosure UI Service business service. 

For more information, see Invoking the Disclosure UI Service Business Service on page 281.

■ View a disclosure history. 

For more information, see Viewing Disclosures Associated with Contacts (End User) on page 282.

Setting Up Disclosures
To implement disclosure processing, you must associate each disclosure with a product and then, if 
applicable, with the appropriate document. 

To associate a disclosure with a product

1 Navigate to the Administration - Product screen > Disclosure view.

2 In the Product form, query for the product.

3 In the Disclosure list, add a new record, and complete the necessary fields.

4 To activate a disclosure, select it in the Disclosure list, and click Activate.

Clicking Activate, changes the Status from In Progress to Active and makes the record read-only. 

To revise an existing disclosure

1 Navigate to the Administration - Product screen > Disclosure view.

2 In the Product form, query for the product.

3 In the Disclosure list, select the disclosure to be revised, and click Revise.

Clicking Revise creates a new version of the disclosure and sets its status to In Progress.
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4 Make the appropriate changes to the new disclosure, and click Activate.

Clicking Activate, changes the Status from In Progress to Active and makes the record read-only. 
The prior version of the disclosure still appears, but displays a Status of Outdated.

5 To associate literature with a disclosure, add a new record in the Literatures list, and complete 
the necessary fields.

For more information on loading literature into Siebel Insurance, see the sharing literature discussion 
in Siebel Applications Administration Guide.

Understanding and Activating Disclosure Workflows
Siebel Insurance includes three workflows that help manage the display of disclosure documents and 
disclosure event logging. Table 57 describes each workflow.

Table 57. Disclosure Workflow Processes

Workflow Process Comments

FINS Disclosure The FINS Disclosure Workflow process accomplishes the following 
tasks:

1 Invokes the Setup method of the Disclosure UI Service 
business service. Invoking this method sets up the 
appropriate disclosure documents based on the selected 
product.

2 Calls the FINS Disclosure Goto File View subprocess. This 
sub-process navigates users to the Disclosure Documents list, 
where they can review all the disclosure documents pertaining 
to the selected product. This subprocess also navigates users 
back to the previous view after they accept or decline the 
disclosure. This final navigation step is accomplished by 
invoking the View Back method of the Disclosure UI Service.

3 Calls the FINS Disclosure Create Activity Sub Workflow 
subprocess. If the user accepts the disclosures, the workflow 
calls the FINS Disclosure Create Activity Sub Workflow 
subprocess to log the disclosure activity.

FINS Disclosure Goto File 
View

This subprocess navigates users to the Disclosure Documents list, 
where they can review all the disclosure documents pertaining to 
the selected product. This subprocess also navigates users back to 
the previous view after they accept or decline the disclosure. This 
final navigation step is accomplished by invoking the View Back 
method of the Disclosure UI Service.

FINS Disclosure Create 
Activity Sub

If the user accepts the disclosures, this sub process logs the 
disclosure activity.



Business Services for Siebel Financial Services ■ Automating the Display of Disclosure
Documents

Siebel Insurance Guide Version 8.0, Rev. A 281

Before you can display disclosure documents, you must:

■ Deploy the workflow processes using Siebel Tools. 

For more information, see Siebel Business Process Designer Administration Guide.

■ Activate the workflow processes described in Table 57. 

For more information, see To activate the workflows used to display disclosure documents on 
page 281

■ Invoke the Disclosure UI Service business service. 

For more information, see Invoking the Disclosure UI Service Business Service on page 281.

To activate the workflows used to display disclosure documents

1 Navigate to the Administration - Business Process screen > Workflow Deployment view.

2 In the Repository Workflow Processes list, use a query to find all processes where the Name field 
contains the word Disclosure. 

NOTE: You can query on *Disclosure*.

3 Activate each workflow process shown in Table 57 on page 280, that has a status of Inactive.

a Select the workflow process record.

b Click Activate.

4 To verify that the Status is Active for each process:

a In the lower Active Workflow Processes list, query again for Name = *Disclosure*. 

b For each process, check that Deployment Status = Active.

Invoking the Disclosure UI Service Business Service
You can invoke the Disclosure UI Service from a workflow. This section describes some of the possible 
steps you can include to enable this invocation. You may need to modify and expand on this 
procedure to accommodate more complex business requirements. The workflow process you create 
must contain the following steps:

■ Start. Initiates the process instance. When the conditions have been met, the application 
initiates the process instance. 

■ Sub Process. Calls the FINS Disclosure Workflow. When creating this step, you must populate 
the following inputs:

■ Contact Id. The Row Id of the contact who places the order of the product.

■ Disclosure Name. The name of the Disclosure that relates to the product.

■ Product Id. The Row Id of the product that the customer has ordered.

■ End. A step in a process that specifies when a process instance is finished. 
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For more information on workflows, see Siebel Business Process Designer Administration Guide.

Viewing Disclosures Associated with Contacts (End 
User)
All end users can view disclosures associated with a specific contact on the Contacts Disclosures 
view. This view is read-only and displays the:

■ Disclosure name

■ Date the disclosure was presented to the user

■ Date the user acknowledged the disclosure

■ Date the user accepted the disclosure

For more information on setting up disclosure processing, see Automating the Display of Disclosure 
Documents on page 279.

To view a disclosure history

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact.

3 Click the Disclosures view tab.

SmartScript Integration with Workflow
You can invoke a SmartScript from a workflow process and pass parameters from the SmartScript to 
the workflow process. These business services support SmartScript integration with workflow:

■ FINS Web Shopping Service. 

For methods, see FINS Web Shopping Service Methods on page 284.

■ FINS SmartScript Output Service. 

For methods, see FINS SmartScript Output Service Methods on page 285.

NOTE: In order to completely understand the concepts in this section, familiarity with SmartScript 
is required. For more information, see Siebel SmartScript Administration Guide.

For a detailed explanation about how to integrate SmartScript with Workflow, see Example of 
Integrating SmartScript with Workflow on page 283.
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Example of Integrating SmartScript with Workflow
The scenario outlined in this section is an example of how to insert a SmartScript in a workflow 
process. After the SmartScript ends, the workflow proceeds to the next step in the workflow process. 
Your company may follow a different workflow that fits its business requirements.

In this scenario, you are designing a SmartScript that allows customers to complete a loan 
application online. After the loan application is complete, your workflow verifies the customer’s 
address in an external system.

To configure SmartScript integration with Workflow

1 In the SmartScript, create Save User Parameters for the parameters you want to pass to the 
workflow. For more information on SmartScript user parameters, see Siebel SmartScript 
Administration Guide.

2 Create a Business Service step for your workflow, using the FINS Web Shopping Service business 
service, and enter the input arguments described in Table 58 on page 284.

3 Create a subprocess to invoke the SmartScript using the workflow User Interact step. The 
subprocess is based on the SmartScript Player business object and has three steps: a start step, 
a user interact step, and an end step. 

a In the user interact step, set the view name to FINS SmartScript Player View (App).

b In the Next Step’s applet, add two conditions, entering the information listed in the following 
tables:

Entries for Record 1 (first condition):

Entries for Record 2 (second condition):

Field Entry

Branch Name Cancel

Type Condition

Next Step End

Event Object Type Applet

Event Invoke Method

Event Object Smart Script Player Applet (FINS 
eSales App)

Subevent CancelScript

Field Entry

Branch Name Finish

Type Condition
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4 Add a Business Service step using the FINS SmartScript Output Service business service. Enter 
the output arguments described in Table 59 on page 285.

Now you may either end your workflow process or include additional steps, depending on your 
company’s business requirements. The SmartScript is integrated in your workflow process.

FINS Web Shopping Service Methods
The FINS Web Shopping Service business service methods are described in Table 58.

Next Step End

Event Object Type Applet

Event Invoke Method

Event Object Smart Script Player Applet (FINS 
eSales App)

Subevent FinishScript

Table 58. FINS Web Shopping Service Methods

Method Description / Arguments

SetSmartScriptName Input Arguments:

■ Script Name (Required): The name of the SmartScript you want to 
invoke.

■ SSUserParameter# (Required): A SmartScript user parameter 
between 1 and 20. 

For example, SSUserParameter1. The value for the input argument 
must be the exact name of the user parameter specified in the 
SmartScript, whose value needs to be passed into the workflow 
process at the conclusion of the SmartScript.

Field Entry
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FINS SmartScript Output Service Methods
The FINS SmartScript Output Service business service methods are described in Table 59.

Dynamic UI Business Service
This business service and associated administration views allow you to create and render views 
containing a single read-only applet in the Siebel Financial Services application. These views and 
applets, called dynamic applets, allow business analysts and developers to make frequent changes 
to the user interface without the need to recompile and redeploy a Siebel Repository File (SRF).

The following topics are included in this section:

■ Example of Creating a Dynamic Applet with the Dynamic UI Business Service

■ Displaying Dynamic Applets in a Workflow

Example of Creating a Dynamic Applet with the Dynamic 
UI Business Service
The scenario outlined in this section is an example of a Dynamic UI Service in a workflow process. 
Your company may follow a different workflow that fits its business requirements.

You would like to set up your company’s user interface to dynamically display read-only views at run 
time, based on user input. For example, a customer requests a quote for an auto insurance policy. 
The policy includes the option to cover additional drivers. After the customer enters additional driver 
information, the workflow process uses a Dynamic UI applet to display a read-only list of the 
additional drivers for review. Customers can review the list, then select an option to continue the 
process.

To set up a similar user interface for your business, follow the instructions that follow.

Table 59. FINS SmartScript Output Service Methods

Method Description / Arguments

SetOutput Reads the SmartScript user parameters and outputs them as workflow 
properties:

Output Arguments:

■ The name of the user parameter. Specifies the SmartScript user 
parameters as output arguments, and passes the value of the user 
parameters back to the workflow process when the SmartScript ends. 
These output arguments can be mapped to process properties.

■ SmartScript Result Action: Returns the action users take to end the 
SmartScript. Possible values are Finish or Cancel.
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To create a dynamic applet 

1 Navigate to the Administration - Finance screen > Dynamic Applet Administration view.

2 In the Dynamic Applet list, click New, then enter the view alias and view name. 

The view alias must be a unique name. The view name is a picklist of the views defined in the 
Template Definition view.

3 Step off the record. The Applet Instance list automatically displays the name of the applet 
template defined for this view.

4 In the Applet Instance list, enter the applet title, business object name, and business component 
name. 

The business object and business component determine the fields to display for this applet.

5 If you want to set up a default search specification, enter:

■ Business component field. Specifies the field on which to base your search.

■ Default. Specifies a default value for which you want to search. 

6 In the Field Control list, add a new record for each field you want to display. Each field control is 
displayed as a read-only text box with a text label. For each record, enter:

■ Display Sequence number. Indicates the display order for the field. For list applets, the order 
is left to right. For form applets, the order is left to right and top to bottom.

■ Field name. The business component field whose value you want to display.

■ Caption. The display label for the field.

7 In the Button Control list, add a new record for each button you want to display. Enter the 
sequence number, caption, and method for each button.

■ Display Sequence. Indicates the display order for the button, from left to right.

■ Caption. The display label for the button.

■ Method. The method invoked when the button is clicked. The method name must begin with 
FrameEventMethod. For example, FrameEventMethodContinue.

Displaying Dynamic Applets in a Workflow
Workflows can invoke a dynamic applet as part of a process defined for a product application. This 
feature enables an application administrator to establish applet instances without requiring 
recompilation and redeployment of individual applets. 

To integrate the dynamic applet in a workflow

1 Create a subprocess based on the FINS Dynamic UI business object.

2 Add a Dynamic UI Service business service step and invoke the Set View Name method described 
in Table 60 on page 287.
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3 (Optional) Add a second Dynamic UI Service business service step and invoke the AddRecord 
method described in Table 60 on page 287.

4 Add a User Interact step to display the dynamic applet. 

a For the view property of the User Interact step, enter the view template name defined in Step 2 
of Example of Creating a Dynamic Applet with the Dynamic UI Business Service.

b For each button that may be clicked in the dynamic applet, add entries into the Next Steps list 
applet of the User Interact step. The following is an example of such an entry:

The Dynamic UI Service business service methods are described in Table 60.

Creating a View Template for Dynamic Applets
Creating a view template involves first creating views and applets based on specialized applet classes 
within Siebel Tools. These views and applets contain placeholder fields. Placeholder fields are applet 
controls that are not mapped to any particular business component. The views and applets will then 
form the basis of view templates and applet templates. You can use a single view and applet template 
to create any number of dynamic applets. 

Field Entry

Branch Name Continue Button

Type Condition

Next Step End

Event Object Type Applet

Event InvokeMethod

Event Object FINS Dynamic UI List Applet

Subevent FrameEventMethodContinue

Table 60. Dynamic UI Service Methods

Method Description / Arguments

Set View Name Input Arguments:

View Alias (Required): The view alias defined in Step 2 of Example of 
Creating a Dynamic Applet with the Dynamic UI Business Service.

AddRecord 
(Optional)

Overrides the default search specification value.

Input Arguments:

■ Business Component Name (Required): The name of the source 
business component.

■ Object ID (Required): The row ID of the business component.
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Two templates are provided as part of seed data: a view template containing a list applet template, 
and a view template containing a form applet template. The view templates are named as follows:

■ FINS Dynamic UI Form view. A view template that contains a form applet template.

■ FINS Dynamic UI view. A view template that contains a list applet template.

For more information about creating views and templates within Siebel Tools, see Using Siebel Tools.

When creating dynamic applets in Siebel Tools, note the considerations listed as follows. (Use of the 
word applet in the following bulleted list refers to applets created in Siebel Tools.)

■ When setting applet class, use:

■ CSSFrameListFADynamicUI for list applets

■ CSSFrameFADynamicUI for form applets

■ If using a preconfigured business component, the applet business component should be FINS 
Dynamic UI.

■ If you create your own Virtual Business Component (VBC) in Siebel Tools, the business class 
should be CSSBCVDynamicUI.

Dynamic Applet supports 20 fields and five currency codes (that is, five types of currency value). 
In your new VBC, all field names should start with the prefix Field and a number value, (for 
example, Field0..., Field19). All currency code fields should start with the prefix Currency Code 
and a number value, (for example, Currency Code0..., Currency Code4).

■ It is recommended that applets based on the same VBC have their corresponding views use a 
different business object.

Once the views and applets have been created in Siebel Tools, in order to define them as view 
templates and applet templates, they must be added to the Template Definition view.

To add views and applets to the Template Definition view

1 Navigate to the Administration - Finance screen > Dynamic Applet Administration view > 
Template Definition view.

2 In the Template Definition list, click New, and then enter the view name. 

3 In the Applet Template Definition list, click New, and then enter the applet name.

FINS Application View Navigation
The FINS Application View Navigation Service guides users through a series of views based on 
administration data. The view list is dynamically generated according to the products associated with 
the current record. It replaces the Next/Previous button functionality, known as the FINS Application 
Workflow, in previous releases. 

The following topics are presented in this section:

■ Business Service Methods on page 289

■ Business Service Behaviors on page 289
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■ Business Service Administration on page 290

■ Example of FINS Application View Navigation on page 290

■ Upgrade Note on page 291

Business Service Methods
The business service has two methods:

■ GetNextViewName. Gets the next view name without view navigation.

■ GotoNextView. Navigates to the next view.

Table 61 describes the arguments for these methods.

Business Service Behaviors
The FINS Application View Navigation Service is constrained by the following behaviors:

■ The business service can be invoked from any screen.

Table 61. FINS Application View Navigation Service Arguments

Name Type Description

BusComp Required The master buscomp through the view navigation.

Navigation Direction Optional Forward or Backward. Default is Forward.

Product Id Optional Product Id value.

Product Id Field Optional The field in the buscomp that is used to retrieved 
Product Ids.

Status Output ■ 0: success 

■ 1: EOF

■ 2: BOF 

■ 3: Error

Next View Name Output Name of the Next View.

FINS View Navigation 
Mgr Admin BC

Optional Name of the admin buscomp.



Siebel Insurance Guide Version 8.0, Rev. A

Business Services for Siebel Financial Services ■ FINS Application View Navigation

290 

■ The navigation is limited to the views in the current screen that are accessible to the current 
login. 

For example, if there is a product that is associated with views in both the Contact and 
Opportunity screens, and the invocation occurs inside the Contact screen, views in the 
Opportunity screen are ignored. Furthermore, the views that the current login do not have access 
to are also ignored.

■ A view in the view list that is left by clicking the Next button, is treated as a visited view.

■ At any point in the view navigation, if a next view request is triggered and there are views ahead 
of the current views not marked as visited, the service navigates to the skipped views.

■ During the navigation sequence, the master buscomp record row Id should not be changed. 
Otherwise, all the views will be treated as unvisited after the record change.

Business Service Administration
The FINS Application View Navigation Service is administered through the Administration - Product 
screen. 

To administer the FINS Application View Navigation business service

1 Navigate to the Administration - Product screen > Products view.

2 In the Products list, query for the desired product, and drill down on the product name link. 

3 Click the More Info view tab.

4 In the More Info form, click the Application Workflow view link. 

5 Create new records to associate views and their sequence to the product.

NOTE: You can associate views from any screen with a product.

If you specify views with a gap in the sequence on two different products and add both those 
products to, for example, an Application, you navigate based on sequence number and not on 
product. 

For example, if you specify:

■ View V1 with sequence 1 and view V2 with sequence 3 on product A

■ And then also specify view V3 with sequence 2 and view V4 with sequence 4 on product B

■ And then proceed to add both these products to an Application

The navigation sequence will be V1, V3, V2, V4.

Example of FINS Application View Navigation
The FINS Application View Navigation Service is used in Siebel Insurance on the Application screen, 
where the Application form contains Previous and Next buttons. 
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The invocation on the Application screen uses Applet Named Method, a feature of frame classes 
derived from CSSSWEFrameBase and CSSSWEFrameListBase. The applet User Property has the 
following name/value pairs:

The Next and Previous buttons are mapped to methods as follows:

Upgrade Note
In previous releases, the function provided by the FINS Application View Navigation business service 
was available through NextView and PrevView methods in CSSSWEFrameFINApplication. 

These methods are no longer supported since Siebel Insurance 7.7. If you have upgraded to Siebel 
Insurance 7.8 from a release prior to Siebel 7.7, the Next and Previous buttons need to be 
reconfigured following the example provided in Example of FINS Application View Navigation on 
page 290. 

■ Named Method 1: GotoPreView 'INVOKESVC', 'FINS Application View Navigation Service', 
'GotoNextView', '"BusComp'", "'Opportunity'", "'Navigation 
Direction'", "'Backward'", "'Product Id Field'", "'Opportunity 
Product Id'"

■ Named Method 1: GotoNextView 'INVOKESVC', 'FINS Application View Navigation Service', 
'GotoNextView', "'BusComp'", "'Opportunity'", "'Navigation 
Direction'", "'Forward'", "'Product Id Field'", "'Opportunity 
Product Id'"

■ Previous GotoPreView

■ Next GotoNextView
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A Siebel Insurance Reports

This appendix lists the Actuate reports that are specific to the Siebel Insurance (Table 62). For more 
information about Actuate reports, including how to customize, enhance, and create Siebel reports, 
see Siebel Reports Administration Guide.

Table 62. Siebel Insurance Reports

Report Name and Description Navigation Path Report Selection

Client Summary 

Displays all insurance policy information for 
the current contact including the policy 
effective date, policy number, premium 
amount, product, and rate plan.

Contacts > My Contacts Client Summary

FINS Call Report Detail

Displays call report details, participating 
contacts and employees, action items, and 
notes of a single call report.

Call Reports > My Call 
Reports 

Detail

FINS Call Report Summary

Displays the company profile of commercial 
banking clients including a corporate 
summary, financial profile, subsidiaries, 
contacts, and activities.

Call Reports > My Call 
Reports

Summary

FINS Contact Profile

Displays contact profile information such as 
name, address, date of birth, interests, 
experience, and activities.

Contacts > My Contacts Profile

FINS Life Policy - By City

Displays lists of life policies, grouped by city, 
with information such as premiums, effective 
dates, and insured amount.

Life and Annuities > My 
Policies/Quotes

By City

FINS Life Policy - By Sales Rep

Displays lists of life policies, grouped by sales 
representative, with information such as 
premiums, effective dates, and insured 
amount.

Life and Annuities > My 
Policies/Quote

By Sales Rep
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FINS Life Quotes - BY Source

Displays lists of life policies, grouped by 
referral source, with information such as 
premiums, effective dates, and insured 
amount.

Life and Annuities > My 
Policies/Quote

By Source

INS Auto Policy Application

A sample automobile insurance application.

Auto Policies > My Policies/
Quotes

Auto Policy 
Application

INS Auto Policy Binder

A sample automobile policy binder.

Auto Policies > My Policies/
Quotes

Auto Policy Binder

INS Auto Policy Change Request

A sample automobile insurance policy change 
request.

Auto Policies > My Policies/
Quotes

Auto Policy Change 
Request

INS Auto Policy Memorandum

A sample auto memorandum of insurance.

Auto Policies > My Policies/
Quotes

Auto Policy 
Memorandum

INS Auto Policy Receipt of Payment

A sample auto insurance receipt of payment.

Auto Policies > My Policies/
Quotes

Receipt of Payment

Opportunities - By Product Line Opportunities > My 
Opportunities

By Product Line

Table 62. Siebel Insurance Reports

Report Name and Description Navigation Path Report Selection
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A
accounts

Financial Services, as used in 20
action items

associating with call reports 71
activities

group pension plan, creating activity 
associated with 82

viewing aggregated activities for a 
company 42

activity plan templates
group policies, creating activities for the 

template 158
group policies, creating for 157

Actuate reports, table of 293
agencies

agents, adding 172
business scenario, company signs new 

agent 170
business scenario, employee adds a new 

agency 170
defined 169
information, adding information associated 

with an agent 172
new partners, adding 171

annuities
administrative tables 147
assessment template, administering 148
beneficiary, adding 150
business scenario 146
insurance product, adding 148
life or annuity coverage, defining 148
loan request, submitting 151
payment plan, setting up 152
policies, table of 145
quote, generating 149
transfer request, submitting 151
underwriting report, ordering 150
value history information, viewing 152
withdrawal or surrender request, 

submitting 151
applets

Command Center applet, configuring 
example 27

Command Center applet, defining actions 25
Command Line applet, creating global 

commands for 29

applications
associating company applications with a 

company 43
Applications Administration Guide

about setup tasks information 19
approval stage

approving or declining 278
assessment template, administering 148
assessments

company assessments, about creating 43
company assessments, performing 43

Assignment Manager
about using to resolve coverage team 

problems 36
Assignment Statements, fine tuning

about 220
Cache flag, about 222
Light Parser flag, about 221

attachments
associating with call reports 71

auto policies
auto insurance policy quote, providing 85
business scenarios 83
coverages, adding 85
discounts, adding 86
drivers, adding to policies 87
payment plan, setting up 87
underwriting information, adding 87
underwriting report, ordering 88
vehicles, adding to policies 87
vehicles, coverages, and premiums, viewing 

associated with policy 86
automating approval processing

about 275
approval items and stages, defining 275
FINS Approval Item Service, invoking from a 

workflow 276

B
beneficiaries

adding to group policies 167
beneficiary

adding a beneficiary 150
beneficiary information

recording for participant 81
billing

entering billing information group 
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pensions 80
billing accounts

about 185
billing account records, adding or 

modifying 186
business scenario 185
contact or company, associating billing 

account with 187
policy, associating a billing account with 187
service request, adding to a billing 

account 188
BRP

See Business Rule Processor
Business Rule Process

procedure, defining 213
procedure, defining a step 213
procedures, about defining 212

Business Rule Processor
about 203
business rule process, creating 206
creating and managing, about 205
existing process, revising 206
process of defining 204
process, activating 207
process, exporting 207
process, importing 207
properties, defining 208
property types. about 208
property, defining 211

Business Rules Process
errors, recovering from within process 223
errors, throwing errors within 222
FINS CAP Buscomp Data Loader Business 

Service 224
FINS CAP Buscomp Handler Business 

Service 228
helper business services, about using 224

Business Rules Processor
debug messages, logging 236
invoking using eScript 235
invoking, about 234

business services
about 194
active business objects, use of 271
approval items and stages, defining 275
approval stage, approving or declining 278
Assignment Statements, fine tuning 220
automating approval processing 275
Business Rule Process procedure, 

defining 213
Business Rule Process procedure, defining a 

step 213
Business Rule Process procedures, 

defining 212

Business Rule Processor debug messages, 
logging 236

Business Rule Processor property types 208
Business Rule Processor property, 

defining 211
Business Rule Processor, about 203
Business Rule Processor, about creating and 

managing 205
Business Rule Processor, activating a 

process 207
Business Rule Processor, creating 206
Business Rule Processor, defining 

properties 208
Business Rule Processor, exporting a 

process 207
Business Rule Processor, importing a 

process 207
Business Rule Processor, invoking using 

eScript 235
Business Rule Processor, process of 

defining 204
Business Rule Processor, revising an existing 

process 206
Business Rules Process, about using helper 

business services 224
Business Rules Process, recovering from 

errors 223
Business Rules Process, throwing errors 

within 222
Business Rules Processor, invoking 234
Cache flag, about 222
calculation details, specifying 253
calculation expressions in Data Transfer 

Utilities 266
Calculation Manager, about and 

examples 251
Calculation Manager, invoking 256
calculation rule set. specifying 251
Customer Authentication Manager 245
Customer Authentication Manager, 

invoking 249
customer authentication rules, creating 248
customer authentication templates, 

creating 246
Customer Expectation Manager rules, 

defining 258
Customer Expectation Manager, 

invoking 260
Customer Expectations Manager 257
data map component advanced options 262
data map components 261
data map fields 264
data map objects 261
data maps, about 260
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Data Transfer method 268
Data Transfer Utilities, about 260
Data Validation Manager, about 202
disclosure documents, activating workflows 

used to display 281
disclosure history, viewing associated with 

contacts 282
disclosure processing, automating 

display 279
Disclosure UI Service, about invoking from 

workflow 281
disclosure workflow processes (table) 280
disclosures, associating with a product 279
dynamic applet, creating with Dynamic UI 

business service example 285
dynamic applet, displaying in a workflow 286
dynamic enabling of commands 273
Dynamic UI business service, about 285
Dynamic UI Service methods 288
embedded script for mortgage calculation 

example 254
event-based commands, configuring 272
existing disclosure, revising 279
FINS Application View Navigation 

Service 288
FINS Application View Navigation Service 

example 290
FINS Application View Navigation Service, 

administering 290
FINS Application View Navigation Service, 

behaviors 289
FINS Application View Navigation Service, 

methods 289
FINS Application View Navigation Service, 

upgrade note 291
FINS Approval Item Service, invoking from a 

workflow 276
FINS CAP Buscomp Data Loader Business 

Service 224
FINS CAP Buscomp Handler Business 

Service 228
FINS SmartScript Output Service 

methods 285
FINS Web Shopping Service methods 284
Free Format Converter 201
invocation context 271
Light Parser flag, about 221
named parameters, using in Data Transfer 

Utilities 265
Record Group templates, creating 242
record templates, creating 238
recursive invocation 272
requirement templates, creating 239
Requirements Manager 237

Requirements Manager key features 237
Requirements Manager, about invoking 237
Requirements Manager, administration 

steps 238
Requirements Manager, example of using for 

Record Group templates 244
Requirements Manager, invoking 242
SmartScript, about invoking from a 

workflow 282
SmartScript, integrating with workflow 

example 283
Template Definition view, adding views and 

applets 288
variables, specifying 252
VBC cache and Instance Manager 196
view template, about creating for dynamic 

applets 287
well-positioned buscomps 271
what is a business service 194

C
Cache flag, about 222
Calculation Expectations Manager

about 257
invoking 260
rules, defining 258

calculation expressions
about 266
curley bracket pair {field} 266
named parameters 267

Calculation Manager
about and examples 251
calculation details, specifying 253
calculation rule set, specifying 251
embedded script for mortgage calculation 

example 254
invoking 256
variables, specifying 252

call report email templates
viewing or changing 69

call reports
action items, notes, and attachments, 

associating with 71
business scenario 66
call report charts, viewing 67
call report distribution list, creating 71
call report email templates, viewing or 

changing 69
call report privacy flag, setting 72
call report, adding 69
Data Transfer Utility, about using 68
defined and about 65
emailing and printing 72
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New Call Report Workflow, activating 68
categories

creating contact information for 52
census data

census information, adding 160
detailed census data, importing 159
segmented census data, importing 160

claim elements
defined 107

claimant property information, recording 
adverse 106

claims 114
activity plan, creating 110
adjuster’s financial limits, administering 99
appraisals, adding 113
assigning claim to adjuster 108
bulk payments 127
business rules processor 138
business scenario 92
claim elements 111
claimant property information, recording 

adverse 106
Claims Center Locators, about setting up 95
Claims Center Locators, assigning longitude 

and latitude 96
Claims Center Locators, assigning new claim 

center 96
Claims Center Locators, entering claim center 

information 96
coverages, about 114
employee hierarchy, administering 100
events 107
events, creating 107
first notice of loss, creating 104
fraud information, managing 134
Insurance Services Office, integrating 

with 100
insured property information, recording 106
invoice records, creating 121
ISO database, checking a claim against 108
loss codes, administering 98
loss, associating an involved party with 105
Office of Foreign Assets Control, integrating 

with 103
payment record, generating 122
payment, issuing settlement 127
payment, tracking demands for 121
police and fire reports, tracking 114
policy validity, checking 104
recovery information, managing 128
reserve codes, administering 97
reserves, about 114
reserves, adjusting 120
reserves, creating 120

reserves, deleting 120
reserves, managing 117
reserves, opening 120
settlement payments, issuing 122
specialist unit, assigning claims to 112
workflow processes 97
workflows 141

ClearCache method, about 228
Collapse button

Edit Layout view 21
summary view control, about 20

command center
about and interface types 22
configuration and administration, about 22

Command Center Action form
Command Center Action applet, configuring 

example 27
Command Center action, selecting 

responsibilities 27
Command Center applet, defining actions 25
Command Center business object, 

defining 23
process of configuring appearance and 

functions 22
Command Center applet

configuring example 27
defining actions 25

Command Center business object
defining 23

Command Line applet
creating for global commands 29

commands
dynamic enabling, about 273
event-based commands, configuring 272
Mock Event Sink mode 274
Srf mode 274
toolbar buttons, defining 274

companies
about 31
aggregated activities viewing for a 

company 42
aggregated coverage team, viewing 42
aggregated list of contacts, viewing 43
aggregated opportunities, viewing 42
billing account, associating with 187
business scenario, sales representative tracks 

company information 33
company applications, associating with a 

company 43
company assessments, about creating 43
company assessments, performing 43
company coverage team, adding a 

member 45
company coverage teams, about 
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managing 45
company hierarchies, about 32
company hierarchies, default 39
company information, making unavailable to 

users 35
company or investor, adding 41
company summaries, viewing 45
competitor designation, changing 36
competitor, indicating a company is a 

competitor 35
coverage team members, about verifying 36
coverage team members, adding or 

deleting 37
coverage team members, search for a 

company without 36
custom-defined relationship type, about 

managing 37
custom-defined relationship type, adding 37
custom-defined relationship, creating 46
data aggregation, about generating company 

hierarchies for 38
default company hierarchy, generating 39
dynamic company hierarchy, creating 40
industry, adding 34
parent-subsidiary relationship, 

establishing 46
primary coverage team members, 

changing 37
service requests, adding associated with a 

company 44
territory, adding 35
values, about setting up 34

company hierarchies
aggregated activities, viewing for a 

company 42
aggregated coverage team, viewing 42
aggregated list of contacts, viewing 43
aggregated opportunities, viewing 42
data aggregation, generating for 38
default company hierarchies 39
default company hierarchy, generating 39
dynamic company hierarchy, creating 40

company relationship hierarchies
custom-defined relationship, creating 46
viewing 46

company summaries, viewing 45
competitor

company, indicating as a competitor 35
designation, changing competitor 

designation 36
contacts

adding 51
billing account, associating with 187
business scenario, sales representative adds a 

new contact 50
categories, creating for contact 

information 52
company, associating a contact with a 

company 52
contact relationship hierarchies, viewing 56
contact summary, viewing 56
customer assessments, about creating 55
customer assessments, creating 55
customer value stars. adjusting 56
defined 49
disclosure history, viewing associated with 

contacts 282
financial plans, creating 58
group pension plan contacts, recording 79
household, adding to a 61
households, associating with 61
managing contact information, about 51
mortgages, managing 58
notes, creating about contacts 53
referral, creating to a contact 54
referral, entering a referral received from a 

contact 53
relationship between contacts, defining 57

coverage teams
company coverage team, adding a 

member 45
company coverage teams, about 

managing 45
customer assessments

creating 55
creating, about 55
customer value stars, adjusting 56

Customer Authentication Manager
about 245
customer authentication rules, creating 248
customer authentication templates, 

creating 246
invoking 249

customer value stars, adjusting 56
customizable products

reconfiguring in plan design 164
Customize Plan button, using 164

D
data aggregation

company hierarchies, default 39
company hierarchies, generating for data 

aggregation 38
default company hierarchy, generating 39
dynamic company hierarchy, creating 40

Data Transfer method
arguments and descriptions 268
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FAFireEventxx method 269
GetActiveViewProp method 269
QueueMethod 270
TryMockMethod 270

Data Transfer Utilities
about 260
about using 68
active business objects 271
calculation expressions in DTU, about 266
data map component advanced options 262
data map components 261
data map fields 264
data map objects 261
data maps, about 260
Data Transfer method 268
invocation context 271
named parameters, using in DTU 265
recursive invocation 272
well-positioned buscomps 271

Data Validation Manager
about 202

deleting
company information, making unavailable to 

users 35
coverage team members 37

disclosure documents
automating display, about 279
contacts, viewing disclosure history 282
Disclosure UI Service, invoking from 

workflow 281
disclosure workflow processes (table) 280
disclosures, associating with a product 279
existing disclosure, revising 279
workflows, activating used to display 

disclosure documents 281
Disclosure UI Service

invoking from a workflow 281
discounts auto policies, adding 86
distribution list

about creating 71
documentation, attaching 114
Drivers, adding to auto policies 87
dynamic applets

See Dynamic UI business service
dynamic company hierarchy, creating 40
Dynamic UI business service

about 285
dynamic applet, creating with Dynamic UI 

business service example 285
dynamic applet, displaying in a workflow 286
Dynamic UI Service methods 288
Template Definition view, adding views and 

applets 288
view template, about creating for dynamic 

applets 287

E
Edit Layout view

about using and buttons 21
email templates

viewing or changing call report email 
templates 69

emailing
call reports 72

employees
adding employee classes for group 

policies 161
enrolling

new participants in group pension plan 81
enrolling members

in group policies 166
enrollment waiting periods

coverage, impacting on the start of 163
errors

Business Rules Process, throwing errors 
within 222

recovering from errors within a Business Rules 
Process 223

event-based commands
configuring 272

Expand button
Edit Layout view 21
summary view control, about 20

F
facility locator, adding facilities 96
FAFireEventxxx method 269
financial plans, creating 58
FINS Application View Navigation Service

about 288
administering 290
business service behaviors 289
business service methods 289
example 290
upgrade note 291

FINS Approval Item Service
business service step, configuring 278
start step, configuring 277
workflow, about invoking 276

FINS CAP Buscomp Data Loader Business 
Service

about 224
ClearCache method, about 228
LoadData method example using field 

[n] 227
LoadData method example using Key and 

Value fields 228
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LoadData method, about 225
FINS CAP Buscomp Handler Business Service

about 228
GetFieldValue method, about 231
InsertRecord method, about 232
NextRecord method, about 233
query method, about 229
SetFieldValue method, about 232

FINS EAI Free Format Converter
about 201
methods 201
user properties 201

FINS Group Policy Member benefits business 
component

enrollment waiting period, about rules 163
FINS SmartScript Output Service 

methods 285
FINS Web Shopping Service methods 284
fire reports, tracking 114
Free Format Converter

about 201
methods 201
user properties 201

funds
group pension plan, viewing available within 

plan 81

G
geocode data, about 95
GetActiveViewProp method 269
GetFieldValue method, about 231
global commands

creating for the Command Line applet 29
group pensions

activity, creating associating with a plan 82
administering group pension plans, list of 

tasks 80
billing information, entering 80
business scenario 75
eligible plan members, adding 81
funding vehicles, defining for a group pension 

product 77
funds and investments available within plan, 

viewing 81
group pension plan contacts, recording 79
group pension plan, defining 78
group pension plans, process of defining 78
group pension product, defining 77
managing, about 75
new participants, enrolling in plan 81
note, creating associated with a plan 82
participant beneficiary information, 

recording 81

participant classes, defining for plan 
participants 79

plan rules, specifying 79
service request, creating associated with 

plan 81
tasks, samples performed when managing 

group pensions (diagram) 76
group policies

activity plan templates, creating 157
activity plan templates, creating activities for 

the template 158
beneficiaries, adding 167
business scenario 155
census data, importing 159
census information, adding 160
customizable products, reconfiguring in plan 

design 164
defined 153
employee classes, adding for group 

policies 161
enrollment waiting periods, impact start of 

coverage 163
group insurance products, adding 156
group policy record, adding 158
members, adding eligible members 166
members, enrolling members 166
payment plans, setting up 167
plans, adding for group policies 162
policy screens, views common to all 154
proposal templates, creating 158
proposals, generating for group policies 164
rate bands, adding 157
segmented census data, importing 160
underwriting information, adding 165
underwriting information, viewing 165

H
Hide button

Edit Layout view 21
summary view control, about 20

households
business scenario 60
contact, adding to a household 61
contacts, associating with households 61
defined 59
household summary, viewing 62
privacy option, setting 61
relationship hierarchy, about viewing 62

I
importing

census data 159
segmented census data 160
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InsertRecord method, about 232
Instance Manager, and VBC Cache

about 196
caching VBC configuration 198
components 197
features and limitations 196
purging the VBC cache 199
stages of caching process 197

insurance policy, associating with billing 
account 187

Insurance Services Office 100
insurance, group policies

about 153
activity plan templates, creating 157
activity plan templates, creating activities for 

the template 158
beneficiaries, adding 167
business scenario 155
census data, importing 159
census information, adding 160
customizable products, reconfiguring in plan 

design 164
employee classes, adding for group 

policies 161
enrollment waiting periods, impact start of 

coverage 163
group insurance products, adding 156
group policy record, adding 158
members, adding eligible members 166
members, enrolling 166
payment plans, setting up 167
plans, adding for group policies 162
policy screens, views common to all 154
proposal templates, creating 158
proposals, generating for group policies 164
rate bands, adding 157
segmented census data, importing 160
underwriting information, adding 165
underwriting information, viewing 165

insurance. See auto policies; life insurance; 
PUL policies

integration
integration messages 190

investments
viewing available within group pension 

plan 81
investors

about 31
investor, adding 41

involved parties
loss, associating with 105

ISO ClaimSearch database 108

L
latitude and longitude

assigning 96
life insurance

administrative tables 147
assessment template, administering 148
beneficiary, adding 150
business scenario 146
insurance product, adding 148
life or annuity coverage, defining 148
loan request, submitting 151
payment plan, setting up 152
policies, table of 145
quote, generating 149
transfer request, submitting 151
underwriting report, ordering 150
value history information, viewing 152
withdrawal or surrender request, 

submitting 151
Light Parser flag, about 221
List of Values

about configuring 20
LoadData method

about and parameters 225
ClearCache method, about 228
example using field [n] 227
example using Key and Values fields 228

loan request, submitting 151
loss

See also loss report
first notice, creating 104
involved party, associating with 105

loss report
See also loss
adverse claimant property 106
associating involved party 105
creating first notice 104
insured property 106
issuing settlement payment 127
police and fire reports 114
salvage and subrogation 128

M
members

beneficiaries, adding to group policies 167
eligible members, adding 166
enrolling members 166

Mobile Web Client
about performing administrative functions on 

local db 19
Mock Event Sink mode 274
mortgages, managing

about 58
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Move down button
Edit Layout view 21

Move up button
Edit Layout view 21

N
National Association of Security Dealers 

(NASD) registration
tracking 172

New Call Report Workflow
activating 68
Data Transfer Utility, about using to 

modify 68
NextRecord method, about 233
notes

call reports, associating with 71
creating about contacts 53
group pension plan, creating associated with 

plan 82

O
Office of Foreign Assets Control 103

P
parent-subsidiary relationship

establishing 46
partners

agents, adding 172
business scenario, company signs new 

agent 170
business scenario, employee adds a new 

agency 170
defined 169
information, adding information associated 

with an agent 172
new partners, adding 171
sharing data with partner, about 

enabling 169
payments

auto policy payment plan, setting up 87
claims, tracking demands for 121
payment plan, setting up 152
payment plan, setting up for group 

policies 167
property policy, setting up payment plan 180
settlement, issuing 127

pensions
See group pensions

personal umbrella liability. See PUL policies
plans

customizable products, reconfiguring in plan 
design 164

group policies, adding for 162
payment plans, setting up for group 

plans 167
police reports, tracking 114
policy premiums. See billing accounts
policy screens, common views 154
printing

call reports 72
privacy flags

setting the call report privacy flag 72
privacy option, setting 61
products

customizable products, reconfiguring in plan 
design 164

property coverage
adding property coverage 177
property coverage limit, adding 177

property information
recording 106
recording adverse claimant 106

property insurance policy, providing a 
quote 178

property policies
Accident Violation view tab, about 181
All SPP Items view tab, about 181
Boat Details view tab, about 181
Boat Operator view tab, about 181
business scenario 175
payment plan, setting up 180
property coverage limit, adding 177
property coverage, adding 177
property insurance policy quote, providing 

a 178
property types, adding 177
property underwriting information, querying 

for 179
Replacement Cost Summary view tab, 

about 180
Replacement Cost view tab, about 180
scheduled personal property, adding 179
underwriting information, adding 178
underwriting report, ordering 179

proposal templates
creating for group policies 158

proposals
group policies, about generating for 153
group policies. generating for 164

PUL policies
about 183
business scenario 183
PUL insurance policy quote, generating 184
Rate button, about adding 184
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Q
querying for property underwriting 

information 179
QueueMethod 270
quotes

auto insurance policy quote, providing 85
life insurance or annuity, generating 

quote 149
property insurance policy, providing a 

quote 178
PUL insurance policy quote, generating 184

R
rate bands

plans, adding for group policies 162
rate band, adding* 157

Rate button, about adding 184
rate policies, adding Rate button 184
Record Group templates

creating 242
Requirements Manager, example of using for 

Record Group templates 244
record templates, creating 238
referral information

referral, creating to a contact 54
referral, entering a referral received from a 

contact 53
relationship hierarchy

contact, about viewing 56
contacts, defining a relationship between 

contacts 57
household relationship hierarchy, about 

viewing 62
relationship types, custom defined

managing, about 37
managing, adding 37

reports
table of 293

requirement templates, creating 239
Requirements Manager

about and scenarios 237
administration steps 238
example of using for Record Group 

templates 244
invoking Requirements Manager 242
invoking, about 237
key features 237
Record Group templates, creating 242
record templates, creating 238
requirement templates, creating 239

roll-up views
aggregated activities, viewing for a 

company 42

aggregated coverage team, viewing 42
aggregated opportunities, viewing 42

S
salvage and subrogation, recording 

details 128
scheduled personal property, adding 179
service requests

adding associated with company 44
billing account, adding to 188
group pension plan, creating associating 

with 81
SetFieldValue method

about 232
settlement, issuing payment 127
Show button

Edit Layout view 21
Siebel Calculation Expectations Manager

about 257
Siebel Calculation Manager

See Calculation Manager
SmartScript

FINS SmartScript Output Service 
methods 285

FINS Web Shopping Service methods 284
integrating with workflow example 283
workflow, about invoking from 282

Srf mode 274
summary information

viewing a household summary 62
summary views

configuring, about 20
layout, editing 21

surrender request, submitting 151

T
team members

coverage team members, about verifying 36
coverage team members, adding or 

deleting 37
coverage team members, searching for a 

company without 36
primary coverage team members, 

changing 37
Template Definition view

adding views and applets 288
templates

activity plan templates, creating activities for 
group policies 158

activity plan templates, creating for group 
policies 157

call report email templates, viewing or 
changing 69
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customer authentication templates, 
creating 246

Dynamic UI Service methods 288
proposal templates, creating for group 

policies 158
Record Group templates, creating 242
Record Group templates, example of using 

Requirements Manager for 244
record templates, creating 238
requirement templates, creating 239
Template Definition view, adding views and 

applets 288
view template, about creating for dynamic 

applets 287
toolbar buttons, defining 274
transfer request, submitting 151
TryMockMethod 270

U
umbrella policies. See PUL policies
underwriting

auto policies report, ordering 88
auto policy underwriting information, 

adding 87
information, adding 178
property underwriting information, querying 

for 179
report, ordering (life and annuities) 150
report, ordering (property policies) 179

underwriting information
adding 165
viewing 165

V
value history information, viewing 152
VBC Cache and Instance Manager

about 196
caching VBC configuration 198
components 197
features and limitations 196
purging the VBC cache 199
stages of caching process 197

Vehicles, adding to auto policies 87
view template

dynamic applets, about creating for 287
Dynamic UI Service methods 288
Template Definition view, adding views and 

applets 288

W
wealth management industry

about access to household’s aggregated 
holdings 60

withdrawal request, submitting 151
workflows

disclosure documents, activating (table) 281
Disclosure UI Service, invoking from a 

workflow 281
disclosure workflow processes (table) 280
dynamic applets, displaying in a 

workflow 286
FINS Approval Item Service, invoking from a 

workflow 276
SmartScript, about invoking from a 

workflow 282
SmartScript, integrating with workflow 

example 283
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